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Crashed Disk and File Recovery, Backup, Optimization, and Security 

• Preinstall SUM Shield for fast and 
easy data recovery 

• Recover crashed disks and 
deleted files with SUM Recover 
even if SUM wasn't installed 

• Backup and restore applications 
and files with SUM Backup 

• Improve disk speed and perfor­
mance with SUM TuneUp 

• Organize and secure disks with 
SUM Partition 

• Encrypt documents and folders 
with SUM Encrypt 

• Copy and initialize floppies fast 
with SUM QuickCopy 

• Edit files. disks, and memory with 
SUM Tools 

• Diagnose and repair disk problems 
quickly with SUM Disk Clinic 

IMPORTANT NOTICE 

US State Department license 
required to export this product 
outside the US and Canada. 



Dear Symantec Customer: 

Congratulations on your choice of Symantec Software, the "Perfect 
Balance Of Performance And Quality." 

This software product has been tested and assured to be compatible 
with Apple's new System 7 operating system with the exception of the 
SUM Tools module. SUM Tools does not operate under System 7. 
To use SUM Tools, create a System 6.0.x start-up disk and copy SUM 
Tools on to it. Then start your Macintosh from this disk whenever 
SUM Tools is required. All the other functionality of SUM II remains 
unchanged and fully compatible with System 7. 

Our quality assurance team has noted that several popular System 
Enhancements (lNITs) are not compatible with System 7. The SUM 
Installer is vulnerable to incompatible System Enhancements. To 
install SUM II under System 7, hold down the shift key while System 
7 starts-up. This will temporarily disable all System Enhancements 
until the next time you start-up. 

Please refer to the SUM II manual for instructions in the use of the 
many excellent features in this product. 

Thank you for selecting Symantec. We value your business and 
welcome your comments and suggestions. 

Sincerely, 

Alison Unden 

06001-92000-03011-38265 

06-70-00044 
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SYMANTEC. 
License Agreement 

This is a legal agreement between you, the end user, and 
Symantec Corporation ("Symantec"). The enclosed Symantec 
software program (the "SOFTWARE") is licensed by Syman­
tec to the original purchaser and any subsequent owner of the 
product for use only on the terms set forth here. Please read 
this license agreement. Opening this diskette package indi­
cates that you accept these terms. If you do not agree to these 
terms, return this product, with the diskette package un­
opened, to your dealer within 30 days for a full refund. 

• GRANT OF LICENSE. Symantec grants to you the right to 
use one copy of the enclosed SOFTWARE on a single user 
computer system (i.e., with a single CPU). You may not 
network the SOFTWARE or otherwise use it on more than one 
computer or computer terminal at the same time. 

• COPYRIGHT. The SOFTWARE is owned by Symantec or its 
suppliers and is protected by United States copyright laws and 
international treaty provisions. Therefore, you must treat the 
SOFTWARE like any other copyrighted material (e.g., a book 
or musical recording) except that you may either (a) make two 
copies of the SOFTWARE solely for backup or archival pur­
poses provided that you reproduce all copyright and other 
proprietary notices that are on the original copy of the SOFT­
WARE provided to you, or (b) transfer the SOFTWARE to a 
single hard disk provided you keep the original solely for 
backup or archival purposes. You may not copy the written 
materials accompanying the SOFTWARE. 

• OTHER RESTRICTIONS. You may not rent or lease the 
SOFTWARE, but you may transfer the SOFTWARE and ac­
companying written materials on a permanent basis provided 
you retain no copies and the recipient agrees to the terms of the 
Agreement. You may not decompile, deassemble, or create 
derivative works from the SOFTWARE. 

• DUAL MEDIA SOFTWARE. If the SOFTWARE package 
contains both 3-1/2" and 5-1/4" disks, then you may use only 
the disks appropriate for your single-user computer. You may 
not use the other disks on another computer or computer 
network or loan, rent, lease, or transfer them to another user 
except as part of the permanent transfer (as provided above) 
of all SOFTWARE and written manuals. 

• LANGUAGE SOFTWARE. If the SOFTWARE is a Symantec 
language product, then you have a royalty-free right to include 
object code derived from the libraries in programs that you 
develop using the SOFTWARE, and you also have the right to 
use, distribute, and license such programs to third parties 
without payment of any further license fees, so long as a 
copyright notice sufficient to protect your copyright in the 
software in the United States or any other country is included 

in the graphic display of your software and on the labels affixed 
to the media on which software is distributed. 

• GOVERNMENT LICENSEE. If you are acquiring the SOFT­
WARE on behalf of any unit or agency of the United States 
Government, the following provisions apply: 

The Government acknowledges Symantec's representation 
that the SOFTWARE and its documentation were developed 
at private expense and no part of them is in the public domain. 

The Government acknowledges Symantec's representation 
that the SOFTWARE is "Restricted Computer Software" as 
that term is defined in Clause 55.227-19 of the Federal 
Acquisition Regulations (FAR) and is "Commercial Computer 
Software" as that term is defined in Subpart 227.401 of the 
Department Defense Federal Acquisition Regulation Supple­
mental (DFARS). The Government agrees that: 

(i)1f the SOFTWARE is supplied to the Department of De­
fense (000), the SOFTWARE is classified as "Commercial 
Computer Software" and the Government is acquiring only "re­
stricted rights" in the SOFTWARE and its documentation as 
that term is defined in Clause 55.227-7013 (c) (1) of the 
DFARS. 

(ii) If the SOFTWARE is supplied to any unit or agency of the 
United States Government other than 000, the Government's 
rights in the SOFTWARE and its documentation will be as 
defined in Clause 55.227-19 (c) 2 of the FAR. 

RESTRICTED RIGHTS LEGEND. Use, duplication, or disclo­
sure by the Government is subject to restrictions as set forth in 
subparagraph (c) (1) (iii) of the Rights in Technical Data and 
Computer Software clause at DFARS 55.227 -7013. Symantec 
Corporation, 10201 Torre Avenue, Cupertino, CA 95014. 

EXPORT LAW ASSURANCES. You acknowledge and agree 
that the SOFTWARE is subject to restrictions and controls 
imposed by the United States Export Administration Act (the 
"Act") and the regulations thereunder. You agree and certify 
that neither the SOFTWARE nor any direct product thereof is 
being or will be acquired, shipped, transferred, or reexported, 
directly or indirectly, into any country prohibited by the Act and 
the regulations thereunder or will be used for any purpose 
prohibited by the same. 

GENERAL. This Agreement will be governed by the laws of the 
State of California, except for that body of law dealing with 
conflicts of law. 

The following applies to user's of Symantec network products: 

• GRANT OF LICENSE. Symantec grants to you the right to 
use one copy of the enclosed SOFTWARE on a single terminal 



connected to a single computer (Le., with a single CPU), or on 
a LICENSED COMPUTER NETWORK. A computer network 
is any combination of two or more terminals that are electroni­
cally linked and capable of sharing the use of a single software 
program. A LICENSED COMPUTER NETWORK is a com­
puter network for which you have purchased and dedicated at 
least one (1) Symantec SOFTWARE manual (which can 
include an instruction manual or manuals for the single-user 
version of the SOFTWARE) for each concurrent user of the 
SOFTWARE on the network. Each concurrent user of the 
SOFTWARE must have exclusive access to a Symantec 
SOFTWARE manual during his use. 

• DUAL MEDIA SOFTWARE. If the SOFTWARE package 
contains both 3-1/2" and 5-1/4" disks, then you may use only 
the disks appropriate for your single-user computer or LI­
CENSED COMPUTER NETWORK FILE SERVER. You may 
not use the other disks on another computer or computer 
network, or loan, rent, lease, or transfer them to another user 
except as part of the permanent transfer (as provided above) 
of all SOFTWARE and written materials. 

Should you have any questions concerning this Agreement, or 
if you desire to contact Symantec for any reason, please write: 
Symantec Customer Sales and Service, 10201 Torre Avenue, 
Cupertino, CA 95014. 

Limited Warranty 

To the original buyer only, Symantec warrants for the period of 
ninety (90) days from the date of delivery of the SOFTWARE 
to you as evidenced by a copy of your receipt, or until the 
SOFTWARE is modified by you, which ever period is shorter, 
that: (1) The SOFTWARE, unless modified by you, will perform 
substantially the functions described in the documentation 
provided by Symantec. (2) The media on which the SOFT­
WARE is furnished will be free from defects in materials and 
workmanship under normal use. 

Your sole remedy under this warranty is that Symantec will 
undertake to correct within a reasonable period of time any 
reported "SOFTWARE Error" (failure of the SOFTWARE to 
perform substantially the functions described in the documen­
tation), correct errors in the documentation, and replace any 
magnetic media which proves defective in materials or work­
manship on an exchange basis without charge. In order to 
make a claim under this warranty you must return the defective 
item with proof of purchase to Symantec or an authorized 
dealer, postage prepaid, during the warranty period. If Syman­
tec is unable to replace defective media or if Symantec is 
unable to provide corrected SOFTWARE or corrected docu­
mentation within a reasonable time, Symantec will, at its sole 
and exclusive option, either replace the SOFTWARE with a 
functionally equivalent program at no charge to you or refund 

the purchase price of the SOFTWARE. These are your sole 
and exclusive remedies for any breach of warranty. 

Symantec does not warrant that the SOFTWARE will meet 
your requirements, that operation of the SOFTWARE will be 
uninterrupted or error-free, or that all SOFTWARE errors will 
be corrected. Symantec is not responsible for problems caused 
by changes in the operating characteristics of computer hard­
ware or computer operations systems which are made after 
the release of the SOFTWARE nor for problems in the interac­
tion of the SOFTWARE with non-Symantec software. Syman­
tec will have no responsibility to replace or refund the purchase 
price of the media damaged by accident, abuse, or misappli­
cation. 

THE ABOVE WARRANTIES ARE EXCLUSIVE AND IN LIEU 
OF ALL OTHER WARRANTIES, WHETHER EXPRESS OR 
IMPLIED, INCLUDING THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE. NO ORAL OR WRITTEN INFORMATION OR 
ADVICE GIVEN BY SYMANTEC, ITS EMPLOYEES, DIS­
TRIBUTORS, DEALERS OR AGENTS SHALL INCREASE 
THE SCOPE OF THE ABOVE WARRANTIES OR CREATE 
NEW WARRANTIES. 

SOME STATES DO NOT ALLOW THE EXCLUSION OF 
IMPLIED WARRANTIES, SQ THE ABOVE EXCLUSION MAY 
NOT APPLY TO YOU. IN THAT EVENT, ANY IMPLIED 
WARRANTIES ARE LIMITED IN DURATION TO NINETY 
(90) DAYS FROM THE DATE OF DELIVERY OF THE SOFT­
WARE. THIS WARRANTY GIVES YOU SPECIFIC LEGAL 
RIGHTS. YOU MAY HAVE OTHER RIGHTS, WHICH VARY 
FROM STATE TO STATE. 

Limitations of Remedies 

REGARDLESS OF WHETHER ANY REMEDY SET FORTH 
HEREIN FAILS OF ITS ESSENTIAL PURPOSE, IN NO EVENT 
WILL SYMANTEC BE LIABLE TO YOUR FOR ANY SPE­
CIAL, CONSEQUENTIAL, INDIRECT OR SIMILAR DAM­
AGES, INCLUDING ANY LOST PROFITS OR LOST DATA 
ARISING OUT OF THE USE OR INABILITY TO USE THE 
SOFTWARE OR ANY DATA SUPPLIED THEREWITH EVEN 
IF SYMANTEC OR AN AUTHORIZED SYMANTEC DEALER 
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES, OR FOR ANY CLAIM BY ANY OTHER PARTY. 

SOME STATES DO NOT ALLOW THE LIMITATION OR EX­
CLUSION OF LIABILITY FOR INCIDENTIAL OR CONSE­
QUENTIAL DAMAGES SO THE ABOVE LIMITATION OR EX­
CLUSION MAY NOT APPLY TO YOU. 

IN NO CASE SHALL SYMANTEC'S LIABILITY EXCEED THE 
PURCHASE PRICE FOR THE SOFTWARE. 



Product Support 

All Symantec Corporation products are thoroughly tested and 
come with a comprehensive User Guide. However, if you have 
a problem using the product, we recommend you do the follow­
ing: 

1. Review the User Guide - it answers most questions and 
problems. Also, check your computer system to make oertain 
the program works with its operating system, interfaces, pe­
ripherals, and overall configuration. 

2. If you purchased this product from a dealer, please consult 
their staff - they are your best source for convenient, local 
assistance. Most dealers are familiar with the operation of 
Symantec Corporation products. 

3. If you still have a problem, contact Symantec Corporation 
at the address below, or call our Product Support Hotline at 
408-253-2167 (in North America) between the hours of 8:00 
a.m. and 5:00 p.m. Pacific time, Monday through Friday. When 
you call, please have your User Guide and original Program 
Disks at hand and, if possible, be seated at your computer with 
the product running. This makes it easier for our Product 
Support Analyst to understand your problem and assist you 
promptly. If you prefer, you can write to us at the following 
address (be sure to include your telephone number for a faster 
response): 

Symantec Corporation 
Utilities Group 

Product Support Department 
10201 Torre Avenue 
Cupertino, CA 95014 

Outside of the United States, product warranties, registration, 
guarantees, and support are offerred locally in many countries. 
If you are located outside the United States or Canada, please 
contact your local Symantec office or distributor for product 
support. To obtain information about the Symantec office or 
distributor in your area, please call (408) 253-9600. 

For information regarding this product in the United Kingdom, 
telephone Symantec (UK) Ltd. directly at (0628) 776343, or 
write to us at the following address: 

Symantec (UK) Ltd. 
MKA House 

36 King Street 
Maidenhead, Berkshire, SL6 1 EF England 

Copyrights 

Program copyrights © 1989-1990, Micro Analyst, Inc. and Mi­
croseeds Publishing. The Symantec Utilities for Macintosh 
User Guide is copyrighted and all rights reserved. Information 
in this document is subject to change without notice and does 
not represent a commitment on the part of Symantec Corpo­
ration. The software described in this document is furnished 
under a license agreement. The document may not, in whole 
or in part, be copied, photocopied, reproduced, translated, or 
reduced to any electronic medium or machine readable form 
without prior consent, in writing, from Symantec Corporation. 

SYMANTEC CORPORATION MAKES NO WARRANTIES, 
EITHER EXPRESS OR IMPLIED, REGARDING THE EN­
CLOSED COMPUTER SOFTWARE PACKAGE, ITS MER­
CHANTABILITY, OR ITS FITNESS FOR ANY PARTICULAR 
PURPOSE. THE EXCLUSION OF IMPLIED WARRANTIES 
IS NOT PERMITTED BY SOME STATES. THE ABOVE 
EXCLUSION MIGHT NOT APPLY TO YOU. THIS WAR­
RANTY PROVIDES YOU WITH SPECIFIC LEGAL RIGHTS. 
THERE MIGHT BE OTHER RIGHTS YOU HAVE WHICH 
VARY FROM STATE TO STATE. 

Trademarks 

Macintosh is a trademark of Apple Computer, Inc. SUM is a 
trademark of Symantec Corporation. Other brands and their 
products are trademarks of their respective holders and should 
be noted as such. 

30 Day Money-Back Guarantee* 

If within 30 days of purchase this product does not perform in 
accordance with our claims, you may return it to your dealer for 
a refund. If you purchased it directly from Symantec Corpora­
tion, a Returned Merchandise Authorization (RMA) number 
must be assigned. To obtain an RMA number, please call 408-
253-9600 between 8:00 a.m. and 5:00 p.m. Pacific time, 
Monday through Friday. You will be given an RMA number and 
instructions on where to return the product. Returns will not be 
accepted without an RMA number. 

* Available in U.S. only. For information outside of the U.S., 
please contact your local distributor regarding local policies. 
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SUM Disk Clinic 
Recovery Procedures 

This section contains graphic, step-by-step instruc­
tions to help you use SUM Disk Clinic's various proce­
dures. These procedures will help you: 

• Repair a damaged volume. 

• Recover files from a crashed volume. 

• Recover deleted files from a volume. 

This section is divided by recovery procedure, such as 
how to recover a damaged volume or check a volume 
for errors. With any recovery procedure, you begin by 
launching SUM Disk Clinic, but the volume from which 
you launch SUM Disk Clinic depends on the recovery 
procedure you are attempting. 

For example, if you have a crashed hard disk, you 
shouldn't install and launch SUM Disk Clinic from that 
hard disk. Instead, make working copies of SUM Pro­
gram Disks#1 and#2, and launch SUM DiskClinicfrom 
your working copy of SUM Program Disk #1 on your 
floppy drive. Remember, don't copy or install SUM II or 
any other files on the volume you are trying to recover. 

If you have a hard disk that is now crashed, 
read Before You Start on the next page, 
then turn directly to Emergency Hard Disk 
Recover (page 29) and use those instruc-
tions to repair your hard disk. 

If you are having trouble deciding where to begin your 
recovery process, take some time to review the han­
dyTask Index on page 3. It tells you which page to turn 
to for each recovery procedure. 



Before You Start 
Before you start the Recovery Procedures, you should 
be familiar with such basic Macintosh operations as 
using the mouse, manipulating windows, choosing menu 
commands, and displaying pop-up menus. 

In this section, the term "volume" refers to different 
storage mediums, such as hard disks, hard and soft 
partitions, and floppy disks. "Disk" is used when referring 
specifically to a floppy disk or hard disk. 

If you aren't familiar with displaying and using pop-up 
menus to select a volume, take a minute to read the 
following information. 

A pop-up menu is a menu that appears somewhere 
besides the menu bar. For example, notice in the dialog 
below the pop-up menu identified by the label Right 
BOOK. You can identify a pop-up menu by looking for a 
box with a shadowed outline. In SUM Disk Clinic, these 
menus show the name of the currently selected volume, 
such as Hard Disk 40, HD 40, My Floppy, or Right 
BOOK. 

SUM Disk Clinic 

o Select the Uolume you want to Recover ... 

bill Right BOOK I 
H.lp ........................................ . ....................... 

ThE' mel"llJ above l1StS thE' volumE's th~t arE' part of your current 
configuration information If thE' vollJme you want to stlect 1$ riot 
in the m~rIIJ, USE' H.1nuill Configure- or Automatic Configurif' 
(as exp1alnE'd m ChaptE'r 4 of your USE'r GUldE') to add thE' vollJme 
to this rneonu 

....................................................................................................................................... 

Or pop-up menus in SUM Disk Clinic look like this: 

DEST IN AT ION Volume: 

I}" _I I Hard Disk I 
1 81 70 Free KBy tes 

To display the menu, place the mouse pointer di­
rectly on top of the menu. Then, press and hold the 
mouse button. The menu and its available volume 
selections are displayed. For example: 

........Hard Disk 
DO 50 
SUM II 
My Floppy 

Drag through the menu until the volume you want is 
highlighted. When you release the mouse button, a 
check mark, like the one above, is placed to the left 
of the selected volume. 

Next to every volume pop-up menu is the Eject 
button, which mayor may not be grayed out. If you 
select a removeable volume, such as a floppy disk, 
the Eject button is enabled and is no longer grayed 
out. 

If you want more information on pop-up menus, see 
Volume Selection in Chapter 1. 

As you learned earlier, the Emergency Recovery 
Procedures has step-by-step instructions. Next to 
the steps on either the left or right is a screen shot, for 
example, a dialog box or a window from SUM Disk 
Clinic. Refer to these illustrations as you perform the 
recovery procedures to ensure accurate results. 



To recover files to ... 

Task Index g I: I ~ 
Floppy Hard Volume 
Disks Disk Partition 

If the problem you have is a ... 
Page # Page# Page # 

17h1 Damaged Floppy Disk 5&11 5& 11 5&11 

~D Damaged Hard Disk 5&11 5&11 5&11 

~~ Damaged Volume Partition 5& 11 5& 11 5&11 

~ ~ : la_LTLlu- Hard Disk Initialized 
o Files by Mistake 11 11 11 
o Folders 

If you want to recover files deleted from a ... 

rg Floppy Disk 21 21 21 

6 Hard Disk 21 21 21 

• Volume Partition 21 21 21 

* See the Glossary for definitions of the terms in the Task Index. 



Notes 



Quick Fix 

This procedure diagnoses your volume for 
certain types of volume errors. If Quick Fix 
finds errors, it can often make repairs, and 
thereby, save you the trouble and time of 
recovering all files from the volume and 
reinitializing or reformatting the volume. 

To use Quick Fix, read the following warning 
message first and move directly to step 1 
below. 

Do not copy or install SUM Disk Clinic onto 
the volume you are trying to fix. 

To use Quick Fix, proceed as follows: 

1. Launch SUM Disk Clinic. 

2. When the Main Menu appears, click 
Quick Fix. 

SUM Disk Clinic 

Main Menu 

Quick FiH 

m® Recouer Uolume 
SUtvl Disk Clinic 

Recouer Deleted Files I 
...................................................... 

Select the procedure you want to run b'J clicking Quick Fix, Recoye ... Volume, (". Recoye ... 
Deleted Files. To see more information about a procedure, click the icon to the ri'lht of it; button. 
Other functions are available in the Options mer,u. Launch other programs vi. the launch menu 

D 
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Lh WARNING! 

There is a risk of losing files 
wh~n you repair .a YO lume using 
the Quick Fix procedure. This can 
occur beocause the- volume's 
directory' structure must be 
altered. 

Given this possib lity , we 
recommend you recover your MOST 
IMPORT ANT files from the volume 
BEFORE allowing Quick Fix to 
attempt rep.irs. This way, if the 
YO lume should be damaged. your 
import.nt data is still safe. 

If you w.nt to recover your 
important files NOW, before 
proceeding, click 'Recover 
Files' - this I.unches the 
~rocedure to hel~ ~ou do this 
important step. 

If you have already recovered 
your imporhnt files, or if you 
have none to recover, click 
'Continue' to go on to the next 
step in Quick Fix procedure. 

[~[ __ ... c ... iI ... nc ... e ... 1 __ ;;;/111.[ Continue Recouer Files 1 

SUM Disk Clinic 

~ Select the Uolume you want to Quick FiH ••• 

~ I RightBOOK I [ Eject I 

Help 

Th", menu above lists the volumes that ar'" part of y our current 
configuration information. If th", volume you want to select is not 
in the menu, use Manual Configure or Automatic Configure 
(as explained in Chapter 4 of your User Guide) to add th", volume 
to this menu. 

Main ) (Continue) 

The WARNING dialog, shown to the left, 
gives you various options for howto proceed 
at this point. When Quick Fix repairs a vol­
ume, there is always the risk that some data 
might be lost. Therefore, you should always 
recover your most important files from the 
volume before repairing it with Quick Fix. 

3. If you have important files you want 
to recover before continuing with 
Quick Fix, click Recover Files and 
continue with step 1 on page 15. 

If you want to abort Quick Fix and 
return to the SUM Disk Clinic Main 
Menu, click Cancel. 

If you have already recovered your 
important files and are ready to 
proceed with Quick Fix, click 
Continue and proceed to step 4. 

4. Display the pop-up menu to 
determine the volumes that are 
mounted. Select the volume you 
want to repair from the menu. 

If the volume you want isn't in the menu, see 
the descriptions of Automatic Configure 
and Manual Configure in Chapter 4, SUM 
Disk Clinic. 

5. After selecting a volume, click 
Continue. 



SUM Disk Clinic launches SUM Recover 
automatically, and you see the SUM Quick 
Fix window. 

6. Click Check Volume. 

(If you are examining a floppy disk, insert 
your disk when prompted.) SUM Recover 
begins examining the volume for errors. As 
QuickFix checks the volume, you see a de­
scription of the process in the Current Activ­
itywindow, and the results of the examina­
tion appear in the Messages window. 

If Quick Fix does not detect any errors, the 
Repair Volume button remains disabled. In 
this case, no other action is necessary, and 
you can leave SUM Recover. You can use 
the volume just examined without worrying 
about problems. Choose Quit or SUM Disk 
Clinic from the File menu to leave SUM Re­
cover. 

If Quick Fix does detect errors, you see this 
dialog. 

If the SUM Shield Volume Restore Record 
IS installed on the volume you are attempt­
ing to repair, Quick Fix uses it to make re­
pairs. (This record can be installed by run­
ning SUM Install as described in Chapter 2, 
Getting Started). If the record has not al­
ready been installed, you cannot install it at 
this time, but Quick Fix may still be able to 
repair your volume. Otherwise, the message 
"Sorry, unable to repair" is displayed. 

7. If the Volume Restore Record was 
previously installed on the volume, 
click Volume Restore Record IS 
Installed; otherwise, click Volume 
Restore Record is NOT Installed. 

SUM Quick FiH 

~ Selected Uolume: I Hard Disk 

[ Check Uolume 

Current Activity: 

I 
Messages: 

I 

Help 

) ( fjopdil'llOlurrlO ) Click Ch~ck Yolum~ and Quick Fix will 
examine your volume for errors that 
might exist. The 'Current Activity' 

I 

window shows you what is happening and 
the results appear in the 'Messages' 
window. 

If the volume contains errors Quick Fix 
can repair, R~pair Yolum~ is activated 
and you are asked if the Shield Volume 
Restore Record is installed on the volume. 

~ 
Respond to the question and then click 
R~pair Yolum~. 

Quick Fix shows you the results of the 
attempted repairs. If your volume is not 
repaired successfully, return to the Disk 
Clinic Main Menu and use R~coY~r 
Yo lum~ to recover your files. 

Is the SUM Shield UOLUME RESTORE RECORD 
installed on this Uolume? I f so, Quick FiH can 
use it to make repairs. 

Uolume Restore Record IS Installed 

Uolume Restore Record is NOT Installed 

I 



Errors haue been detected on this 
uolume in the areas listed below: 

SCSI Mapping 

ADVANCED USERS ONLY .. 

You can selecti ..... ly enable and disable repairs to any error 
category by cl1cking 'Repalr Options', Please do not use thlS 
featurtunless you know speciflcally whatyou.a.rtdomg 

SUM Quick FiH 

Continue )1 

[ Repair Options ... ] 

~ Selected Uolume: I Hard Disk 

[ Check Uolume ) ( 
H~lp 

Repair Uolume ) 
Click Check Yo lume to ~xamin~ your 

Curr~nt Activity: se I~ct~d vo lum~ for th~ pr~senc~ of any 

I I 

~rrors that Quick Fix can repair. Watch 
th~ 'Messag~s· window for a report of 
the examination. 

If Quick Fix does not report any errors, 
choos~ SUM Disk Clinic from th~ File 
m~nu to exit. 

If Quick Fix do~s d~t~ct specific typ~s 
M~ssag~s: of ~rrors, th~y app~ar in th~ 'Messages· 
Bad first block in bit map. ~ window and are a Iso reported in a sp~cia I 
Bad vo I ume name. dia log. In this case, the dialog explains 
Bad MOB f i I e extents. the st~ps you should follow from that 
Bad MOB co to I og ex ten ts . point. 

Volume Info Block is bad. 
R5 Unable to check directory. 

D 

I 

This dialog lists the errors that Quick Fix 
found on your volume. 

8. Unless you consider yourself an 
advanced Macintosh user, click 
Continue and proceed to step 9. 

The Repair Options button can be used to 
enable and disable specific types of repairs 
that Quick Fix attempts to make. You should 
not use this option unless you fully under­
stand the benefits and ramifications of doing 
so. If you want more information on the 
Repair Options, see SUM Quick Fix Window 
in Chapter 5, SUM Recover. 

9. When the SUM Quick Fix window 
appears, click Repair Volume. 



This is yourfinal checkpoint before proceed­
ing with actual repairs to your volume. You 
have three options: 

10. Click Cancel to abort Quick Fix at 
this point and return to the SUM 
Disk Clinic Main Menu. 

If you have not yet recovered your 
important files, click Recover Files 
and go to step 1 on page 15. 

If you're ready to have Quick Fix 
make repairs to your volume, click 
Repair Volume. 

This dialog appears only if you clicked Vol­
ume Restore Record IS Installed in step 7. 

This dialog gives you the option of using a 
backup copy of the Volume Restore Record 
to repair the volume or using the record from 
the damaged volume itself. See Volume 
Restore Record in Chapter 3, SUM Shield, if 
you need help making a selection here. 

11. Click either Use BACKUP Copy or 
Use ORIGINAL Version. 

If you click Use BACKUP Copy, a file selec­
tor appears, so you can select the backup 
copy you want to use. 

If you click Use ORIGINAL Version, SUM 
Recover scans the volume to locate the Vol­
ume Restore Record. 

~ Quick FiH Procedure - Final Preparation 

Somt trror condlHons 
r.port.d by Quick Fix ar. 
actually normal and r.palrs 
art the-r.fore- unntctssary. 

If thIS vo1um. does not show 
DEF IN ITE signs of damag. (such 
as tho inability to mount), you 
should NOT "apir it with Quick 
Fix. 

If the vo1um. IS funchon,ng 
normally, c hck 'Canee I' to 
return to tho SUM Disk Clinic 
Main M.nu. Othorw,so, road 
tho n.xt pan.1 

n Cancel lJ 

If you havo not y.t rocovorod 
your ,mportant f,l.s from this 
YO lumeo , here ;s anothE'r 
opportunity to do so b.for. 
proc •• ding w,th tho ropairs. 

Click 'R.cover Fil .. ' if you 
st,l1 have ,mportant f,les you 
want to recover. This 1aunch.s 
the n.eessary proeedur. to do 
this stop. 

If you hay. a 11ready recovor.d 
your important files, or if you 
have non. to rteover I 90 on to 
the n.xt panel 

Recouer files 

Click 'Ropair Vo1um.' and Quick 
Fix w,l1 aUompt to corroct tho 
errors ,t detectod on this 
vo)um., 1\\ the end, you will 
s.e a moss ago as to wh.thor 
or not r.pairs wer. mad •. 

To make any repairs, Quick Fix 
must first unmount the vo1um •. 
So I afterward I when ~ ou 
roturn to your d.sktop, you 
must restart your MaCintosh 
so that tho vo1um. can 
reomount, 

( Repair Uolume 1 

Do you want to use a BRCKUP copy of 
the Uolume Restore Record, 

- or-
the ORIGINRL Uolume Restore Record 
on the uolume being repaired. 

Use BRCKUP Copy 

Use ORIGINRL Uersion 



Quick Fix begins making the necessary repairs to your volume, 
and at the conclusion, shows you the results and explains how to 
proceed. 

Normally, if you have come this far with Quick Fix, the chances 
of successfully repairing your volume are quite good. However, in 
some cases, repairs might not be possible. Your only alternative 
is to return to the SUM Disk Clinic Main Menu and use the 
Recover Volume function to recover your files. 

A Final Word 
Your chances of recovering a damaged volume are always 
greatly improved if the SUM Shield Volume Restore Record is 
installed on the volume. Once you have restored your damaged 
volume to a "healthy" state with Quick Fix, we strongly recom­
mend you install this record on the volume. Instructions for install­
ing this record are found in Chapter 2, Getting Started. 

( End of procedure) 



Recover Volume 

This procedure can be used to recover files 
from a floppy disk, hard disk, or volume 
partition that is damaged (commonly re­
ferred to as a "crashed disk"). It can also be 
used to recover files from a hard disk that 
was initialized by mistake. (You cannot re­
cover files from a floppy disk that was 
accidentally initialized.) 

With this procedure you can recover one file, 
many files, or all files from a crashed disk -
depending on your needs. For example, you 
can use this procedure before running Quick 
Fix to recover your important files, or you can 
use it to recover all of your files from a 
crashed disk before reinitializing or refor­
matting it. 

Do not copy or install SUM II or any other 
files onto the volume you are recovering. 

To use the Recover Volume procedure, do 
the following: 

1. Launch SUM Disk Clinic. 

2. When the Main Menu appears, click 
Recover Volume. 

I® 
SUM Disk Clinio 

If you are using this procedure to 
restore a volume on which a 
Volume Restore Record IS in­
stalled, please read Synchroniz­
ing Your Volume (Chapter 3) and 
Synchronized Recovery (Chap­
ter 4) before proceeding. 

SUM Disk: Clinic 

Main Menu 

( Quick: FiH ) C4V 

( Recouer Uolume ) LD 

~ 
( Recouer Deleted Files J I 

Select the ~rocedure you want to run by clicking Quick Fix, Recover Volume, or R .. cov .. r 
D .. l .. t .. d F1l .. ". To see more informatio~ about a procedure, click the icon to the right of its button. 
Other functIOns are ava1lable 10 the Ophons menu. Launch other programs via tt,e launch mer,u. 



-) 
SUM Disk Clinic 

Is the Shield UOLUME RESTORE RECORD installed 

on the uolume you want to recouer? 

o r Uolume Restore Record IS installed 

~ [ Uolume Restore Record is NOT installed 1 

... Help ............................................................................................................................................................................................................................ , 

: Chck ... Rpcord IS installpd onl,! If It,e rer.ord was prevIously Inslalled on Ihe volume in question I 
i (mslallation oflhis record is accomplished b,! running SUM Inslall). In all olher cases, click 
; ... Rpcord is NOT installed. 

Main ) 

SUM Disk Clinic 

0 Select the Uolume you want to Recouer ... 

bill Right BOOK I [ Eject 1 

, ..... Help 

The menu above lists the volumes that are part of your c'Jrrent 
configur ation information. If the volume you want to selecl is not 
in the menu, use Manual Configure or Automatic Configure 
(as explained in Chapter 4 of your User Guide) to add the volume 
to Ihis menu. 

( Main 1 ( Back ) (continue 1 

J~ 
/ 

From here the path you take to recover files 
from your damaged volume depends on 
whether or not the SUM Shield Volume 
Restore Record was previously installed on 
the volume. (You cannot install the record at 
this point.) This window asks you for this in­
formation. 

3. If the Volume Restore Record was 
not previously installed, click 
Volume Restore Record is NOT 
Installed and proceed to page 15. 

If the Volume Restore Record was 
previously installed via SUM 
Install, click Volume Restore 
Record IS Installed. 

4. Display the pop-up menu and select 
the volume you want to recover. 

This pop-up menu lists the devices available 
in your current configuration information. If 
the volume you want is not listed, refer to the 
descriptions of the Manual Configure and 
Automatic Configure commands in Chap­
ter 4 for further instructions. 

5. After selecting a volume, click 
Continue. 



SUM Disk Clinic launches SUM Recover 
automatically, and you see the SUM Volume 
Restore window. 

6. Click a radio button to indicate 
whether you intend to use a backup 
copy of the Volume Restore Record 
or use the one on the crashed 
volume. 

7. Click Recover Volume. 

This file selector appears only if you selected 
Use Info from BACKUP Volume in step 6. 
Use this dialog to locate and select the 
backup copy of the Volume Restore Record 
you want to use for this procedure. 

(If you selected Use Info from CRASHED 
Volume in step 6, the program begins search­
ing your volume for the Volume Restore 
Record. Once the record is located, you see 
the dialog shown in step 9.) 

8. Locate the backup copy you want to 
use and click Select. 

D 
SUM Uolume Restore 

Volume to Recover 

I Herd Disk 

@ Use Info from BACKUP Uolume 

Use this option if you have a recent 
backup copy of the Shield Vol ume 
Recovery Record on a separate disk. This 
is the preferred option because it alloVls 
the crashed vol ume to be recovered 
quickl y. You Vlill be prompted for the 
backup copy of the Recovery Record. 

o Use Info from CRASHED Uolume 

If you do not have a recent backup copy 
of the Shield Vol ume Recovery Record 
you should use this option. The program 
Vlill scan the crashed vol ume to locate 
the Volume Recovery Record - Vlhich 
might take quite a bit of time. 

Recouer Uolume 

O%CI ========================================~I 100% 

D 
I=SUM III 

D Edited RSRCs i:£ =SUM II 
[] Help Strings 
[] Old Procs Eject 

[] Procedures Driue 
[] SUM U 
[] System 
[] User Guide 

n. , . '. , . ' . , ",,\,.:,' 
Q 

~ l) Select 

( Cancel ) 

Select Uolume Restore Record 

D 



The Uolume Restore Record you haue selected was updated on: 

I mm/dd/yy - hh:mm:ss I 
This proc~dur~ might damag~ th~ curr~nt 
dir~ctory on your vo lum~ b~cause directory 
structure-s must be change-d. 'We recommE'nd 
you recover your MOST IMPORTANT files 
from the volume before proce~ding. 

It is also important to recover work done 
between the time the Volume Restore Record 
was updated and th~ time your vo lum~ crashed. 
Recover these fil~s BEFORE r~storing the 
volume, or they could be lost, permanently! 

If you want to select a different Volume 
Restore RE'cord to USE' for this procedure I 
click 'Cancel' to return to the SUM Volume 
Restore window. 

If Y ou want to r~cover important fil~s or those 
you worked on AFTER the Volume Restore 
Record '''.is Upditi'd, click 'Ricover Files'. This 
launches the Recover Volume procedure, which 
you can use to recover your files. 

If you have ALRE ADY recov~red a 11 necessary 
files and you are ready to proceed with the 
r~stor ation of your volume, c lick 'R~stor. 
Volume'. 

Your User Guide contains more information about 
the proc~dures described h~r~. S~. 
'Sy nchroni<ing Your Volume' (Chapter 3) and 
'Sy nchroniz~d Recov~ry , (Chapt~r 4) for mor~ 
details. 

Recouer Files Restore Uolume [ancel 

After your volume has been restored, a dialog instructs you to 
restart your Macintosh after you quit SUM Recover and return to 
your desktop. This step remounts your restored volume because 
the program unmounts your volume during the restoration proc­
ess. 

After restarting your Macintosh and mounting your restored 
volume, the volume should be available for normal use. 

If you recovered any other files before restoring the volume, check 
that they are present on the restored volume. If not, copy them to 
the restored volume at this time. 

As a final check, you might want to open a random sample of your 
files with their parent applications (the ones with which they were 
created) just to ensure that your data is intact. 

( End of procedure) 

Once a Volume Restore Record has been 
selected or located, you see this dialog indi­
cating when the record was last updated. 
This is a critical point, and you have three 
options for how to proceed: 

9. If you want to select a different 
Volume Restore Record to use, 
click Cancel, and you return to the 
SUM Volume Restore window. 

If this Volume Restore Record is 
not synchronized to the point at 
which your volume crashed, click 
Recover Files and proceed to step 
1 on page 15. 

If everything is in order and you are 
ready to proceed with the restora­
tion of your volume, click Restore 
Volume. 



Recover Volume (continued) 

This section continues the Recover Volume 
procedure. It explains how to recover files 
from a volume where the SUM Shield Vol­
ume Restore Record is NOT installed. 

In some cases, you'll use this procedure on 
a volume where the Volume Restore Record 
IS installed. For example, you use this pro­
cedure to recover important files prior to 
repairing a volume with the Quick Fix proce­
dure. You might also use this procedure to 
recover files before restoring a volume if the 
Volume Restore Record is not properly syn­
chronized to the point at which a volume 
crashed. (See Synchronizing Your Volume 
in Chapter 3 and Synchronized Recovery in 
Chapter 4 for more on this subject.) 

1. Click one of the buttons in this 
window to indicate what type of 
problem you have with your volume. 

Crashed Volume is the normal response -
it covers most problems not specifically ad­
dressed by the other two options. 

Choose Initialized by Mistake only if you 
know your volume is a hard disk that was 
mistak~nly initialized. You cannot recover 
a floppy disk that was initialized by mis­
take. 

If one or more files on your volume contains 
unrecognizable data, click 'Garbage' in File. 
Although SUM Disk Clinic cannot directly 
repair your files, it can offer some sugges­
tions on how you might be able to recover 
your data. 

( 

~ 
t·=,~"= o Files 

o Folders 

[i 
Main ) 

SUM Disk Clinic 

Indicate the nature of the problem ... 

Help 

Click the button that most 

( Crashed Uolume 1 close ly describes the problem you 
have with your volume. 

Crashed Volume is the normal 
response here, un less the 
problem specifically falls into one 

( Initialized by Mistake) 
of the other two areas. 

Click the icon to the left of any 
button for a brief explanation of 
that particular problem. 

( 'Garbage' in File 1 

( Back ) 



SUM Disk Clinic 

D:=J Select Uolumes to be used ... 

Recol1er Files FROM ... • Recol1er Files TO ... 

~ I Right IJOOI( I ~ I Hard Disk I 

( Main I ( Back I ( Continue I 

The pop-up menu on the left lists the devices 
that are part of your current configuration 
information. 

2. Display the left pop-up menu and 
select the volume FROM which you 
want to recover files. 

If the volume you want to select does not 
appear in this menu, yourconfiguration infor­
mation needs to be updated. See the de­
scription of the Manual Configure com­
mand in Chapter 4 for further instructions. 

The pop-up menu on the right lists the vol­
umes that are currently mounted on your 
system. 

3. Display the right pop-up menu and 
select the volume TO which you 
want to recover files. 

If the volume you want to select is not listed, 
you need to mount it before continuing. If you 
are recovering files to floppy disks (or any 
other type of removable media, such as a 
disk cartridge), insert the disk to mount it, 
and it will then appear in the menu. If you 
need to mount a non-removable volume 
(such as a hard disk), you must quit this 
procedure and return to your desktop to do 
so. Once the volume is mounted, restart this 
procedure. 

4. After selecting both volumes, click 
Continue. 



This window does not appear if you are re­
covering files from a hard disk that was 
initialized by mistake because in that case, 
Volume Scan is the only recovery method. 

5. Choose one of the three Recovery 
Methods here by clicking its button. 

Always choose Directory Scan first as a 
recovery method because it is faster than 
either of the other two methods. Volume 
Scan should be used after you have used 
Directory Scan, and it did not successfully 
recover all your files. 

If you are recovering files from a floppy disk, 
select Floppy Recovery, but only after us­
ing Directory Scan and Volume Scan first, 
and both methods did not successfully re­
cover all the files on your floppy disk. 

Once you choose a Recovery Method, SUM 
Disk Clinic launches SUM Recover, and you 
see the SUM File Recover window. 

6. When you're ready to begin 
searching the SOURCE Volume for 
files you can recover, click Search. 

During the search, the Search button 
changes to Stop. You can cancel the search 
by clicking this button. But if you do, you 
must search the volume again from the 
beginning before you can recover any 
files. That is, the search procedure must 
finish completely before you can recover 
any files. 

SUM Disk Clinic 

Please select the Method you want to use to recouer files ••. 

" 
H~lp 

( ) 
Select a recovery method by clicking 

Directory Scan the appropriate button. For a bri~f 
exp lanation of a method, c lick the icon to 
the left of its button. 

The Floppy R.cov ... method can be 
selected ""0/ if you are attempting to 

~ ( ) recover files from a damaged floppy. 
Uolume Scan You can select only one recovery 

method to us~ during any given attempt 
to recover fIles. However, you can us~ 
the methods in any combination since one 

... method might be able to recover fll~s 

'~Q ( Floppy Recouer ) that another cannot. See your {f.,w·&f4<o 
for addItional information. 

( Main ) ( Back ) 
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Items in List Selected: Total Bytes Selected 

~ ~ 10K I 
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At the conclusion of the search, all files SUM 
Recover located appear in the File List win­
dow. 

You can use the List pop-up menu to list 
either Files or Folders in the window. 

The By pop-up menu lets you list items by 
Name, Date, Size, or Type. 

Items in List (at the bottom of the window) 
tells you the number of items SUM Recover 
was able to locate. 

Please read the descriptions of the com­
mands available in the SUM Recover menus 
(Chapter 5) for several additional ways to 
use this window. 

7. Select the item you want to recover 
by clicking on it in the File List 
window. 

To select multiple items, use the 
Shift-click method, or choose 
Select All or Select Modified from 
the Edit menu. 

Note that as you select items, the Selected 
and Total Bytes Selected fields are dynami­
cally updated. 

8. Click Recover to recover the item 
or items you have selected. 

During the recovery process, the program 
might need to split one or more files. If this 
occurs, see Splitting Files for Recovery in 
Chapter 5 for more information. 



LJ 
A .SUM Recovered Files 

D 
SUM Recover creates one or more folders on your DESTINA­
TION Volume where it stores your recovered files. The first folder 
created is named A.SUM Recovered Files. If additional folders 
are needed, they are named B.SUM Recovered Files, C.SUM 
Recovered Files, and so on. 

9. Unless you intend to use another SUM Disk Clinic 
procedure (such as Quick Fix) following this procedure, 
your next step would normally be to reinitialize or 
reformat your damaged volume. You would then restore 
your recovered files to the volume by copying them from 
the folder or folders described above back onto your 
newly initialized volume. In this case, choose Quit from 
the File menu to return to your desktop and complete 
the necessary steps. 

If you are using this procedure to recover files in prepa­
ration for using another procedure (for example, Quick 
Fix), choose SUM Disk Clinic from the File menu to 
return to the Main Menu. Then, restart the original 
procedure. 

( End of procedure) 



Notes 



Recover Deleted Files 

This procedure can be used to recover files 
without a directory entry; that is, files re­
moved from a volume by dragging their icons 
to the Trash, and then subsequently empty­
ing the Trash. 

Your success at recovering a deleted file 
depends on many different factors, such as 
how long ago the file was deleted, where it 
was originally located on the volume, and so 
forth. Read the description of the Deleted 
File Record in Chapter 3, SUM Shield, for 
more information about what happens when 
files are deleted. -y 
Before you launch SUM Disk Clinic, make a 
working copy of SUM Program Disk #1 and 
launch the program from that disk. Do not 
install SUM II on the volume you are recov­
ering. 

To use the Recover Deleted Files proce­
dure, proceed as follows: 

1. Launch SUM Disk Clinic. 

2. When the Main Menu appears, click 
Recover Deleted Files. 

SUM Disk Clinic 

Main Menu 

( Quick FiH ) ~ 
m§ ( Re(:ouer Volume ) LD 

SUM Di.k Clirdc 

"oR 

( Re(:ouer Deleted Files ) I 
S.l.ct tho. proc.dur. 'Jou want to run b'J clickin9 Quick Fix, Recoyer Yolume, or Recoyer 
Deleted Files. To ••• rMr. information abo'Jt a proc.dur., click th. icon to th. ri9ht of It. button. 
Oth.r function. ar. availabl .. in tt, .. Options mo.r,u. launch otto.r program. via tt,. Launch m.n'J. 



SUM Disk Clinic 

~[[[[ Is the Shield DELETED FILE RECORD installed on the 

[llill uolume from which you want to recouer files? 

o ( Deleted File Record IS installed 

~ ( Deleted File Record Is NOT installed 

r' Help .................................................................................................................................................................................................................... , 
! 
i Click ••. R .. cord IS inshll .. d only if the record was previously installed on the volume in question 
i (installation of this record is accomplished by running SUM Install). In all other cases, click 

l .. ::.~':!'::~~~ .. ~~ .. ~.~!. ... ~nst.ll .. d ............................................................................................................................................................ , 

( Main ) 

SUM Disk Clinic 

II Select the Uolume from which you want to recouer deleted files ... 

c=J I Hard Disk I I [jed I 
Free Space : 7533 KBy tes 

, .... Help 

The menu above lists the volumes that are .·(lnWlflt,t 
n><JUr1h>ifon your system. If the volume you want is 
not listed, mount it (e.g., insert a floppy disk) and 
then display the menu. 

( Main ) ( Back ) (continue) 

D 

The path you follow from here to recover the 
deleted files depends on whether or not the 
SUM Shield Deleted File Record was previ­
ously installed on the volume where you are 
trying to recoverthe files. (You cannot install 
the record at this point.) The window asks 
you for this information. 

3. If the Deleted File Record is NOT 
installed on the volume, click 
Deleted File Record is NOT 
Installed and turn to page 25. 

If the Deleted File Record IS 
installed on the volume, click 
Deleted File Record IS Installed 
and continue with step 4 below. 

4. Display the pop-up menu and select 
the volume from which you want to 
recover deleted files. 

This pop-up menu lists only those volumes 
that are currently mounted on your sys­
tem. If the volume you want is not in the 
menu, you must mount it before continuing. 
If you are attempting to recover files from a 
floppy disk (or other removable media, such 
as a disk cartridge), insert the disk and then 
display the menu. If you try to recover files 
from non-removable media (such as a hard 
disk) and it is not currently mounted, you 
must return to your desktop, mount the vol­
ume, and restart this procedure. 

5. After selecting a volume, click 
Continue. 



SU M Disk Clinic automatically launches SUM 
Recover, and you see the SUM File Recover 
window. 

Note that the Search button is inactive, and 
the File List is already available in the File 
List window. Therefore, searching the vol­
ume is unnecessary, and the Search button 
is never activated with this procedure. 

In addition, the SOURCE and DESTINA­
TION Volume names are identical because 
the files are recovered by "reactivating" them 
on the volume that they were originally de­
leted from. 

You can, if necessary, select a different 
SOURCE Volume by choosing the one you 
want from the DESTINATION Volume pop­
up menu. 

6. Select the item you want to recover 
by clicking on it in the File List 
window. 

To select multiple items, use the 
Shift-click method, or choose 
Select All or Select Modified from 
the Edit menu. 

When you select one or more items in the 
File List window, the Recover button is acti­
vated. 

7. Click Recover to recover the item 
or items you have selected. The file 
name in the File List window 
changes to italics when the file is 
recovered. 

8. After recovering all items you want, 
exit from the program by choosing 
Quit, SUM Disk Clinic, or Transfer 
from tr.e File menu. 
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SUM Recover creates a folder named A.SUM Recovered Files 
on your DESTINATION Volume where it stores the files you have 
recovered. If additional folders are needed, SUM Recover names 
them B.SUM Recovered Files, C.SUM Recovered Files, and so 
on. 

At this point, all the files you recovered should be immediately 
available on your DESTINATION Volume. Since the files are 
recovered on the volume from which they were originally deleted, 
the files should now be on that volume. 

Sometimes if you try to open a document you have recovered, the 
alert tells you that the application is busy or missing, or the 
recovered application may not launch. Normally this indicates that 
the file's Type and Creator codes are incorrect or missing. You 
can insert these codes in two ways. You can use the Get Info 
command in SUM Recover's File menu at the time you are recov­
ering the files. Or if you are a power user, you can use SUM Tools 
to insert the codes once you have left SUM Recover. (Appendix 
B contains a list of the common Type and Creator codes.) 

Because you were able to recover a file, does not mean that it is 
completely intact. Check your recovered documents by opening 
each one with its parent application (the application with which it 
was created) and then make sure all of your data is present. 
Check any recovered applications by launching them. 

( End of procedure) 



Recover Deleted Files (continued) 

This section continues the Recover Deleted 
Files procedure from page 22. It explains 
how to recover files deleted from a volume 
on which the SUM Shield Deleted File Rec­
ord is NOT installed. 

Before continuing here, you should have al­
ready done the following: 

1. Launched SUM Disk Clinic. 

2. Clicked Recover Deleted Files at 
the Main Menu. 

3. Specified Deleted File Record is 
NOT Installed on the volume from 
which you are attempting to recover 
files. 

4. Select the volume FROM which you 
want to recover files in the left pop­
up menu. 

5. 

Note that if the volume does not 
appear in the menu, see the Help 
information about mounting 
volumes. 

Select the volume TO which you 
want to recover files in the right 
pop-up menu. The volume must be 
currently mounted to appear in this 
menu. 

6. After selecting both volumes, click 
Continue. 

If you select the same volume in both menus, 
SUM Recover warns you that you are at risk 
of losing data. If you are recovering files from 
a floppy disk to another floppy disk using the 
same drive, you can override the alert and 
continue. In all other cases, you should 
select a different volume in each menu. 

... from page 22 

SUM Disk Clinic 

II Select Uolumes to be used •.. 

Recouer Files FROM ... Recouer Files TO •.. 

~ I Hard Oisk I I' -f'1 I Floppy Diskl 
Fr •• Sp.co : 778 KBytos 

Help ............................................... . . •....•.•..•.....•.•.••.•..... 0' ...................................................................................................................... , 

This menu lists volumes in your configuration 
information. If the volume you want isn't listed, 
use Manual Configu,." or Automatic 
Configu,." to add the volume as explained in 
Chapter 4 of your User Guide. 

( Main ( Back ) 

This menu lists the volumes that are currently 
nmKInv on your sy stem. If the volume you want 
isn't listed, mount it (e.g., insert a floppy disk) 
and then display the menu. 

( Continue) 



SUM Disk Clinic 

Select the Method you want to use to recouer deleted files ... 

~ ( Uolume Scan 

.. .og (FlOPPY Recouer ) 
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D 

Help 

Select the method you ",ant to u •• to 
recover files by clicking Volume Sean or 
Floppy Reeo .... e ... Click the icon to the len 
of either bullon for more details about that 
method. Please see ~',"'wy /''''Ifu",~;in 
Chapter 4 of your User Guide for a complete 
discussion. 

Sometimes Volume Sean and Floppy 
Reeo .... e .. cannot recover a file's name or 
its Type and Creator codes. SUM Recover 
gives the f,l. name as the pa .. ent application 
name and a sequence number (ExcelDataOl). 
See Appendix C for Instructions on d.aling 
"'ith missing Type and Creator codes. 
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This window appears only if you are attempt­
ing to recover files from a floppy disk - as 
specified in the preceding window. If you are 
recovering from any other type of volume, 
continue with the window below. 

7. Choose Volume Scan by clicking 
on that button. Even though you are 
trying to recover deleted files from a 
floppy disk, you should use Volume 
Scan after using Directory Scan, 
and then Floppy Recovery as a last 
resort. 

For more information about these options, 
see Recovery Methods in Chapter 4, SUM 
Disk Clinic. 

SUM Disk Clinic automatically launches SUM 
Recover, and you see the SUM File Recover 
window. Note that you can select a different 
DESTINATION Volume here if you wish, but 
you cannot change the SOURCE Volume. 

8. To begin searching the SOURCE 
Volume for the files you can 
recover, click Search. 

During the search, the Search button 
changes to Stop, and the beachball rotates 
on the screen. You can cancel the search at 
any point by clicking this button. But if you do, 
you lose all entries accumulated to that 
point and must search the volume again. 



At the conclusion of the search, all files SUM 
Recover located appear in the File List win­
dow. 

You can use the List pop-up menu to list 
either Files or Folders in the window. The 
By pop-up menus lists items by Name, Date, 
Size, or Type. 

Items in List (at the bottom of the window) 
shows the number of items SUM Recover 
was able to locate. 

The File, Edit, and Options menus in SUM 
Recover let you manage the items in the File 
List window. See Chapter 5, SUM Recover, 
for descriptions of the commands. 

9. Select the item you want to recover 
by clicking on it in the File List 
window. 

To select multiple items, use the 
Shift-click method, or choose 
Select All or Select Modified from 
the Edit menu. Notice that Selected 
and Total Bytes Selected are 
updated as you select items. 

10. Click Recover to recover the item 
or items you have selected. During 
the recovery process you can 
change the DESTINATION Volume 
at any point. For example, if the 
DESTINATION Volume becomes 
full, wait until the disk full message 
appears, then select a new DESTI­
NATION Volume. 
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SUM Recover might need to split one or more files during 
recovery. See Splitting Files for Recovery in Chapter 5 for further 
information. 

11. After recovering the items you want, exit SUM Recover 
by choosing Quit, SUM Disk Clinic, or Transfer from 
the File menu. 

SUM Recover creates a folder named A.SUM Recovered Files 
on your DESTINATION Volume where it stores the files you have 
recovered. If additional folders are needed, they are named B.SUM 
Recovered Files, C.SUM Recovered Files, and so on. 

If you want to restore your recovered files back onto the same 
volume from which they were originally deleted, you can do so 
simply by copying them from the folders described above. 

Sometimes if you attempt to open a document you have recov­
ered, an alert stating that the application is busy or missing is 
displayed. Or you might find that a recovered application is unable 
to launch. This normally indicates that the file's Type and Creator 
codes are incorrect or missing. (SUM Recover cannot always 
retrieve these codes.) You can insert the correct codes at the time 
you recover the files using the Get Info command in the File menu 
(Appendix B contains a list of common Type and Creator codes.) 
If you are more technically inclined, you can also use SUM Tools 
to insert the codes if you have already quit SUM Recover. (See 
Edit File Attributes in Chapter 11.) 

Remember, because you were able to recover a deleted file, does 
not necessarily mean it is completely intact. If the file was 
fragmented on your disk or some of it was overwritten by another 
application, only part of the file might have been recovered. 
Therefore, you should check all recovered files thoroughly by 
opening documents with their parent applications (the application 
with which they were created) and launching all recovered appli­
cations to determine if all data is present. 

( End of procedure) 
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Emergency Hard Disk Recover 

Use the Emegency Hard Disk Recover procedure only 
in the following situation: 

Your hard disk is currently crashed and you 
have purchased Symantec Utilities for Macin­
tosh so that you can recover your files and 
restore the disk. 

If you purchased and installed SUM II and then experi­
enced a crash, DO NOT USE THIS PROCEDURE. 
Instead, use the Recover Volume or the Quick Fix 
procedure described earlier in this section. 

The instructions in this section don't provide much 
detail except when essential to making a decision. 
However, help is available along the way if you need it. 
You should read this entire section carefully before you 
begin. 

Since you use this procedure only with hard disks, we 
will not discuss recovering a damaged floppy. Return to 
the Task Index (page 3) for directions on that process. 

Three Recovery Phases 
The Emergency Hard Disk Recover procedure has 
three separate phases: 

Phase I: Recover Your Important Files - Recover 
your most important files from the crashed disk. This is 
essential because the repairs you will attempt in Phase 
II could lose data from the disk if it is damaged in certain 
ways. 

Phase II: Use Quick Fix - Use the SUM Disk Clinic 
Quick Fix procedure to try and repair the disk. If suc­
cessful, Phase III is unnecessary, and your disk should 
be back in service. If Quick Fix cannot repair the disk, 
move on to Phase III. 

Phase III: Recover Your Remaining Files - Use the 
SUM Disk Clinic Recover Volume procedure to recover 
the remaining files from your crashed disk. Then, reini­
tialize or reformat the disk. Finally, copy your recovered 
files back to the disk. Everything should now be back to 
the way it was prior to the crash. 

Things You Need 
Unless you have a second hard disk or a mountable 
tape drive, you need a supply of floppy disks. It isn't 
necessary to initialize the disks beforehand because 
the recovery routines initialize them for you "on the fly." 

There is no way to estimate the number of floppy disks 
you might need. But this section may be helpful in 
calculating that number. 

Before you begin, make copies of your original SUM II 
Program Disks, referred to as SUM Disk #1 and SUM 
Disk #2 throughout this procedure. You can launch 
SUM Disk Clinic from disk#1 from a floppy drive orfrom 
a healthy hard disk if you have installed the program 
there. 

Do not use your original SUM II Program Disks in 
this procedure. If you damage them, you will have a 
new set of problems to deal with. 

Finally, you will need a copy of the Volume Information 
File (VIF) for your hard disk. We recommend using one 
of the following ways to acquire a VIF: 

1. Use the VIFs provided on SUM Program Disk 
#2. 

2. Use SUM Disk Clinic to create a VIF for a 
hard disk with a configuration similar to your 
crashed disk - the same model, manfacturer, 
and make. 

3. As a last resort, call the manufacturer of your 
hard disk and request a copy of the VIF you 
need. 

See Create Volume Info File in Chapter 4, SUM Disk 
Clinic, for more information about creating VIFs. 



Phase I: Recover Your Important Files 

1. If your Macintosh is running, shut it 
down now. 

2. Insert SUM Disk #1 in your internal 
drive and start your Macintosh. 
SUM Disk #1 contains the System 
and the Finder files, so you can 
start up directly from this disk.' 

3. Eject SUM Disk #1 and replace it 
with SUM Disk #2. The disk's 
window opens automatically onto 
your desktop. 

4. Locate the Read Me file and 
double-click its icon to launch 
TeachText. Examine the Read Me 
file thoroughly (you cannot print it at 
this time). This file might contain 
important instructions that supple-
ment those in this section. 

5. Eject SUM Disk #2 and replace it 
with SUM Disk #1. 

SUM Disk Clinic 6. Locate the SUM Disk Clinic icon 
Main Menu (shown below) and double-click it to 

~ ( Quick FiH ) 

i~ ( Recouer Uolume ) ~ 
SUM Disk Clinic 

launch the program. .. I® 
I ( Recouer Deleted Files ) 

SUM Disk Clinic 

7. After SUM Disk Clinic starts, you 

Select the procedure you want to run by clicking Quick Fix, Recoyer Yolume, or Recoyer 
Deleted Files. To see more information about a procedure, click the icon to the right of its button. 

see the Main Menu (shown here). 
Click Recover Volume. 

other functions are available in the Options menu. Launch other programs via the Launch menu. 

D 



8. Click Volume Restore Record is 
NOT Installed. 

9. Click Crashed Volume. 

.. Help 

SUM Disk Clinic 

Is the Shield UOlUME RESTORE RECORD installed 

on the uolume you want to recouer? 

Uolume Restore Record I S installed I 
Uolume Restore Record is NOT installed) 

! Click •.. Record IS installed only if the record was previously installed on the volume in question 
! (installation of this record is accomplished by running SUM Install). In all other cases, click 

L.:.::.~~~~~~. is HOT ... i.~.~.~~~~~~: ....................................................................................................................... .. 

Main 

SUM Disk Clinic 

Indicate the nature of the problem ... 

Help 

[§ Click the button that most 

( Crashed Uolume I close ly describes the problem you 
have with your volume. 

Crashed Volume is the normal 
response here, un less the 

t·=,~,= problem specifically falls into one 

I Initialized by Mistake I of the other two areas. 
o files Click the icon to the left of any 
o folders button for a brief explanation of 

that particular problem. 

[i I 'Garbage' in File I 

( Main ) ( Back 1 



SUM Disk Clinic 

~ Select Uolumes to be used ... 

- Right BOOK FROM .•. • Recouer Files TO ••• 

Right 400K 
l':oI;f,TYillmr. r -"f"1 I My Floppy I [ Eject I 

SUM II Free Space: 778 KBytes 

r' Help ...................................................... ················· .. ··························1········· ........................................................................................................... , 
i This menu lists volumes in your configuration This menu lists the volumes that are currently i 
i information. If the volume you want isn't listed, nWlHlhV on your sy stem. If the volume you want i 
i use Manual Configure or Automatic isn't listed, mount it (e.g., insert a floppy disk) i 
i Configure to add the volume as explained in and then display the menu. ! 
l ..... ~.~~~~~.~ .. ~ .. ~.~.:.~.~~ .. ~~.~~ .. ~~.~~.~.·............................................... . ............................................................................ . 
( Main Back (continue) 

SUM Disk Clinic 

~ Select Uolumes to be used •.• 

I Hard Disk I 

.. I HO 40 
l!!J"'" DO 50 

SUM II 
[!:jed I r -"f"1 III 

Recouer Files FROM ..• s TO ••• 

Free Space: 778 KBytes 

, .. Help .............................................................. ··· .. ·············· .. ··········· ... ··1·················· .. · ............................................................................................... , 
! This menu lists volumes in your configuration This menu lists the volumes that are currently I 
i information. If the volume you want isn't listed, nWlHlhVon your system. If the volume you want i 
i use Manual Configure or Automatic isn't listed, mount it (e.g., insert a floppy disk) i 
! Configure to add the vo lume as explained in and then display the menu. ! 
i Chapter 4 of your User Guide. i 
t ............................................................................................................................................... " ...................................................................................... .1 

Main ) ( Back ( Continue) 

1 O. Display the left pop-up menu and 
select your crashed disk from this 
menu. (Your menu won't look 
exactly like the one shown here.) 

If your crashed volume does not appear in 
this menu, turn to Chapter 4, SUM Disk 
Clinic, and read the description of the Man­
ual Configure command. Follow the in­
structions for adding a device to your con­
figuration. You will probably need to load a 
Volume Information File (VIF) for your de­
vice during the manual configure operation. 
For information about creating VIFs, turn to 
Create Volume Info File in Chapter 4. 

11. Display the right pop-up menu and 
select the volume TO which you 
want to recover files. (Again, your 
menu will look different.) 

If you are recovering to floppy disks, you can 
eject the disk currently in your drive by 
selecting it in the menu and then clicking 
Eject. Then, insert the first floppy where you 
are going to recover files and select it in the 
menu. 

Do not select your crashed hard disk in 
this menu, even if it does appear. Recov­
ering files back onto the same volume can 
destroy your data and prevent you from ever 
recovering it. 

12. After selecting both volumes in this 
window, click Continue. 



13. Click Directory Scan. 

After a short delay, you see the SUM File Re­
cover window. 

14. Click Search. 

The program begins scanning yourvolume's 
directory for files it can recover. This process 
can take anywhere from 5 minutes to more 
than 1 hour, depending on the size of the 
volume. 

The progress indicator bar begins filling as 
the program searches your disk, and the 
Search button changes to Stop. You can 
click Stop to cancel the search, but if you do, 
you lose the entire list of files that has 
accumulated inthe File Listwindow, which 
means you would have to search the disk 
again. 

When the search is complete, the Stop but­
ton changes back to Search. 

D 
SUM Dislc Clinic 

Please Select the Method you want to use to recouer files .•. 

" 
Help 

( ) 
Se lect ~ recovery method by clicking 

Directory Scan the appropriate button. For a bnef 
explanation of the method, click the icon 
to the left of its button. 

The Flopp" R4!cov4!r method can be 
se lected ""0/ if you are attempting to 

~ ( ) 
recover flIes from a damaged floppy. 

Uolume Scan You can select only one recovery 
method to use during any given attempt 
to recover files. However, you can use 
tho methods in any combination sinc. OM 

.... method might be able to recover files 

i.j~ ( H(lpp~j He( (){J~~r ) that another cannot. See your {f.,w· 6IIfd<' 
for additional information. 

( Main ) ( Baclc ) 

D 
SUM File Recouer 

~ 
SOURCE Yo lume : List: I Files I By: I Name I 
I Hard Dislc I Name Size 

'" ~ 
DEST IN AT ION Yo lume : 

r -"f"1 I My Floppy I [ Eject I 
778 Free KBy tes 

( Search I ( He({){Jpr I 

0% I 1100% 

Messages: 

I I 
~ 

Items in List Selected: Total By tes Selected 

~ ~ 10K I 

D File List Window 



SUM File Recouer 

~ SOURCE Volume: 

W 1 Hard Disk 
By: I Name I List: 1 FlIes 

Name Size 

+ At·~,~nl:'ld 307 t~ ~ 
De.~ tc.p 5 1 • DESTINATION Volume: 
froctc.graph 18 l, 

He I p 1 REt'c 9 ~ 

He I p2 R.r C 11 1 

I -tl I My Floppy I 
778 Free KBy tes 

Help3 F:.rc 11 .-

Search Recouer Help4 R$rc 1.2 I: 

HelpS. R$rc 11 K 

Help6.Rsrc 10K 
1100<JiS 0<JiS ,--I ______ ------' LAZ I i f e2 . Ou 19 K 

Messages: Mos ter . Rsrc 7 K 

Omn i s 3 Do to F i Ie .0 12 K 

Psion 1 K 

Ps i onChess . Rsrc 20 K 

Items in List Selected: Tola 1 By tes Selected 

~ ~ 13922 K 1 

File List Window 

Once the search is complete, your objective. 
is to recover those files that are most impor­
tant to you before going on to the next 
phase. 

(You can, if you prefer, recover all files in the 
list at this point. See the sidebar on the next 
page for considerations.) 

15. Locate and select those files in the 
File List window that are essential, 
and you feel must be recovered. 

Click a file name in the list to select it. Use the 
Shift-click method to select multiple files or 
folders. Use Find File in the Options menu 
to locate files by name. 

16. After selecting the files you want to 
recover, click Recover. 

The program begins recovering your files to 
the DESTINATION Volume specified in the 
window. SUM Recover deselects the file 
when it is recovered. Notice that in most 
cases, the program works from the top of the 
list to the bottom. 

In some cases, the program might find it 
necessary to split a file across multiple vol­
umes and alerts you when this is necessary. 
If this happens and you need help, read 
Splitting Files for Recovery in Chapter 5, 
SUM Recover. 

The program notifies you after all files have 
been recovered. 



At this point, you should have one or more 
disks containing the important files you just 
finished recovering. 

In the process of recovering your files, the 
program creates a new folder on each 
DESTINATION Volume for storing your re­
covered files. Each folder is named SUM Re­
covered Files and is prefixed with a capital 
letter and a period for unique identification: 

A .SUM Recovered Files 

If the program needs to create additional 
folders on the same volume, it does so by 
incrementing the prefix letter, for example, 
B.SUM Recovered Files, C.SUM Recov­
ered Files, and so on. This information isn't 
relevant at the moment, but it might become 
important later. 

If you recovered your files to floppy disks, 
label your disks and set them safely aside -
you might need them later. 

If you recovered your files to a hard disk, they 
are safe where they are, and you don't need 
to do anything further. 

You have now completed Phase I of the 
recovery process, and you are ready to 
move on to Phase II. Turn the page when 
you're ready to begin. 

The main criteria you should use in deciding whether to 
recover all of your files or only your important ones at this 
point is how long it took to complete the search of your 
volume. 

If the search was a relatively short one, recover only your 
important files. 

If the search was lengthy, you might want to recover all 
of your files now. The reason for this is that if during 
Phase II Quick Fix is unable to repair your volume, it will 
then be necessary to do the entire search again during 
Phase III. 

On the other hand, if during Phase II Quick Fix does 
repair your volume, recovering all of your files would 
have been an unnecessary and time consuming proc­
ess. 

Unfortunately, there is no way to predict the outcome of 
the Quick Fix procedure, and thus, no way to advise you 
which approach might be best in your situation. The best 
advice is to make your decision, and go with it. 

Even if you do decide to recover all of your files now, you 
should still complete Phase II. If Quick Fix does repair 
your volume, this will save you the time required to 
reinitialize your disk and then restore all of your files back 
to it. 



Phase II: Use Quick Fix 

Get Info ... ~I 

Page Setup ... 
Print list... ~P 

SUM Disk: Clinic ~D 
Transfer... ~T 

Help ~H 

Quit 

SUM Disk: Clinic 

Main Menu 

( Quick: FiH ) ~ 

i® ( Recouer Uolume ) ~ 
SUM Disk Clinic 

( Recouer Deleted Files ) I 
Select the procedure you want to run by clicking Quick Fix, Recoyer Volume, or Recoyer 
Deleted Files. To see more information about a procedure, click the icon to the right of its button. 
Other functions are av ailab Ie in the Options menu. Launch other programs via the launch menu. 

17. Choose SUM Disk Clinic from the 
File menu. 

18. When the SUM Disk Clinic Main 
Menu appears, click Quick Fix. 



19. Read the WARNING screen, and 
then click Continue. 

20. Display the pop-up menu and select 
your crashed disk. 

21. Click Continue. ~ 

( Main ) 

D 
~ WARNINGI 

Th€'r. is: a risk of losmg fll~s 
whe-nyourt>pair i volumt using 
the-QuIck Fix proce-durf. This can 
occurbtcauseo thtvolumt's 
dlre-ctorl! structure must bf 
altered. 

Given this posslbhty, ",e 

recomme-nd you re-coytr your MOST 
IMPORT ANT f,I •• from Ih. volume 
BEFORE .11owing Qu,ck Fix 10 
atte-mptrepairs. ThiswaY"fthe 
yolume should beodamagE"d,your 
important data is shll safe. 

Cancel Continue 

If you want to rtcovtr your 
lmporhnt fIles NOW, before 
procuding,chck'Recovtr 
Flles'-thislaunchtsth. 
~rocE'dur. to htlQ y.ou do this 
imporhntstep. 

If you have already fE-covered 
your Important fl1u, or If you 
have none to recover,click 
'Continue' to go on to the- next 
step 10 QUIck Fix procE'dur-e. 

Recouer Files 1 

D 
SUM Disk Clinic 

Select the Uolume you want to Quick FiH ... 

~ I Hard Disk I [ [j!~c1 1 

Help 

The menu above lists the volumes that are pad of your current 
configuration information. If the volume you want to select is not 
in the menu, use Manual Configure or Automatic Configure 
(as explained in Chapter 4 of your User Guide) to add the volume 
to this menu. 

D 
(continue) 



SUM Quick FiH 

~ Selected Uolume: I Hard Disk 

Help 

[ Check Llolume ) ( HO~l<Ilr llolurrlo ) Click Check Yolume and Quick Fix will 

Current Activity: 
examine your volume for errors that 
might exist. The 'Current Activity' 

I 
Messages: 

I 

I 

window shows you what is happening and 
the results appear in the 'Messages' 
window. 

If the volume contains errors Quick Fix 
can repair, Repair Yo lume is activated 
and you are asked if the Shield Volume 
Restore Record is insh lied on the volume. 

~ 
Respond to the question and then click 
Repair Yolump. 

Quick Fix shows you the results of the 
attempted repairs. If your volume is not 
repaired successfully, return to the Disk 
Clinic Main Menu and use Recoyer 
Yo lume to recover your files. 

Errors haue been detected on this 
1I0lume in the areas listed below: 

SCSI Mapping 

ADVANCED USERS ONLY ... 

You can selectively enable and disable repairs to any error 
category by clickinQ 'Repair Options'. Please- do not use this 
feature un less you know specifically 'What you are doing 

Continue 

[ Repair Options ... ) 

I 

After a short delay, you see the SUM Quick 
Fix window. 

22. Click Check Volume. 

Quick Fix examines your disk and shows the 
results in the Messages window. 

If the program does not detect errors in your 
disk that it can repair, the Repair Volume 
button remains deactivated. In this case, 
proceed directly to Phase III beginning on 
page 41. 

If the program does detect errors, you see 
the following dialog. 

This dialog lists the errors Quick Fix found on 
your volume. The list you see might be 
different from the one shown next. If Quick 
Fix cannot repair your volume, the message 
"Sorry, unable to repair" is displayed. In that 
case, click OK, and continue with Phase III 
on page 41. 

23. Click Continue to move to the next 
step in the repair process. 



24. Click Volume Restore Record is 
NOT Installed. 

25. Click Repair Volume. 

D 
Is the SUM Shield UOLUME RESTORE RECORD 
installed on this Uolume? If so, Quick FiH can 
use it to make repairs. 

Uolume Restore Record I S Installed 

[ Uolume Restore Record is NOT Installed 

D 
SUM Quick FiH 

~ Selected Uolume: L..:I H~a:.:r:..:d:...:D:::i:.:s~k _______________ -, 

Check Uolume [Repair Uolume 

Curr.nt ActivIty: 

Messagos: 

Bad firs t block i n bit map. 
Bad vo I ume name. 
Bad MOB f i I e extents. 
Bad MOB catalog extents. 

Vo I ume In foB lock i s bad. 
Unab I e to check d i rec torq 

D 

H.lp ....................................................................................... , 

Chck Check Volume and Quick Fix will 
.xamin. your vo lum. for .rrors Ihal 
mighl .xis\. Th. ·Curr.nl Activity' 
window shows you whal is happ.ning and 
Ih. resuHs app.ar in Ih. 'Mossagos' 
window. 

If Ih. volumo conlains orrors Quick F,x 
c.an repair ~ Repair Volume is activated 
and you ar. askod if Ih. Shi.ld Vo lum. 
Roslor. R.cord is Inslollod on Iho volumo. 
Rospond 10 Iho question and Ihon click 
Repair Yolum". 

Quick Fix shows you tho rosults of tho 
att.mptod ropairs. If your volumo is not 
ropairod succ.ssfully, roturn to tho Disk 
Clinic Main Menu and use- Recoyer 
Volume to rocovor your fl10s. 



Quick FiH Procedure - Final Preparation 

Some- e-rror conditions 
reported by QUick Fix are 
actually normal and t"eopairs: 
are therefore unnecessary. 

If this volume does not show 
DEF IN ITE signs of damage (such 
as the inabllity to mount), you 
should NOT reapir it with Quick 
Fix. 

If the volume is functioning 
norma lly , click 'Cance l' to 
return to the SUM Disk Clinic 
Main Menu. Otherwise, read 
the next paM 1 

Cancel JJ 

If you have not yet recovered 
your important files from this 
vo lume I he-reo is another 
opportunity to do so before 
proceeding with the repairs. 

Click 'Recover Files' if you 
still have important files you 
want to recover. This launches 
the Mcessary procedure to do 
this step. 

If you have a llready recovered 
your important files, or if you 
have- none to recoveor I go on to 
the next panel 

[ Recouer Files) 

Click 'Repair Volume' and Quick 
Fix will attempt to correct the 
errors it detected on this 
volume. At the end, you wiTI 
see a message as to whether 
or not repairs were made. 

To make any repairs, Quick Fix 
must first unmount the volume. 
So, afterward, when you 
return to your desktop, you 
must restart your Macintosh 
so that the volume can 
remount. 

I Repair Uolume ) 

Quick Fix attempts to make the necessary repairs to your volume 
and shows you the results. 

If repairs are successful, Quick Fix instructs you to return to your 
desktop and restart your Macintosh (restarting is necessary to 
mount the repaired volume, which was unmounted during repair 
procedures). If the volume mounts, your volume should be ready 
for normal use, and the repairs have been successful. 

If repairs are not successful, you must now move on to Phase III 
and recover all remaining files from your damaged volume. When 
you are ready, go on to the next page. 

26. Click Repair Volume. 



Phase III: Recover Remaining Files 

Don't let the fact that Quick Fix could not 
repair your disk bother you in any way. Quick 
Fix looks for and repairs specific types of 
problems. The fact that it did not work simply 
means your disk is not damaged in a way 
that Quick Fix can deal with. This should not 
affect your ability to recover your remaining 
files from your crashed disk in any way. 

Phase III is actually the same as Phase I, ex­
cept that you will be recovering all of your re­
maining files from the crashed disk, rather 
than just your important ones. 

[E ::'~. ---

If you recovered all of yourfiles during Phase 
I, choose Quit from the File menu and then 
proceed directly to step 32 on page 43; oth­
erwise, 

27. Choose SUM Disk Clinic from the 
File menu. 

28. Once SUM Disk Clinic loads, you 
must repeat several steps you 
performed earlier. Turn to page 30 
in this section and repeat steps 7 
through 12. After completing step 
12, return here and continue with 
step 29 on the next page. 

D 
Get Info ... 881 

Page Setup ... 
Print List... 88P 

SUM Disk Clinic 88D 
Transfer... 88T 

Help 

Quit 

D 
To step 7, page 30 



SUM Disk Clinic 

Please Select the Method you want to use to recouer files ... 

• 
Help 

( J 
Select a recovery method by clicking 

Directory Scan the appropriate button. For a brief 
exp 1anation of the method, click the icon 
to the left of its button. 

The Flopp\I Recoyer method can be 
selected ""0/ if you are attempting to 

~ ( ) 
recover files from a damaged floppy. 

Uolume Scan You can select only one recovery 
method to use during any given attempt 
to recover files. However, you can use 
the methods in any combination since one 

.... method might be able to recover files i.;g [ HOpp~) He( OUPf ) that another cannot. See your U:,w· &1M.> 
for additional information. 

( Main ) ( Back ) 

29. Click Volume Scan. 

After a short delay, you see the SUM File Re­
cover window. 

30. Click Search. 

The program begins scanning your volume 
forfiles it can recover using the Volume Scan 
Recovery Method. This process can take 
some time, depending on the size of the vol­
ume. 

The progress indicator bar begins filling as 
the program searches your disk, and the 
Search button changes to Stop. (With Vol­
ume Scan, the items are not displayed in the 
File List window until the process is com­
pleted.) 

If you click Stop, the files accumulated so far 
are lost. 



.. .from step 14 D 
SUM File Recouer 

~ 
SOURCE Vo lum. : List: I Flies I By: I Name I 
I Hard Disk I Nam. Size 

+ Arkonoid 307 K F! 
DESTINATION Volume: 

Oesk lop 5 K 

I -'tl I My Floppy I [ Eject 1 
froc logroph 18 K 

Helpl.Rsrc 9 K 
778 Free KByt.s He I p2. Rsrc 11 K 

He Ip3. Rsrc 11 K 

[ Search 1 [ Recouer 1 
He I p4 .Rsrc 12 K 

He I p5.Rsrc 11 K 

Hel p6. Rsrc 10 K 

0% 1 1100% LAZlife2.0u 19 K 

Mos ler . Rsrc 7 K 
M.ssages: 

I I 
Omnis 3 Dolo Fi Ie .0 12 K 

Psion 1 K 

Ps i onChess . Rsrc 20 K 

Items in List Select.d: Total Bytes S.lected 

~ ~ 10K I 

D File List Window 

When the search is complete, the items are 
displayed in the File List window, and the 
Stop button changes back to Search. 

Your objective here is to recover those files 
you did not recover during Phase I. 

31. Choose Select All from the Edit 
menu to select all files in the File 
List window. 

32. Use the Shift-click method to dese­
lect those files you did recover 
during Phase I. 

33. Click Recover. 

The program begins recovering your files to 
the DESTINATION Volume. If the program 
finds it necessary to split files during recov­
ery, refer to Splitting Files for Recovery in 
Chapter 5, SUM Recover. 

The program notifies you when all files have 
been recovered. 

34. Once recovery is complete, choose 
Quit from the File menu to return to 
your desktop. 



Assuming you recovered your files to floppy 
disks, you now have a stack of floppies you 
can use to restore your disk to service. But 
before doing so, you need to correct what­
ever is wrong with the crashed disk. 

35. Reinitialize your crashed disk. 

Normally, you would accomplish 
this step by selecting the disk's icon 
on your desktop and choosing 
Erase Disk from the Special menu. 

Some hard disk manufacturers 
provide their own software for 
initializing and reformatting. If you 
have such a drive and the neces­
sary software, reinitialize your drive 
according to the manufacturer's 
instructions. 

36. After you have reinitialized your 
disk, copy all of your recovered files 
back onto the volume. If any of your 
files were split during recovery, 
refer to Restore Split File in Chapter 
4, SUM Disk Clinic, for instructions. 

37. Install SUM II according to the 
instructions in Chapter 2, Getting 
Started. We strongly recommend 
you install the Shield Volume 
Restore Record on the disk you just 
restored and on any others that 
contain important data. 

Although your disk is restored and back in 
service, it's a good idea to hold on to the 
disks containing your recovered files until 
you are satisfied everything is working prop­
erly. 

( End of procedure) 

LJ 
A .SUM Recovered Files 

Remember, your recovered files are 
located in a folder like the one shown 
here. If you don't find all of your files in 
the folder named A.SUM Recovered 
Files, look for folders named B.SUM 
Recovered Files, C.SUM Recovered 
Files, and so on. 
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Introduction 
to SUM II 

This is 

Symantec Utilities 

for Macintosh 

Version 2.0 

Crashed Disk Recovery, Backup, 
Optimization, and Security 

Symantec Utilities for Macintosh version 2.0 
(called SUM II from here on) is a collection of 
utility programs that keeps your Macintosh 
disks operating at peak performance, protects 
you from disk problems (such as crashed disks, 
unintentionally initialized disks, and mistakenly 
deleted files), and provides maximum security 
for your disks and the data they contain. 



Chapter 1 

Components 

+ 
SUM Shield is the ultimate tool for 
protecting your hard disk against disk 
crashes and accidental initialization 
and for recovering deleted files from a 

disk. With SUM Shield, you can recover from 
any of these problems faster and easier than you 
ever thought possible. 

.. SUM Disk Clinic is the "heart" of 
r;I ~ SUM II, and it serves two major 
1iIIl.::J purposes. First, its diagnostic abilities 

greatly simplify the steps involved in 
recovering crashed disks and deleted files. 
Second, it serves as a launching pad from which 
you can start and run the other SUM II 
programs. 

~ 
SUM Recover is the program that 
actually recovers files and repairs 
damaged disks. SUM Recover is 
normally launched by SUM Disk 

Clinic in response to the way you answer the 
diagnostic questions. 

~ SUM BackUp is a disk backup utility 
~ program. You should run this 

program regularly to protect the data 
on your disks whether or not you are 

using SUM Shield. Although SUM Shield 
protects your disks and helps you recover from 
most problems, it is not intended to replace 
good backup procedures. SUM BackUp was 
designed and engineered by Microseeds Pub­
lishing, Inc. and is based on the popular backup 
program, Redux. 

f1 
SUM TuneUp keeps your hard disk B operating at peak performance by 
reorganizing (or "defragmenting") 
your files and optimizing the way 

space is used. In addition, SUM TuneUp can 
analyze your disks and tell you if they need to 
be tuned up. This program also works with 
floppy disks. 
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.n SUM Partition lets you divide a hard 
~ disk into separate volumes. You can 

then use each volume (partition) as a 
separate hard disk. The program lets 

you protect the individual partitions by encrypt-
ing the data and assigning a password (encryp­
tion, unlike simple password protection, is 
extremely difficult to break). Like SUM TuneUp, 
SUM Partition can also be used with floppy 
disks. You'll learn later how useful this can be. 

* 
... 

DiM '.:;'.:.: 
: .. : 

SUM Encrypt protects individual 
files and folders from unauthorized 
access. This program encodes data 
using the standard DES (Data 

Encryption Standard) method. Encrypted files 
and folders are protected with passwords. SUM 
Encrypt quickly decrypts files and folders when 
you need to access the information. 

_:tf-:lI SUM QuickCopy is an extremely 
~11 fast utility program for duplicating 
~1JiDJ floppy disks. You can quickly and 

easily make one or more copies of 
any floppy disk and initialize floppy disks faster 
and easier than with the standard Macintosh 
desktop method. The program is ideal for mass 
duplication of floppies. 

SUM Tools is a disk, file, and 
memory editing utility. You can use 
it to make changes to data files on a 
disk, to edit information about the 

disk itself, or to directly alter computer memory. 
Although the program is designed primarily for 
Macintosh power users, it provides some features 
other users might find useful. 

Do not use SUM Tools to edit vol-
urnes, files, or memory unless you are 
absolutely sure about what you are 
doing. Even minor changes can have 

serious ramifications to your system. 
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Major Features and Benefits 
• Ease of Use. As powerful as SUM II is 

and considering how many things it does 
for you, you'll find the programs very 
easy to understand and use. All the 
programs provide extensive help, so 
assistance is always available if needed. 

• Peace of Mind. You might not spend a 
lot of time worrying about crashed disks 
and lost files, but if this ever happens, the 
effects can be devastating. SUM Shield 
protects your disks from this type of 
damage and ensures tha t even in the 
worst of cases, you can be back up and 
running with your data fully intact, with 
minimal effort, and in the shortest 
possible time. Add to this the power of 
SUM BackUp and you have everything 
you need to protect your disks and your 
data against almost any catastrophe. 

• Improved Disk Performance. Keeping 
your disks in tip-top shape keeps your 
entire system running smoothly and 
efficiently. Periodic maintenance with 
SUM TuneUp keeps your disks operating 
like a finely-tuned automobile. Your 
applications open and save files more 
efficiently, and your disks have much 
larger blocks of free, contiguous space 
available. 

• Fast Disk Duplication. Copying and 
initializing floppy disks on the Macintosh 
desktop is a slow and tedious process. 
But with SUM QuickCopy, you'll be able 
to speed through these tasks. And if you 
need to make many copies of a single 
disk, there is simply no quicker way than 
with SUM QuickCopy. 

• Disk Partitioning. Disk partitioning 
gives you several options for organizing 
applications and data files into a logical 
structure. For example, you might want 
to create one partition for your 
applications, another for documents, and 
yet another for your sensitive data. While 
partitioning is especially useful on hard 
disks, you can also use it on floppies to 
protect sensitive information. 

• Data Security. SUM II gives you several 
different ways to secure your data. With 
SUM Encrypt, you can encode 
information in individual files and 
folders. With SUM Partition, you can 
encrypt all data in a volume. And with 
SUM TuneUp, you can completely erase 
information from your hard disk so that 
even the most sophisticated programs 
cannot recover the information. Any time 
you encrypt data, you assign a password 
to prevent anyone from accessing the 
information without authorization. 

• Volume Compatibility. All SUM II 
components work with hard disks, 
floppy disks, and mountable tape drives 
(except SUM QuickCopy, which only 
works with floppy disks). This guide 
generally assumes you are using a hard 
disk - exceptions for using the 
components with other media are noted 
when necessary. 
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About This Guide 

Your guide is divided into two primary sections: 
Recovery Procedures and Reference. 

Recovery Procedures contains step-by-step 
instructions to guide you through the 
process of recovering crashed volumes 
and deleted files. 

The Reference section provides 
descriptions of each individual SUM II 
component. 

Appendix A, Error Messages, lists and explains 
the error messages you might see when using 
any of the SUM II programs. 

Appendix B, Type and Creator Codes, contains a 
comprehensive list of codes associated with 
various types of Macintosh files. You might find 
this list useful when recovering files from a 
crashed disk or recovering deleted files. 

A Glossary and an Index are also provided at the 
end of this guide. 
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How to Use This Guide 
If you purchased Symantec Utilities for Macin­
tosh because you have a crashed hard disk that 
needs immediate repair, turn to Emergency Hard 
Disk Recover in the Recovery Procedures section (in 
the front of this guide) and follow the steps de­
scribed there. The procedure does not go into a 
great deal of explanation - it is designed to walk 
you through the necessary steps in as short a 
time as possible so that you can repair your disk 
and get back up and running. 

Skim through the chapters in the Reference 
section to get a feel for how the guide is organ­
ized and learn a little about each of the SUM II 
components. This will also help you decide 
which components you want to install on your 
Macintosh. 

Carefully read and complete all steps described 
in Chapter 2, Getting Started, to install SUM II. 

Study Chapter 3, SUM Shield, and configure this 
component to work the way you want. 

Study the Recovery Procedures section. You'll find 
the procedures easier to comprehend if you read 
them in a relaxed atmosphere rather than under 
the stress of a problem situation, such as a 
crashed disk. 

Study the remaining chapters in the Reference 
section to learn how to use different SUM II 
programs. 



Assumptions 
The instructions in this guide assume that you 
are familiar with basic Macintosh operations. 
Before starting you should know how to: 

• Point, click, and drag the mouse. 

• Select, copy, rename, and move icons on 
the desktop. 

• Choose commands from various menus. 

• Manipulate windows, including opening, 
scrolling, resizing, and moving windows. 

• Work with documents, folders, and 
applications. 

• Use Macintosh shortcuts, such as double­
click, Shift-click, and so forth. 

• Use the Finder, Chooser, and Control 
Panel. 

If you aren't familiar with these terms and 
operations, please see your Macintosh User's 
Guide and spend time with your computer 
before attempting to use SUM II and this guide. 

Most of the instructions in this guide assume 
you are using SUM II with a hard disk. You can, 
however, use all components equally well with 
floppy disks, except SUM QuickCopy. 

Introduction to SUM /I 

Conventions 
Certain conventions are used throughout this 
guide so that the information is easier to 
understand. 

All command names and button names appear 
in boldface; for example, Quit and OK. Option 
names (those associated with radio buttons and 
check boxes) are also in boldface. 

Some command names, when they appear in a 
menu, are followed by an ellipse ( ... ) to indicate 
that a dialog appears when you select that 
command. The Transfer ... command is one 
example. The ellipse is omitted from this guide 
for easier reading. 

You'll find the term volume used extensively 
throughout this guide. Volume is a generic term 
used in reference to various storage mediums, 
such as hard disks, partitions on a hard disk, 
and floppy disks. Normally, volume is synony­
mous with hard disk, but it is necessary to use 
the generic term to include all other types of 
storage mediums. 

Another term you'll find used in this guide is 
mount, which describes the process of making a 
volume available for use. For example, when 
you insert a floppy disk into your Macintosh 
drives, the volume is mounted when its icon 
appears on your desktop. 

Please consult the Glossary if you come upon any 
other terms that you aren't familiar with. 
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Volume Selection 
Selecting a volume or volumes to use in SUM II 
is always done using pop-up menus. Pop-up 
menus before they "pop-up" look like this: 

Inst.a 11 SUM on : DEST IN AT ION VolumE' : 

I Hard Disk I I Hard Disk I 
1 0411 FrE'E' KBy tE'S 

To use a pop-up menu, place the pointer directly 
atop the menu, and then press and hold the 
mouse button. The menu "pops-up" to display 
its available selections. Drag up or down 
through the menu until the item you want to 
select is highlighted, and then release the mouse 
button. 

When you display a pop-up menu in this 
fashion, a check mark always appears to the left 
of the current selection. 

The first thing you'll notice is that every volume 
pop-up menu has an Eject button associated 
with it. 
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The Eject button is enabled only when you 
select a removeable volume, such as a floppy 
disk, in the menu. 

I My Floppy I ( Eject) 
Free Space : 48 KBy tes 

In most cases, a removeable volume is a floppy 
disk, but it can also be a removeable disk 
cartridge or any other media that can be ejected. 

When you select a removeable volume and then 
eject it, its name remains in the menu but is 
grayed out, as shown below. This is due to a 
limitation in the Macintosh file system. 

V"'Hard Disk 
DO 50 
SUM II 
Mq r~oppg 

When you are running SUM Disk Clinic, the 
volume pop-up menus work as described here, 
but the actual menu entries differ depending on 
the names of your volumes. Please see Volume 
Pop-Up Menus in Chapter 4, SUM Disk Clinic, to 
learn about these differences. 



What You Need 

Software Requirements 
SUM II requires Macintosh System File version 
4.2 and Finder version 5.3 or later. If you do not 
have the required versions, you can obtain them 
from an authorized AppleTM dealer or from 
many on-line services, like CompuServe®. 

The SUM II programs are compatible with 
MultiFinder. However, you will generally have 
better results if you do not run SUM II with 
MultiFinder. 

Hardware Requirements 
SUM II works with the following Macintosh 
computers: 

• Macintosh Plus 

• Macintosh SE 

• Macintosh SE/30 

• Macintosh II 

• Macintosh IIx 

• Macintosh IIcx 

• Macintosh IIci 

• Macintosh Portable 

SUM II works with floppy disks (single-sided, 
double-sided, and high-density), hard disks 
(SCSI and non-SCSI), volume partitions, device 
partitions, and tape drives. 

If you are installing SUM II on a hard disk, a 
minimum of 2 megabytes of contiguous (adja­
cent) space is required. You can use SUM 
TuneUp to create contiguous space on your hard 
disk if it is not available. (See Chapter 6 to learn 
about SUM TuneUp.) 

Introduction to SUM II 

Package Contents 
Your SUM II package contains the items listed 
below. 

• Symantec Utilities for Macintosh User Guide 
(this book) 

• Two floppy disks (SUM #1 and SUM #2) 

• Customer Service Plan booklet, which 
includes your Registration Card, Disk 
Replacement Coupon, and Change of 
Address form 

If anything is missing and you purchased SUM 
II from a dealer, contact your dealer for replace­
ments; otherwise, telephone Symantec Customer 
Service between 8:00 a.m. and 5:00 p.m. Pacific 
time, Monday through Friday at 408-252-3570. 

Your SUM II disks are double-sided, 800K 
floppy disks. If your disks are damaged in any 
way, please complete and mail the Disk Re­
placement Order Coupon (included in the Cus­
tomer Service Plan) and return it with your 
damaged disk or disks to Symantec Corpora­
tion, ATTN: Customer Service. 

End of Chapter 1 
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Getting Started 

s 
U 
M 

This chapter describes the steps you should 
complete in preparation for using SUM II. 

Your SUM Program Disks contain SUM Install, 
a program designed to help you quickly and 
easily install the various SUM II components on 
your Macintosh hard disks or floppies. 

This chapter begins with some Preliminary Steps 
you should complete before running SUM 
Install. 

Please take a few moments to read 
this chapter once before doing the 
actual steps. 



Chapter 2 

Preliminary Steps 

Copy Program Disks 
Before you continue, make working copies of 
both SUM II program disks. You will need two 
copies of SUM II Program Disk #1; that extra 
copy will eventually be your emergency startup 
disk. 

We recommend you use SUM QuickCopy, a 
disk duplication utility, to make working copies 
of SUM II Program Disks #1 and #2 because it 
makes exact duplicates of your original disks, 
including all the invisible files. 

Before starting, make sure you have three SO OK 
disks for your working copies. To make your 
copies with SUM QuickCopy, do the following: 

1. Insert your original SUM II Program Disk 
#2 in your floppy disk drive. If the disk 
window is not open, open the window 
now. 

2. Locate the SUM QuickCopy icon: 

3. Launch SUM QuickCopy by clicking on 
the icon to select it, and then choose Open 
from the desktop's File menu. Or simply 
double-click on the icon. 

4. The SUM QuickCopy window appears. 

5. Click in the radio button for Copy ALL 
Sectors. 

6. If your disks are new or you want to erase 
all the data on your Target disks (the disks 
you are copying TO), click in the check 
box for Initialize Before Copying. 

7. Click Start Copy. 
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S. When QuickCopy prompts you, insert 
your Source disk (the disk you are copy­
ing FROM), SUM II Program Disk #1, in 
the appropriate drive. 

9. Insert your Target disk into the appropri­
ate disk drive. (If you have a 1 megabyte 
machine, swap the Source and Target 
disks when prompted.) 

10. After inserting the Target disk, click Write 
toTarget. When the copying process 
finishes, label this disk SUM II Program 
Disk #1. 

11. To make another copy of SUM II Program 
Disk #1, insert a new Target disk and click 
Write to Target. Label this disk your 
Emergency Startup Disk. 

12. Finally, you need a copy of SUM II 
Program Disk #2, so repeat steps 7 
through 10. Use SUM II Program Disk #2 
as your Source disk. Once the copy is 
complete, label this SUM II Program Disk 
#2. 

13. Click Quit to exit from SUM QuickCopy. 

Store your original disks in a safe place and use 
the copies from here on. (For more information 
on SUM QuickCopy, see Chapter 9.) 

Check Disk Contents 
The illustrations on the facing page show the 
contents of both SUM II Program Disks. Insert 
each disk, in turn, into your floppy drive and 
check that you have all of the components 
shown in the illustrations. 

If any component is missing, contact the dealer 
where you purchased SUM II for replacements, 
or use the Disk Replacement Form in the Cus­
tomer Service Plan to order replacement disks. 



iii 2 ihm:: 773K in di::tk 1 3K ;.v ~il;.b lQ 

l[] II 
Sy stem Folder 3Utv1 Disk Clinic 

D SUM Disk Clinic 

SUM Install 

Your SUM II Program Disks 
should contain the items shown 
in these windows. If any items 
are missing from your disks, 
contact your dealer for 
replacements or use the Disk 
Replacement Form to order 
replacement disks. 
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Complete Registration Card 
Your SUM II Registration Card is included in 
the Customer Service Plan booklet. Please 
remove the card, complete all requested infor­
mation, and return the card to Symantec at your 
earliest opportunity. 

Registering your ownership of SUM II is for 
your benefit. It makes it possible for us to notify 
you regarding enhancements and upgrades to 
the product. 

SUM Version 1.x Users 
This section explains which files and folders to 
remove before installing SUM II if you are using 
an earlier version of SUM. 

Remove Files and Folders 

You should remove HD Partition INIT, HD Par­
tition DA, Shield INIT, and the Disk Clinic 
folder from your startup volume so they do not 
conflict with SUM II. To remove these compo­
nents, do the following: 

• Drag Shield INIT and HD Partition IN IT 
from the system folder into the Trash. 

• Use the Font/DA Mover to remove HD 
Partition DA from your System file. 

• Remove the Disk Clinic folder by dragging 
it to the Trash. Press the Option key while 
trashing the components to bypass the 
warning alert. 

Once these components are removed, restart 
your Macintosh. 
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Remove Guardian Files 

If you installed the Guardian files (Guardian­
DelData and GuardianSavData) on your vol­
umes, you must use SUM Tools to remove these 
files. You'll need to remove these files because 
SUM Install doesn't delete them during the 
installation process. 

Removing the Guardian files will give you more 
free space on your volume or volumes. Because 
the Guardian files are invisible, the only way to 
remove them is by using SUM Tools or a similar 
type of program. 

To remove the Guardian files from a volume, do 
the following: 

1. Insert your copy of SUM II Program Disk 
#2 in your internal floppy disk drive if it 
isn't there. If the disk window isn't open, 
open it now. 

2. Locate the SUM Tools icon in the window: 

3. Launch SUM Tools by clicking on the icon 
to select it, and then choose Open from 
the File menu. Or simply double-click on 
the SUM Tools icon. 

4. From Other File Tools on the File menu 
select Delete File. 

5. This opens a dialog similar to the one 
shown on the next page: 

6. Select the volume where the Guardian 
files are stored, for example, your hard 
disk, by clicking on the Drive button. All 
the items on the volume are listed in al­
phabetical order. 



I~ liard Disk I 
[) Desktop ~lIard Disk 
o Games 
o PageMaker 3.0 
o SUM 
o System Folder 

Driue 

Delete 

Cancel 

7. Click on GuardianDelData to select it. 

8. Click the Delete button. 

9. When the dialog "Delete this file?" 
appears, click OK to remove the file. 

10. Repeat steps 4 through 9 to delete the file 
GuardianSavData. 

11. When both files are deleted, choose Quit 
from the File menu to leave SUM Tools. 

The Guardian files are now removed from your 
hard disk, and you can install SUM II. 

SUM Install 

New Terms 

A few terms have changed from the earlier 
version of SUM. The old and new terms are as 
follows: 

"Volume Parameters" are now called 
Volume Information Files or VIFs for short. 

"Guardian Volume Save Record" is now 
called the Volume Restore Record. 

"Guardian File Save Record" is now called 
the Deleted File Record. 

Guardian protection is now referred to as 
Shield protection, which consists of Shield 
INIT, the Deleted File Record, and the 
Volume Restore Record. 
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Using SUM Install 
SUM Install 

Utility Programs 

o SUM Disk Clinic 

o SUM BackUp 

o SUM TuneUp 

o SUM QuickCopy 

o SUM Partition 

o SUM Tools 

o SUM Encrypt 

o SUM Install 

Info 

Launching SUM Install 

1. Insert your copy of SUM II Program Disk 
#2 in your internal, floppy disk drive. If 
the disk window is not open, open the 
window on the desktop now. 

2. Locate the SUM Install icon in the win­
dow: 

3. Launch SUM Install by clicking on the 
icon to select it, and then choosing Open 
from the desktop's File menu. Or simply 
double-click on the SUM Install icon. 

4. The SUM Install window appears on your 
screen, like the one pictured above. 
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I Hard Disk I CI:Eiill 

Support Fl1~s 

o Uolume Information Files 

o Signatures 

SUM Shield Files 

o Deleted File Record 

o Uolume Restore Record 

In~t!ll! 

As you can see in this window, SUM II consists 
of many different components. Do not move 
any of the SUM II components on your SUM II 
Program Disks because SUM Install looks for 
those components in specific locations. If the 
components are misplaced, SUM Install will be 
unable to complete the installation. 

You need to decide which components you want 
to install before actually running SUM Install. It 
is entirely up to you which component you 
choose to install. For example, if you aren't 
planning to partition your hard disk, then you 
would not install SUM Partition. SUM Tools is 
another component you may never need. 

Chapter I, Introduction to SUM II, provides a 
brief explanation of each SUM II component. 
For more information about a component, see 
the appropriate chapter in this guide or install 
the component after you know more about it. 

When you click any check box in the window, a 
brief description of the component appears in 
the Help area. Read the Help information before 
installing any SUM II component. For complete 
instructions on the installation process, choose 
Help from the File menu. 



Selecting a Volume 
The pop-up menu, labeled "Install SUM on," 
shows the volume where the SUM II compo­
nents will be installed. To install the components 
on a different volume, display the pop-up menu 
and choose the volume you want. The volume 
must be mounted for you to be able to select it. 

You can install the components on as many 
different volumes as you like. Normally, you 
install the Utility Programs and the Support Files 
on only your startup volume. But you'll proba­
bly want to install the Deleted File Record and 
Volume Restore Record on multiple volumes. This 
will become clear as you read the rest of this 
chapter. 

Selecting Utility Programs 
Listed under Utility Programs are the different 
SUM II programs you can install: SUM Disk 
Clinic, SUM BackUp, SUM TuneUp, and so on. 
Click in the check boxes to place an X next to the 
utility programs you want to install on the 
selected volume. 

[EJ 
When you install SUM Partition, SUM 

I ::-..:. Install gives you the choice of install-
ing it directly into your System file or 
simply copying it into your system 

folder. The latter option (copy only) is provided 
if you have applications like MasterJuggler™ or 
Suitcase™. If you are not using one of these, you 
should install SUM Partition in your System file 
- assuming you wish to use the component. 

If you don't install SUM Disk Clinic with SUM 
Install, copy SUM Recover into the same folder 
as SUM Disk Clinic. These two components 
must be in the same folder to operate properly. 
Also, place all of the SUM utility programs 
(SUM Backup, SUM TuneUp, and so on) in the 
same folder as SUM Disk Clinic if you want to 
launch these utility programs within SUM Disk 
Clinic. 

SUM Install 

Volume Information Files 
Volume Information Files (VIFs) are special files 
used by SUM Disk Clinic to tell the recovery 
programs what they need to know about a par­
ticular volume when that volume has crashed 
and needs to be restored. VIFs are necessary 
because each particular type of volume has its 
own characteristics. For example, the character­
istics of an Apple 40 megabyte SCSI hard disk 
are significantly different from those for a 
MacBottom™ 20 megabyte serial hard drive. 

If a crash does occur, SUM II reads the informa­
tion in the VIF if it is unable to access the 
volume normally. Without the VIF, SUM II 
might still be able to access the volume, al­
though the chances are decreased somewhat. So 
to give yourself the best chance of recovering a 
crashed volume, you should have a VIF avail­
able for every volume on your system that you 
want to protect. 

Although an assortment of VIFs are provided on 
SUM II Program Disk #2, you don't need to 
install these VIFs if you plan to create VIFs for 
your volumes. Creating a Startup Disk at the end 
of this chapter shows you how to create VIFs for 
your volumes after you have finished installing 
SUM II. Create Volume Info File in Chapter 4, 
SUM Disk Clinic, has complete details about 
creating VIFs. 
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Signatures 
Signatures are files with special information that 
help SUM Recover locate and recover files from 
a crashed disk. Different software applications 
(MORETM II, THINK Pascal, etc.) use different 
signatures. Your SUM II Program Disks come 
with the Packed Signatures file that contains 
many different signatures for the most popular 
software applications. By clicking the Signatures 
check box to place an X in it, these signatures 
will be installed on your system and will help 
you recover files, when necessary. (For informa­
tion on viewing signatures, read Show Signatures 
in Chapter 5, SUM Recover.) 

We strongly recommend you install the 
Signatures file as this greatly improves your 
chances of recovering files from a damaged 
volume. 

Deleted File Record 
You should install this record on any volume 
that you might want to recover deleted files 
from, provided you have adequate free space on 
that volume. 

When you click the Deleted File Record check 
box to place an X in it, a dialog like the following 
appears in which you can specify the number of 
deleted files you want to track on the selected 
volume. 
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~ How many deleted files do 
lliill you want to keep track of? 

Number of files: I~i' I 
(May be from 50 to 500) 

Space required: 8 k bytes 

Cancel 'OK 11 
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You can track any number of files from 50 to 
500. Space required shows the amount of disk 
space required on the volume to track the 
number of files you have specified. 

After specifying the number of files to track, you 
see a dialog similar to this: 

Deleted File Record -will be 
insta ned on: Hard Disk 

Select the startup volumes where you 
want to install SUM Shield IN IT . If you 
have already installed SUM Shield INIT, it 
is not necessary to install it again at this 
time. If you do reinsh 11 the IN IT , it will 
overwrite your existing copy and reset 
all options to the original settings. 

Hard Disk 
HD20 

OK J] 

Notice that the name of the startup volume 
where the Deleted File Record will be installed, 
in this case Hard Disk, is shown at the top of the 
window. Now take a look at the lower half of 
the window where a list of volumes is shown. 
These mounted volumes are the volumes that 
can be used as startup volumes. From this list, 
you need to select the startup volumes on which 
you want to install SUM Shield INIT. 

To install SUM Shield INIT, you 
must select the volume or volumes 
in this window where you want 
Shield INIT installed. 

Click on the volume name or use the Shift-click 
method to select multiple volumes. The selected 
volume is highlighted, like the one on the next 
page: 



Deleted File Record ..,ill be 
installed on: Hard Disk 

Se led the startup volumes where you 
want to install SUM Shield IN IT. If you 
have already installed SUM Shield IN IT , it 
is not necessary to install it again at this 
time. If you do reinstall the IN IT , it will 
overwrite your existing copy and reset 
all options to the original settings. 

Hard Disk 
HD20 

[[ OK 1] 

When you finish selecting volumes, click OK. 

You can increase or decrease the size of the 
Deleted File Record after it is installed. To do 
this, rerun SUM Install and simply reinstall the 
record on the volume. 

e When you reinstall the record in 
this manner, the existing Deleted 
File Record is overwritten by the 
newly installed record. Thus, the 

names of all deleted files in the existing record 
are lost permanently. 

The Options menu in SUM Disk Clinic contains 
a command (Remove Shield Files) for removing 
the Deleted File Record from a volume. This 
command is described in Chapter 4, SUM Disk 
Clinic. 

Volume Restore Record 
You should install the Volume Restore Record on 
any volume that contains important information. 
With this record installed, recovering files from 
the volume in the event of a crash is painless 
and fast. For a complete description of this 
record, please refer to Volume Restore Record in 
Chapter 3, SUM Shield. 

SUM Install 

The size of the Volume Restore Record varies 
depending on the volume's capacity, the 
amount of space used on that volume, and 
several other factors. As a rough estimate, a 30 
megabyte volume that is about 90% filled with 
data requires a Volume Restore Record of ap­
proximately 230K. 

When you click the Volume Restore Record 
check box to place an X in it, you see a dialog 
similar to this: 

Volume Restore Record ..,ill be 
installed on: Hard Disk 

Select the startup volumes where you 
want to install SUM Shie 1d IN IT. If you 
have alreadlJ installed SUM Shield INIT, it 
is not necessary to install it again at this 
time. If you do reinstall the INIT, it will 
overwrite your existing cOP'J and reset 
all options to the original settings. 

HD 20 

[[ OK l] 

-

At the top of this dialog the volume name where 
the Volume Restore Record will be installed is 
displayed. (The volume name corresponds with 
your selection in SUM Install.) 

This window lists the currently mounted vol­
umes that can be used as a startup device. From 
the list of volumes, you must select the volume or 
volumes in the list on which you want to install 
SUM Shield IN IT because 

SUM Shield INIT and the Volume Restore 
Record work together. To protect your 
volumes, the Volume Restore Record must 
be updated on a periodic basis - SUM 
Shield IN IT does this for you. Because 
SUM Shield IN IT is a startup document, it 
must reside in the system folder on your 
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startup device so that it can update the 
Volume Restore Record when necessary. 

If you use different startup volumes, you should 
install SUM Shield INIT on each volume. If you 
do not select a volume in this window, SUM 
Shield INIT is not installed. 

Select the volume or volumes in the volume list 
on which you want to install SUM Shield INIT 
and click OK. Use the Shift-click method to select 
multiple volumes. 

The Remove Shield Files command in 
the SUM Disk Clinic Options menu 
can be used to remove the Volume 
Restore Record from a volume. 

The Invisible Files 
The Deleted File Record and Volume Restore 
Record are not files you will find on your 
desktop - they are invisible. This is helpful 
because it prevents you from accidentally 
deleting these files. 

We recommend you create a Deleted File Record, 
Volume Restore Record, and Volume Informa­
tion File for each disk, disk partition, floppy disk, 
file server, and so on that you want to protect. 
(Note that the Volume Information File is not 
invisible, and its icon appears on the desktop 
after you create it.) 

For example, if you add a hard disk to your 
system and you want to install only the invisible 
files on that volume, press the Option key as you 
launch SUM Install. With this method, SUM 
Install allows you to install the Deleted File 
Record and the Volume Restore Record without 
any of SUM II's other components on the 
selected volume. 
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Installation Info 
Click or choose the Info command from the File 
menu to see how much space is required on the 
selected volume to install the components you 
have specified. You see a dialog similar to this: 

H8 M· 
SUM In~tallation Figures 

Selected Uolume: Hard Disk 

Llolume Capacity: 14n:n k bytes I 
Free Space on Llolume: 119621 Ie bytes I 

Required For Installation: 11024 k bytes I 
Free Space Rfter Installation: 118603 Ie bytes I 

If OK .11 

If the dialog indicates that you don't have 
adequate space, you have these options: 

• Deselect one or more SUM II components 
so they aren't installed on the current 
volume. You can install these components 
on a different volume if you wish. 

• Remove one or more items from the current 
volume to make room for the SUM II 
components you want to install. 

• Copy SUM TuneUp on a different volume 
that has adequate contiguous space. Run 
SUM TuneUp on this volume to defragment 
and optimize the volume that didn't have 
enough contiguous space. If the volume is 
badly fragmented, this might free up 
enough space so that you can install the 
SUM II components the way you want. 
Install the components on the volume you 
tuned up. (See Chapter 6 for instructions on 
using SUM TuneUp.) 



Installing SUM II 
Click Install or choose the Install command 
from the File menu to begin installing the 
selected components on the chosen destination 
volume. Insert SUM II Program Disk #1 and #2 
when the program prompts you. During the 
installation, a dialog similar to this is displayed: 

SUM Installation In Progress 

Sele( ted llolume: Hard Disk 

Now Installing: fa SUM TuneUp 

Progress: 

0%1 11 00% 

II Cancel 1IIl. II 

This screen keeps you updated as each compo­
nent is installed, and SUM II prompts you when 
the installation is completed. 

If you click Cancel during the installation, SUM 
Install asks you to confirm the cancellation or 
lets you resume the installation. If you do decide 
to cancel the installation, SUM Install finishes in­
stalling the current component. Since this may 
take some time, it may be a while before you are 
prompted to confirm the cancellation. 

SUM Install 

Post Installation 
After installing all of the SUM II components, 
choose Quit from the File menu to return to 
your desktop. 

Restart your Macintosh so that the SUM Shield 
and SUM Partition INITs can load into memory 
and begin working for you. These components 
will not be available until you restart. 

I __ .. Suitcase and you copied SUM Parti-[E 
If you are using MasterJuggler or 

--- tion desk accessory to your system 
folder rather than installing it in your 
System file, you must open the SUM 

Partition DA to have it appear in your" menu. 

The Emergency Startup 
Disk 
Earlier in the chapter, you made an extra copy of 
SUM II Program Disk #1. That disk, called your 
emergency startup disk, will make it possible for 
you to recover your startup volume if it crashes. 

By the time you finish this section, the emer­
gency startup disk will contain the system 
folder, the SUM Disk Clinic folder, which 
contains SUM Disk Clinic, SUM Recover, and 
Packed Signatures, and your volumes' VIFs. The 
VIFs, which you'll create next, will be stored on 
your emergency startup disk. You'll need to 
create VIFs for each volume you want to protect. 

e Although SUM II Program Disk #2 
contains a folder of existing VIFs (that 
work in most recovery cases), you 
should create your own VIFs if 
possible to ensure the optimal recov-
ery of a damaged volume. 
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SUM Disl< Clinic 

Ii~ Select the lJolume for which you are creating a 
~) Uolume Information File (UIF) ... 

~ I Hard Disl< I 

Create UIF 

This window ma'! be used to create a Vol'Jme Information File (VIF) for an'! device attac~,ed to your 
Macintosh. The VIF makes it possible for the program to access and work with a device even if it 
has crashed. Select the device from t~,e pop-up menu and then click C .... at .. YIF. A file save dialog 
appears for you to name the VIF and indicate where you want to store it. VIFs can have any name 
you like and be stored wherever you wish. NOTE: Flopp'! Drive VIFs are not n.eded. 

( Main ) 

In the steps that follow, you will launch SUM 
Disk Clinic and create VIFs for all the volumes 
attached to your Macintosh (including hard 
disks, soft and hard partitions, and so forth). 
Even if you have installed the VIFs with SUM 
Install, this step ensures that your VIFs are 
absolutely accurate and provides the best chance 
of recovering a crashed volume. 

If you didn't restart your Macintosh after the 
installation, do so now. 

To finish the startup disk and create a VIF for 
each volume you have, follow these steps: 

1. Retrieve the extra copy of SUM II Program 
Disk #1 that you made earlier. Make sure 
this is labeled Emergency Startup Disk. 

2. Insert this copy of SUM II Program Disk 
#1 in your floppy disk drive. If the disk 
window is not open, open it now. 

3. Locate the SUM Disk Clinic folder and 
open it if it is closed. 

4. Locate the SUM Disk Clinic icon: 
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5. Launch SUM Disk Clinic by clicking on 
the icon to select it, and then choose Open 
from the desktop's File menu. Or simply 
double-click on the icon. 

6. Enter your name and organization at the 
first screen, which only appears the first 
time you launch the program. (In Organi­
zation enter at least one character, such as 
a space, even if you don't have an entry; 
otherwise, you cannot continue.) 

[la -_ .. --. 
If you try to save your name and or­
ganization on a locked disk, SUM 
Disk Clinic returns to the Finder. If 
this happens, unlock the disk and 

launch SUM Disk Clinic again. 

SUM Disk Clinic loads, and the message "Please 
stand by ... Scanning for configuration info." 
appears temporarily. SUM Disk Clinic auto­
matically collects your system's configuration 
information the first time it is launched. It is best 

To create a VIF for each volume, follow these 
steps: 

1. Choose Create Volume Info File from the 
Options menu. The Volume Information 
File window, shown above, appears. 



2. Select a volume from the pop-up menu for 
which you want to create a VIF, for 
example, your hard disk or volume parti­
tion. 

3. Click Create VIF. 

4. A default file name is displayed, such as 
HardDisk.VIF. You can use the default or 
enter a new file name for the VIF. Before 
clicking Save, you can select the drive 
where you want to store your VIFs; in this 
case, they should be saved on your 
emergency startup disk (SUM II Program 
Disk #1). 

5. Click Save to save the VIFs to the selected 
volume. 

6. Click OK when the message "VIF success­
fully created" is displayed, and the 
program returns to the VIF window. 

7. Repeat steps 2 through 5 for each volume 
you want to protect, including all hard 
disks and soft and hard partitions. (To 
create a VIF for a password-protected 
partition, you must remove the password 
first, and then create the VIF. See Removing 
Passwords in Chapter 8, SUM Partitio1l for 
more information. ) 

8. Choose Quit from the File menu to leave 
SUM Disk Clinic when you have created 
all your VIFs. 

SUM Install 

When you return to the desktop, your VIFs are 
displayed in the SUM Disk Clinic folder on your 
emergency startup disk. 

There should be enough room on the emergency 
startup disk for the VIFs from all your volumes. 
If the disk space is inadequate, use another disk 
to store any VIFs that don't fit on the startup 
disk. 

When all the VIFs are saved, remove the disk 
and place the startup disk in a safe place. If you 
need to restore a crashed volume, retrieve the 
startup disk and see Recover Volume in the 
Recovery Procedllres (front of this guide) for in­
structions on recovering your volume. 

End of Chapter 2 
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SUM Shield is one of the most important and 
beneficial components of SUM II. It gives you 
the ability to: 

o Quickly and easily recover a volume that 
has either crashed or has been initialized 
by mistake. 

• Quickly and easily recover files deleted 
from a volume. 

• Protect the "integrity" of a volume's 
directory by preventing accidental or 
intentional changes that could make the 
volume inaccessible. 

We stress the word "ability" here to point out 
that SUM Shield does not actually recover 
volumes and deleted files; these functions are 
performed by SUM Disk Clinic and SUM Re­
cover. However, SUM Shield is the component 
that protects volume directories and makes 
volume and file recovery possible. 

SUM Shield 

SUM Shield operates as a "startup document" 
(an IN IT) rather than as a standard Macintosh 
application like MORE II or MicrosoftTM Excel. 
Because it is a startup document, the only thing 
you have to do to use it is make sure the SUM 
Shield component is located inside the system 
folder on your startup volume. (SUM Shield 
must not be nested within another folder in your 
system folder.) 

Every time you start your Macintosh, SUM 
Shield loads into memory and begins working to 
maintain your invisible files - the Volume 
Restore Record and the Deleted File Record. 
This combination, known as "shield protection," 
protects your volumes from disaster. 

If you used SUM Install to install SUM Shield (as 
explained in Chapter 2), the program is correctly 
located and ready to use. However, before 
learning how to use SUM Shield, you need to 
understand how the program protects your 
volumes. Therefore, this chapter begins with 
discussions of the Volume Restore Record and 
Deleted File Record. 
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Volume Restore Record 
When you run SUM Install, you have the option 
of installing the Volume Restore Record on 
those volumes you want to protect. It is this 
record that gives SUM II the ability to restore 
crashed or mistakenly initialized volumes. If 
you do not install the record on a volume, you 
can still use SUM Disk Clinic to recover from a 
crash, but the time and effort required increases 
considerably. 

You can install the Volume Restore Record on as 
many different volumes as you like. For the 
purposes of this discussion, we'll assume you 
have installed the record on one hard disk. 

While you are working with your Macintosh, 
SUM Shield periodically takes a "snapshot" of 
your volume's directory and stores it (along 
with some other information) in the Volume 
Restore Record on that volulne. You can control 
when the snapshot is taken - you can force it to 
occur in response to pressing certain keys, 
automatically at specific time intervals, and 
when you shut down or restart your computer. 
You'll learn how to accomplish this later. 

Volume 
Directory 

"Snapshot" 
Update 

If your volume sustains a crash or is initialized 
by mistake, SUM Recover can use the snapshot 
in the Volume Restore Record to restore your 
volume. 

Removing Shield INIT from your system folder 
means that the Volume Restore Record isn't 
regularly updated. Suppose your volume sus­
tains a crash, and the only Volume Restore 
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Record you have is outdated. It isn't advisable 
to use that record to recover your files. Your best 
chance of recovering all your files would be to 
use the Directory Scan Recovery Method. 

Backing Up Volume Restore Record 

Often times, crashed volumes sustain damage to 
the volume directory. As a result, when you use 
SUM Recover to restore the volume, the pro­
gram must search the entire volume to locate the 
Volume Restore Record. This can take consider­
able time on a 20 megabyte hard disk and 
significantly longer on larger disks. SUM Shield 
gives you a way to avoid such lengthy searches. 

The key to avoiding lengthy searches is to keep 
a backup copy of the Volume Restore Record on 
a separate volume (such as a floppy disk). If a 
crash does occur, you can use the backup copy 
to restore the volume. 

As part of your periodic update procedure 
(when the volume snapshot is taken), you can 
instruct SUM Shield to create a backup copy at 
the same time the snapshot is taken. This 
ensures that your backup copy is always 
current. 

If you don't use the automatic backup function, 
you can use SUM Disk Clinic to manually create 
backup copies of your Volume Restore Record. 
See the Backup Shield Files command in Chap­
ter 4, SUM Disk Clinic. 



[EJ At times the backup copy of the 
I ::.~ Volume Restore Record may not fit on 

a single floppy disk, for example, if 
you are backing up the Volume 

Restore Record from a large hard drive that is 
filled with information (80 megabytes or more). 
To split the backup file across multiple floppy 
disks, use the Backup Volume Restore Record 
command from the Options menu in SUM Disk 
Clinic. (See Chapter 4, SUM Disk Clinic, for 
details.) 

Synchronizing Your Volume 

If a volume crashes and you use the Volume 
Restore Record to restore it, it is likely that 
things will be out of synchronization following 
restoration. To illustrate this, assume that on 
Monday at 3 o'clock you update the Volume 
Restore Record with a new snapshot. Two hours 
later your volume crashes. 

Even following the crash, chances are good that 
all of your work (including what you accom­
plished between 3 and 5 o'clock) is still on the 
volume. But if your first step is to use SUM Disk 
Clinic to restore the volume using its Volume 
Restore Record, the volume's directory would 
be restored to the way it was at 3 o'clock, and 
you will lose the work you did between 3 and 5. 

O 
You can avoid this potential loss of 
data and recover all of your work by 
following the procedure explained 
under Synchronized Recovery in 

Chapter 5, SUM Recover. Please read this special 
section before going any further with the re­
covery process. 

The synchronization factor brings up the ques­
tion of how often you should update the Vol­
ume Restore Record with a new snapshot. There 
is no definite answer to this question; it depends 
on how critical you feel your work is, how much 
time you're willing to spend recovering your 
missing files, and several other factors. (You'll 
see later in this chapter how SUM Shield gives 

SUM Shield 

you complete control over this function.) The 
best advice is to update often. The amount of time 
required to take the snapshot is relatively minor 
compared to the time and effort required to 
synchronize your volume following a crash. 

Deleted File Record 
To better understand how the Deleted File 
Record works, you need to understand what 
actually happens when you drag a file's icon to 
the Trash on your desktop. 

When you place a file in the Trash, that file is 
not physically removed from the volume at that 
moment. As you know, up to a certain point you 
can open the Trash can and recover a file simply 
by dragging its icon back onto your desktop. 
This is possible until such time as any of the 
following occur: 

• You choose the Empty Trash, Shut Down, 
or Restart command from the Special 
menu. 

• You launch any application other than the 
Finder. 

• You unmount the volume. 

• You give another file the same name as 
one currently in the Trash. 

When the Trash is emptied and a file's icon is 
removed, the file still remains on your volume. 
What actually occurs is that the Macintosh file 
system marks the file's entry in the volume 
directory to indicate that the space occupied by 
the file can now be used for other purposes. 
Thus, as you create or modify files on the 
volume, some or all of the deleted file's space 
might be overwritten with new data at some 
point. Thus, at any given point, you might be 
able to recover some or all of a deleted file. 

When you install the Deleted File Record on a 
volume (via SUM Install), you specify the 
number of files you want to recover. SUM Shield 
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keeps track of each file deleted from the volume 
by recording its name and location in the 
Deleted File Record. When you want to recover 
a deleted file, SUM Recover uses the information 
in the Deleted File Record to do so. 

What you must keep in mind is that even 
though the Deleted File Record contains an 
entry for a deleted file, you might not be able to 
recover the file completely if some or all of the 
data has been overwritten by some other 
application. If SUM Recover suspects there 
might be something wrong with a file you are 
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attempting to recover, it lets you know. You'll 
learn how this works in Chapter 5, SUM Recover. 

The Deleted File Record works on a queuing 
basis. Once the record reaches its maximum ca­
pacity, the first entry in the record is automati­
cally "bumped out" when the next file is de­
leted. For example, if you set up a record to 
contain a maximum of 100 entries, entry number 
one is moved out when entry 101 is made; entry 
two is bumped out by entry number 102; and so 
forth. Thus, your most recently deleted files are 
always available in the Deleted File Record. 



SUM Shield 

Using SUM Shield 

o Control Panel 

fO 1 [I SUM Shield Options 

1::1 iliii': ::~;~,~C:;O::::i::I~:liV. L ., .. ·.,:i .. ,i:: .. ,i.,; Shield protects the directory of your startup 
~ disk from viruses and similar damage. 

:::=1: [8] File Recouery Actiue <l )~ :!:II; Shie ld keeps track of files deleted from 

S,"od I ~ ~~~~;~;:.~::::::t::;:·VR;"'d 
rn Shield saves 'snapshots' of directories on 

? 6.:,;.~,;.:.: volumes where the Volume Restore Record is 
installed to facilitate recovery after a crash. 

Startup Device!O [ Uolume Salle Options I 
3.3.1 

As explained earlier, once SUM Shield is inside 
your system folder, the program loads every 
time you start your Macintosh. Thereafter, most 
of the functions performed by the program are 
completely automatic and require no action on 
your part. However, you might want to change 
how the program is operating by changing its 
configura tion. 

To reconfigure SUM Shield, begin by choosing 
the Control Panel from the '* menu. When the 
Control Panel appears, scroll down the window 
on the left side until you see the SUM Shield 
icon: 

Click the SUM Shield icon, and the Control 
Panel changes so that it looks similar to the one 
pictured above. 

Show Icon at Startup 
Click this option On (click to place an X in its 
check box) if you want the SUM Shield icon to 
appear on your startup screen; otherwise, click 
the option Off. 

Volume Protection Active 
With this option clicked On, SUM Shield pro­
tects your volume against certain types of 
activity that might cause damage to its directory. 
Damage can be inflicted by certain types of 
viruses, by applications that do not operate 
correctly, or by applications under development 
by software engineers. 

Unless you have a specific reason for deactivat­
ing this option, we recommend you always 
leave it selected for maximum protection of your 
volumes. 
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At times SUM Shield INIT interferes with 
certain installation programs. Before running 
the Install program for Aldus Pagemaker® or 
Persausion, remove SUM Shield INIT from your 
system folder and restart your computer. After 
completing the installation, copy SUM Shield 
INIT into the system folder and restart your 
computer. 

File Recovery Active 
If you have installed the SUM Shield Deleted 
File Record on one or more of your volumes and 
this option is clicked On, SUM Shield keeps 
track of files deleted from your volume or 
volumes. If you click this option Off, the names 
and locations of files are not entered in the 
Deleted File Record when they are deleted from 
a volume. 

Volume Recovery Active 
If you have installed the SUM Shield Volume 
Restore Record on one or more volumes and this 
option is clicked On, SUM Shield updates the 
record with a new directory snapshot when you 
instruct it to. When you click this option On, the 
Volume Save Options button at the bottom of 
the Control Panel becomes active. This button 
gives you access to those options that let you 
control if and when the directory snapshot is 
taken. These options will be discussed in a mo­
ment. 

Whenever you instruct SUM Shield to update 
the Volume Restore Record with a new snap­
shot, the program examines every volume that is 
currently mounted to determine whether or not 
the Volume Restore Record is installed. If the 
record is installed, SUM Shield takes the snap­
shot and updates the record on that volume; 
otherwise, it moves on and examines the next 
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mounted volume until all the volumes have 
been examined and updated as necessary. 

Unless you have a specific reason for deactivat­
ing the Volume Recovery Active option, leave 
this option selected for maximum protection of 
your volumes. 

Volume Save Options 

Clicking the Volume Save Options button 
displays the dialog shown here: 

Save Record on Original Volume AND: 

D Saue Record on Supplemental Uolume 

@ Promp t tor HolumI' to u~(J <11 ~!Wl' timl'. 
o lJ~(~ ,>p~~ein( lJO!!HHI' r"i~·i~·r·ii"·i)·i';;·~"l 

, ... Update on Shutdown and Eject 

r8J Update Record on Shutdown 

o Option key ENABLES update 
@ Option key DISABLES update 

r·1 Update on Demand using Hot Key 

D Update Record - Command Option Keys + ~ 

•... Update Periodically 

D Update Record at Time Interual 

Upd<11 (~ (w(Jl"~J g [""MTi~·ijf;;·;;······1 

([ Cancel J) ( Help ) ( Saue I 

This dialog gives you several different options 
for controlling when SUM Shield updates the 
Volume Restore Record on your volumes. 

Volume 
Directory 

"Snapshot" 
Update 



Note first of all that the dialog contains four 
separate check boxes that you can click On and 
Off in any combination. Thus, you may combine 
the options in any way that suits your needs. For 
example, you can specify that a snapshot be 
taken in response to a hot key during any shut 
down procedure mId at a specific time interval. 
In some cases, combining certain options may 
not work, but you can easily identify when this 
happens. 

Any time SUM Shield updates the Volume 
Restore Record on a volume, it automatically 
overwrites any existing backup file with the 
same name without confirming the back up. 

Save Record on Supplemental Volume 

This option lets you create the backup copy 
while updating the original Volume Restore 
Record. SUM Shield automatically updates the 
Volume Restore Record on the original volume; 
that is, the volume where the record is installed. 
Remember, it is good practice to have a backup 
copy of the Volume Restore Record on a separate 
volume to simplify recovery. 

If you want to back up the Volume Restore 
Record to a volume other than the startup 
volume, you can set Prompt for Volume to use 
at save time to prompt you for the backup 
volume since the other volumes are unmounted 
before the startup volume. 

SUM Shield 

If you click this option On and then select 
Prompt for Volume to use at save time, SUM 
Shield asks you to select the volume on which 
you want to store the backup copy of the 
Volume Restore Record at the time the original is 
being updated. You can, at that time, select a 
floppy disk, a hard disk, or any other currently 
mounted volume. 

If you want the backup copy of the Volume 
Restore Record saved to floppy disk on shut 
down, select Prompt for Volume to use at save 
time. This lets you select the floppy disk to store 
the backup copy. 

If you click this option On and select Use 
Specific Volume, you must select the volume 
you want to use from the pop-up menu. If you 
want to use a floppy disk for this purpose, insert 
the disk before displaying the pop-up menu. 
The volume you select from this menu must be 
mounted at the time the snapshot is taken. If the 
volume isn't mounted, the snapshot is taken, but 
the backup record is not created. 

If you click Save Record on Supplemental 
Volume Off, no backup will be created. An 
alternate method to make a backup copy of the 
record using Backup Shield Files command in 
the SUM Disk Clinic Options menu. 

Update Record on Shutdown 

If you click this option On and then select 
Option key ENABLES update, the record is 
updated only if you hold down the Option key 
during the shut down or restart procedure. 

If you click this option On and then select 
Option key DISABLES update, the record is not 
updated if you hold down the Option key 
during the shut down procedure. 

If you click Update Record on Shutdown Off, 
the Volume Restore Record is never updated 
during a shut down procedure. 
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When using security programs (such as Night­
Watch and Mac Password) that take over your 
Macintosh upon Shut Down, SUM Shield cannot 
update the Volume Restore Record. 

If more than one volume is updated by SUM 
Shield at Shut Down and Shield Options is set to 
update the Shield files (Volume Restore Record 
and Deleted File Record) when the Option key is 
held down, you must hold down the Option key 
until the last volume is updated; otherwise, 
some volumes aren't updated. 

Update Record - Hot Key 

You might find it useful to be able to force an 
update of the Volume Restore Record at any 
given time. For example, if you have just com­
pleted a lengthy session of important or complex 
work, that would be a good time to update the 
record. 

This option lets you specify that when certain 
key combinations are pressed (called hot keys), 
the update is performed at that moment. 

The hot key combination must always include 
the ~ key, the Option key, and one other key of 
your choice. By default, the third key in this se­
quence is the letter "y" (lowercase only). To use 
a letter other than "y," select the text box and 
type the letter you want to use. 

When selecting a hot key combination for SUM 
Shield, try to avoid conflicts with your other 
applisations. For example, entering ~-Option-Y 
while working within MicrosoftTM Word initi­
ates an entirely different action, which prevents 
the Volume Restore Record from being updated. 

Update Record at Time Interval 

Click this option On if you want SUM Shield to 
update the Volume Restore Record at specific 
time intervals. Then, select the time period 
(Minutes or Hours) from the pop-up menu and 
enter the time measurement in the text box. 
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Updlt'? P'?riodiclll'J ..................................................................................................................... , 

[2J Update record at time interual 

Update euery IEIilII Minutes 

The time interval is measured relative to the 
time you start up your Macintosh. When the 
time interval has elapsed, SUM Shield sounds an 
audible signal, suspends all current activity, and 
immediately updates the Volume Restore 
Record. While the update is taking place, a small 
Shield icon appears on your screen. 

_ If you hear the audible signal while 
U working on your Macintosh, stop work 

until SUM Shield completes the 
update. Otherwise, any work you do during the 
update is not recognized. 

[EJ If you are using Pyro! (Fifth Genera-
I :.==~ tion Software) and have activated the 

time interval update, the Volume 
Restore Record update does not occur 

while Pyro! is in its "sleep state." If an automatic 
update is due, it occurs after the screen is 
refreshed. (Note that SUM Shield only works 
with version 3.3 of Pyro!.) 

Click OK to save the changes to the Volume 
Save Options before quitting. 

Quitting SUM Shield 
To quit SUM Shield, click the Control Panel's 
close box. 

Whatever configuration changes you make to 
SUM Shield take effect immediately; it isn't 
necessary to restart your Macintosh. 

End of Chapter 3 
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SUM Disk Clinic is best described as a "diag­
nostician." That is, it asks you a series of ques­
tions about the type of problem you are having, 
diagnoses the problem, and prescribes a cure. 

The primary functions of SUM Disk Clinic are to 
help you: 

• Repair a damaged volume. 

• Recover files from a damaged volume. 

• Recover files deleted from a volume. 

These primary functions are discussed at length 
in Recovery Procedures (at the front of this guide) 
and are not repeated in this chapter. However, 
the information in this chapter supplements the 
Recovery Procedures section and is essential for 
using the application. 

SUM Disk Clinic also has several secondary 
functions that help you: 

• Diagnose and repair a damaged volume 
without using the SUM II programs. 

• Make backup copies of your Volume 
Restore Records. 

• Create Volume Information Files. 

• Restore files that were split during 
recovery. 

• Remove Deleted File Records and Volume 
Restore Records from volumes. 

• Keep your system configuration 
information current. 

This chapter is devoted primarily to discussing 
these secondary functions. 
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Launching SUM Disk Clinic 

Please read this entire section before launching 
SUM Disk Clinic. 

1. Locate the SUM Disk Clinic icon on your 
desktop: 

2. Click the SUM Disk Clinic icon to select it 
and then choose Open from the File 
menu, or simply double-click the icon. 

Automatic Configuration 
Scan 
SUM Disk Clinic stores information about your 
system hardware configuration internal to the 
program. This makes it easy to select the vol­
umes you want to use while running the pro­
gram - even if a volume is crashed. 

~ -- .. ---
The first time you launch SUM Disk 
Clinic after installing it, the program 
automatically scans your system to 
collect and store the configuration 
information it needs. 

Normally, SUM Disk Clinic assumes that the 
configuration information it has available is 
current and correct and launches using this 
information. However, if your configuration has 
changed since the last time you ran SUM Disk 
Clinic, you can force the program to automati­
cally scan your system to collect new configura­
tion information during startup. 
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To force an automatic configuration scan during 
startup, press the Option key immediately after 
opening the program's icon. To be more specific, 
double-click the SUM Disk Clinic icon, or select 
it and choose Open from the File menu. Then, 
press and hold the Option key until you see the 
dialog shown here: 

Please confirm that you want 
to scan your system to create 
new configuration 
information. Note that the 
new information will 
completely replace what 
currently eHists. Clic/( 'OK' to 
confirm. 

OK (f Cancel l 

Do not press the Option key before opening the 
SUM Disk Clinic icon because this causes your 
Macintosh to switch startup volumes. 

The preceding dialog simply asks you to con­
firm that you do, in fact, want to perform an 
automatic configuration scan. 

& 
Before performing an automatic 

I configuration scan, please read the 
• description of the Automatic Config­

ure command later in this chapter. If 
you just want to add a single device to your con­
figuration or remove an existing one, read the 
description of the Manual Configure command. 
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SUM Disk Clinic Main Menu 

i" ~~.~:p 

I Cil:! ! i:,: 
! ~.:;:! ,.;~ '.> : 

l ... :":.·:.~::.~ .. ~.!.~:: .. 

SUM Oisl< Clinic 

Quick FiH 

Recouer Uolume 

Recouer Deleted Files !i~ 

!:~!t~<:H Quid: fix. R~¢¢~Ht 
:. ~~~nn t·~ .;~ .. ? ~ b: ·~~.1 d·?~··~: ·~,·t 

See 
Page 

5 

See 
Page 

21 

.......................... 

! ! 

?:.~~ .. ?:': 

. ........................ . 

See 
Page 

11 

Once SUM Disk Clinic starts, the Main Menu ap­
pears. The diagram above shows you the page 
to turn to in the Recovery Procedures section (at 
the beginning of this guide) for more informa­
tion on Quick Fix, Recover Volume, or Recover 
Deleted Files. 

The rest of this chapter discusses SUM Disk 
Clinic's secondary functions, which can be ac­
cessed via the Options and Launch menus. 
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SUM Disk Clinic Menus 

SUM Disk Clinic has four menus: File, Edit, 
Options, and Launch. Only the Options and 
Launch menus are pictured here. The File menu 
contains only the Quit command, which exits 
the program and returns you to your desktop. 
The commands in the Edit menu are available 
only when you are working with desk accesso­
ries. 

Options I 
Symptoms 6' Solutions... 3€S 
Backup Volume Restore Record... 3€B 
Create Volume Info File... ~I 

Restore Split File... 3€F 
Remoue Shield Files ... 

--- See page 4-5 

--- See page 4-6 
-- See page 4-7 

-- See page 4-8 
--- See page 4-9 

Manual Configure ... 
Automatic Configure 

3€M -- See page 4-11 

--- See page 4-14 

launch I 
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SUM TuneUp :3€O 
SUM BackUp :3€B 
SUM QuickCopy :3€D 
SUM Tools :3€T 

These commands launch the SUM II utility program 
indicated. Note that when you quit any launched 
utility, you have the option of returning to SUM Disk 
Clinic or to the desktop. 

SUM Encrypt :3€E 

Other ... 
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This command lets you launch any other application 
--------- available on your system. When you quit the launched 

application, the program automatically returns to the 
desktop. 



Symptoms & Solutions 
SUM Disk Clinic 

Symptoms (i' Solutions ... Things to try first 
I( yeour veolurn. di,ph'J' • S,!"'pleorn d •• crib.d b.low, click It,. Po;sibl. Solutio", buHon, 10 l •• rn 
.bo'JI slops It,ll rni'ltol fix It,. probl.rn w11houl 90""9 Ihrough It,. (ull r.cover'! proc ... 

SYtlPTOt1: SYt1PTOtl 
Th~ v~luri'lE' does not t-10UNT - that 1;3:1 its icon t-1ac rE'coQr'lizE's the volume and athmpts to 
doE'S not appe-ar on thE' de-sktop boot from ,t, but crashes} rtboots, dlsphlJs 

an E'rror messaQE', Clr doesn't mount thE' volume 

POSS ISLE ~,OLUT IONS' POSSIBLE SOLUTIONS: 

Rebuild Desktop Reset SCSI Control Panel 

Boot Different Uolume Reinstall Driller 

RecoLler using Application Boot Different Uolume 

Disk Information 

( Main I 

SUM Disk Clinic 

Choosing Symptoms & Solutions from the 
Options menu displays the first in a series of 
dialogs describing various symptoms that are 
common with crashed or damaged volumes. 
The first dialog you see (pictured above) is like 
an index. Find the SYMPTOM that most closely 
matches your problem, and then click a 
SOLUTION button to see the possible solution 
for solving that problem. 

Before making any major repairs to a damaged 
volume, it is good practice to back up your im­
portant data beforehand, if possible. If you 
attempt to use one or more of the solutions 
prescribed but are not successful in restoring 
your volume, your best alternative is to use 
SUM Disk Clinic and SUM Recover. 

Symptoms & Solutions is strictly for informa­
tional purposes. The solutions offered in the 
various dialogs describe steps that might restore 
a damaged volume to service without using 
SUM Disk Clinic. Of course, there is no guaran­
tee that the prescribed solutions will solve your 
problem, but you have nothing to lose but a 
little time by trying. In fact, you might save 
yourself considerable time if the prescribed 
solution does work. 
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Backup Volume Restore Record 

SUM Disk Clinic 

Copy Uolume Restore Record 

FROM ... 

c::::J I Hard Disk I ~ 
R~cord .ize : 60 KBy t •• 

[ Create Backup I 
~1 .. sag.s 

Se le-ct Source and Dtstinat;on 

( Main ) 

Backing up your Volume Restore Record or 
Records on a frequent and regular basis can save 
you a great deal of time if one of your volumes 
should crash. You can use the backup copy to 
quickly and easily restore the damaged volume 
to service. If you don't have a recent backup 
copy, the program can scan the damaged 
volume to locate the original Volume Restore 
Record. However, there is some element of risk 
involved with this because the record itself 
might be damaged. And scanning a volume in 
this manner can take considerable time. 

SUM Shield gives you the option to automati­
cally back up your Volume Restore Record or 
Records. (See Chapter 3, SUM Shield.) The 
Backup Volume Restore Record command lets 
you back up the Volume Restore Record or 
Records manually if you aren't using the auto­
matic procedures. 
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I 
Copy Uolume Restore Record 

TO ... 

• c::::J I Hard Disk I ~ 

I 
Fr.e spac. : 5616 KBy te. 

U.e the FROM pop-up menu to •• 1ect the 
volume ",her. the R .. toro Rocord you", ant to 
back up i. located. Use tho TO pop-up menu to 
select the volume on ",hich you", ant to store 
the backup copy of the Restore Record. DO NOT 
select the same volume in both menu •. 

After s.lecting tho vo1um.s, click Crute 
Backup. 

To manually back up a Volume Restore Record, 
do the following: 

1. Choose Backup Volume Restore Record 
from the Options menu. The window 
pictured above appears. 

2. Use the left pop-up menu to select the 
volume FROM which you want to back 
up the record. (If the Volume Restore 
Record is not installed on the volume you 
select, the message liN 0 Restore Record" 
appears just below the pop-up menu.) 

3. Use the right pop-up menu to select the 
volume TO which you want to copy the 
record. (If you want to select a floppy 
disk, insert it before displaying the pop-up 
menu.) 

4. Click Create Backup. 

If the volume you are copying TO already 
contains a backup record for the volume 
you are copying FROM, SUM Disk Clinic 
asks for confirmation before overwriting 
the existing record. 



At times the backup copy of the Volume Restore 
Record may not fit on one floppy disk. Backup 
Volume Restore Record automatically asks if 
you wish to split the record onto another floppy 
disk if the space is inadequate on the Destina­
tion volume. 

When SUM Disk Clinic determines that there is 
insufficient room to back up the Volume Restore 
Record, this message is displayed: "Insufficient 
room on Destination Volume. Do you want to 
split the file." 

To remove the message and continue, click OK. 
Select a new Destination volume. Once you have 
done that, the program displays the space 
needed to back up the Volume Restore Record. 
The program then prompts you to insert the 

SUM Disk Clinic 

new Destination volume and begins backing up 
the Volume Restore Record. 

The Volume Restore Record is usually stored on 
your hard disk, but you may choose to keep the 
record on a partition created with SUM Parti­
tion. If your Volume Restore Record is on a 
partition created with SUM Partition and you 
want to back up that record, the partition 
shouldn't be password protected. SUM Disk 
Clinic will not let you back up the Volume 
Restore Record from a password-protected 
partition. 

To get around this, remove the password protec­
tion temporarily in SUM Partition. Back up the 
Volume Restore Record, and then reinstate the 
password protection. 
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Create Volume Info File 
SUM Disk Clinic 

r;;_"'IJjL~ 1M '-' Select the Uolume for which you are creating a 
~I Uolume Information File WIF) ... 

~ I Hard Disk I 

Create UIF 

Holp ..................................................................................................................................................................................................................... . 

~td~.Wi~di)· ... 1 m:.tJ be- ~:::.~d ~o cre-3~1? a VolrJrflE> Informa~ion F11E> (VIF) for an.~ de-vicE' athche-d to I~OIJ" 
r1.:..:.mto.:.h. Tt'~ VIF m.:fkll?s 1t posslblE' for the- program to aeeE's::: .:.nd ..,forl< .... fith a d':''f1r:':> E'v~n if it 
~I'~S cr:Zh~d. S.E'lll?ct :h€' do?Vlc€' from ~he.pop-up rfl€'nu ind UIE'n clk~ C .... ~t. YIF. A fjl~ s.:'~·E' diakll~ 
.:8~PE'~~.:- ('.It" I~OIJ to n':lrne- ttl€' VIF and mdlcatE' .... /trl?'rE' IJOIJ war,t to storE' it. VIFs c·:.rt h.: ...... E' .UIIJ r.·:.rn€' 
yc.u hk!? and bl? st6re-d wtlE't"e-ve-r yOIJ wish 
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Volume Information Files (VIFs) are special files 
SUM Disk Clinic uses to determine certain char­
acteristics about a given type of volume. Because 
different volumes have different characteristics, 
SUM Disk Clinic must know what those charac­
teristics are to successfully communicate with 
the volume. VIFs provide this information. 

Normally, Macintosh applications can deter­
mine a volume's characteristics by getting the in­
formation they need directly from the volume. 
However, when a volume is damaged, the infor­
mation might not be available or reliable. For 
this reason, SUM Disk Clinic relies on VIFs to 
provide accurate and reliable information. 

Although you installed VIFs when 
you ran SUM Install, you should use 
this command to create a new VIF 
for every volume on your system 
immediately after the installation. 
This is necessary because volume 

characteristics change (such as when you create 
SCSI partitions on a volume) and such changes 
can negate or reduce the effectiveness of the 
VIFs you installed with SUM Install. If you 
reformat or repartition a volume, you should 
always create a new VIF for it. 
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To create a VIF, do the following: 

1. Choose Create Volume Info File from the 
Options menu. The window shown above 
appears. 

2. Use the pop-up menu to select the volume 
for which you want to create a VIF. 

3. Click Create VIF. 

4. SUM Disk Clinic collects the information 
it needs about the selected volume, and 
then asks you to give the VIF a name and 
indicate where you want to store it. These 
steps are accomplished using the standard 
Macintosh file save dialog. 

[1a -_ .. .. -
We recommend you store your VIFs 
(or at least copies of them) on a 
separate volume, such as a floppy 
disk. If a volume crashes, you still 

have access to the VIF you need to restore it. If 
the VIF is on the crashed volume, you will not 
be able to get to it, and you might not be able to 
create a new one. 
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Restore Split File 
SUM Disk Clinic 

Before attempting to 
restoro a Spllt file, 
you must place all of 
the 'pieces' AND the 
control file (id.ntified 
b'l the suffix .SPL 1) 
into the s.me folder, 
as ,.hown by the 
diagram on the right. 

If you have NOT 
cc,mpleted these 
pre-parations, rE-turn to 
the desktop and organize 
the file. asrequired. 
Otherwi.e, your file 
cannot be properly 
re.tored. 
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Sometimes it is necessary for SUM Recover to 
split a file across multiple volumes during recov­
ery. This occurs when the volume receiving the 
recovered file does not have adequate space 
available. For example, if you are recovering 
files to 800K floppy disks and a file you are 
recovering is 2 megabytes in size, SUM Recover 
must split the file across multiple floppies. 

The Restore Split File command gives you an 
easy way to "reassemble" the pieces of a split 
file, and thus, restore it to your repaired volume. 

Please read Splitting Recovered Files in Chapter 5, 
SUM Recover, before using this command. 

The Restore Split File window (shown above) 
provides detailed instructions. Here are some 
additional points to keep in mind: 

• Do not restore split files until after you have 
reinitialized or reformatted your damaged 
volume. 

If you HAVE completed 
preparations, click 
'Restore Filt...' and 
uso the •• l.ctor dialog 
to locate and s.leet tho 
.SPLT (control) file. 
After .electing this 
file, your ori9inalfile 
will then be re.tored. 

If you require further 
instructions, pleaseo refer 
to your SUM U •• r Guid •. 

Restore File... )) 

• Make certain you have every disk you need 
to restore the split file. If one or more of the 
"pieces" are missing, your file cannot be 
restored. 

• After restoring a split document file, open it 
using the parent (original) application to 
make sure it was restored satisfactorily. 
Once you are sure the file is completely 
intact and useable, you can remove the 
individual pieces of the split file from your 
volume and recycle the disks used to split 
the file. 

• After restoring a split application file, open 
it to make sure it runs normally. If it 
doesn't, check the file's Type and Creator 
codes to make sure they are correct. If they 
are, replace the file with a copy from your 
original disks. 
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Remove Shield Files 
SUM Disk Clinic 

Select a Uolume •.. 

~ ~ 
Fr •• Spac. : 211 73 KBy t.s 

Select Files(s) to remoue ... 

I3l Deleted File Record 
I3l Uolume Restore Record 

[ Remoue File(s) 

( Main I 

Removing the Deleted File Record or the Vol­
ume Restore Record from a volume is not 
something you will find necessary under normal 
circumstances. 

For example, you might want to remove the 
Deleted File Record if free space is extremely 
short on a volume. (However, remember that 
you can reduce the size of the Deleted File 
Record by specifying that it contain fewer 
entries. See Chapter 2, Getting Started, for further 
instructions.) 

You might want to remove the Volume Restore 
Record if your volume is short of free space. 
However, the value of this record is so signifi­
cant that you should consider removing other 
files instead. 
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I 

H.lp 

Us. tho pop-up monu to 
solect the volume from which 

[ Eject) you want to romovo oithor or 
both rocords. 

Click the appropriate check 
box or boxos to indica to 
which files you want to 
remove. 

Click Remoye File(s) and 
the file or files will then be 
removed. 

When you select a YO lume 
from the pop-up monu, the 
check boxes will be onab l.d 
Mo/ if that particular record 
is installed on tho YO lumo. 

To remove the Deleted File Record, the Volume 
Restore Record, or both from a volume, do the 
following: 

1. Choose Remove Shield Files from the 
Options menu. The window pictured 
above appears. 

2. Use the pop-up menu to select the volume 
from which you want to remove the 
record or records. The check boxes in the 
center of the window become available 
depending on which of the two records is 
installed on the volume you select. 

3. If you want to remove the Deleted File 
Record, click its associated check box to 
mark it with an X. 

4. If you want to remove the Volume Restore 
Record, click its check box to mark it with 
anX. 

5. Click Remove Files. 
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Manual Configure 

SUM DIsk Clinic 

@ Floppy Driues 0 Seriill Driues 

o SCSI Deuices 0 Uolume Pilrtltlons 

Sel.ct • Devic. Category by 
clicking its radio button. Tho pop-up 
menu then lists the devices 
currently in that cat.gory. 

Current Configuration for Selected Categor~ 

Scan Category scans for .11 
devices in the selected cate90r~ and 
rep laces tho current information. 

bill Ri ght BOOK I [ Eject 1 

Add lets ~ou add a devic. to the 
selected cate90r~ . 
Remoye deletes the current 

device (.hown in the pop-up menu) 
from the selected category. 

SCiln this Ciltegory 

As you learned earlier, SUM Disk Clinic main­
tains information internally about your Macin­
tosh system configuration - that is, information 
indicating what types of volumes are attached, 
where they are attached, the partitions that are 
available, and more. This configuration data 
determines what appears in some pop-up 
menus when you need to select a volume or par­
tition to work with. 

The first time you launch SUM Disk Clinic fol­
lowing installation, the program automatically 
scans your Macintosh to collect the configura­
tion information. Normally, you will not need to 
update the information unless your configura­
tion changes (such as adding or removing a 
volume), or you have to reinstall your copy of 
SUM Disk Clinic. 

If it becomes necessary to change your configu­
ration information, SUM Disk Clinic provides 
several different ways to do so. You'll learn 
about these methods in this section. (Also recall 
that you can force an automatic configuration 
scan when launching SUM Disk Clinic by 
holding down the Option key.) 

Say" Configuration pres.rves 
an~ changes you make - otherwise, 
changes apply only to the current 
session of SUM Disk Clinic. 

[ Cilncel Done 

If you display a pop-up menu while using SUM 
Disk Clinic and the volume you want to select is 
not listed, either the volume is not mounted, or 
the volume is not included in your configuration 
information. In the first case, all you have to do 
is mount the volume (for example, insert a 
floppy disk), and it appears in the menu. In the 
second case, you need to update your configura­
tion information using either the Manual 
Configure or Automatic Configure command. 
(See Volume Pop-Up Menus later in this chapter 
for important information about menu con­
tents.) 

e Do not choose Automatic Configure 
without first reading the command 
description that follows in this 
chapter. This is especially important if 
you have a crashed volume you are 
trying to recover. 

When you choose Manual Configure, the 
window pictured above appears. You use this 
window to modify your configuration informa­
tion as necessary, for example, to add a new 
volume. 
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Device Categories 
SUM Disk Clinic separates devices into four 
different categories: 

• Floppy Drives 

• SCSI Devices 

• Serial Drives 

• Volume Partitions 

When you click one of the Device Category radio 
buttons, the pop-up menu changes and shows 
the devices currently available in that category 
based on your configuration information. You 
can then use the buttons Scan Category, Add, 
and Remove to update the configuration 
information for the currently selected category. 

Scanning Categories 
The Scan Category button works similar to the 
Automatic Configure command except that it 
scans only for devices in the currently selected 
category. 

This function erases all current configuration 
information for the selected category and replaces 
it with new information. If you do not want this 
to happen, consider using the Add or Remove 
buttons instead. 

Adding Devices 
To add a particular device to the currently 
selected category, click the Add button. What 
occurs next depends on which category you 
have selected. 

4-12 

Symantec Utilities for Macintosh 

Floppy Drives 

The Add button is not available when you select 
the category Floppy Drives. You can only add 
floppy drives by scanning your system for the 
information. 

To add a floppy drive to your configuration, use 
the Scan Category button just described. 

SCSI Devices 

Clicking Add when SCSI Devices is the current 
category displays a dialog similar to this: 

1) 5el eet I'l 5C5 I Devi ee 

~ & ~ ~ 
c:::l - - - 5' c:::l c:::l 

0 1 2 3 4 6 7 

2) 5el eet I'l Pert it i on on the 5C5 I: 

OK l.on!!lnl' Cancel 

The top portion of this dialog shows the SCSI 
devices currently attached to your Macintosh 
and their respective drive numbers, 0 through 7. 
(Note that SCSI device number 7 is reserved for 
your Macintosh computer.) Click the icon that 
represents the device you want to add. 

After you select a device, SUM Disk Clinic lists 
the device partitions available on that device in 
the lower window. 

Device partitions are different from software 
partitions (like those created with SUM Parti­
tion). Device partitions are sometimes created by 
the device manufacturer, or you create them 
using software the manufacturer provides. Soft­
ware partitions are not listed in this window. 



If a device partition name appears in italics, it 
means the program is unable to completely 
identify the partition. If you select this partition, 
a Volume Information File is needed to access it, 
so the Load VIF button at the bottom of the win­
dow is activated. Click Load VIF, and select the 
VIF that applies to the SCSI device selected in 
the upper window. 

After selecting a device partition (and if neces­
sary, loading a VIF), click OK, and the device is 
added to your configuration. 

Serial Drives 

Clicking Add when Serial Drives is the current 
category displays a dialog similar to this: 

1) Select e Driver by clicking on the ICON. 

c:::TI ~ e C@ ~ 

0' 2' - I:J I:J I:J '7 1 3 4 5 6 

I:J I:J I:J I:J 

8 9 10 11 

Drive Volume Name 2) Select DrlV8 

r 
:r-it. 

OK Cancel) 

The top window shows the "Drivers" available 
on your system. Click the one that pertains to 
the Serial Drive you want to add to your con­
figuration. (Note that SCSI Devices are also 
listed here because SUM Disk Clinic has no way 
of making a distinction. So be sure you select a 
serial-type device driver.) 

Once you select a driver, the drive number 
(which is not necessarily the same as the Driver 
number above) and volume name appear in the 
bottom window. In most cases, only one entry is 
listed here. However, in some cases, you might 
see multiple entries. 

SUM Disk Clinic 

If a drive name appears in italics, it means the 
program is unable to completely identify the 
drive. If you select this drive, a Volume Informa­
tion File is needed to access it, so the Load VIF 
button at the bottom of the window is activated. 
Click Load VIF and select the VIF that applies to 
the driver selected in the upper window. 

After selecting a drive (and if necessary, loading 
a VIF), click OK, and the device is added to your 
configura tion. 

Volume Partitions 

Clicking Add when Volume Partitions is the 
current category displays a standard Macintosh 
file selector dialog. Use this dialog to select the 
Volume Partition (such as one created with SUM 
Partition) you want to add to your current 
configura tion. 

Removing Devices 
Clicking Remove deletes the device currently 
shown in the device pop-up menu. 

Never remove a device if that particu­
lar device is currently crashed. By 
doing so, you will jeopardize your 
chances of recovering your data from 
that volume. 

Saving Configuration Data 
Clicking Save Configuration permanently 
records any changes you have made. If you do 
not save your configuration in this manner, your 
changes are effective only until you quit the 
current SUM Disk Clinic session. 
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Automatic Configure 

Options 
Symptoms (( Solutions ... 3€S 
Backup Uolume Restore Record ... 3€B 
Create Uolume I nfo File ... 3€ I 
Res tore S p Ii t File... 3€ F 
Remoue Shield Files ... 

Manual Configure ... 

Automatic Configure performs a complete scan 
of your system to collect and store new configu­
ration information. Although it is a quick and 
convenient way to update your configuration 
information, there are times when you should 
not use this command. For example: 
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When you choose Automatic Configure, 
all of your current configuration informa­
tion is replaced with new information. The 
new information is based on whatever 
volumes SUM Disk Clinic finds available 
on your system at the time it performs its 
scan. 

If you have a crashed volume, SUM Disk 
Clinic can probably give you access to the 
volume to recover it because it is part of 
your current configuration information. If 
you do an Automatic Configure at this 
point, SUM Disk Clinic might not be able 
to recognize the volume because it is 
crashed. Consequently, when the new 
configuration information is collected, the 
crashed volume will not be included, and 
you will have no way to access it. 

The rule of thumb here is to never use Automatic 
Configure unless all volumes on your system 
are in a "healthy" state. To put it another way, if 
one or more of your volumes is damaged, use 
Manual Configure rather than Automatic 
Configure if you need to add a device to your 
configuration information. 

Any time you choose the Automatic Configure 
command, SUM Disk Clinic asks you to confirm 
that you do want to replace all current configu­
ration information with new data. Keep the 
above rule in mind before you confirm this 
action. 



Recovery Methods 

You have three different recovery methods 
available for recovering files from a crashed 
volume - Directory Scan, Volume Scan, and 
Floppy Recover. Although these methods are 
actually part of SUM Recover (discussed in 
Chapter 5) and not SUM Disk Clinic, they are 
described here because they are usually 
launched from SUM Disk Clinic. 

In most cases, when recovering files on a 
damaged volume, you launch SUM Disk Clinic. 
Once in SUM Disk Clinic, you pick the recovery 
method you want to use. After choosing the re­
covery method, SUM Disk Clinic launches SUM 
Recover for you, and you can then recover the 
files. 

The three recovery methods each use a different 
technique to locate files on a volume. You can 
use the various recovery methods in different 
combinations to recover files, but you should 
select the method that has the best chance of re­
covering the greatest number of files. Consider 
this example: 

Your hard disk has crashed, and you have 
launched SUM Disk Clinic in an effort to 
recover your files. You choose Directory 
Scan first for the Recovery Method. SUM 
Recover is automatically launched for 
you. Using Directory Scan, the program is 
able to locate 90% of your files that you 
then recover. 

You launch SUM Disk Clinic again, but 
this time you choose Volume Scan to try 
and recover the remaining files. Because 
SUM Disk Clinic is using a different 
recovery method, the program is able to 
locate the remaining files, not found in 
your first attempt with Directory Scan. 
This time you select the files located with 
Volume Scan and recover them. 

SUM Disk Clinic 

Between these two methods, you should 
be able to recover every file from any 
crashed disk - hard or floppy. Suppose 
you have a crashed floppy disk and the 
two previous recovery methods have not 
been completely successful. You can run 
SUM Disk Clinic again and choose Floppy 
Recover to locate any remaining files on 
your floppy disk. Then, recover those files. 
Do keep in mind that Floppy Recover can 
only recover files from 400K and 800K 
floppy disks and not high density disks. 

The recovery methods should be executed in a 
specific order. Notice that in this example, 
Directory Scan was used first, followed by 
Volume Scan when all the files were not success­
fully recovered with Directory Scan. If you are 
recovering files from a floppy disk, you would 
use Floppy Recover, but only after you have 
tried to recover files with Directory Scan and 
Volume Scan first. 

Before launching a second or third recovery 
attempt, consider the amount of time involved. 
The larger the volume's capacity, the more time 
required to search through it. Before you set off 
to search an 80 megabyte hard disk for a few 
missing files, you might find it more efficient 
simply to recreate them. 

Although you don't really need to know how 
each recovery method goes about locating files, 
the discussions that follow will help you decide 
which method to select in a given situation. 

Keep in mind that you can use different recov­
ery methods on the same volume to locate and 
recover the maximum number of files. (Floppy 
Recovery is only meant for floppy disks. You 
should use it after Directory Scan and Volume 
Scan proved unsuccessful.) 
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Directory Scan 
Directory Scan searches the 
volume's existing directory 
to locate whatever directory 
entries might still be avail­
able. When SUM Recover 
locates what appears to be a 
valid directory entry, it then 
attempts to locate the actual 

file associated with that entry - wherever it 
resides on the crashed volume. If the directory 
entry for the file appears to be valid and the 
actual file appears to be intact, SUM Recover 
believes it can recover the file successfully and 
makes it available in the SUM Recover File List 
window. 

Directory Scan is meant to recover files on a 
crashed volume and is ineffective for recovering 
deleted files that have no directory entry. A file's 
directory entry is destroyed when you trash the 
file; that is, when you throw a file in the Trash 
on the desktop and empty the Trash, it destroys 
the directory entry. 

A Directory Scan can be completed in a rela­
tively short amount of time (compared to a 
Volume Scan). Unless you are absolutely sure 
that a volume's directory is damaged beyond 
use, choose Directory Scan in your first attempt 
to locate and recover files. 

In most cases, Directory Scan should 
be the first Recovery Method you 
choose when attempting to locate 
and recover deleted files. 

Once the files are recovered and you return to 
your desktop, the recovered files are displayed 
on the desktop in the SUM Recovered File 
folders. Even though the file icons are displayed, 
this does not mean that the files were success­
fully recovered. To verify the recovery, open 
several of the files from their parent application. 
Only after you are sure that the files have been 
recovered should you reinitialize or reformat 
your hard disk and restore the files. 
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Volume Scan 

ElF) 

'-' 
Volume Scan uses two different 
methods to search for files. 
Both methods take place 
simultaneously. 

• The first method searches for special 
markers that indicate the beginning location 
of a file stored on disk. If the program finds 
this marker, it generally assumes that the 
file can be recovered successfully. 

• The other method uses something called 
Signatllres, which are special, unique codes 
that SUM Recover uses to recognize 
different types of files. Your original SUM 
Program Disk #1 contains a document 
named Packed Signatures where the 
signatures the program uses are stored. 
These signatures have been specially 
prepared by Symantec with the cooperation 
of various software developers and 
publishers. If you cannot find the 
Signatures you need in this file, contact 
Symantec Product Support. To view the 
Signatures file, use the command Show 
Signatures on the Options menu in SUM 
Recover. (Symantec updates the Packed 
Signatures on a periodic basis.) For SUM 
Recover to locate a particular type of file 
based on the file's Signature, the Packed 
Signatures document must be available. 
Assuming you used SUM Install to install 
the Signatures, the document should 
always be available. 

Volume Scan works on the same basic philoso­
phy as Directory Scan. If Volume Scan locates a 
file and determines that it is logically intact, it 
assumes that it can recover the file and lists the 
file in the File List window after the search 
process is finished. This is in contrast to Direc­
tory Scan where the files are displayed as the 
search process takes place. 



Floppy Recover 
N····.... Floppy Recover can only be used with 
~.~f, floppy disks. This recovery method is 

n a last resort method for recovering 
files on a floppy disk; that is, you 

should use Directory Scan first and then 
Volume Scan to recover files on your floppy 
disk. If those two methods are unsuccessful in 
recovering all the files from your floppy disk, 
then launch SUM Disk Clinic and use Floppy 
Recover to recover the files. 

You cannot use Floppy Recover to 
recover files on hard disks, volume 
partitions, or 1.4 megabyte floppy 
disks. 

Summary 
Because Directory Scan deals only with the 
volume directory, it can locate and list files much 
quicker than Volume Scan. However, if the vol­
ume's directory is damaged, the Directory Scan 
method might not be effective. In most cases to 
save time, you should use the Directory Scan 
method before using Volume Scan. 

When you are attempting to recover a hard disk 
that has been initialized by mistake, you are not 
given a choice of recovery methods. Volume 
Scan is used by default because the volume's 
directory is "wiped clean" when the hard disk is 
initialized. Thus, the Directory Scan method 
cannot operate on the directory. 

Many SUM users have reported that Volume 
Scan seems to be able to locate the greatest 
number of files on a damaged volume. How­
ever, the Volume Scan method is lengthy 
because the program must search the entire 
volume whereas Directory Scan searches only 
the directory. We recommend using Volume 
Scan only when your results with Directory Scan 
are not satisfactory. 

SUM Disk Clinic 

~ 
Because of the way Volume Scan and 

I ::-..:' Floppy Recover locate and recover 
files, certain information is not 
recovered at times. The most notable 

information that might be missing is the file 
name and its Type and Creator codes. 

If SUM Recover cannot recover a file's name, it 
shows the file creator's name (the name of the 
application used to create the file) and an 
incremented counter. For example, ExceiData01, 
ExceiData02, and so forth. 

If SUM Recover cannot recover a document file's 
Type and Creator codes, when you attempt to 
open the document your Macintosh alerts you 
that the application you are attempting to 
launch is busy or missing. You can insert the 
correct Type and Creator codes at the time you 
are recovering files using the SUM Recover Get 
Info command (see Chapter 5). You can also use 
SUM Tools for this purpose "after the fact" of 
recovering files and quitting SUM Recover. 
Appendix B contains a list of Type and Creator 
codes for this purpose. 

If an application file's Type and Creator codes 
are missing, a variety of problems can result­
the most notable of which is the application's 
inability to launch. You can insert the correct 
Type and Creator codes in the application files 
the same way as document files, as described in 
the preceding paragraph. 

Because of the way Volume Scan searches 
volumes, it cannot locate all fragments of a 
fragmented file. Thus, it is to your advantage to 
keep your files defragmented as much as 
possible. Using SUM TuneUp on a frequent and 
regular basis to defragment your files increases 
your chances of recovering files with Volume 
Scan. 
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Volume Pop-Up Menus 
Sometimes when you are selecting volumes 
from SUM Disk Clinic pop-up menus, you'll 
notice that the list of available volumes in two 
separate menus is different. This happens 
because one menu lists the devices available on 
your system, whereas the other lists the vol­
umes that are currently mounted. 

For example, you might display one pop-up 
menu that looks similar to this: 

HD 40 
DO 50 
SUM II 

V"'My Floppy 

Frl?l? Spacl? : 778 KBy tl?S 

( Eject) 

This menu lists the devices available on your 
system. SUM Disk Clinic constructs this menu 
using your current configuration information. 

You might display another pop-up menu in the 
same window that looks similar to this: 

Right BOOK 
Right 400K 

This menu lists your currently mounted vol­
umes. SUM Disk Clinic constructs this menu by 
scanning your computer to find the currently 
mounted volumes. 
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Why Menus Are Different 
Assume you have a crashed floppy disk that will 
not mount. You can insert the disk in a disk 
drive, but your Macintosh does not recognize it. 
As a result, SUM Disk Clinic has no way of 
knowing anything about the disk and cannot 
work with it. Consequently, you cannot select 
the disk from a pop-up menu, or by any other 
means, unless SUM Disk Clinic gives you a way 
of doing so. 

This is where your configuration information 
becomes so important. Although the Macintosh 
file system cannot tell SUM Disk Clinic you have 
inserted a floppy disk, the program does know 
that you have a floppy disk drive because your 
configuration information indicates this. Thus, 
you can point SUM Disk Clinic to the floppy disk 
drive where you have inserted the crashed disk, 
and the program will be able to access the 
volume. This is what makes it possible for SUM 
Disk Clinic to work with a crashed disk. 

When you use the other pop-up menu to select 
the volume on which you will store recovered 
files, you will be using a "healthy" volume that 
is able to mount. So SUM Disk Clinic builds this 
menu using information the Macintosh file 
system provides about your currently mounted 
volumes. 

Thus, the reason the pop-up menus are some­
times different is that one contains your configu­
ration information, and the others contains a list 
of your currently mounted volumes. 



SUM Recover, a utility program, performs the 
actual recovery of damaged volumes and 
deleted files. 

SUM Recover displays one of three different 
windows, depending on what you are attempt­
ing to do. For example, if you are attempting to 
recover a damaged volume using Quick Fix, 
SUM Recover shows you the SUM Quick Fix 
window; if you are attempting to restore a 
damaged volume on which the Shield Volume 
Restore Record is installed, SUM Recover shows 
you the SUM Volume Restore window; and if 
you are attempting to recover files (whether 
from a damaged volume or deleted files), SUM 
Recover shows you the SUM File Recover 
window. This chapter describes these three 
windows. 

SUM Recover 

launching SUM 
Recover 

Normally, you do not launch SUM Recover 
yourself. SUM Disk Clinic launches the program 
for you at the appropriate time and displays the 
window you need to accomplish what you are 
attempting to do. 

SUM Recover can be launched directly from the 
desktop. Launching it from the desktop, how­
ever, means that SUM Disk Clinic's recovery 
methods are unavailable. 

When you launch the program in this way, this 
message is displayed: Shield Deleted File Re­
covery is active. You must use SUM Disk 
Clinic to select a recovery method. If you want 
to use Quick Fix, Recover Volume, or Recover 
Deleted Files, you must use SUM Disk Clinic. 
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SUM Recover Windows 
SUM File Recouer 

~ SOURCEVol'Jm.: List:~ By: I Name I 
I Right BOOK I Name Siz~ 

I 

+ :kt 
~ DESTINATION Volum.: 

[Right BOOK I [ Eject I 
1.,6~O Free KBy tes 

( Search ) ( fi(J(OIJN ) 

0% I 1100% 

MessagE's: 

:0 

I I~ems in list Selected: Tobl B'~tes S.lected 

~ E::::::J 10K 

SUM Uolume Restore 

Volume to Rf'cover 

I Hard Disk 

@ Use Info from BRCKUP Uolume 
Usethisoptiononlyifyouhavta 1~'Mf 
b.ckup copy of th. SUM Shi.ld Volum. 
Restort Record on a ,)~"JIh-volum •. W'hE"n 
you click RecoYer Volume, ~ file selector 
ipptarssoyoucinlocattandulectthe 
backup copy you want to ust for this 
procedure 

o Use Info from CRRSHED Uolume 
Use this option if you do not have a backup 
copy of the SUM Shield Volum. Rutor. 
Rfcord,or ifth. copy you do have;s not 
r~Mt. WhlPn you click Recover Volume, 
thtprogram btqinssCinningth.volumtto 
locahl thE' ncord. This c.m take consider.ble 
time. 

Recouer Uolume 

I 

O%[I========================================::JIIOO% 

SUM Quick FIH 

~ Selected Uolume: c.:1 H.:..:II:..:..r::.d..::D.:..:isc.:.:k'--____________ -' 

Check Uolume 
H.lp .......................................................... ······· .... · ................ ··1 

Click Chl'ck Yoluml' to examine your 
seole-cted volume-for the presenc:eofany 
errors that Quick Fix can repair. Watch 
the- 'Messages' window for a report of 
th.txamination. 

If Quick Fix does not report any errors, 
choose SUM Disk Clinic from the Fill' 
menu to txit. 

If Quick Fix does detect specific types of 
errors, they appear in the 'Messages' 
window and are also reported in a special 
dialog. In this case, the dialog explains the 
steps you should follow from that point. 

Choost Hl'lp from the- Fill" menu for 
more-information about Quick Fix. 
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SUM File Recover Window 

See page 5-3 (opposite). 

Recovering files with or without SUM Shield installed 
or if you select Recover Volume and SUM Shield is 
not installed. 

SUM Volume Restore Window 

See page 5-9. 

Select Recover Volume and SUM Shield is installed. 

SUM Quick Fix Window 

See page 5-13. 

Select Quick Fix to repair a damaged volume. 



SUM Recover 

SUM File Recover Window 
SUM File Recouer 

D. SOUR. CE Volurn. : 

IIiI I Right aOOK 

+ 
DESTINATION Volum.: 

GSI I Hard Disk I ~ 
18170 Fr •• K8IJI •• 

Search ne( DON 

list: I Files 

Arkanoid 

Desktc'p 

frae togr·"ph 

Helpl.R~rc 

He Ip2. Rsrc 

He I pJ. Rsrc 

He Ip4. R~rc 

He Ip5 .Rsrc 

He Ip5. Rsrc 

By: I Name I 
Siz. 

307 K 

5 K 

19 K 

9 K 

11 K 

1 Ie 

Q = 

File List Window 

0% 1'--______ --'1100% LAZI i fe2.0u 

12 K 

11 K 

10 K 

19 K 

7 K 

12 K 

Any time you attempt to recover files from a 
volume (whether the volume is damaged or you 
are recovering deleted files), SUM Recover 
displays the window like the one above. 

SOURCE Volume 
This field always shows the name of the volume 
FROM which you are trying to recover files. 

You selected the SOURCE Volume at a previous 
window while running SUM Disk Clinic. Nor­
mally, you can't select a different SOURCE 
Volume from this window (except when you are 
recovering deleted files from a volume on which 
the Deleted File Record is installed). If you want 
to use a different volume, you must return to the 
SUM Disk Clinic Main Menu and repeat the 
steps. 

& 
If the SOURCE Volume is a software 

I partition, you must unmount the par-
• tition before recovering files because 

sometimes the partition may be 
damaged during the recovery process. (See 
Chapter 8 for more about partitions.) 

11"s ter . Rsrc 

O.,n i s 3 D" t" F i Ie .0 
~i~ 1 K 

Ps i onChe,;,;. R.::rc 20 K 

DESTINATION Volume 
This pop-up menu displays the name of the 
volume on which recovered files are stored as 
they are recovered. 

You selected the DESTINATION Volume from a 
previous window while running SUM Disk 
Clinic. You can select a different DESTINATION 
Volume now by choosing the one you want 
from the pop-up menu. 

If you are recovering files from a 
volume where the Deleted File 
Record or the Volume Restore 
Record are NOT installed, you 
should never select the same 

volume for your source and destination. If you 
do, there is a good chance of overwriting files, 
and thereby making any further attempts to 
recover the files impossible. 
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Search Button 
Clicking Search (~-S) initiates a search of the 
SOURCE Volume to locate whatever files might 
be recoverable. 

If you are attempting to recover files from a 
volume on which the Deleted File Record IS 
installed, the Search button is disabled when the 
SUM File Recover window appears. In this case, 
the File List window already lists the names of 
recoverable files on the SOURCE Volume, and 
therefore, a search of the volume is unnecessary. 

While the search is taking place, the progress bar 
fills in gradually to indicate what percentage of 
the SOURCE Volume has been scanned. Also, 
the Search button changes to Stop, and you can 
cancel the search at any time by clicking Stop. 

e lf you cancel a search by clicking 
Stop, all entries in the File List .. 
window are lost. (The files them­
selves are not affected.) Without the 
File List, you cannot recover files. 

Therefore, even if you should see the name of 
the file or files you want to recover listed in the 
File List window, do not cancel the search at that 
point and assume that you will be able to 
recover the file or files. To put it another way, if 
you want to recover any files, you must allow 
the Search process to continue all the way to the 
end. 

At the conclusion of the search, the following 
things occur: 

• The names of those files SUM Recover was 
able to locate appear in the File List 
window. 

• The number of files SUM Recover was able 
to locate is shown under Items in List. 
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Search Methods 

When you click the Search button and SUM 
Recover begins its scan of the SOURCE Volume, 
it uses the Recovery Method you selected in a 
previous SUM Disk Clinic window, either 
Directory Scan, Volume Scan, or Floppy 
Recover. 

You'll find detailed discussions of the Recovery 
Methods in Chapter 4, SUM Disk Clinic. It is 
important to point out here, once again, that 
each Recovery Method uses a slightly different 
technique for locating files on the SOURCE 
Volume. Thus, one Recovery Method might be 
able to locate and help you recover files that 
another could not. Fortunately, you can use the 
different Recovery Methods in any combination 
on the same SOURCE Volume (with the excep­
tion of Floppy Recover, which can be used only 
with floppy disks and after the other two 
methods were unsuccessful). 

For example, assume your hard disk is crashed, 
and the Shield Volume Restore Record is NOT 
installed. You launch SUM Disk Clinic and 
choose the Directory Scan Recovery Method. 
Once the program scans the directory and dis­
plays the items in the File List window, you can 
recover your files. After this, you determine that 
all your files were not recovered. You'll need to 
run the Volume Scan to try and recover there­
maining files. But before you do that, print a list 
of the files in the File List window. To do this, 
select Print List from the File menu. You'll need 
this list for reference after the Volume Scan. 

Once the list is printed, you'll launch SUM Disk 
Clinic again, but this time choose Volume Scan. 
When the File List appears following this 
search, it contains the missing files, as well as 
many of the same ones listed following the 
original search. 



Using the list you printed, determine which files 
still need to be recovered. At this point, select 
and recover those files that were missing from 
the original search and bypass those you already 
recovered. 

The Directory Scan and Volume Scan methods 
can take considerable time to complete on high­
capacity volumes. However, keep in mind that 
Directory Scan is mIlch faster than Volume Scan. 
You must decide whether or not any missing 
files are important enough to warrant the 
additional time. 

"List" Pop-Up Menu 
The List pop-up menu lets you control whether 
files or folders are listed in the File List win­
dow. Make your selection by displaying the 
pop-up menu and selecting either Files or 
Folders. 

"By" Pop-Up Menu 
The By pop-up menu lets you control the logical 
order of the items listed in the File List window. 

By: V"'Name 
Date 
Type 
Size 

SUM Recover 

You can list items by 

• Name - alphabetical listing by file name. 

• Date - the date the file was created or last 
modified, in ascending chronological order. 

• Type - alphabetical listing based on each 
file's type code (for example, applications 
normally have a file type code APPL, 
Control Panel devices have the code CDEV, 
and so forth). 

• Size - a listing based on each file's size in 
kilobytes. 

File List Window 
This window lists the files (or folders) that SUM 
Recover was able to locate on the SOURCE Vol­
ume during the search. Items in List at the 
bottom of the window displays the total number 
of items in the window. The name and size of 
each item is next to the item in the list. 

Selecting Items 

The File List window lets you select the items 
(files or folders) you want to recover from the 
Source volume. 

To select a single item in the File List 
window, click on it. 

To select multiple items, use the Shift-click 
method to select them. You can use this 
method to select noncontinuous items in 
the list. 

To select all items in the list, choose Select 
All from the Edit menu. 

To select files based on the date and time 
they were last modified, choose Select 
Modified from the Edit menu. 
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When you select items in the File List window, 
the total number of items Selected and the Total 
Bytes Selected are shown near the bottom of the 
window. The Total Bytes Selected figure can be 
useful by comparing it to the Free KBytes figure 
shown just below the DESTINATION Volume 
pop-up menu. This tells you immediately 
whether or not you have sufficient room on the 
DESTINATION Volume to store the items you 
have selected for recovery. 

At times items in the File List window appear in 
italics (before attempting to recover). SUM Re­
cover uses the italics to designate an unrecover­
able file. For example, when a portion of a file is 
overwritten, the entire file becomes unrecover­
able. 

If you want additional information about any 
item selected in the File List window, use the 
Get Info command in the File menu. A com­
plete description of Get Info appears later in 
this chapter. 

Recover Button 
The Recover button is enabled when you select 
one or more items in the File List window. 

After selecting the item or items you want to 
recover, click the Recover button. SUM Recover 
recovers the item from the SOURCE Volume 
and places it on the DESTINATION Volume. 

[EJ -_ .. 
---

If you optimized your SOURCE 
Volume using SUM TuneUp, you 
cannot recover the files deleted before 
the optimization from that volume. 

Because the files are moved to different locations 
during the optimization, the Deleted File Record 
loses track of their locations. 

Notice that once an item is recovered it is 
deselected in the File List. The item name 
appears in italics in the File List window if the 
Recover Deleted File Record IS Installed or if 
you selected Recover Deleted Files. To 
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determine whether or not the recovery was 
successful, check the Messages area at the 
bottom of the window. 

In rare cases, a file may appear recovered and 
actually isn't. For example, if you deleted a file 
with the File menu Delete command in 
Microsoft Word, SUM Recover can't recover the 
file. Although the file appears recovered in the 
File List window, Word will not open it. 

About Recovered Files 

During the process of recovering files, SUM 
Recover creates one or more folders on your 
DESTINATION Volume for storing the 
recovered files. Each folder is named SUM 
Recovered Files and is preceded by a single 
character and a period, such as A., B., C., and so 
forth (which is incremented with each new 
folder) . For example, the first folder created on 
your DESTINATION Volume is named: 

A .SUt1 RE'covE'rE'd FilE'S 

If a second folder is created, it is named "BSUM 
Recovered Files," and so on as necessary. 

When you open a folder, you will find your 
recovered folders and files inside. 

During the recovery process, SUM Recover may 
encounter files with duplicate names, such as 
Read Me files. When the program encounters a 
duplicate file name, the program stops and 
displays the message "Duplicate file error." If 
you wish to recover the duplicate file, you must 
reselect the DESTINATION Volume and click 
Recover to continue. SUM Recover starts a new 
recovery folder on a different DESTINATION 
Volume and continues the recovery process. If 
you like, you may return to the original 
DESTINATION Volume once the duplicate file 
is recovered. If you return to the original 



DESTINATION Volume, a new recovery folder 
is started. 

If you used the Volume Scan or Floppy Recover 
Method to recover files, you might not be able to 
open the files directly from the desktop at this 
point. For example, if you attempt to launch an 
application by opening its icon, an alert that the 
application is busy or missing may appear. This 
results from the fact that the file's Type and 
Creator codes are missing or incorrect because 
the codes can't normally be recovered with 
either method. 

The Get Info command (described later) lets 
you reinsert the Type and Creator codes while 
you are working with SUM Recover. If you are 
working at the desktop, you can correct this 
problem by opening the parent application, 
opening the file, and then saving the file from 
within the application. This reassigns the correct 
Type and Creator codes to the file. Yet another 
way to insert the Type and Creator codes is to 
use SUM Tools. Appendix B contains a list of 
common Type and Creator codes to help you in 
these situations. 

Splitting Files for Recovery 

Sometimes it is necessary for SUM Recover to 
split a file into two or more pieces during recov­
ery. This occurs when there is not enough space 
on the DESTINATION Volume to store the 
entire file. For example, if your DESTINATION 
Volume is an 800K floppy disk and you are at­
tempting to recover a lOOOK file from a hard 
disk, the file has to be split. 

When splitting a file, SUM Recover requires a 
minimum of two DESTINATION Volumes. Each 
volume contains a separate piece of the file (for 
the technically minded, the file's resource and 
data forks are split between the two volumes). A 
special Control Record that is later used to 
restore the pieces back into a single file is also 
placed on one of the volumes. 

SUM Recover 

When SUM Recover determines that it must 
split a file, it informs you of this by displaying a 
dialog similar to this: 

Note ... 
Insufficient room on the 
Destination uolume for the file ... 

OptimlllFile 79 K 

To store the file on a different 
Destinlltion uolume click ... 

'Select New Destination' 
~ otherwise, to split the file click ... 
~ 'Split File' 

([ Select New Destination JJ 

Split File 

This dialog gives you the option of temporarily 
selecting a different DESTINATION Volume to 
use, and thus, possibly avoid splitting the file. 
For example, if you have a second, healthy hard 
disk available on your system, you might want 
to recover this particular file to that volume 
rather than to floppy disks. To do so, click Select 
Different Volume, and the program prompts 
you to select the volume you want to use to 
recover this particular file. After recovering this 
file, the program automatically reverts back to 
your original DESTINATION Volume. 

If you don't have an alternate DESTINATION 
Volume available or if you don't mind splitting 
the file, click Split File in the preceding dialog. 
SUM Recover prompts you to insert each new 
DESTINATION Volume when needed to split 
the file. 

While it isn't necessary to keep the split file 
volumes in any particular order, it is essential 
that you have all of them when it comes time to 
restore the split file. If any of the file pieces are 
missing, you will not be able to restore the file. 
If it is necessary to split any of your files, be sure 
to keep these volumes separate from any others. 

5-7 



Chapter 5 

Restoring a split file is a relatively simple 
process. See the description of the Restore Split 
File command in Chapter 4, SUM Disk Clinic, for 
instructions. 

Summary 
The SUM File Recover window appears any 
time you need to recover files from a volume. 
Thus, the window appears in these situations: 

• You are recovering files deleted from a 
volume where the Deleted File Record is 
NOT installed. 

• You are recovering files deleted from a 
volume where the Deleted File Record IS 
installed. 

• You are recovering files from a crashed 
volume where the Volume Restore Record 
is NOT installed. 
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SUM Recover 

SUM Volume Restore Window 
SUM Uolume Restore 

Volum~ to R.cov~r 

I Herd Dlsk 

@ Use Info from BACKUP Uolume 
Us. this option only if you hay. a I~'""I 
backup copy of the SUM Shi.ld Vo lum. 
Rutor. Record on a '''PJI~''''volum •. '«hen 
you click Recoyer Yolume, a file selector 
appears so you can locat. Gnd s.l.ct tho 
backup copy y ou want to use for this 
procedure. 

o Use Info from CRASHED UDlume 
u .. this option if you do not havt • backup 
copy of the SUM Shield Vo lum. Restore 
Record, or if the copy you do hay. is not 
I~·""t '«hen you click RecoY"r Yolume, 
the proQram beQins scanninQ the volume to 
locate the record. This can take considerable 
tim •. 

RetoLler Uolume 

O%~I __________________________________ ~ll00% 

The SUM Volume Restore window (pictured 
above) appears only when you are attempting to 
restore a crashed volume where the SUM Shield 
Volume Restore Record IS installed. 

The Volume to Recover area shows the name of 
the crashed volume you selected in a previous 
window. You cannot select a different volume at 
this point. If you selected the wrong volume, 
you must return to the SUM Disk Clinic Main 
Menu and go through the procedure again. 

The SUM Volume Restore window provides two 
options: Use Info from BACKUP Volume and 
Use Info from CRASHED Volume. You must 
select one or the other before proceeding. (Please 
be sure you have read the section Volume Restore 
Record in Chapter 3 before continuing; other­
wise, you might find the following discussions 
difficult to follow.) 

Use Info from BACKUP 
Volume 
When practical, this is the option you should 
select in the SUM Volume Restore window 
because it makes it possible to restore the 
damaged volume in the shortest amount of time. 

If you select this option and then click Recover 
Volume, the program asks you to specify the 
volume on which the backup copy of the 
Volume Restore Record is located. If the backup 
copy is on a floppy disk, you can insert the disk 
at the time you are prompted. 

SUM Recover reads the backup copy and 
compares its name to the name of the volume 
you selected (the one you are attempting to 
restore). If the volume names do not match, 
SUM Recover gives you the option to proceed 
anyway, or to cancel the procedure, so you can 
locate the correct backup copy of the record. 
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Next, SUM Recover shows you the date that the 
backup copy was created and gives you three 
options for how to proceed. 

..... The Uolume Restore Record you haue selected was updated on: 

U I mm/dd/yy - hh:mm:ss I 
ThisproC'E'dureo mightdamagf' the curreont 
direoctory on your volumt bli>CiUSfdirtctory 
structurumustbtchang.d.'Wfreocommend 
you rE-cover your MOST IMPORTANT filu 
from theo volume beofortprocftding. 

Itis.alsoimportinttortCoYE'r'W"orkdont 
bE-tween the time the- VolumE' Rutort Rtcord 
wiS updated and tht time your volumt crashtd. 
ReocoYf'r thut filIi'S BEFORE rtstorin? th. 
vorumt,or thty couldbtlost,ptrmantntlyl 

IfyoU'W'il"lt to select.ll difftrtnt Volum9 
Reostor. Record to us. for this procfdurt, 
click 'Cancel' to nturn to the SUM Volume 
RiE'storewindow. 

If you want to rtcoveor imporhnt files or thou 
you worktd on AFTER the Volumt Restor. 
Rtcord was upd.a~.d, click 'Rtcovtr F;lts'. This 
launches tht Rtcover Volumt procedure, Which 
you can use- to rtcovtr your filts. 

If you havt ALREADY rfocoverfd all MctSury 
filtsandyouartrtad'Jtoprocudwithth. 
restoration of your volumt, click 'Rutort 
Volumt', 

Your User Guid. conhins mort information about 
the- proce-duru de-scrib.dheort. St. 
'Synchronizinljl Your Volume<' (Chaphr 3) and 
'Synchroniztd Re-covtry' (Chaptfr 4) for mort 
de hils 

[ Recouer Files [ Restore Uolume 1 Cancel 

If this is not the Volume Restore Record you 
want to use, click Cancel. This returns you to the 
SUM Volume Restore window, and you can 
repeat the steps to select a different record. 

If the date and time of the Volume Restore 
Record are not properly synchronized to the 
point at which your volume crashed, click 
Recover Files and refer to Synchronized Recovery 
la ter in this section. 

If you are ready to proceed with the restoration 
of your volume using this Volume Restore 
Record, click Restore Volume. 
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Use Info from CRASHED 
Volume 
When you select this option, SUM Recover must 
scan your crashed volume to find the Volume 
Restore Record. It can then use the record to 
restore the volume. 

Scanning a volume to locate the Volume Restore 
Record can take considerable time. And al­
though rare, it is possible that the record was 
damaged during the volume crash and cannot 
be used. Therefore, it is preferable to keep a 
backup copy of the Volume Restore Record and 
use that to restore your volume. 

If you must scan the crashed volume for the 
Volume Restore Record, click Restore Volume. 
SUM Recover immediately begins scanning the 
volume for the Volume Restore Record. Once 
the record is found, the preceding dialog 
appears, and you can proceed as explained in 
that section. 

It is preferable to scan the crashed volume for a 
backup copy of the Volume Restore Record if 
you discover that your backup copy is outdated, 
and you know that the record on your crashed 
volume is more current. 

Of course, the best way to restore your volume 
completely is to use the most current copy of the 
Volume Restore Record. If the record is out­
dated, you can recover the files since the last 
backup copy of the Volume Restore Record 
using the method described in the next section, 
Synchronized Recovery. 



Synchronized Recovery 
In Chapter 3, SUM Shield, you learned that you 
run the risk of losing some of your work if your 
Volume Restore Record is not properly synchro­
nized to the point at which the crash occurred. 
This section explains how to avoid this potential 
loss of data. 

The risk here is that if you restore the volume 
using a Volume Restore Record (or a backup 
copy), the volume directory is restored as it was 
as of the last snapshot update. The current 
volume directory is overwritten, and there is 
very little, if any, chance of recovering the work 
you did after the snapshot was taken. 

The solution is to recover the files that are at risk 
before restoring the volume with the Volume 
Restore Record. The following steps explain in 
detail how to accomplish this. 

1. Launch SUM Disk Clinic. 

2. Choose Recover Volume from the Main 
Menu. 

3. When asked whether or not the Shield 
Volume Restore Record is installed on the 
volume you want to recover, click Vol­
ume Restore Record is NOT installed. 

Even though the record is actually in­
stalled on the volume, be sure you make 
this choice. 

4. Select the volume you want to recover. 

5. When prompted to select a Recovery 
Method, click Directory Scan. 

6. SUM Disk Clinic launches SUM Recover 
automatically. Use the SUM File Recover 
window to locate and recover those files 
that were created or modified after the last 
time the Volume Restore Record was 
updated. 

SUM Recover 

SUM Recover gives you some help determining 
which files you should recover. 

• After scanning the crashed volume, locate 
and select the Volume Restore Record in the 
File List. 

• Use the Get Info command to see when the 
Volume Restore Record was last modified. 

(If the Volume Restore Record does not 
appear in the File List, you have to rely on 
your memory to recall when the Volume 
Restore Record was last updated.) 

• Recover any and all files created or 
modified after the Volume Restore Record 
was modified. (You can use the Select 
Modified command in the Edit menu to 
automatically select all files created or 
modified after the Volume Restore Record 
was updated.) 

Continuing with the recovery. 

7. Choose SUM Disk Clinic from the File 
menu to return to the Main Menu. 

S. Choose Recover Volume once again. 

9. This time, click Volume Restore Record 
IS installed when questioned. 

10. Again SUM Disk Clinic launches SUM 
Recover automatically, but this time you 
see the SUM Volume Restore window. 
Use the window to restore your volume 
using the instructions earlier in this 
section. 
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At this point, your damaged volume should be 
restored to the way it was at the time the last 
snapshot update was taken. You should also 
have a stack of floppy disks (or some other 
media) containing all of the work you did 
between the last snapshot update and the 
moment of the crash (those recovered in steps 1 
through 6). To restore your volume to the way it 
was at the time of the crash, do the following: 

11. Choose Quit from the File menu to return 
to your desktop. 

12. When your desktop appears, the volume 
you just restored is no longer mounted­
that is, its icon is not present, which is 
normal. To remount the volume, restart 
your Macintosh. 
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13. Now copy the recovered files back to the 
original volume. Use the standard method 
of dragging each file's icon to the restored 
volume's icon. 

Remember, your recovered files are 
located in one or more folders, like the one 
shown below, that SUM Recover creates 
on your DESTINATION Volume or 
Volumes. (See About Recovered Files earlier 
in this chapter for more information. ) 

A .SUM Rt?oovt?rt?d Filt?s 

Your volume is now restored and ready to use. 



SUM Recover 

SUM Quick Fix Window 
SUM Quick FiH 

~ Selected Uolume: I Hard Disk 

[ Check Uolume 1 ( H(Jpdil'llolum(J 1 
Curr~nt Activity: 

I 
Mtssagts: 

I 

The SUM Quick Fix window appears, similar to 
the one pictured above, when you use the Quick 
Fix procedure to repair a damaged volume. 

Quick Fix looks for specific types of errors that 
are common with damaged volumes. If these 
specific types of errors are found, Quick Fix can 
normally repair them. The advantage of the 
Quick Fix procedure is that you can often repair 
a damaged volume and restore it to service 
quickly without having to recover all of your 
files or reinitialize the volume. The disadvantage 
is that Quick Fix repairs only certain types of 
errors, and unless your volume is damaged in 
one of these ways, Quick Fix cannot make the 
repairs. 

In many cases, when Quick Fix is able to repair a 
volume, it must do so by altering the volume's 
existing directory structure. So to protect your 
important files, you should always recover them 
from the volume before allowing Quick Fix to 
make any repairs. The Quick Fix procedure is 
designed with this caveat in mind. 

I 

~ 

I 
H~lp 

Click Check Yo lume to ~xamin~ your 
stltcttd volum~ for th~ prtstnct of any 
trrors that Quick Fix can repair. Watch 
th~ 'M~ssagts' window for a rtport of 
tht txamination. 

If Quick Fix dots not r~port any ~rrors, 
choost SUM Disk Clinic from th~ File 
mtnu to ~xit. 

If Quick Fix do~s d~ttct sp~cific typtS of 
trrors, th~y apptar in th~ 'Messag~s' 
window and ar~ also report~d in a spocial 
dialog. In this cas~, tho dialog oxplains tho 
st~ps you should follow from that point. 
Choos~ Help from th~ File m~nu for 

moro information about Quick Fix. 

For a complete and detailed description of the 
Quick Fix procedure, please refer to the Recovery 
Procedures section at the beginning of this User 
Guide. This section does not reiterate the entire 
procedure. 

Selected Volume 
The volume you selected to Quick Fix in a 
previous window is shown near the top of the 
SUM Quick Fix window. You cannot select a 
different volume at this point. If you want to 
select a different volume, choose SUM Disk 
Clinic from the File menu to return to the Main 
Menu and then go through the procedure again. 
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Check Volume 
Click the Check Volume button. SUM Recover 
begins examining the volume to determine 
whether or not it can be repaired using the 
Quick Fix method unless you are examining a 
floppy disk. 

If you are examining a floppy disk, SUM Re­
cover asks you if the disk is in the drive. If you 
wish to examine the disk currently in the floppy 
drive, click OK. If the disk is not inserted, click 
Cancel and either insert the disk or manually 
eject the disk in the drive and insert another one. 
After inserting the disk, click Check Volume 
and then click OK. 

During the check of the volume, the Current 
Activity area keeps you posted on exactly what 
is happening. In addition, various messages 
appear in the Messages area to let you know the 
results of the volume check. 

If Quick Fix does not detect any errors on the 
volume, the program displays the items it 
checked in the Messages area. The Repair 
Volume button remains disabled. This does not 
mean, however, the volume is error-free, it 
simply means Quick Fix did not find errors that 
it can repair. If the volume is, in fact, giving you 
problems, your best alternative at this point is to 
return to the SUM Disk Clinic Main Menu and 
use the Recover Volume procedure to recover 
your files. 

IF SUM Shield is installed or Quick Fix detects 
errors it can fix, Quick Fix displays a dialog 
similar to this: 
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~0 Errors haue been detected on this 
Y L'olume in the are.s listed below: 

YOIJ¢lIn!E'lE'chvtl'.1~n..blE'.nddluble,.,tpn-stoinll·rror 
c.tE"~':W'.l by c-hc-Hng '~E'P-llir Ophor,s', f'IU:llE' do root IJSt thIS 
fufur.ur.lusY(luknow' !pE'clflClIlly wtI1tyou,ar.domg 

(ontinue 

I Rep.ir Options ... ) 
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If QuickFix detects errors but does not think it 
can correct them, it asks if SUM Shield is in­
stalled. A yes response displays the dialog you 
just saw. If you click No, QuickFix may be able 
to repair your volume, and therefore, the Repair 
Options button is enabled. 

Notice that the dialog below states that if you 
consider yourself an advanced user, you can 
selectively enable and disable repairs to the 
listed errors by clicking Repair Options. Click­
ing this button displays the following dialog: 

YO'Jr volume conhins the errors ir.dk.ated b.~ an .>~. in the 
check br.ox or boxes below. Click OK if YO'J want Quick Fix 
to attempt to repair these errors. YO'J car. disable repair 
of ar. indicated error b.~ c liddng to remove the 'X' in its 
check box b .. ti>l ... clicking OK. 

o SCS I Mapping o Dire(:tory 

o Uolume Info Blo(:1c o Files 

Note: If your '/olume is fundiorring nonn.all.~, we recommend 
you DO NOT attempt these rep.~irs beca'Jse thel~ are- probab l'~ 
root r.ecessar'J. If ye.u decide to go ah€'."d "lith thE' repairs, 
click Cancel and ther. use the Recoyer Volume function 
from the Disk Clinic t1."in Men'J to recover I~ olJr t'10ST 
It1PORT ANT files beforehand or I~ ou could lose these files. 

OK Can(:el 

We recommend that you do not select options 
other than those already marked in this dialog 
unless you fully understand what you are doing 
and why. 

Repair Volume 
When you click Continue in the dialog shown in 
the opposite column, you return to the SUM 
Quick Fix window and the Repair Volume 
button is active. 

Click Repair Volume to initiate repairs. 



SUM Recover Menus 

Get Info ... ~I 

Page Setup ... 
Print list... ~P 

SUM Disk: Clinic ~D 
Transfer... ~T 

Help ... ~H 

Quit 

.IJIII[lln, .. 

Show Summary... 3€S 

Find File ... 3€F 

Show Signatures ... 

~ ......... Pass 1 
............................................................................. Pass 2 

Double Click Recouer Pass 3 

rut 
fnplJ 
Pns10 
fknr 

Select All 3€A 
Select Modified ... 
Clear File List 

../Normal 
Aduanced 

Recouer Parameters ... 

Load Uolume Info File .. . 
Saue Uolume Info File .. . 

Detailed descriptions of these menu 
commands are listed in this section. 

SUM Recover 
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File Menu 

Get Info... WI 

Page setup ... 
Print list ... WP 

SUM Disk Clinic WD 
Transfer •.. WT 

Help... WH 

Quit WQ 

Get Info 
This command is available when one or more 
items (files or folders) are selected in the File List 
window. Get Info displays a dialog containing 
information about the selected item or items. 

If the selected item is a file, a dialog similar to 
this appears (the dialog for selected folders 
looks similar with obvious exceptions): 

File Name 

1 Remember.eps 

In Folder 

ITemPlates 

Date Created Date Modified 

11/9/89 1112/29/88 6:08 PM 

Creator Type 

IUHI[ 1 IEPSF 

File Size Recover ab le? 

1
26 IYes 

kBytes 

~ Done )1 [ Change ) [ NeHt 
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If multiple items are selected in the File List, the 
N ext button is available, and you can use it to 
cycle through all selected items. The keyboard 
shortcut for this button is ~-N. 

The Change button is available if you used the 
Volume Scan or Floppy Recover method to 
locate and recover files. (It is not present if you 
use Directory Scan). The button lets you change 
the Type and Creator codes for the current file 
because Volume Scan and Floppy Recover 
cannot always recover this information. 

All Macintosh files have a unique Type and 
Creator code. These codes, among other things, 
tell the Macintosh which application it should 
launch if you open a particular file (i.e., docu­
ment) and also determine which icon is used to 
represent the file on your desktop. If these codes 
are not available or are incorrect, you will not 
be able to launch an application by opening a 
document (your Macintosh tells you the applica­
tion is busy or missing), and a generic icon rep­
resents the file. 

Appendix B contains a list of common Type and 
Creator codes. Please refer to this appendix 
before making changes to these codes for any 
p~rticular file. If you insert the wrong codes, a 
variety of undesirable things can happen. 

If you discover that a file's Type and Creator 
codes are missing after you have quit SUM 
Recover, you can use SUM Tools to insert the 
codes. 



Page Setup 
Displays the standard Macintosh page setup 
dialog for specifying page orientation, size, and 
so forth for your printer. The command is used 
in conjunction with Print List (described next). 

Print List 
Use this command to print the current contents 
of the File List Window. 

SUM Disk Clinic 
Terminates SUM Recover and launches SUM 
Disk Clinic. 

Transfer 
Use this command to launch any application 
available on your system other than SUM Disk 
Clinic. When you quit the application you have 
launched, you return to your desktop - not to 
SUM Recover. 

Help 
Displays the first in a series of dialogs explain­
ing the basics of using SUM Recover. 

Quit 
Terminates SUM Recover and returns to your 
desktop. 

Edit Menu 

1: ut 
fnpq 
Pns1 (1 

flp!H' 

Select All a€A 
Select Modified ... 
Clear File list 

",Normal 
Aduanced 

SUM Recover 

Note that the Undo, Cut, Copy, Paste, and Clear 
commands are not available in this menu. They 
are only available when you are using desk 
accessories. 

Select All 
Selects every item in the File List Window. 

Select Modified 
Selects all items in the File List window that 
were created or modified after a specific date 
and time. When you choose this command, you 
see a dialog similar to the one shown on the next 
page. 

Please note that Select Modified is not available 
with all the Recovery Methods. While it is 
always available with the Directory Scan, it may 
or may not be available when using Volume 
Scan. For example, Select Modified is available 
if Volume Scan was able to locate date informa-
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tion on the files you are trying to recover; 
otherwise, it isn't. 

To select files modified after a certain date and 
time, enter your date and time criteria in this 
dialog and click Select. 

Sel ect all files Modified after: 

Month I Day I Year 

Hours I Minutes 

~ I @] RM 

Select ([ Cancel II 

Use the Tab key to move between text fields. To 
change the time designation from AM to PM 
(and vice versa), click it. 

Select Modified is a particularly useful com­
mand when you need to do a synchronized 
recovery (as explained earlier in this chapter 
under the SUM Volume Restore Window). If you 
know the date and time a volume's Volume 
Restore Record was last updated, you can use 
this command to quickly isolate the files you 
need to recover before doing the volume restore. 
For example, if you know the Volume Restore 
Record was last updated at 12:30 PM on July 15, 
1989, enter this criteria into the Select Modified 
dialog and click Select. SUM Recover selects 
every file in the File List that was created or 
modified after this date and time. All you have 
to do is click the Recover button to recover these 
files. 
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Clear File List 
This command removes all entries from the 
current File List. 

You cannot undo this operation. If you clear the 
File List, the only way to restore it is to search 
the volume again. SUM Recover asks you to 
confirm your choice before clearing the list. 

Normal/ Advanced 
You can use SUM Recover in either Normal or 
Advanced mode. The mode you are currently 
using is checkmarked in the menu. 

Advanced mode is a "power user" feature. It 
gives you access to functions that require some 
understanding of disk and file structures. Unless 
you possess such an understanding, Advanced 
mode will be of little or no use to you, and you 
should always remain in Normal mode. 

When you choose Advanced mode, the Ad­
vanced menu title appears in the menu bar. This 
menu and its commands are described later in 
this section. 



SUM Recover 

Options Menu 

.ljllWll~" Find File 
Show Summary... ~s 

Find File ... ~F 

Show Signatures ... 

Double Clicl< Recouer 

..IPass 1 
Pass 2 
Pass 3 

Show Summary 
This command displays a dialog summarizing 
the choices you made in SUM Disk Clinic: 

Summary of Aecol!er Function 

Source 

~ 
Floppy Disk 

Uolume Volume Name: Right BOOK 

Recovered files will be saved to thiS 
Destlnlltlon 

Volume Name: HO 40 Volume c=J 
Free =,pace : 15730 kBytes 

Recoyery - Dlrecton~ Scan 
sun Shield Volume Restore Record 

Method is NOT installed 

naximum number of files able to find per pass 2500 ([ Done J) ~laximum number of folders able to find per pass: 1500 

You cannot change anything in this dialog - it is 
strictly for information purposes. 

At the bottom of the Summary dialog are two 
pieces of information that might come in handy 
under some conditions. The Max number of 
files ... and the Max number of folders ... infor­
mation tells you the maximum number of items 
the program can locate and recover in a single 
pass. This information relates to the Search Pass 
command described later in this section. 

Use this command to quickly locate a particular 
file in the File List. Choosing the command 
displays this dialog: 

Find? I SUM Chapters 

Note ... This is NOT a case-sensitiue search. 
That Is, it makes no difference whether you 
enter upper or lower case characters in the 
aboue teHt field. 

Find lJ Cancel 

Enter the name of the file you want to find and 
click Find. SUM Recover scrolls the list to that 
file. 

Show Signatures 
This command is available only when you use 
the Volume Scan method to locate and recover 
files because Signatures are not used with the 
Directory Scan and Floppy Recover methods. 

Choosing the command displays this dialog: 

Current Signatures 
I. Adobe.ArlDala 
2. Freehand 
3. Cr i c:kel Draw 
4. Cr i c:kel Graph 
5. Exc:e I Char lDola 
6. Exc:e I Dala 
7. tlSExc:e I Sy I kDa la 
8. F i I etlakerDa la 
9. Fi letlaker 4 
10. F i I el1akerDala 
II. FI~8Par l i l i onDa la 
12. LoneSlarPart i lion 

OK )] 
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The window lists the Signatures that are 
included in the file named Packed Signatures on 
your disk. This file is provided on your original 
SUM Program Disks and can be installed when 
running the SUM Install program. (See Chapter 
2.) Symantec updates the Packed Signatures file 
periodically to provide additional signatures. If 
the signature you need is not listed, Symantec 
may have it. Please contact our product support 
department. 

If you have not installed the Packed Signatures 
file or if its has been renamed, damaged, or 
removed, SUM Recover notifies you at launch 
time that it cannot locate the file: 

~ 
~ 

Unable to locate 'Packed Signatures' file. 

Click 'Select' to select a Signatures file. 
Click 'Continue' if you do not want to use Signatures. 
Click 'Cancel' to eHit to Finder. 

Select) [ Continue) ( Cancel) 

Search Pass 
While SUM Recover scans a volume to locate 
whatever files it can recover, it is building a list 
of those file names in your computer's memory. 
At the completion of the scan, it displays the list 
in the File List Window. 

The number of files or folders that the program 
can place in the list depends upon the amount of 
memory available in your computer. The Show 
Summary dialog (described earlier) tells you the 
maximum number of files and folders the 
program can keep in the list. 

If you need to recover more than the maximum 
number of files and folders the program can 
accomodate, the Search Pass command provides 
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the solution. (Unless you are recovering a very 
large number of files with a limited amount of 
memory, you'll probably never have occasion to 
use this command. You might want to bypass 
reading this description until you need it.) 

Search Pass lets you make up to three separate 
passes on the volume to locate and recover files. 
During each pass, the program knows which 
files it located in the previous pass or passes. For 
example, assume that the maximum number of 
files the program can locate and recover in a 
single pass is 3,000 (which you learn by choos­
ing the Show Summary command), but your 
volume contains 8,000 files that you need to 
recover. Here is the correct procedure to use: 

1. In the SUM File Recover window, click the 
Search button. The program locates the 
first 3,000 files and lists them in the File 
List window. 

2. Select the files you want to recover in the 
File List and click Recover. 

3. After recovering the first batch of files, 
display the Search Pass submenu and 
choose Pass 2. 

4. Click Search again and the program 
locates the next 3,000 files and lists them 
in the File List Window. 

5. Select the files you want to recover and 
click Recover. 

6. Display the Search Pass submenu again 
and choose Pass 3. 

7. Click Search again and the program 
locates and lists the remaining 2,000 files. 

8. Select the files you want to recover and 
click Recover. 



Double Click Recover 
Activating this command (it is active when a 
check mark appears to its left) provides you 
with a shortcut method for recovering files - that 
is, when you double-click a file name in the File 
List window it is the equivalent of selecting the 
file and then clicking Recover. 

Advanced Menu 

Recover Parameters ... 

Load Uolume I nfo File .. . 
Save Uolume Info File .. . 

The Advanced menu title appears in the menu 
bar only when you select Advanced mode in the 
Edit menu. 

Use of the commands in the Advanced menu 
requires some understanding of disk and file 
structures. We recommend that you do not 
attempt to use these commands unless you 
understand these concepts. 

Recover Parameters 
This command can be used to modify the 
parameters used by SUM Recover. Choosing the 
command displays this dialog: 

SUM Recover 

SCSI Device 

StortBlotlc 

Physical 
Set tor Size 

0256 
0512 
01024 

@ Use Data found on Uolume 
o Use Uolume Information File Data 

Number of Blotlcs for 11600 
Direttory Search ;::" ====~ 

Rllototion Biotic Size 1512 

~== First Biotic in Bit Mop 14 

==~ 

The SCSI Parameters area can be used to set the 
current parameters for the SCSI device, includ­
ing device number, starting block, and sector 
size. These options are available only if the 
startup volume was a SCSI device or another 
SCSI is available and selected; otherwise, SCSI 
Parameters is greyed out. 

The Recover Parameters can be used to describe 
the volume size, allocation, and structure. 

Load Volume Info File 
Use this command to select a Volume Informa­
tion File you want to force the program to use. 

Save Volume Info File 
Saves the settings in Recover Parameters in a 
separate Volume Information File. If you edit 
the Recover Parameters, use this option to save 
the settings. The program assigns the default file 
name "source volume name.VIF." 

End of Chapter 5 
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SUM TuneUp 

SUM TuneUp's primary function is to maintain 
your volumes at peak efficiency and speed. 
Several secondary functions are available for 
helping maintain your volumes in other impor­
tant ways. SUM TuneUp performs these func­
tions: 

• Defragments disk files. 

• Optimizes disk space. 

o Verifies file data. 

• Erases unused disk space. 

• Locks out bad disk sectors. 

• Lists all INITs in system folders. 
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Fragmentation and Optimization 

What Is Fragmentation? 
When you first connect a new hard disk to your 
system, it performs at top efficiency. But as you 
add new files, change existing ones, delete files, 
and do other routine maintenance to the disk, its 
performance decreases. This loss of performance 
is mainly due to fragmentation. 

Fragmentation results when your Macintosh 
cannot find enough contiguous free space on the 
disk to store an entire file. When this happens, 
the file is split into two or more separate frag­
ments (or pieces) and placed on the disk wher­
ever space is available. The various fragments 
are linked together so that an application can 
easily locate the fragments in their correct 
sequence. Fortunately, the Macintosh handles all 
of this for you, so you don't have to be too 
concerned about it. 

The problem with fragmentation is that the 
Macintosh must physically move the disk's 
read/write heads from one place on the disk to 
another to store and collect all of the various 
fragments of the file. These physical movements 
are mechanical, and compared to the relative 
speed of your computer, quite slow. If a file is 
highly fragmented (that is, split into many 
fragments widely spread throughout the disk), a 
great deal of head movement is required, and 
thus, reading or writing the file requires consid­
erable time. 

You might be asking at this point why, if 
fragmentation creates these types of problems, is 
it used? The answer is that if it were not used 
you would not be able to store as much informa­
tion on disk because finding enough contiguous 
free space becomes impossible after a very short 
time. 
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Normally, the more information a disk contains 
and the more it is used, the more it is frag­
mented. This is because it becomes increasingly 
difficult to find adequate contiguous free space. 
And, fragmentation occurs so gradually that you 
might not even be aware it is slowing down 
your hard disk. 

Overcoming Fragmentation 
One way SUM TuneUp restores performance is 
by defragmenting the files on the disk. This is 
done by reorganizing the fragments into con­
tiguous areas, thus minimizing head movement 
and maximizing performance. 

The diagram below shows an example of how a 
single file might be fragmented on your disk 
(the dark areas indicate various fragments). 



This diagram shows how the same file might be 
organized on the disk after it has been defrag­
mented with SUM TuneUp. 

Normally, SUM TuneUp cannot defragment 
every file on your hard disk. This is especially 
true if your disk contains very little free space. 
Other factors, which you'll read about later in 
this chapter, also determine whether or not a file 
can be defragmented. 

The major factor that determines whether or not 
defragmentation will improve your disk's 
performance is how badly it is currently frag­
mented. To help you make the decision as to 
whether or not a tune up is needed, SUM 
TuneUp has an option that examines your disk 
to determine how much fragmentation exists. 
This option shows you the extent of fragmenta­
tion that currently exists so that you can decide 
whether or not you want to tune up the volume. 

SUM TuneUp 

Optimizing Volumes 
Defragmenting files on a disk normally im­
proves performance, as you have just seen. Yet 
even after defragmentation, the various files are 
still spread out in many different locations. 
Although this has very little effect on drive 
performance, defragmenting files can signifi­
cantly reduce the amount of contiguous space 
available on the volume. 

Having large blocks of contiguous free space on 
a volume can be useful for the following rea­
sons: 

• It reduces the probability that new files you 
add to the volume will be fragmented. 

• It allows you to create larger partitions. 

SUM TuneUp has a feature available that 
optimizes free space on your volumes. This is 
accomplished by literally moving each and 
every file into a contiguous area of the disk. 
Think of it this way, if you moved all of the 
furniture in your living room into one corner, 
you'd have a great deal more contiguous floor 
space available, and everything would be more 
readily accessible. 

Defragmenting your files and then subsequently 
optimizing your volume organizes your data in 
the most compact and efficient manner possible. 
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Using SUM TuneUp 
SUM TuneUp 

c:J I Hard Disk I ~ Fr .. Spae. -12154 KByt .. 

Current Actlvl ty 

Uolume Info 

TuneUp Options 

O~ I 1100~ 

Tun.Uplog 

Begin 

Launching SUM TuneUp 
1. Locate the SUM TuneUp icon on your 

desktop: 

I 

2. Launch SUM TuneUp by clicking on the 
icon to select it and then choose Open 
from the File menu. Or simply double­
click the SUM TuneUp icon. (You can also 
launch SUM TuneUp directly from SUM 
Disk Clinic.) After SUM TuneUp starts, 
your screen looks similar to the one above. 

Selecting a Volume 
The pop-up menu at the top of the window 
shows the volume that is currently selected. You 
can select a different volume by choosing it from 
the pop-up menu. 

If you select a floppy disk (or other type of 
removable media), the Eject button is activated. 
Clicking this button ejects the volume. 
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~ 
Some restrictions apply when selecting volumes: 

• You cannot optimize space on your startup 
volume or on the volume from which you 
launch SUM TuneUp. You can overcome 
this by starting up from a different volume 
or launching SUM TuneUp from a different 
volume. 

• You cannot tune up a volume partition 
smaller than BOOK in size. Volumes must be 
at least BOOK to be in the HFS format, and 
SUM TuneUp works only with HFS 
volumes. This applies to partitions created 
with SUM Partition or any similar software. 

• You cannot tune up any volume on which 
Apple™ Desktop Manager is running. 

< • Before running SUM TuneUp, remove all 
copy-protected software (some music 
programs and games are copy-protected) 
from the volume you are tuning up. 



Volume Info 
Clicking Volume Info instructs SUM TuneUp to 
analyze the selected volume and show you the 
results. You would normally analyze the volume 
in this way prior to performing the actual tune 
up to determine how badly the volume is 
fragmented and also to determine how much 
free space is available. 

After the analysis is complete, a window similar 
to the one shown here is displayed. 

V.lum.: Hard Disk 

Sizt: 39991 K 
~ - --- --.:::- - ..:....--

Frtf 12154 K spoc.: 

C.n\t~ 
Spae.: 6006 K 

; 
Numberl 66 
F .. ~s: I 
Numb.rl 625 Flles: ! 

i 
2:1: I Fr.g'd I 17 F,ItS: 

! 

II Done J) 

This window shows graphically how the 
volume is organized along with various impor­
tant statistics. The window is for observation 
only; therefore, you cannot change anything. 

The graphic display on the left side of the 
window gives you some indication of the state 
of fragmentation that exists on the volume. 
Black represents Used Space - that is, locations 
that contain data; White represents Available 
Space; Gray represents the Frame for the 
window - that is, this area is not available to the 
particular volume. 

The statistics on the right side provide the 
following information: 

Size: Indicates the volume's maximum 
capacity. 

Free Space: Indicates the total amount of 
space currently available on the volume. 

SUM Tune Up 

Contig Space: Indicates the largest block of 
contiguous free space available. 

Number Frags: Indicates the number of file 
fragments found on the volume. 

Number Files: Is the total number of files 
on the volume. 

Frag'd Files: Shows the percentage frag­
mented files (in this case, 17) relative to 
the total number of files (625). We recom­
mend tuning up a volume that is more 
than 5 to 7% fragmented. 

TuneUp Options 
Clicking TuneUp Options gives you access to 
the other functions you can have SUM TuneUp 
perform on the selected volume. 

TuneUp Options 

_ [gI TuneUp Uolume ~ [gI Uerlfy Flies 
[gI Defragment flies OK 
[gI Optimize Uolume 

Requested spaCe~Kbytes a [gI Lock Out Bad Sectors 

W [gI Erase Free Space 
- @Wrlte D's 

OD's, 1 '5, random lID [gI List ALL INITs 

Write IIlIII times, 

(I Cancel )) [ OK I 

You can also activate and deactivate the TuneUp 
options by clicking their respective icons located 
just below the TuneUp Options button. Activat­
ing an option this way uses whatever option 
settings are currently selected in the TuneUp 
Options'dialog. 
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TuneUp Volume 

I) 
This is the standard tune up option. 
Click it ON when you want SUM 
TuneUp to reorganize and defrag­
ment files on the selected volume. 

TuneUp Volume offers two additional options 
for controlling how the tune up is performed: 
Defragment Files and Optimize Volume. 

Defragment Files Option 

This option instructs SUM TuneUp to tune up 
the volume by simple defragmentation of files. 
In this case, the program leaves the first frag­
ment of each file in its current location on disk, 
collects the other fragments of the file, and then 
attaches the stray fragments to the first fragment 
in its original location. 

Optimize Volume Option 

Optimize Volume moves files around on the 
volume to maximize available free space. 

When you select Optimize Volume, this dialog 
appears: 

~ 
~ 

When we encounter orphans do you want 
them remol1ed or do you want optimization to 
stop with a D 1 Drphan Error? 

Orphans are blocks on your hard disk that 
are not claimed by any file or the operating 
system. Orphans can result from system 
crashes or from software protection schemes. 

We recommend remol1lng orphans. 

.. @ Remoue Orphans when encountered. 

• 0 Stop optimization when orphan encountered. 

t OK ]1 

This dialog lets you decide how SUM TuneUp 
handles "orphans," which SUM TuneUp may 
encounter during a tune up operation. An 
orphan is a block on your volume without a 
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directory entry or a file allocation or doesn't 
belong to any file or operating system. This 
usually is caused by a system crash or certain 
software protection schemes. 

You can control how SUM TuneUp handles an 
orphan by selecting an option in the Optimize 
Volume dialog. You can choose to Remove 
Orphans when encountered or Stop Optimiza­
tion when orphan encountered. 

If you select Remove Orphans when encoun­
tered, SUM TuneUp eliminates the orphans 
from the volume when it finds them. This is 
done automatically and without interrupting the 
tune up process. 

If you select Stop Optimization when orphan 
encountered, SUM TuneUp alerts you when an 
orphan is encountered with the message "Unex­
pected error, cancelled. D 1" and terminates the 
tune up operation. Once the optimization is 
terminated, leave SUM TuneUp and use 
Apple™ Disk First Aid to fix your volume's 
errors. 

Of the two orphan control options, we recom­
mend the first - Remove Orphans when en­
countered. This option lets you optimize a 
volume without interrupting the process and 
eliminates the orphans automatically. 

Select an orphan control option by clicking on 
the button. Then, click OK to save the setting. 

When you select Optimize Volume, the Re­
quested Space ... kBytes text field becomes 
active. By entering a number in this field, SUM 
TuneUp will attempt to reorganize the files so 
that you end up with at least that amount of 
free, contiguous space on the volume. The 
default value you see here is always the maxi­
mum amount of contiguous space that can be 
made available on the selected volume. 



Verify Files Option 

c:tJ 
OK 

Clicking this option ON instructs 
SUM TuneUp to verify each and 
every file on the volume. That is, SUM 
TuneUp reads each file to ensure that 
it can be read without resulting in a 
disk error. 

Using the Verify Files option gives you the 
security of knowing that all of your files are 
correct following any tune up operation, but it 
does lengthen the operation considerably. You 
must weigh whether or not the additional time 
is important to you. 

Erase Free Space Option 

It. 
When you click the Erase Free Space 
option ON, SUM TuneUp erases all 

':.:. '-00 unused space on your volume, in-
cluding space occupied by deleted 
files, by replacing it with binary 

zeros or a random pattern of binary zeros and 
ones. 

Remember, when you delete files or defragment 
a volume, the original information remains on 
the volume. Even though the data cannot be ac­
cessed directly by the Macintosh file system, 
data can be recovered using special utility pro­
grams, such as SUM Tools, SUM Recover, and 
others. This options ensures that the data cannot 
be recovered by any method. For example, if you 
erase free space, all the entries in the Deleted 
File Record are invalid, and you cannot recover 
deleted files from the volume. 

You'll find the Erase Free Space option useful if 
your volume contains sensitive data that you 
want to make sure no one can access. 

When you select this option, you must also 
select the method you want to use to erase free 
space. You can either Write O's (zeros), or Write 
O's and l's in random order. (The latter option is 
one typically used by government agencies.) 

SUM Tune Up 

Write D's Option 

SUM TuneUp fills the free space with binary 
zeroes. This option is adequate for most 
purposes. 

Write 0' S, l' S, Random 

SUM TuneUp fills the free space with a random 
pattern of binary zeroes and ones. 

When you select this option, you can also 
specify the number of times you want the 
random pattern written into the free space by 
entering a value into the Write ... Time(s) text 
field. 

This option makes three separate passes on the 
volume to write the bit pattern and, therefore, is 
time consuming. Unless you specifically require 
this bit pattern, use the Write O's option. 

Lock Out Bad Sectors 

.a. Sometimes the physical surface of a 
U device sustains damage that can lead to 

problems. For example, a small area 
might loose some of its ability to hold 

the magnetic charge needed to record data (this 
is commonly referred to as "dropping bits"). 
Your Macintosh does not detect these problems 
(unless they are severe) and will go ahead and 
write data into these bad areas or "sectors." But 
when you attempt to read the data, you might 
find it is corrupted or even unreadable. 

The Lock Out Bad Sectors option detects bad 
sectors and "flags" them so that data cannot be 
written into those sectors. 

If SUM TuneUp detects a bad sector, it reports 
its location in the TuneUp Log area. 

If a bad sector already contains a file, you must 
recover that file before locking out the sector. In 
this case, SUM TuneUp tells you how to do this, 
(or you can refer to the error message "Sector is 
alloca ted to a file ... " in Appendix A). 
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List All INITs Option 

INITs are small programs that load into memory 
every time you start up your system. They 
reside in your system folder and perform a 
variety of functions. For example, the SUM 
Partition INIT occupies a small portion of 
memory and handles all of the operations you 
want to do with volume partitions. 

DODD 

[]J 
By clicking the List All INITs option 
ON, SUM TuneUp displays a list of 
the INITs and CDEV s in your system 
folder along with the 10 numbers and 
other pertinent information. 

Begin Button 
After selecting the options you want and the 
volume you want to use, click Begin to start the 
tune up. A dialog appears suggesting that you 
backup your important files before doing the 
operation. This is a precautionary step, but one 
we recommend. See Chapter 7, SUM BackUp. 

While the tune up is taking place, the Begin 
button changes to STOP. Click STOP to halt the 
operation or press ~ - . (period) at any point. If 
an operation is in progress when you click 
STOP, that operation finishes before the pro­
gram halts. 

If a screen blanker, such as Pyro™ or AutoBlack, 
is installed and activates during the tune up 
process, the screen is not fully refreshed. The 
results of the tune up are displayed when the 
process is complete. 

Current Activity Indicator 
While the tune up is being performed, the 
current activity is indicated in this box. The icon 
displayed matches those shown in the TuneUp 
Options'dialog. 
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Progress Indicator 
This bar gradually fills in from 0% to 100% to 
indicate how much of the current activity has 
been completed. 

Messages Area 
Messages appear in the Messages area to keep 
you informed of the program's progress. You 
can save the information that appears in the 
Messages window using the Save TuneUp Log 
command in the File menu. (This command is 
described later in this chapter.) 

You might occasionally see a message that SUM 
TuneUp is unable to defragment a file. In some 
instances, SUM TuneUp cannot defragment a 
file because 

• SUM TuneUp cannot find enough 
contiguous disk space to store the file it is 
attempting to defragment. 

• The file is locked (this is done using the Get 
Info command in the desktop's File menu). 

• The file is in use. This always occurs with 
the System and Finder files on the current 
startup disk. It can also occur if you are 
running an application under MultiFinder 
or if you have desk accessories open. 

These situations do not require action on your 
part. The program continues to run without 
your response. 

If an error occurs, an error message appears in 
the Messages area. In rare cases, you may see 
this message "Unexpected Error, cancelled. 0 
I." This message is displayed when SUM 
TuneUp encounters an orphan. 

SUM TuneUp provides a way to handle or­
phans. See Optimize Volume Option on page 6-6 
for more information. 



You can find a list of error messages with 
detailed descriptions and proposed solutions in 
Appendix A, Error Messages. 

Once the tune up is complete, the program 
shows the results in the Messages area. 

Quitting SUM TuneUp 
When you are finished with SUM TuneUp, you 
can exit to various locations by choosing one of 
the following commands from the File menu: 

• SUM Disk Clinic takes you to the SUM 
Disk Clinic Main Menu. 

• Transfer lets you transfer directly to a 
different application. 

• Quit returns you to the desktop. 

Special Operations 

Defragmenting Your Desktop 

SUM TuneUp cannot defragment a file that is 
currently in use, such as the System file or the 
desktop on your startup volume. Because of its 
high level of activity, the desktop is often the 
most fragmented file on a volume. Tuning up 
the desktop normally helps your Macintosh 
operate faster and more efficiently. 

SUM Tune Up 

You need a special startup disk for this opera­
tion. This startup disk should contain a system 
folder (with at least the System and Finder files 
inside) and a copy of the SUM TuneUp utility. 

Here's how to tune up the desktop on your 
startup volume: 

1. Use your special startup disk to start your 
Macintosh. 

2. Launch SUM TuneUp. 

3. Select your original startup disk (the one 
containing the desktop you want to de­
fragment) as the volume to tune up. 

4. Click TuneUp Options and select the 
options you want to use. You should at 
least select the Defragment Files option. 

5. Click Begin when you are ready to start. 

6. After the tune up is complete, quit SUM 
TuneUp and restart your Macintosh from 
your original startup volume. 

Copy· Protected Files 

You should not tune up any volume that 
contains copy-protected files. Remove such files 
from your volume before doing the tune up and 
then replace them afterward. 

SUM TuneUp on Networks 

You can tune up most volumes on a network, 
but you cannot tune up the file server from a 
remote location. 
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File Menu 

Salle TuneUp log ~S 

SUM Disk Clinic ~D 

Transfer ••. ~T 

Page Setup ... 
Print TuneUp log... ~P 

Help ~H 

Quit ~Q 

Save TuneUp Log 
This command saves a copy of the information 
in the Messages window to a file on disk. 

The log file is always stored at the lowest level 
(root) of the volume that was tuned up. The file 
is named with the name of the volume, the date 
and time, and the word SUM. For example, if 
you tune up the volume named "Hard Disk" at 
2:15 PM on July 1st, the log file is named Hard 
Disk 7/1/89 2.15 PM.SUM. 

The log file is a standard, unformatted text 
document; therefore, you can open it using most 
word processing applications. 

SUM Disk Clinic 
Choose this command if you want to launch or 
return to SUM Disk Clinic. 
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Transfer 
Use this command if you want to launch any 
application other than SUM Disk Clinic. A 
standard file selector dialog appears so you can 
select the application you want. 

Page Setup 
Displays the standard Macintosh dialog for 
setting page orientation, size, and printing 
options. Use prior to printing the TuneUp Log 
with the Print TuneUp Log command. 

Print TuneUp Log 
Prints the TuneUp Log as shown in the Messages 
window. 

Help 
Displays a series of dialogs containing instruc­
tions for using SUM TuneUp. 

Quit 
Terminates SUM TuneUp and returns you to the 
desktop. 

End of Chapter 6 



SUM BackUp 

SUM BackUp provides a fast and efficient way 
to back up the files on your hard disk. You can 
back up to floppy disks, other hard disks, 
removable cartridges, or any other device that 
shows up on your desktop as an HFS volume. 
However, you cannot use SUM Backup to back 
up from one floppy disk to another; use SUM 
QuickCopy for that. 

Because SUM BackUp automatically backs up 
only the files that have changed since the last 
backup, this makes it convenient to back up on 
a daily basis. You can also use the program to 
restore your files because SUM BackUp stores 
the files in a special format. 

SUM BackUp automatically includes all your 
files in a backup, you can be selective about the 
files you back up or restore. You can: 

• Back up or restore everything. 

• Back up or restore only applications. 

• Back up or restore only documents. 

• Back up or restore a single file or folder. 
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Using SUM BackUp 

SUM BackUp 
~ ......................................... , ....................................................................................................................... ': 
~ 1. Select Backup or Restore function ~ 
! 2. Select one uolume from each list ! 
~ 3. Choose an instruction from the popup menu ~ 

I .. ~~ ... ~.~.~.~.~ ... ~.~.~ ... ~~.~.~.~.~.~.:.~ ... ~.~.~.~.~.~..................................... . ............................... .1 
Backup FROM ... 

I Rob's HD 
1 Backup .1 
I. Restore 1 

Backup euerything 

Launching SUM BackUp 
1. Locate the SUM BackUp icon on your 

desktop: 

2. Launch SUM BackUp by clicking on the 
icon to select it and then choose Open 
from the File menu. Or simply double­
click the icon. (You can also launch SUM 
BackUp directly from SUM Disk Clinic, as 
described in Chapter 4). After SUM 
BackUp starts, your screen looks similar to 
the one above. 

Notice the steps 1 through 4 at the top of the 
window. These are the steps you follow during 
a Backup or Restore process. Take a moment to 
read these before continuing. 

Backup or Restore 
The two buttons - Backup and Restore -let 
you back up or restore files from and to various 
volumes. 
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Backup TO ... 

I Untitled I 
( Eject 

n Begin D 

Click Backup to store copies of your files on 
floppy disks or some other media; click Restore 
to copy previously backed up files back onto 
your hard disk. 

Selecting Volumes 
The two pop-up menus, Backup FROM and 
Backup TO, display all the currently available 
volumes. They allow you to choose the volume 
you're backing up or restoring (source) and the 
volume you're backing up to or restoring from 
(target). 

To select a different volume, display the pop-up 
menu and select a volume. 

Source Volume 

The source volume is the volume you want to 
backup FROM or restore TO. Choose your 
source volume from the pop-up menu on the 
left. 



Target Volume 

The target volume is the volume you want to 
backup TO or restore FROM. Choose your target 
volume from the pop-up menu on the right. 

Only the volumes marked with a diamond in 
the pop-up menu can be used for backups. Any 
other volumes shown are unavailable because 
the volume is a startup volume, this is the 
volume you launched SUM Disk Clinic from, or 
the volume is locked. 

Initial Backup 
To back up the files on your hard disk, you will 
perform an initial backup and create a set of 
backup disks, called a backup set. Once you have 
this initial set, you can use them again and again 
in incremental backups (described next). (If you 
are making backups to floppy disks, the pro­
gram tells you exactly how many disks are 
needed.) 

To create an initial backup, do the following: 

1. Click Backup. 

2. Select your source volume (the hard disk 
you want to backup). To do this, display 
the pop-up menu on the left and choose 
the hard disk you are copying FROM. 

3. Select your target volume (the disk you 
want to backup TO). If you're backing up 
to floppy disks or other removable media, 
insert a disk now. Display the pop-up 
menu Backup TO and choose the name of 
your target volume. 

Any volume not currently mounted on 
the desktop is not shown in the pop-up 
menu. Because the volume is not dis­
played, you cannot select it as the source 
or target volume. 

4. Click Begin. A dialog confirms that it's 
OK to erase the target disk. If you insert a 

SUM BackUp 

floppy disk that is part of previous backup 
set, you'll see this dialog: 

1.\, Do you really want to erase "2.Sharon·s 
ill Disk", which is already part of a 

BackupSet? Or are you recycling an old 
backup disk you don't need anymore? 

NOTE: If you're recycling an old BackupSet, you might 
want to click "Erase & don't nag me" so you won't 
be asked about each backup disk you recycle. 

Erase this disk 
H Use a different disk )1 

[ Erase & don't nag me) 

Read the warning carefully, then click one 
of these buttons: Use a different disk, 
Erase this disk, or Erase & don't nag me. 

After you respond, SUM BackUp begins 
backing up everything from the source 
volume you selected. Please note that 
SUM BackUp does not back up files if 
the file name begins with a period. 

5. Insert disks as prompted. You will be 
asked to insert as many disks as needed to 
complete the backup. SUM BackUp 
numbers these disks internally, but you 
need to label them externally! Label the 
disks "l.hard disk name," I/2.hard disk 
name," and so forth. 

Except for the first disk in the backup set, 
you can insert unformatted disks, blank 
disks, or used disks. The first disk cannot 
be part of a previous SUM backup set, and 
preferably, should be blank. 

6. After all files are backed up, SUM BackUp 
prompts you to reinsert the first disk so 
that the backup set directory can be 
updated. It's important not to skip this 
step! 

Do not misplace the first disk in you 
backup set because that disk 
contains important information 
needed to restore your files. 
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Incremental Backup 
After you create an initial backup set, SUM 
BackUp reuses the backup set, backing up only 
those files that have changed since the last 
backup. The program compares the contents of 
your source volume with the contents of the 
backup set and makes the changes to the backup 
set. This means new files are added to the 
backup set, changed files are overwritten, and 
files deleted from your hard disk are removed 
from the backup set. 

To perform an incremental backup: 

1. Click Backup. 

2. Select your source volume. 

3. Select your target volume (the first disk of 
your existing backup set). If you used 
floppy disks or other removable media for 
the backup, insert the first disk of the 
backup set now. 

4. Click Begin. A dialog box appears asking 
you to confirm that it's OK to use this 
backup set. After you respond, SUM 
BackUp begins backing up only the files 
that have changed. 

5. Insert the disks when prompted. You are 
only asked to insert the disks that contain 
files that have changed; if new files were 
added, you may need a new disk or two. 

6. Reinsert the first disk in the backup set at 
the end of the backup to update backup 
set directory. 

&! 
Reinserting the first disk at the end 
of the backup is an important step. 
You cannot restore your files if you 
don't update the backup set direc­
tory! If your backup is interrupted 

, before this step is completed, follow the instruc­
tions on page 7-7 to correct the situation imme­
diately. 
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Restore 
In the event that your hard disk has been erased 
or reinitialized, you can smoothly reconstruct its 
contents by using SUM BackUp to restore your 
entire hard disk. (Redux files are not inter­
changeable with SUM BackUp, so if you back up 
a volume with Redux, you can't restore the files 
using SUM BackUp or vice versa.) 

First, you'll need to create a disk from which 
you can start your Macintosh and launch SUM 
BackUp. This disk, let's call it startup, should 
contain a system folder (with the System and 
Finder files inside) and a copy of SUM BackUp. 

1. Use this startup disk to start your Macin-
tosh. 

2. Launch SUM BackUp. 

3. Click Restore. 

4. Select your source volume (the hard disk 
you want to restore TO). To do this, 
display the pop-up menu on the left and 
choose your hard disk. If your hard disk is 
not available, you can also restore to 
floppy disks or any other HFS volume. 

5. If you're restoring from floppy disks, 
you'll need to eject your startup disk so 
that you can insert the backup set disks. 
To do this, display the pop-up menu on 
the right and choose the name of the 
startup disk. Click the Eject button. 

6. Select your target volume (the disk you 
want to restore FROM). If your backup set 
is on floppy disks or other removable 
media, insert the first disk of the backup 
set now. Display the pop-up menu on the 
right and choose the name of your target 
volume. 



7. Click Begin. SUM BackUp begins restor­
ing files to the destination you specified. 
The program prompts you to insert each 
disk of your backup set as needed. If SUM 
BackUp tries to restore a file that already 
exists on the hard disk, you must confirm 
the replacement. 

[B If you are restoring a file that is 
I __ .. larger than the destination volume, 

--- the message IIHad problem writing 
'file name.' Disk Full. Stop Now or 

Continue." is displayed. By selecting Continue, 
you can locate, select, and restore files that will 
fit on the destination volume. 

Special Restore Operations 

Running SUM BackUp on the Hard Disk 

You can also restore your hard disk by running 
SUM BackUp from the hard disk itself. To do 
this, the hard disk must contain SUM BackUp, a 
System file, and the Finder. Then, you can 
simply run the program from the hard disk, 
following the instructions described in the last 
section, but eliminating the need to eject the 
startup disk (Step 5). 

Restoring Does Not Erase Source 

If you restore to a hard disk that already con­
tains files, SUM BackUp will not erase the files 
currently on the hard disk It simply writes the 
files to be restored in whatever space is available 
and continues to do so until all files have been 
restored or until you encounter a "Disk Full" 
message. 

SUM BackUp 

Replacing Existing Files 

If SUM BackUp tries to restore a file that already 
exists on the hard disk, it asks you whether you 
want to replace that file or skip it. You'll also 
have the opportunity to tell SUM BackUp to 
"Replace all" duplicate files or "Skip all" 
duplicate files. 

Selective Restores 

If you want to restore just one file or folder, 
perhaps all your applications, or all your docu­
ments, you can use SUM BackUp to streamline 
the process. These features are described on the 
next page. 
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Selective Backups 
SUM BackUp automatically backs up every file 
and folder on your source volume. However, 
you can back up a specific set of files. You can 
use a Backup Instruction to tell SUM BackUp to 
backup only documents, for example, a single 
file or folder. 

To select an instruction for an initial backup: 

1. Launch SUM BackUp. 

2. Click Backup. 

3. Select your source volume. 

4. Select your target volume. 

5. Choose one of the Backup Instructions 
from the pop-up menu at the bottom of 
the SUM BackUp window: 

Backup everything backs up all files and 
folders on your source volume. 

Backup only applications backs up only 
the applications on your source volume. 

Backup only documents backs up all files 
except applications or system files. 

Backup a single file or folder allows you 
to choose individual items to be backed 
up. Choosing this menu item displays this 
dialog: 

Backup Idhich file or folder? 
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6. Click on a file or folder to select it; double­
clicking a folder opens that folder. Select 
an item by clicking on it or use the Shift­
click method to select multiple items. 
When the item or items are selected, click 
the Backup button. 

7. After you've selected a Backup Instruc­
tion, click Begin to start the backup. Only 
the files you specified are backed up. 

8. Finish the backup as normal, inserting 
disks as necessary, including reinserting 
the first disk at the end of the backup. 

When you specify a Backup Instruction in an 
initial backup, all incremental backups per­
formed with that backup set follow the same 
instruction. If, for example, you chose "Backup 
only documents" in your initial backup, any ap­
plications you add are not added to the docu­
ments-only backup set. 

~ 
If you want to change the instruction 

I __ .. of an existing backup set during an 
--- incremental backup, press and hold 

the Option key and click on the 
existing instruction. The pop-up menu reap­
pears, and you can select a different instruction. 
This changes the contents of your backup set. 

Selective Restores 
You can also use SUM BackUp to perform 
selective restores of your hard disk. After you 
click Restore and select your source and target 
volumes, you'll be able to select a Restore 
Instruction from the pop-up menu that has four 
options: restore everything, restore only appli­
cations, restore only documents, or restore a 
single file or folder. 



Missing Disks 
If one of the disks in your backup set is missing, 
you can use SUM BackUp to recreate the disk 
(during a backup) or skip the missing disk (if 
you're restoring). 

Suppose you're in the middle of a backup and 
SUM BackUp asks for a disk you don't have. If 
you click the Missing button at the bottom of 
the window, SUM Backup recreates the missing 
disk. 

If you are restoring files with your backup set 
and you don't have the disk that SUM BackUp is 
asking for, click the Missing button. SUM 
BackUp skips over that disk and continues 
restoring files from the next disk. 

You cannot recreate the first disk 
of the backup set because that disk 
contains the directory. Make sure 
you don't lose this disk since you 
cannot recreate that disk if it is 

damaged or lost. As a precaution, use SUM 
QuickCopy to make an extra copy of the first 
disk of your backup set. 

Resuming the Backup 
If for any reason your Macintosh experiences an 
unexpected shut down while you're in the 
middle of a backup, you can resume the backup 
exactly where you left off. 

If SUM BackUp stops unexpectedly due to a 
power outage or a system crash, look for the file 
"Directory" in the same folder as SUM BackUp 
on your hard disk. Drag this file to the first disk 
of your backup set and update the set. Then, 
launch SUM BackUp again. Once the program is 
launched, click Backup, choose your source 
volume, choose the new updated target disk, 
and click Begin. SUM BackUp continues from 
where you left off, and only asks you to insert 
disks that contain files not backed up the first 
time around. 

SUM BackUp 

Pause or Stop Now 
During the backup process, you can pause or 
stop at any time. While SUM BackUp is backing 
up files, notice the Pause and Stop Now buttons 
in the window. 

Pause temporarily halts the backup; when you 
click Continue, the backup is resumed. 

Stop Now ends the backup session. You must 
insert the first target disk, SUM BackUp then 
updates the directory on the first target disk. 
The next time you use this backup set, SUM 
BackUp reads the directory from the first disk 
and continues the backup where you left off. 

Quitting SUM BackUp 
When you finish SUM BackUp, you can exit by 
choosing one of these commands from the File 
menu: 

• SUM Disk Clinic takes you to the SUM 
Disk Clinic Main Menu. 

• Transfer lets you move directly to another 
application. 

• Quit returns you to the desktop. 
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SUM BackUp Menus 

File Menu 

Saue Preferences 

Show Log Window WL 
Saue Log Rs ... 

SUM Disk Clinic 
Transfer ... 

Quit 

Save Preferences 

Saves the settings you choose in the Preferences 
menu. 

Show Log Window 

When checked, this command causes the SUM 
BackUp Log window to display a report of the 
backup in progress. 

Save Log As 

Saves the contents of the Log window as a text 
file so that you can keep records of your backup. 
The file can be opened with most word proces­
sors. 
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SUM Disk Clinic 

Takes you to the SUM Disk Clinic Main Menu. 

Transfer 

Lets you transfer directly to another application. 

Quit 

Exits SUM BackUp and returns to your desktop. 



Preferences Menu 

Preferences' ~ 

../Uerify files 

../Sound effects 
Pause on errors 
Ask for every disk 
Auto initialize new BackupDisks 

Verify files 

Instructs SUM BackUp to compare each backed 
up file to its original counterpart on the hard 
disk. We highly recommend you leave this item 
checked because it helps maintain the integrity 
of your backups. 

Sound effects 

When checked, you hear the standard Macin­
tosh "beep" when it's time to insert another 
disk, respond to a dialog, and so forth. 

Pause on errors 

When checked, SUM BackUp interrupts the 
backup if it has trouble backing up a file. 
Normally, SUM BackUp reports any errors in 
the Log Window while your backup proceeds, 
and confirms the integrity of the backup at the 
end of a session. However, if Pause on Errors is 
checked, the backup is interrupted if an error is 
reported; you must respond to a dialog to con­
tinue. 

SUM BackUp 

Ask for every disk 

Use this command when you want to recreate a 
missing backup disk. When this item is checked, 
SUM BackUp asks for every disk in the Backup­
Set during an incremental backup. When the 
program asks for the missing disk, click the 
Missing button, and the backup disk is recre­
ated. 

Auto initialize new Backup Disks 

When checked, SUM BackUp automatically 
initializes new disks when they are inserted and 
selected as target volumes, instead of asking if 
you want to initialize each new disk. 

End of Chapter 7 
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SUM Partition 

SUM Partition lets you divide a volume into 
multiple, separate partitions that are treated and 
managed independently of one another. Think 
of each partition as a separate disk drive that 
you can manage like any drive on your system. 
Partitions have these unique features: 

o You can specify the size of each partition as 
long as you have enough contiguous space 
available. 

• Each partition is identified by a special icon 
on the desktop so you can easily distinguish 
it. 

o Mounting the partition provides access to 
the contents, while unmounting it makes 
the contents unavailable. 

o Encryption and password protection 
provide partition security. 

When you encrypt a partition and protect it with 
a password, the partition cannot be accessed 
without entering its password first. This lets you 
protect sensitive documents, such as personnel 
files, payroll information, financial spreadsheets, 
and so forth. 

SUM Partition works with hard disks and floppy 
disks. Although the program's principle use is 
with hard disks, the encryption schemes make 
this program useful on floppy disks under 
certain situations, which you'll learn about later. 

Although the basic procedures are the same 
with hard disks or with floppies, this chapter 
assumes you are using a hard disk. 

SUM Partition consists of two components: 

SUM Partition 

SUM Partition INIT contains 
information your system needs, 
such as the number and location 
of partitions, thus it must be in 

your startup disk's system folder. Once in your 
system folder, SUM Partition's icon appears 
briefly on the screen when you start your 
Macintosh. If it doesn't appear, it was unable to 
load, and you cannot access your partitions . 

SUM Partition DA is used to 
create, mount, unmount, and 

SUM Partition DA delete partitions. It also lets 
you select the partitions you 

want automounted at startup time and change 
passwords for encrypted partitions. 
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Using SUM Partition 
-0 SUM Partition 

SUM Partition 

Menu L:....-..J I Hard Disk: I~ Copyright cD 1988-1989 
Micro Analyst, Inc. Volume Pop-Up 

Partitions' List 

Volume or Part 
Information 

ition 

8 Encrypted Partition 

~ Mounted Partition 
Irv AutoMount Partition 

Pare-nt Volume- : Hard Disk 
Fre-e-space- : 17297 K Bytes 

No. Partitions: 3 

SUM Partition INIT must load into memory at 
startup time for you to use the partitioning 
functions, but you use the desk accessory to 
actually perform the functions. (Do not use SUM 
Partition with the DA Camera because it can 
corrupt your partitions. SUM Partition works 
well with many other screen capture programs.) 

To access the desk accessory, choose SUM 
Partition from the 4 menu. You see a window 
similar to the one shown above. 

The currently selected volume appears in the 
Volume pop-up menu. You can select a different 
volume by displaying the pop-up menu and 
choosing from those listed. If you choose a 
removable volume (such as a floppy disk), the 
Eject button becomes available to remove and 
insert a different volume. 

Notice that near the bottom of the window the 
amount of free space and the number of parti­
tions on the selected volume are shown. 

The Partitions' List shows the partitions available 
on the current volume. You can select a partition 
in this list by clicking on it but can only select 

8-2 

Symantec Corporation 

~ 
[ Create 3€C) 

[ UnMount ) 

( Delete l 

[AutoMount 3€Aj 

10 
( Password 3€Pj 

[ Help 3€H ) 

one at a time. When you select a partition in the 
list, the information at the bottom of the window 
~changes to show the partition's size and the date 
and time it was created: 

Partition : Pay ro 11 Records 
Size-: 1 000 K By tes Help 3€H 

Cre-ate-d: Sat, May 20, 1989 1 :49 :20 PM 

The names in the Partitions' List are often pre­
ceded by one or more of the following icons to 
indicate their current status: 

& 

Indicates that the partition is currently 
mounted. When you select this partition 
in the list, the Mount button is disabled. 

Indicates that the partition is assigned 
AutoMount status. 

Indicates that the partition is assigned a 
password and encrypted. 

You'll learn more about these icons later in this 
chapter. 



Creating Partitions 
To create a partition, click Create in the SUM 
Partition window. The Create Partition window 
appears: 

Creete pert i ti on on Hard Disk 
Meximum Pertition Size Aveileble 2474 k bytes 

Pert 1t ion Neme ":,r, Oil-h. I 
Pertition Size §Ok bytes (1 OOOk by tes = 1 meg_by te) 

Minimum partition size = SOk byt ... 

AutoMount? @No OVes 

Encryption Options @None o Simple o CompleH 

( Help :J€H I ( Cancel I ([ Create I) 

At the top of the window, you see the name of 
the currently selected volume, and the amount 
of space it has available for creating partitions. 
This figure might not match exactly the Free 
Space shown in the SUM Partition window 
because partitions can only be created in con­
tiguous free space areas. The amount of free 
space and the size of the partitions determines 
how many partitions you can create on a vol­
ume. 

Keep in mind that you can only create SUM 
partitions on HFS volumes because SUM Parti­
tion does not support the MFS volume format. 

Enter the partition's specifications as follows: 

Partition Name: Enter the name you want to use 
to identify the partition. This name appears 
beneath the partition's icon on your desktop 
when the partition is mounted. 

SUM Partition 

Partition Size: Notice that 512K is the default 
partition size; however, the value you enter 
cannot exceed the "Maximum Partition Size 
Available." 

The value you enter determines the size of the 
partition. The value is interpreted in kilobytes: 
that is, if you enter 800, SOaK bytes are allocated 
to the partition. You can enter any value from 50 
to the available space figure shown at the top of 
the window. However, if you create a partition 
400K or smaller, it will not be in HFS format, 
and therefore, you cannot tune up the partition 
with SUM TuneUp. 

If you want to maximize the amount of free 
space available on a volume, you can optimize 
your volume with SUM TuneUp. (See Chapter 6, 
SUM TuneUp, for more information.) 

A small part of every partition you create is 
used to store information about the volume. For 
example, if you create an SOaK partition, you 
will have slightly less than SOaK available for 
storing data. (This is a normal situation with all 
volumes. For example, when you format an 
SOaK floppy disk, part of the disk is used for 
volume information.) 

AutoMount?: Select Yes if you want this parti­
tion to be mounted automatically every time 
you start your Macintosh. You can change a 
partition's automount status at any time using 
the AutoMount button in the SUM Partition 
window (this button is described later in this 
chapter). 

Only those partitions on your startup volume 
may be assigned automount status. The maxi­
mum number of automount partitions you can 
have on your startup volume is limited by the 
amount of memory allocated to the Finder. 

You cannot automount encrypted partitions. 
When you select the AutoMount option, the 
Simple and Complex Encryption options 
(descriptions follow) are disabled. 
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Encryption Options: SUM Partition offers three 
options for encryption. 

None - the data in the partition is not 
encrypted. Note that you cannot assign a 
password when you select this option. 

Simple - encrypts the data using simple 
encryption algorithms. This form of 
encryption is adequate for most purposes. 
The advantage it has over Complex 
encryption is that it doesn't require quite 
as much time to decrypt the data. Note 
that if you select this option, you must 
assign a password by entering it in the 
text box just below the Simple button. The 
default password is My Password. To use a 
different password (which is advisable), 
enter it in the text box. (Make sure you 
read the section Password Options later in 
this chapter for additional details.) 

Complex - encrypts the data using 
complex encryption algorithms. Here 
again, if you select this option you must 
assign a password. 

[EJ When entering passwords, keep in 
I ::.~ mind that they are case sensitive. That 

is, the uppercase and lowercase char­
acters you enter must match exactly 

those entered when the password was originally 
assigned. 

Two different icons can appear in the Partitions' 
List to indicate whether a partition is encrypted 
with the Simple or Complex method: 

a Simple Encryption 

Q Complex Encryption 

Once you have entered all specifications for the 
partition you want to create, click the Create 
button at the bottom. 
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During the encryption, do not switch 
off your Macintosh until the encryp­
tion process is completely finished. 

The time it takes to encrypt a partition is directly 
related to your Macintosh's processor speed. For 
example, to encrypt a 1024K partition on a 
Macintosh SE takes about 20 seconds while on a 
Macintosh lIci the encryption takes about 4 
seconds. These tests were conducted on a stan­
dard Macintosh lIci (using System 6.0.4) and 
Macintosh SE (using System 6.0.3); therefore, 
your encryption time may vary depending on 
your system configuration. 

When the encryption process finishes, a dialog 
appears indicating whether or not the partition 
was created per your specifications. 

When you create a new partition, we recom­
mend you create a VIF, the Deleted File Record, 
and the Volume Restore Record for this parti­
tion. If the partition crashes, you can use this 
information to recover it. 

Even if you already have a VIF for your hard 
disk before you create a new partition, you must 
create a VIF for that new partition. 

If a partition crashes and you don't have a VIF, 
there is a way to create a substitute VIF. First, 
create another partition that is exactly the same 
size as the crashed partition (if you have enough 
contiguous space). Then, create a VIF for the 
new partition. Use the VIF from the new parti­
tion to recover the crashed partition, and then 
delete the new partition from the volume. 

To avoid such a disaster, create a VIF immedi­
ately after you create a new partition. 



Mounting Partitions 
Before you can access a partition, you must 
mount it. Mounting causes the partition's icon 
to appear on your desktop. Once the partition is 
mounted, you open it the same way you open 
any other icon - that is, either double-click the 
icon, or select it and choose Open from the 
desktop's File menu. 

To mount a partition, do the following: 

1. Choose SUM Partition from the 4 menu. 

2. If necessary, use the pop-up menu to 
select the volume where the partition you 
want to mount is located. 

3. Select the partition you want to mount in 
the Partition List by clicking on it. Re­
member, the icons to the left of the parti­
tion names indicate their current status. 

4. Click Mount, and the selected partition is 
mounted. You should then see its icon on 
your desktop. 

e 
I 

~ 

If the partition you select is encrypted and 
password protected, a dialog prompts you 
to enter the password. When you type the 
password in the dialog, the characters you 
type do not appear but are represented by 
asterisks. This prevents unauthorized 
persons from observing the password as 
you enter it. 

Once the partition is mounted, its icon in the 
Partitions' List reflects its current status. 

SUM Partition 

Unmounting Partitions 
Unmounting a partition removes its icon from 
the desktop - the partition is no longer acces­
sible until you mount it again. 

I ::.~ ware limitation prevents you from un-[E A Macintosh operating system soft-

mounting partitions at the desktop by 
launching SUM Partition from the 4 

menu. In such cases, the UnMount button is 
disabled and is only enabled when you are 
working within an application. To unmount any 
partition from the desktop drag its icon to the 
Trash. Unmounting does not delete the partition 
from the volume. 

To unmount a partition within SUM Partition, 
do the following: 

1. Choose SUM Partition from the 4 menu. 

2. If necessary, use the pop-up menu to 
select the volume where the partition you 
want to unmount is located. 

3. Select the partition you want to unmount 
in the Partitions' List. 

4. Click UnMount. The selected partition is 
unmounted, and its icon is removed from 
the desktop. 

Once unmounted, the partition's icon in the 
Partitions' List changes to reflect its status. 

At certain times, you'll need to unmount a parti­
tion or will have trouble performing certain 
operations. For example: 

• If you are attempting to recover a partition 
with SUM Recover, unmount the partition 
before starting the recovery process. 

• If you are using Apple's Desktop Manager, 
you must have System 6.0.4 to unmount a 
partition, or your attempts to unmount the 
partition are ignored. 

• Before changing a partition's encryption 
options or password, unmount the 
partition. 
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Deleting Partitions 
Deleting a partition removes it permanently 
from the volume and reallocates its space 
accordingly. To remove the partition's icon from 
the desktop but keep the partition on your 
volume, use UnMount rather than Delete. 

You cannot delete a partition that is currently 
mounted. To delete a partition, make sure it is 
not mounted, and then do the following: 

1. Choose SUM Partition from the 4 menu. 

2. If necessary, use the pop-up menu to 
select the volume where the partition you 
want to delete is located. 

3. Select the partition you want to delete in 
the Partitions' List. 

4. Click Delete, and an alert appears inform­
ing you that deleting the partition auto­
matically deletes all of the data it currently 
contains. If you don't mind losing the data 
or if the partition is empty, click OK to 
proceed with the deletion. 
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AutoMounting Partitions 
You can select multiple partitions to automount. 
Each partition you select is automatically 
mounted when you start your system, and its 
icon appears on your desktop. 

One way to automount a partition is to assign it 
AutoMount status when you create the parti­
tion. (See Creating Partitions earlier in this chap­
ter.) 

The AutoMount button in the SUM Partition 
window provides another way to assign or 
remove AutoMount status from a partition. This 
button works like a toggle switch. If the selected 
partition already has AutoMount status when 
you click the button, AutoMount is disabled, 
and vice versa. 

Some limitations apply here: 

• You cannot assign AutoMount status to an 
encrypted partition. 

• Only partitions on your startup volume can 
be automounted. The maximum number of 
automounted partitions allowed depends 
on the amount of memory allocated to the 
Finder. You must not exceed the amount of 
memory allocated. 

• You cannot change the AutoMount status of 
a partition that is currently mounted­
unmount the partition before proceeding. 

To change a partition's AutoMount status, do 
the following: 

1. Choose SUM Partition from the 4 menu. 

2. If necessary, use the pop-up menu to 
select the volume where the partition you 
want to change is located. 

3. Select the partition you're changing in the 
Partitions'List. 



4. Click AutoMount. The partition's icon in 
the Partitions' List changes to reflect its 
current status. If the icon is present, 
AutoMount status is in effect; otherwise, it 
isn't. ' 

If the message "Out of Finder memory ... " or a 
mounting error message is displayed while 
mounting or automounting partitions, unmount 
as many partitions as needed before continuing. 

You can unmount an AutoMount partition at 
the desktop by simply dragging it to the Trash. 
To unmount the partition while in another ap­
plication, seeUnmounting Partitions on page 8-5. 

Password Options 

a The differences between password 
protection and encryption are signifi­
cant. Many skilled computer experts 
can circumvent password protection 

with little or no difficulty. Encrypting a parti­
tion, however, scrambles the data in that partition 
using special encoding schemes. Even if some­
one is able to discover the password, the data 
itself is unusable until it is decoded. Because 
SUM Partition's encoding/ decoding schemes 
are not accessible, an encrypted partition is fully 
protected against unauthorized access. 

You might find encryption useful with your 
floppy disks. For example, assume you have 
sensitive data you want to deliver to a remote 
location by courier, by mail, or by hand. To 
protect that information from unauthorized 
users, you can create a partition on a floppy 
disk, encrypt the data, and assign it a password 
known only to you. When the disk arrives at its 
destination, you give the recipient the correct 
password, and they have access to the data, 
assuming that they have their own copy of 
Symantec Utilities for Macintosh. 

SUM Partition 

Obviously, simply encoding the data in a 
partition without also assigning a password 
does not provide any protection whatsoever. 
Therefore, when you encrypt a partition, you 
must also assign a password. 

Normally, you assign a password to a partition 
and encrypt it at the time it is created. SUM Par­
tition also gives you the ability to remove, add, 
and change an existing partition's password. 

To encrypt a partition or to add, remove, or 
change passwords for existing partitions, do the 
following: 

1. Choose SUM Partition from the" menu. 

2. If necessary, use the pop-up menu to 
select the volume where the partition you 
want to change is located. 

3. Select the partition you want to change in 
the Partitions' List. 

3. Click Password. You then see a window 
similar to this: 

_ Password Options - Encrypted Partition ==== 
You can remove e pessword ONL V if 

( Remoue a€R) you ere eble to correctly enter the 
pert i t ion's current password, 

To Add e new pessword or Chenge en existing one, first 
select the Encryption Method you went to use below 
(Simple or Complex) and then click the Add or Chenge 
button, es eppropri ete. 

I Encryption Method: @Simple o CompleH I 
( Rdd a€A ) ( Change a€C ) 

~ Done l) 
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When you add, change, or remove password 
protection from a partition, the time it takes 
depends on two things: the partition's size and 
your Macintosh's processor. For example, 
adding a password to a 1024K partition took 
only 4 seconds on a Macintosh IIci but 20 
seconds on a Macintosh SE. 

During the password protection 
process, it appears as if nothing is 
happening on the screen, even 
though SUM Partition is working. 
Until SUM Partition indicates that 

the process is complete, you should not try to 
cancel the process or restart your Macintosh. 
This can be disastrous and could actually delete 
the partition you are trying to protect. 

Removing Passwords 

Removing password protection from a partition 
also decrypts the data in the partition. To 
remove a password, you must be able to enter 
its current one. 

There are different reasons for removing pass­
word protection from a partition. For example, 
you must remove the password protection from 
a partition before creating its VIF. 

To remove the password, click Remove. A 
dialog asks you to enter the partition's current 
password. If you enter the correct password, 
SUM Partition decrypts the data and removes 
the password protection. You cannot continue 
with the operation until you enter the correct 
password. 
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Adding Passwords 

Before adding password protection to an 
existing partition, select the Encryption Method 
(Simple or Complex) you want to use. See 
Encryption Options earlier in this chapter for an 
explanation of the differences between Simple 
and Complex encryption. 

Click Add, and a dialog appears prompting you 
to enter the password you want to assign to the 
partition. When you type the password, the 
characters you type do not appear - asterisks 
replace the characters to prevent anyone from 
observing the password as you enter it. Pass­
words should not be more than 22 characters 
long. 

Enter Pilrtition Pilssword for Encrypted Pilrtltion 

After entering the password, another dialog 
prompts you to re-enter the password for verifi­
cation. Again, asterisks appear in place of the 
characters you type. 

&! 
CAUTION: There is virtually no way 
to find out a password once it has 
been entered and assigned. If you 
forget the password, you can no 

longer access the partition. Your only way to 
reclaim the space on the volume in this case is to 
reinitialize it, which means you must first back 
up the volume, and then when restoring it, 
exclude the encrypted partition. When assigning 
passwords, keep them simple and easy to re­
member - you might even want to write them 
down somewhere. 



Changing Passwords 

Changing an existing password is basically the 
same as adding a new password with one 
additional step. 

First, select either Simple or Complex encryp­
tion. Then, click the Change button. 

SUM Partition prompts you to enter the current 
password assigned to the partition. If you enter 
the correct password, you are then prompted to 
enter the new password and then verify it. 

Once the password is verified, the program 
begins changing the password. During this 
process, do not turn off your Macintosh for any 
reason. 

[E Remember, passwords are case sensitve. 
~==~ Uppercase and lowercase characters must 

match exactly as they were originally 
entered when the password was assigned. 

SUM Partition 
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SUM Partition Icons 
The following is a review of the SUM Partition 
icons, indicating what they represent, how they 
are used, and where they appear. 

Desktop Icons 

SUM Partition 

This icon represents SUM 
Partition INIT (a startup 
document). It must be in the 
system folder of your startup 
volume so that it can load 

automatically when you start your system. The 
icon appears briefly on your startup screen if the 
program is able to load successfully. SUM 
Partition INIT remains in memory and contains 
the logic your Macintosh uses to handle volume 
partitions. 

Note that the actual name of this component is 
@SUM Partition INIT. The @ symbol causes the 
INIT to load at startup time before Suitcase. If 
you are using Suitcase, make sure the @ symbol 
always precedes the SUM Partition INIT compo­
nent name. Otherwise, you'll have problems 
running the two programs together. 

SUM Partition D A 

This icon represents SUM 
Partition DA. SUM 
Install gave you the 
option of installing this 
desk accessory directly 

into your System file or of simply copying it to 
your system folder (the later option is provided 
in the event you are using programs like Master­
Juggler or Suitcase). 
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This icon appears on your desktop 
when you mount (or AutoMount) a 
partition. You use it the same way 
you use a hard disk or floppy disk 

icon - that is, you gain access to the partition by 
opening this icon. You can unmount the parti­
tion from within an application using the SUM 
Partition desk accessory: you can unmount the 
partition from the desktop by dragging this icon 
to the Trash. 

Partitions List Icons 

a 

This icon indicates that the partition is 
currently mounted. If you are working 
within an application, you can unmount 
this partition using the UnMount 
button. If you are working at the desk­
top, the only way to unmount the 
partition is by dragging its icon to the 
Trash. 

This icon indicates that the partition is 
assigned AutoMount status. Only those 
partitions on your startup volume can 
be automounted. 

This icon represents a partition that is 
encrypted using the Simple encryption 
method. To mount this partition, you 
must be able to enter its password. 

This icon represents a partition that is 
encrypted using the Complex encryp­
tion method. To mount this partition, 
you must be able to enter its password. 

End of Chapter 8 



SUM QURckCoIPY 

Lock your source disk by sliding 
the Write-Protect Tab so that you 

can see through this hole. 

------/ 

SUM QuickCopy is an extremely fast disk 
duplication utility. You can use it to make copies 
of floppy disks - you cannot use it to copy 
information to and from hard disks. The pro­
gram is especially useful for mass disk duplica­
tion and is also an easy way to initialize several 
floppies at one time. 

SUM QuickCopy uses different terms to distin­
guish one type of disk from another: 

o Source Disk refers to the disk FROM which 
the information is to be copied (the original 
disk). 

• Target Disk refers to the disk TO which the 
information is being copied (the copy). 

& 
Like copying disks on the desktop, 

I SUM QuickCopy has some built-in 
o controls, but it cannot distinguish a 

Source disk from a Target disk. 
Therefore, always protect your Source disk or 
disks by sliding the disk's write-protect tab to 
the Read Only position (that is, push the tab 
toward the top edge of the disk so you can see 
through the hole, as in the figure to the left). 
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Using SUM QuickCopy 
SUM QulckCopy 

Source Disk Options 

@ Copy USED Sectors 
o Copy ALL Sectors 

I' - "I I Right BOOk Driue I 

Stort Copy 

Torget Disk Options 

D Initiolize Before Copying 
D Uerify Doto 
D Writ!) 'fllrupt On InsH1ion 

I' -"I I Right BOOk Driue I 

co~ade: ( 

'---------------
,sou_rc_.D_;s_kN_am_._and_ln_fu_: ________ ~ ,M._ss~ag._.: ________________ ~ 

II S.l.ct options and click 'Start Copy', I 
~----------------~ 

[ SUM Disk Clinic J 

Launching SUM QuickCopy 
To launch SUM QuickCopy from your desktop, 
do the following: 

1. Locate the SUM QuickCopy icon: 

2. Click on the icon to select it and then 
choose Open from the File menu, or 
simply double-click the icon. 

Once SUM QuickCopy starts, you see a window 
similar to the one pictured above. 

Note the Space Available figure shown in the Mes­
sages area at the bottom, right corner of the win­
dow. This figure indicates the amount of mem­
ory the program is able to use - which deter­
mines how effectively it is able to operate. This 
can be affected by several different factors. 
Please read Memory Usage at the end of this 
chapter for more information. 
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Quit 

Source Disk Options 
You have two options available pertaining to 
your Source disk (the disk you are copying 
FROM): Copy USED Sectors or Copy ALL 
Sectors. 

Copy USED Sectors 

This option copies only those parts of the Source 
disk that contain data. This option is relatively 
faster than the Copy ALL Sectors (unless all 
sectors on the Source disk contain data). 

This is the option you'll probably use most 
because in most cases, it requires lessAvailable 
Memory than Copy ALL Sectors and duplicates 
disks faster. 

Copy ALL Sectors 

This options copies every sector from the Source 
disk to the Target disk, whether or not a given 
sector contains data. 



The advantage to this option is that you end up 
with an exact duplicate of the Source disk. 
Therefore, when making copies of an important 
master source disk with SUM QuickCopy, this is 
the option you'll normally use. 

This option has two disadvantages: 

• More time is required to copy the disk. 

• The program requires the maximum 
amount of Space Available to complete the 
copy. 

Copying Applications and Disks 

Making unauthorized copies of applica­
tions and disks is a violation of federal 
law and is a detriment to the software 
development and publishing industry. 
Symantec Corporation, along with other 
developers and publishers, urges you obey 

the federal copyright laws and not use SUM 
QuickCopy or any other means to make copies of 
applications and disks except as duly authorized. 

Some Macintosh applications are copy-pro­
tected, which means only the owner is author­
ized to make one copy for backup purposes. 
SUM QuickCopy does not duplicate disks that 
contain copy-protected files - it simply reports 
that a disk error has occurred. 

Please note that SUM QuickCopy can't be used 
to copy the data from a crashed floppy disk onto 
another disk. You should run the Recovery 
Methods in SUM Disk Clinic to recover a 
crashed floppy disk. 

Selecting the Source Drive 

The pop-up menu on the left lists those floppy 
disk drives you can use to read your Source 
disk. Select the drive you want to use from this 
menu. 

SUM QuickCopy 

~ 
If your Macintosh SE or SE/30 has an 

I ::.~ external floppy disk drive, SUM 
QuickCopy recognizes the external 
disk drive but not the bottom internal 

disk drive. Keep this in mind when selecting the 
Source and the Target disk. 

Target Disk Options 
A variety of options are available for the Target 
disk (the disk you are copying TO). If you are 
making multiple copies of a disk, the Target disk 
options apply to every Target disk. 

SUM QuickCopy overwrites the disk 
directory on your Target disk. 
Therefore, make sure your Target 
disks do not contain any data you 
want to save. 

Initialize Before Copying Option 

Initializing a floppy disk erases all data on that 
disk by setting all data bits to zero. All space on 
the disk is thus available for other files. If you 
select this option, SUM QuickCopy initializes 
the Target disk before copying information to it. 
This option is the equivalent of initializing (or 
erasing) a floppy disk from the desktop. 

You should select Initialize Before Copying in 
the following situations: 

• The Target disk is brand new and has never 
been initialized. 

• The Target disk was initialized in a format 
that is different from that used on the 
Source disk. For example, if the Source disk 
is double-sided (BOOK), but the Target disk 
was initialized as single-sided (400K). Or 
the Source is a 400K disk, but the Target is 
initialized as a high-density disk. The 
bottom line is simply that the Target disk 
(or disks) must be initialized in the same 
forma t as the Source disk. 
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• You have selected the Copy USED Sectors 
option for the Source disk and your Target 
disks contain data that you want to be sure 
does not remain on the Targets after copies 
are made. 

Although you can initialize a single­
sided floppy disk as double-sided, 
there is an element of risk involved. 
When disk manufacturers create 

single-sided disks, they verify only one side of 
the disk. If you initialize such a disk as double­
sided and write data on the unverified side, 
there is no guarantee that the data will be 
written correctly. That is, you might be able to 
use both sides of the disk without problems, but 
at some point you might not be able to access 
the unverified portion of the disk. We, therefore, 
recommend that you do not initialize single­
sided disks as double-sided. 

Verify Data Option 

If you select this option, SUM QuickCopy checks 
to ensure that data written to the Target disk is 
readable. Selecting this option increases the 
amount of time required to make copies, but the 
additional time might be worth it especially in 
those cases where your Target disks are re­
cycled. 

Write Target On Insertion 

This option remains unavailable (grayed out) 
until after a Source disk has been read into 
memory, and SUM QuickCopy has determined 
that it has enough memory available to create 
Target disks in a single pass. If a Target disk can 
be created only by making multiple passes, this 
option remains unavailable. See Memory Usage at 
this end of this chapter for additional informa­
tion. 
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If this option is available and you activate it, 
SUM QuickCopy begins writing data to the 
Target disk as soon as you insert it into the 
designated disk drive. 

This is a convenient option and one that can 
save you some "mousing around." But use this 
option cautiously because inserting the wrong 
disk at the wrong time can cause problems. If 
you do select this option, we strongly recom­
mend setting the Write Protect tab on all of your 
Source disks. 

Selecting the Target Drive 

The pop-up menu on the right side lists those 
floppy disk drives you can use to create Target 
disks. Select the drive you want to use from this 
menu. 

Memory Usage 
One reason SUM QuickCopy is so fast is that it 
reads an entire Source disk into memory and 
keeps it there until you tell it to read a different 
Source disk, or you quit the program. It can then 
create any number of Target disks by simply 
transferring the information directly from 
memory to each Target disk you want to create. 

If your Macintosh does not have enough mem­
ory for SUM QuickCopy to read the entire 
contents of a Source disk into memory, copies 
are made by making multiple passes. That is, 
during the first pass, SUM QuickCopy reads as 
much of the Source disk as memory can accomo­
date and then writes that information to the 
Target disk. On the next pass, it asks you to 
reinsert the Source disk, reads whatever mem­
ory can accommodate, and then writes that to 
the Target disk. Unless you are using high­
density disks (1.4 megabyte capacity), two 
passes are normally sufficient to copy any 
Source disk. 



In general, here is what occurs when you begin a 
copy operation: 

If you have selected the Copy USED 
Sectors option for your Source disk but 
SUM QuickCopy determines that it cannot 
read the entire disk into memory at one time, 
an alert appears to this effect. The alert 
informs you that you must select the Copy 
ALL Sectors option to copy this Source 
disk. 

If you have selected the Copy ALL Sectors 
option and the program determines that it 
cannot read the entire Source disk into 
memory, it reads as much information as 
it can, tells you (in the Message area) the 
number of disk swaps required to make 
the copy, ejects the Source disk, and 
prompts you to insert the Target when 
required. The program then prompts you 
through all of the swaps necessary to 
make the complete copy. In this situation, 
the Write Target On Insertion option and 
the Write to Target button are never 
enabled. 

If you have selected either the Copy 
USED Sectors or Copy ALL Sectors 
option and the program determines that it 
can read the entire Source into memory, the 
copy can be done in a single pass. In these 
cases, the Write Target On Insertion 
option and the Write to Target button are 
both enabled. 

When you launch SUM QuickCopy under the 
Finder, the program "grabs" as much memory 
as it can. But when you launch under MultiFin­
der, SUM QuickCopy can use only the amount 
of memory allocated to it. (This memory alloca­
tion is controlled by the desktop's Get Info 
dialog. See your MultiFinder User Guide for 
complete details.) 

SUM QuickCopy 

Overcoming Memory Limitations 

If you frequently find yourself short of available 
memory when using SUM QuickCopy, you can 
create a special startup disk to use in these 
situations. Your startup disk should contain the 
following: 

• The SUM QuickCopy utility program 

• A System file containing only the minimum 
desk accessories and fonts 

• A Finder (do not use MultiFinder) 

• No startup documents unless absolutely 
essential 

After starting up your Macintosh with this 
startup disk, check to make sure the RAM Cache 
is turned off in the Control Panel. 

With this configuration you should be able to 
copy most 400K and SOaK disks. However, to 
copy most high-density disks, you'll probably 
need at least 2 megabytes of memory. 

9-5 



Chapter 9 

o 
Source Disk Options 

@ Copy USED Sectors 
o Copy RLL Sectors 

LIl I Right 800k Drlue I 

Stort Copy 

SUM QulckCopy 

Torget Disk Options 

o InltioUze Before Copying 
o lIerify Doto 
o Write Torget On Insertion 

LIl I Right 800k Drlue I 

C0[iSad.: ( Write to Torget 

~sou~rc~.D=;sk~Na=m.~an~dl=nfu~: ______ ~ rM.=ssa=9"~: ____________ -. 

I Il s.l.c, oplions and click 'Slarl Copy'. I 
Spac. Availabl. -> 903 K 

~--------------~ 
[ SUM Disk Clinic I Quit 

Making Disk Copies 
This section takes you step-by-step through the 
normal process of copying a Source disk with 
SUM QuickCopy. That is, it assumes you have 
enough memory available to copy your Source 
disk in a single pass. If you don't have enough 
memory and multiple passes are required, 
please refer to the section titled Memory Usage 
earlier in this chapter for additional information. 

1. Double-check your Source Disk Options 
to make sure everything is set up the way 
you want. 

2. Click Start Copy, or press ~-S. SUM 
QuickCopy prompts you to insert the 
Source disk into the floppy drive you have 
selected. 

3. Insert the Source disk in the appropriate 
drive. The program reads the Source disk 
name and other information and displays 
it for you. It then reads the remainder of 
the data from the disk and, when finished, 
activates the Write to Target button and 
the Write Target On Insertion option. 

4. If you want to use the Write Target On 
Insertion option, select it at this time. 

5. Insert a Target disk (the disk you are 
copying TO) into the floppy drive you 
have selected. 
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6. If you selected the Write Target On 
Insertion option, insert a Target disk; 
otherwise, click Write to Target, or press 
~ -W. SUM QuickCopy begins copying 
data to the Target disk, and when 
finished, automatically ejects the floppy 
from the disk drive. 

Once a complete Target disk has been created, 
you can: 

• Click Start Copy to read a different Source 
disk you want to copy, or 

• If you selected the Write Target On 
Insertion option, insert a new Target disk 
into the appropriate disk drive, and SUM 
QuickCopy immediately begins creating 
another Target disk, or 

• If you did not select the Write Target On 
Insertion option, insert a new Target disk 
into the appropriate disk drive and click 
Write to Target to begin creating another 
Target disk. 

Quitting SUM QuickCopy 
After you finish copying disks, click Quit to exit 
from SUM QuickCopy and return to the desk­
top, or click Disk Clinic to return to the SUM 
Disk Clinic Main Menu. 



Initializing Disks 
You can use SUM QuickCopy to initialize one or 
more floppy disks faster and easier than with 
the standard desktop method. Here's how: 

1. Starting at the desktop, initialize a floppy 
disk in the format you require: HFS or 
MFS, single- or double-sided. Give the 
disk a generic name, like Blank. 

2. Launch SUM QuickCopy. 

3. Select Copy USED Sectors for the Source 
disk. 

4. If your Target disks are new disks that 
have never been initialized, select Initial­
ize Before Copying; otherwise, deselect 
this option. 

5. Click Start Copy, and when prompted, 
insert the initialized disk you created in 
step one (above) into the disk drive you 
selected for the Source disk. 

7. Insert the floppy disk you want to initial­
ize and click Write to Target. Repeat this 
step for each disk you want to initialize. 
Every initialized disk receives the same 
name you assigned to your original disk 
in step one. 

End of Chapter 9 

SUM QuickCopy 
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SUM Encrypt is an application for encrypting 
and decrypting individual files or all files in one 
or more folders. SUM Encrypt is designed for 
use in the U.S. and Canada. 

Encryption is a method of coding informa­
tion based on specific algorithms that 
makes it unrecognizable for normal 
purposes. For example, a document 
created with MacWrite™ and subse­
quently encrypted would not be recog­
nized as anything other than "garbage" 
when opened by the creating application. 
Thus, encryption is an excellent way to 
protect sensitive information from un­
authorized individuals. 

Decryption is the exact opposite of encryp­
tion - it is the process of converting the 
encrypted information back into a recog­
nizable form. For example, the MacWrite 
document mentioned above, once de­
crypted, could be opened by the creating 
application just as any other document. 

SUM Encrypt 
II II 

II 

II II II 

Data ::I 
II II II 

II II 
II 

II II 
II 

1:11 II 
II 

II 

II II 
II 

II 
II II 

SUM Encrypt offers two encryption methods -
FasCrypt and DES: 

FasCrypt is a special form of encryption 
available only with SUM Encrypt. Fas­
Crypt is significantly faster than DES and 
is provided in SUM Encrypt primarily for 
increased speed. 

DES (Data Encryption Standard) is an 
encoding scheme developed by the United 
States Federal Bureau of Standards. 

[E
/.," 
---. 
---

. , .. 

SUM Encrypt does not encrypt 
application-type files (such as 
MORETM II, MacDraw™, and so 
forth), your System file, or your 
system folder. 



Chapter 10 Symantec Utilities for Macintosh 

Using SUM Encrypt 
SUM Encrypt 

Data~:t ( ENcrypt Encrypt fl File or Folder 

·:::/tata ( DEcrypt Decrypt fl File or Folder 

Current FOlder:II.....-_________ ---...J 

Current File:II.....-_________ ---...J 

0% 1-1 ______________ ---..11 100% 

Help 3€H 

launching SUM Encrypt 
To launch SUM Encrypt, do the following: 

1. Locate the SUM Encrypt icon on your 
desktop: 

~ 
... 

DaI: '.:;'.:.: 
:-.: 

2. To launch SUM Encrypt, click the SUM 
Encrypt icon and then choose Open from 
the File menu, or simply double-click the 
icon. 

Once the application has started, you see the 
SUM Encrypt window, like the one pictured 
above. 

You can also launch SUM Encrypt directly while 
running SUM Disk Clinic by choosing it from 
the Launch menu, which you'll learn how to do 
la ter in this chapter. 
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Encrypting Files 
To encrypt individual files or all the files in a 
particular folder, do the following: 

1. Click the ENcrypt button (or press ~-E). A 
file selector dialog appears similar to the 
one shown here: 

2. 

I=Hord Disk I 
D Deleted File Aee 01 d 
o Gomes 
o POQeMoker 3.0 
DSUM II 
o System Folder 
o Word 4.0 

=Hord Disk 

Oriue 

I[ Encrypt File 11 

[ t:nCr!m1 rohl!~r 1 

Select File/Folder to Encrypt Concel 

@ FosCrypt 
Encryption Method: 

ODES 

Select the encryption method you want to 
use (FasCrypt or DES) by clicking the ap­
propriate radio button in the bottom, right 
corner of the dialog. 



3. When a folder is selected in the list, the 
Open and Encrypt Folder buttons are 
available in the file selector dialog. 

To open the selected folder, click the 
Open button, press Return, or double­
click the item in the list. 

To encrypt all files (excluding applica­
tions) in the selected folder, click the 
Encrypt Folder button. 

When you click on an individual file name 
in the list, the Encrypt Folder button is 
deactivated, and the Open button changes 
to Encrypt File. To encrypt the selected 
file, click the Encrypt File button, press 
Return, or double-click the item in the list. 

4. Encryption and password protection work 
together to protect your files; therefore, 
when you encrypt a file, you must assign 
a password. SUM Encrypt prompts you to 
enter a password prior to encrypting the 
data by displaying the dialog shown here: 

Enter Password for Payroll Records 

( cancel) n OK l] 

Type the password you want to assign, 
which should not be more than 22 charac­
ters, and click OK. (Please read Using 
Passwords later in this chapter for things to 
consider about passwords.) 

5. To ensure that you have entered the 
password exactly the way you want it, 
SUM Encrypt asks you to verify the 
password by re-entering it. 

After assigning and verifying your password, 
you are back at the SUM Encrypt window. 
Encryption begins immediately. 

SUM Encrypt 

If you selected a folder to encrypt, the folder 
name appears in the Current Folder text field. In 
the Current File text field, you see the name of 
the file currently being encrypted. The Progress 
Scale indicates what percentage of the current 
file has been encrypted. At the end of the 
process (and sometimes during), messages 
appear in the Messages area indicating what has 
transpired. 

It is important that you don't encrypt 
the System files in your system 
folder. 

The time it takes to encrypt/ decrypt a file is 
directly related to your Macintosh's processor 
speed. For example, encrypting a 22K file on a 
Macintosh SE (using System 6.0.3) took about 19 
seconds, but on a Macintosh IIci (using System 
6.0.4), the encryption took only 4 seconds. These 
times are just estimates, and the time it takes to 
encrypt/ decrypt a file will depend on your sys­
tem's configuration. 

Encrypted File Icons 

SUM Encrypt assigns a special icon (shown 
below) to encrypted files when they appear on 
your desktop. 

:.?: EJ
··:· 

~:~:: .f 

If you open one of these icons, the parent 
application (the one with which the file was 
originally created) is not launched. Instead, 
SUM Encrypt is launched, and the decryption 
routine is initiated automatically. However, if 
the encrypted file's parent application is miss­
ing, SUM Encrypt will be unable to launch. 
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Once the file has been decrypted, SUM Encrypt 
terminates automatically, and you return to 
your desktop. The file's original icon reappears, 
and you can now launch the parent application 
by opening the icon. 

[la SUM Encrypt behaves differently in 
I :.::~ MultiFinder due to the way the 

operating system works. For example, 
if you are running under MultiFinder 

and have decrypted a file, that file's icon is re­
stored but is not immediately displayed. To dis­
play the icon, close the window where the file is 
located and then reopen it. At other times when 
encrypting or decrypting a file, the file's icon 
may appear the same on the desktop after the 
process. Close the window where the file's icon 
is located, and then open it. When you open the 
window, the icon should look different. 

Note that folders containing encrypted files do 
not have a special icon - they appear as normal 
folders on your desktop. 

Decrypting Files 
The preceding section (Encrypted File Icons) 
explained the quickest and simplest way to 
decrypt individual files (by opening them 
directly from the desktop). When you need to 
decrypt more than one file at a time, however, 
you'll probably want to use the method de­
scribed in this section. 

To decrypt individual files or all files in a folder, 
do the following: 

1. Click the DEcrypt button (or enter I-D). 

10·4 

A file selector dialog appears similar to 
the one shown here: 
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IOJ Payroll Records I 
o [mployee Records 
D FICH Stats 
o History 
D Security Info 
o TaM Info 
D Witholding Stats 

= Hard Disk 

Driue 

II Open 11 

[ Decrypt Folder 1 

Select File/Folder to Decrypt . [ Cancel 

2. When a folder is selected in the list, the 
Open and Decrypt Folder buttons are 
available in the file selector dialog. 

To open the selected folder, click the 
Open button, press Return, or double­
click the item in the list. 

To decrypt all files in the selected folder, 
click the Decrypt Folder button. 

When you click on an individual file name 
in the list, the Decrypt Folder button is 
deactivated, and the Open button changes 
to Decrypt File. To decrypt the selected 
file, click the Decrypt File button, press 
Return, or double-click the item in the list. 

3. SUM Encrypt prompts you to enter the 
password assigned to the selected file or 
folder (see also Using Passwords below). 

Type the password assigned to the item 
(asterisks appear in place of the characters 
you type) and click OK. 

After entering the password, you are back at the 
SUM Encrypt window. Decryption commences 
immedia tely. 

If you selected a folder to decrypt, the folder 
name appears in the Current Folder text field. In 
the Current File text field you see the name of the 
file currently being decrypted. The Progress Scale 
indicates what percentage of the current file has 
been decrypted. At the end of the process (and 
sometimes during) messages appear in the 
Messages area indicating what has transpired. 



Using Passwords 
This section discusses some important things to 
consider when assigning passwords to en­
crypted files. 

Forgotten Passwords 

You have no way of accessing an encrypted file 
without first entering your password. If you 
forget your password, your data is lost. We 
recommend, therefore, that you keep passwords 
short, simple, and easy to remember. You might 
even consider writing your passwords down 
somewhere for later reference. 

Password Shortcut 

When selecting files for encryption, you can 
select only one file at a time in the file selector 
dialog. Thus, you are required to enter a pass­
word for each individual file you want to 
encrypt. If you are encrypting many files at one 
time, consider placing them all into the same 
folder beforehand. This way, you can select the 
entire folder and then only have to enter your 
password one time. 

The best way to protect your data is to create a 
password-protected partition, and then move 
your encrypted files or folders into this parti­
tion. This means that unauthorized users must 
break two levels of password protection instead 
of one to view your data. 

SUM Encrypt 

Multiple Passwords 

If you select a folder to decrypt and that folder 
contains multiple files with different passwords, 
SUM Encrypt prompts you to enter only one 
password for the entire folder. All files in the 
folder that have a matching password will be 
decrypted. Those files with a different password 
are bypassed, and SUM Encrypt reports an in­
correct password by displaying a dialog similar 
to this: 

1:OS NOTE ... 
The password entered for folder 

Employee Records 

is not ualid for the file named 

Jane Doe 

[[ Cancel 1 [Stop Messages] Continue 

Cancel- immediately aborts the decryp­
tion process for the current folder. 

Stop Messages - continues decrypting the 
remaining files in the folder but prevents 
this dialog from appearing every time a 
password mismatch is encountered. 
However, files with mismatched pass­
words are not decrypted. 

Continue - continues decrypting the 
remaining files in the folder and the above 
dialog appears for all subsequent pass­
word mismatches. 

To decrypt those files that were bypassed, you 
must handle each one individually as explained 
under Decrypting Files earlier in this chapter. 

End of Chapter 10 
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SUM UniCrypt 

SUM UniCrypt is an application for encrypting 
and decrypting individual files or all files in one 
or more folders. This version of encryption is for 
use outside the U.s. and Canada. 

Encryption is a method of coding informa­
tion based on specific algorithms that 
makes it unrecognizable for normal 
purposes. For example, a document 
created with MacWriteTM and subse­
quently encrypted would not be recog­
nized as anything other than "garbage" 
when opened by the creating application. 
Thus, encryption is an excellent way to 
protect sensitive information from un­
authorized individuals. 

Decryption is the exact opposite of encryp­
tion - it is the process of converting the 
encrypted information back into a recog­
nizable form. For example, the MacWrite 
document mentioned above, once de­
crypted, could be opened by the creating 
application just as any other document. 

Data 
• • 

• • • 
• • • • • • • 

• • • 

SUM UniCrypt offers two encryption methods­
Simple and Complex: 

Simple, a fast and easy method of encryp­
tion, is provided in SUM UniCrypt pri­
marily for increased speed. 

Complex is an encoding scheme based on 
sophisticated algorithms that provide the 
highest form of security. 

~
' " SUM UniCrypt does not encrypt 
___ application-type files (such as 

MORETM II, MacDraw™, and so 
forth), your System file, or your sys-
tem folder. 
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Using SUM UniCrypt 
SUM Uni Crypt 

ENcrypt Encrypt CI File or Folder 

DEcrypt Decrypt CI File or Folder 

Current FOlder:L.1 __________ ---l 

Current File:L-1 __________ --' 

0% 1L--_____________ -----11 100% 

Help XH 1 

launching SUM UniCrypt 
To launch SUM UniCrypt, do the following: 

1. Locate the SUM UniCrypt icon on your 
desktop: 

D::tt.fl.:: ... 1t :".: 

2. To launch SUM UniCrypt, click the SUM 
UniCrypt icon and then choose Open from 
the File menu, or simply double-click the 
icon. 

Once the application has started, you see the 
SUM UniCrypt window, like the one pictured 
above. 

You can also launch SUM UniCrypt directly 
while running SUM Disk Clinic by choosing it 
from the Launch menu, which you'll learn how 
to do later in this chapter. 
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Encrypting Files 
To encrypt individual files or all the files in a 
particular folder, do the following: 

1. Click the ENcrypt button (or press gg-E). A 
file selector dialog appears similar to the 
one shown here: 

2. 

1= Hard Disk I 
[) Deleted File Record 
CJ Games 
CJ PaqeMaker 3.0 
CJ SUM II 
CJ System Folder 
CJ Word 4.0 

Select File/Folder to Encrypt 

Encryption Method: 

=Hard Disk 

Driue 

I[ Encrypt File II 
[ [nCr~JPl fol!1pr 1 

Cancel 

@ Simple 

o Complex 

Select the encryption method you want to 
use (Simple or Complex) by clicking the 
appropriate radio button in the bottom, 
right corner of the dialog. 



3. When a folder is selected in the list, the 
Open and Encrypt Folder buttons are 
available in the file selector dialog. 

To open the selected folder, click the 
Open button, press Return, or double­
click the item in the list. 

To encrypt all files (excluding applica­
tions) in the selected folder, click the 
Encrypt Folder button. 

When you click on an individual file name 
in the list, the Encrypt Folder button is 
deactivated, and the Open button changes 
to Encrypt File. To encrypt the selected 
file, click the Encrypt File button, press 
Return, or double-click the item in the list. 

4. Encryption and password protection work 
together to protect your files; therefore, 
when you encrypt a file, you must assign 
a password. SUM UniCrypt prompts you 
to enter a password prior to encrypting 
the data by displaying the dialog shown 
here: 

Enter Password for Payroll Records 

[ Cancel 1 ~ OK J) 

Type the password you want to assign, 
which should not be more than 22 charac­
ters, and click OK. (Please read Using 
Passwords later in this chapter for things to 
consider about passwords.) 

5. To ensure that you have entered the 
password exactly the way you want it, 
SUM UniCrypt asks you to verify the 
password by re-entering it. 

After assigning and verifying your password, 
you are back at the SUM UniCrypt window. 
Encryption begins immediately. 

SUM UniCrypt 

If you selected a folder to encrypt, the folder 
name appears in the Current Folder text field. In 
the Current File text field, you see the name of 
the file currently being encrypted. The Progress 
Scale indicates what percentage of the current 
file has been encrypted. At the end of the 
process (and sometimes during), messages 
appear in the Messages area indicating what has 
transpired. 

It is important that you don't encrypt 
the System files in your system 
folder. 

The time it takes to encrypt/ decrypt a file is 
directly related to your Macintosh's processor 
speed. For example, encrypting a 22K file on a 
Macintosh SE (using System 6.0.3) took about 19 
seconds, but on a Macintosh llci (using System 
6.0.4), the encryption took only 4 seconds. These 
times are just estimates, and the time it takes to 
encrypt/ decrypt a file will depend on your 
system's configuration. 

Encrypted File Icons 

SUM UniCrypt assigns a special icon (shown 
below) to encrypted files when they appear on 
your desktop. 

m··:· :.?: .:. ." 
::::- "I:: 

If you open one of these icons, the parent 
application (the one with which the file was 
originally created) is not launched. Instead, 
SUM UniCrypt is launched, and the decryption 
routine is initiated automatically. However, if 
the encrypted file's parent application is miss­
ing, SUM UniCrypt will be unable to launch. 
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Once the file has been decrypted, SUM UniC­
rypt terminates automatically, and you return 
to your desktop. The file's original icon reap­
pears, and you can now launch the parent 
application by opening the icon. 

[EJ SUM UniCrypt behaves differently in 
::.~ MultiFinder due to the way the 

operating system works. For example, 
if you are running under MultiFinder 

and have decrypted a file, that file's icon is re­
stored but is not immediately displayed. To dis­
play the icon, close the window where the file is 
located and then reopen it. At other times when 
encrypting or decrypting a file, the file's icon 
may appear the same on the desktop after the 
process. Close the window where the file's icon 
is located, and then open it. When you open the 
window, the icon should look different. 

Note that folders containing encrypted files do 
not have a special icon - they appear as normal 
folders on your desktop. 

Decrypting Files 
The preceding section (Encrypted File Icons) 
explained the quickest and simplest way to 
decrypt individual files (by opening them 
directly from the desktop). When you need to 
decrypt more than one file at a time, however, 
you'll probably want to use the method de­
scribed in this section. 

To decrypt individual files or all files in a folder, 
do the following: 

1. Click the DEcrypt button (or enter oo-D). A 
file selector dialog appears similar to the 
one shown here: 
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Ie Payroll Records I 
o Employee Records 
D FICA Stats 
o History 
D Security Info 
o TaH Info 
D Witholding Stats 

(~ 

= Hard Disk 

I: j(J( \ 

Driue 

Open ~ 
[ Decrypt Folder I 

Select File/Folder to Decrypt Cancel 

2. When a folder is selected in the list, the 
Open and Decrypt Folder buttons are 
available in the file selector dialog. 

To open the selected folder, click the 
Open button, press Return, or double­
click the item in the list. 

To decrypt all files in the selected folder, 
click the Decrypt Folder button. 

When you click on an individual file name 
in the list, the Decrypt Folder button is 
deactivated and the Open button changes 
to Decrypt File. To decrypt the selected 
file, click the Decrypt File button, press 
Return, or double-click the item in the list. 

3. SUM UniCrypt prompts you to enter the 
password assigned to the selected file or 
folder (see also Using Passwords below). 

Type the password assigned to the item 
(asterisks appear in place of the characters 
you type) and click OK. 

After entering the password, you are back at the 
SUM UniCrypt window. Decryption begins 
immediately. 

If you selected a folder to decrypt, the folder 
name appears in the Current Folder text field. In 
the Current File text field you see the name of the 
file currently being decrypted. The Progress Scale 
indicates what percentage of the current file has 
been decrypted. At the end of the process (and 
sometimes during) messages appear in the 
Messages area indicating what has transpired. 



Using Passwords 
This section discusses some important things to 
consider when assigning passwords to en­
crypted files. 

Forgotten Passwords 

You have no way of accessing an encrypted file 
without first entering your password. If you 
forget your password, your data is lost. We 
recommend, therefore, that you keep passwords 
short, simple, and easy to remember. You might 
even consider writing your passwords down 
somewhere for later reference. 

Password Shortcut 

When selecting files for encryption, you can 
select only one file at a time in the file selector 
dialog. Thus, you are required to enter a pass­
word for each individual file you want to 
encrypt. If you are encrypting many files at one 
time, consider placing them all into the same 
folder beforehand. This way, you can select the 
entire folder and then only have to enter your 
password one time. 

The best way to protect your data is to create a 
password-protected partition, and then move 
your encrypted files or folders into this parti­
tion. This means that unauthorized users must 
break two levels of password protection instead 
of one to view your data. 

SUM UniCrypt 

Multiple Passwords 

If you select a folder to decrypt and that folder 
contains multiple files with different passwords, 
SUM UniCrypt prompts you to enter only one 
password for the entire folder. All files in the 
folder that have a matching password will be 
decrypted. Those files with a different password 
are bypassed, and SUM UniCrypt reports an 
incorrect password by displaying a dialog 
similar to this: 

11@ NOTE ... 
The password entered for folder 

Employee Records 

is not L.alid for the file named 

Jane Doe 

~.. cancelJ] [Stop Messages) Continue 

Cancel- immediately aborts the decryp­
tion process for the current folder. 

Stop Messages - continues decrypting the 
remaining files in the folder but prevents 
this dialog from appearing every time a 
password mismatch is encountered. 
However, files with mismatched pass­
words are not decrypted. 

Continue - continues decrypting the 
remaining files in the folder and the above 
dialog appears for all subsequent pass­
word mismatches. 

To decrypt those files that were bypassed, you 
must handle each one individually as explained 
under Decrypting Files earlier in this chapter. 

End of Chapter 10 
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SUM Tools is a disk (or, volume), file, and 
memory editing utility. Because most Macintosh 
users rarely have a need to edit these objects, 
SUM Tools is regarded primarily as a program 
for power users - that is, technically minded 
individuals who understand how disks and files 
are structured and what goes on in the memory 
of the Macintosh. 

Some functions are available in SUM Tools, 
however, that typical Macintosh users might 
find helpful in certain situations. For example, 
you can insert Type and Creator codes into files 
following recovery if these codes were not 
recovered. You can also get some useful infor­
mation about your Macintosh that you might 
not have known was readily available. 

SUM Tools 

For instructions on using SUM Tools to insert 
Type and Creator codes, please refer to Appen­
dix B. If you would like to see information about 
your Macintosh, refer to the description of the 
System Information command in the Macin­
tosh menu later in this chapter. 

Please do not use this program to 
edit volumes, files, or memory unless 
you are absolutely sure about what 
you are doing. Making what might 

seem to be a minor change to one of these 
objects can have serious ramifications to the 
extent that you might not be able to use your 
system after making such changes. The program 
does have some built-in controls to prevent 
accidental changes, but they are in no way 
foolproof. 
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Using SUM Tools 

Launching SUM Tools 
Locate the SUM Tools icon on your 
desktop. Select the icon and choose 
Open from the File menu - or, 
simply double-click the icon to 
launch the program. 

You can also launch SUM Tools directly from 
SUM Disk Clinic by choosing it from the Launch 
menu. 

Once SUM Tools has started, the menu bar 
appears on your screen. No windows are open 
at this point. You won't have a window avail­
able until you select the object you want to work 
with - a file, a volume, or memory. 

Selecting Objects 

You select the object you want to work with by 
choosing a command from one of the menus. To 
work with a file, choose Edit File from the File 
menu. To work with a volume, choose Edit 
Volume from the Disk menu. To work with 
memory, choose Edit Memory from the Macin­
tosh menu. 

Choosing Edit File displays a file selector for 
you to locate and open the file you want to edit. 
Choosing Edit Volume displays a volume 
selector with Drive, Eject, and Select buttons for 
selecting the volume you want to edit. Choosing 
Edit Memory immediately opens a window dis­
playing memory contents in hexadecimal 
notation. 

You can have as many different windows open 
on your screen at one time as your Macintosh is 
able to accommodate. 
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SUM Tools Windows 
SUM Tools gives you a wide assortment of 
windows for examining and editing objects. 
Basically, five different windows are available. 
When you are editing files or volumes, the win­
dows are almost identical in appearance. When 
you are editing memory, three of the five basic 
windows are available as are a great many 
additional, special purposes windows. This 
section describes the five basic windows. In the 
sections that follow, you'll learn how to use 
these windows and also learn about the differ­
ences between them. 

(When you are viewing a particular window, we 
normally refer to this as being in a particular 
"mode." For example, when you are working 
with the Hex Edit window, you are in Hex Edit 
Mode.) 

Switching from one window view to another is 
accomplished by choosing the window you 
want from the pop-up menu that always ap­
pears in the upper right corner. 



Hex Edit Window 

When you open any object for editing, SUM 
Tools automatically opens the Hex Edit window, 
similar to this: 

D Edit File: Disle librarian 

Resource Forie 
NumSectors: 149 
Size: 76065 

In Folder: Backups 
Current Sector: 0 
Offset: 0 

00000000 
00000010 
00000020 
00000030 
00000040 
00000050 
00000060 
00000070 
00000080 
00000090 
OOOOOORO 
00000080 
OOOOOOCO 
00000000 
OOOOOOEO 
OOOOOOFO 
00000100 
00000 110 
00000120 
00000130 
00000140 
00000150 
00000150 

PI 

J 0 100 000 I 258B 000 I 248B 0000 0390 
IC07 81FO OOOF 81ED 001F 8F80 007F 
FFFF 81FF FFFF 81FF FFFF 81FF FFFF 
0973 oB20 4C09 5272 0172 5901 oE72 
0000 4150 504C 4C49 4252 2005 0050 
4150 504C 4C49 4252 200~ 0050 OOA~ 

J 0000 0000 0000 0000 0000 0000 0000 
9B08 0751 0000 0000 0001 2921 3F03 
7F83 8070 EOC3 87FO CCC3 81 FO OC03 
OC07 81FO 0007 81FO OOOF 81EO 001F 
007F 81FF FFFF 81FF FFFF 81FF FFFF 
FFFF FFFF FFFF 0000 0080 FFFF FFFF 
FFFF 807F FFFF 807F FFFF 807F FFFF 
807F 887E 001F 887C OOOF 8878 0007 
3F07 8070 7F83 8070 FFC3 8070 E 1 C3 
E lC3 8070 01C3 8070 03C3 8070 0783 
04FO 0000 0500 0000 OooC 0000 04EO 
0020 0000 3F3C 000 I A9FO 08E4 3F3C 
A9FO 09F4 3F3C 0001 A9FO 05CE 3F3C 
A9FO 05DE 3F3C 0001 A9FO OAAE 3F3C 
A9FO OAB8 3F3C 0001 A9FO 01 AC 3F3C 
A9FO 0558 3F3C 0001 A9FO 005E 3F3C 
A9FO 08C2 3F3C 0001 A9FO OoEC 3F3C 

I He" Edit 

Ail: :AiI~oAiI$o~A:n 
AcccAccoAcooAooc 
.Disk Librol""ianr 
.... APPLLlBR .. I 
· .APPLLIBR .. I. ~ 

~~~~: ~~~~A~~~ i?: 
Ac .. ~o .. Ao .. Ao .. 
eA.AoooAoooAooo 
Aooooooo ... AOOOO 
AocFicOAOCAOO 

~~f AP~Apil~Apill 
ApO/Ap ./Ap ./Ap. ~ 
· .. o ....... I ... 0 
..... ?< .. 90. O?< 
.. 90.0?< .. 90.[?< 
· .90. O?< .. 9C.I[?< 
· .90. U?< .. 90 ... ?< 
· .90.X?< .. 90.n?< 
· .90.~?< .. 90.0?< 

The information you see at the top of the Hex 
Edit window varies depending on the type of 
object you are editing. The differences are 
discussed in later sections. 

The Hex Edit window displays an object's con­
tents in both hexadecimal and ASCII notation. 
The leftmost column shows the relative starting 
location of each line (in hex). The next eight 
columns show the actual data content in hex. 
And the far right column shows the character 
(ASCII) translation of the hex data. 

To edit the object's data content, place the cursor 
anywhere within the data or ASCII portion of 
the window and click. This highlights the byte 
under the cursor. You can then change the data 
in the selected byte by typing a new value. 

When you click on a byte, notice that the Offset 
or Cursor value near the top of the window 
changes to indicate the cursor's relative position. 

When you are editing a File or Volume, typing a 
new value into a byte does not immediately 
change the data. To change the data, you must 
use the Write command in the Edit menu. 

SUM Tools 

The preceding statement is NOT 
true when you are editing memory. 
Whatever value you type into a byte 
is immediately recorded in memory. 

If you don't know exactly what you are doing 
at all times, never edit memory! 

For instructions on how to navigate through 
memory or move from one volume or file sector 
to another, see the applicable section later in this 
chapter on File Editing, Volume Editing, or 
Memory Editing. 

Info Windows 

D 
Resource Forie 
NumSectors: 149 
Size: 76065 

Edit File: Disle Librarian 

In Folder: Backups 
Current Sector: 0 
Offset: 0 

Fi Ie Creation Date: 11/7/85 

I File Info 

Last Modi fication Date: 1117/85 Last Backup Date: 1/1/4 

Fi Ie Flogs and Type: 0000 

Fi Ie Type: APPL 

Fi Ie Creator: L1BA 

Fi Ie Flogs: 2100 Bund 

Fi Ie Number' 892 

First Alice Blk Data: a 
Data Fork Logical EOF: 0 Data Fork Physical EOF: 0 

First Alice Blk Asre: 0 

Rsrc Fork Logical EOF: 76005 Asre F crk Phys i co I EOF· 75800 

Fi Ie Clump Size: 0 

Dota Fork Extents: 0 0 o 0 0 0 

Resource Fork Extents: 54017 150 o 0 o 0 

PI 

Both the File Info and Disk Info windows 
convey information specific to the object. While 
the information displayed in each window is 
different, the purpose is the same. Although this 
specific window is not available when editing 
memory, a variation of it is available if you 
choose Mac Info from the pop-up menu (this is 
the same window you see if you choose System 
Information from the Macintosh menu). 
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Map Windows 

The File Map and Disk Map windows show 
graphically how information is allocated on a 
volume. The two windows are almost identical, 
with a few necessary exceptions. Here is an 
example of a Disk Map window: 

Larges t Con t i guous 
0179 KBytes 

Largest Contiguous (available only in the Disk 
Map window) indicates the size of the largest 
contiguous block of free space on the volume. 
Note that this is not necessarily the same as the 
total free space available; it indicates contiguous 
space only. 

Current Sector is a real-time value. That is, if you 
move the cursor directly on top of the allocation 
map, it changes to a crosshair inside a magnify­
ing glass. As you move the cursor over the 
allocation map, the current sector value changes 
constantly to indicate the sector over which the 
cursor is located. 

Below the Current Sector value is a larger 
magnifying glass. As you move the cursor over 
the allocation map, you see a magnified version 
of the map inside the glass. 
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In the case of a Disk Map, the black area within 
the allocation map indicates used sectors of the 
volume; the white area indicates unused sectors; 
the gray area is a frame (it increases and de­
creases according to volume capacity). In the 
case of a File Map, the black area shows where 
the file is located on the disk. 

A map of memory can be viewed by choosing 
Memory Map from the Structure submenu 
while editing memory. The memory map, of 
course, is distinctly different from the File and 
Disk Map windows. It looks similar to this: 

o 
Bllse : 00000000 

Top left: 00000000 
Cursor: 00000000 

Appl icalions running: 2 

CI ick below for I isl. 

~~ 

Memory Edit 

Memory Mep 

tJ SUM Tools -.l 

I 
II structure 

I 
High Ram contains: 

oCode loaded by 1 NITS at 
boot time. Examp I es are 
device drivers, patches 
to the opera II ng sys tern. 

eRam for system caching. 
eSound cmd Disk Buffers 
eScreen Buffers 
eOther dala and storage 

System Parms contains: 

oToolbox Dispatch Table 
oOpera ti ng Sys tem G I oba 15 
.Toolbox Globals 
eOperat i ng System 
Dispatch Table 

oOperating System Globals 
-Trap Uee tors to 

Pressing inside the graphic portion of the map 
displays the Structure submenu. Clicking the 
List box to the left of the graphic shows the 
applications currently running on your system. 



Disasm Windows 

These windows (available when editing any 
object) display the object in its disassembled 
state; that is, a listing of the program instruc­
tions (OpCode, MachineCode, etc.) that are 
executed by the microprocessor when running a 
program. 

D Edit File: Disk Librarian 

Resource Fork In Folder: Backups 
NumSectors: 149 Current Sector: 0 I Disasm I 
Size: 76065 Offset: 0 

00000 0000 DC.~ $0000 
00002 0100 BTST 00,00 
00004 0001 DC.W $0001 
00006 258BOOOI MOVE.L A3, I(A2,DO.~) ~a 
OOOOA 2488 MOVE.L A3, (A2) $0 
OOOOC 0000 DC.~ $0000 
OOOOE 0395 BCLR 01, (A5) ~o 00010 81FO DC.~ $8IFO 
00012 IC07 MOVE .B 07,06 00 
00014 81FOOOOF DIVS.W 15(AO,DO.~),DO Aoo 
00018 81EO DIVS.W -(AO),DO Ao 
OOOIA OOIF DC.~ $OOIF 0 
OOOIC 8F80 DC.~ $8F80 eA 
OOOIE 007F DC.~ $007F 
00020 81FF DC.W $8IFF Ao 
00022 FFFF DC.~ $FFFF 00 
00024 81FF DC.~ $8IFF Ao 
00026 FFFF DC.~ $FFFF 00 
00028 81FF DC.~ $8IFF Ao 
0002A FFFF DC.~ $FFFF 00 
0002C 81FF DC.W $8IFF Ao 
0002E FFFF DC.W $FFFF 00 
00030 OE44 DC.W $OE44 00 

01 

Graphic Windows 

The Graphic windows show the object's hexa­
decimal data in a graphic form: 

D 
Resource Fork 
NumSectors: 149 
Size: 76065 

Edit File: Disk Librarian 

l
in Folder: Backups 
Current Sector: 0 
Offset: 0 

I I Down Bytes/Row I 

I Graphic 

Bytes per Row: 4 

~ 

I2J 

This form of representing data can be useful to 
software developers as a way of breaking down 
data to find out if it is program code, pictures, 
text, icons, and so forth. 

SUM Tools 

File Editing 
File editing allows you to examine and change 
information contained in a disk file. 

To initiate file editing, pull down the File menu 
and choose Edit File. A standard file selector 
dialog appears so you can select the file you 
want to edit. 

After you select a file, SUM Tools displays its 
contents in a Hex Edit window (see the general 
description of this window earlier in this 
chapter). 

Selecting a Fork 

Many Macintosh disk files are comprised of two 
separate forl:s: the Resource Fork and the Data 
Fork. Each fork contains separate components of 
the file. When initially opening a file, SUM Tools 
attempts to open the Resource Fork first. 

You cannot open both forks into separate 
windows at the same time. If you want to switch 
to and edit the fork opposite of the one currently 
displayed, choose Resource Fork or Data Fork 
from the Which Fork submenu in the File menu. 

About the File 

The window title bar shows the window name 
(Edit File) and the name of the file you have 
selected to edit. 

Resource Fork 
NumSectors: 149 
Size: 76065 

Edit File: Disk Librarian 

In Folder: Backups 
Current Sector: 0 
Offset: 0 

Below the window title bar is information about 
the file you have selected: 

Resource Fork or Data Fork indicates which 
fork is displayed in the window. 
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NumSectors: Number of sectors in the fork. 

Size: Number of bytes in the fork. 

In Folder: The folder in which the file is 
located. 

Current Sector: Number of the sector 
currently displayed in the window. 

Offset: Current location of the cursor in the 
sector relative to its beginning. 

Editing File Sectors 

To edit a file sector, you must be in Hex Edit 
mode. See Hex Edit Window earlier in this 
chapter for instructions on changing the actual 
data values of information in a file sector. 

Note that in any other mode (File Info, File Map, 
Disasm, or Graphic) you cannot do any editing 
of the file. These modes are strictly for informa­
tion purposes only. 

Reading File Sectors 

When you first select a file to edit, SUM Tools 
always begins by displaying the first sector of 
the file (that is, sector zero). The Hex Edit 
Window displays one entire sector at a time. Use 
the vertical scroll bar to display other parts of 
the current sector. 

To move from one sector to another, you can use 
either the horizontal scroll bar or the commands 
in the Read submenu (available from the Edit 
menu). See the descriptions of these commands 
at the end of this chapter. 
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Writing File Sectors 

You can, at any point, write the current sector 
back to the volume. For example, after changing 
the data in the sector, you can write that sector 
back to the volume to save your changes. 

& 
SUM Tools makes no logical checks I to ensure that the data you are 

• writing to a volume is accurate. Use 
this function cautiously. 

The program has a built-in safety device to 
prevent accidentally writing to a volume. This 
safety device is the Write Lock command in the 
Edit menu. When the Write Lock command is in 
force (that is, when it is preceded by a check 
mark), you cannot write to the volume. You 
must first select the command to remove the 
check mark, which enables the Write command 
in the same menu. To write the current sector to 
the volume, choose Write. 

Searching File Sectors 

You can search for specific information in a file 
sector using the File Search command in the 
Search menu. See the command description at 
the end of this chapter. 



Volume Editing 
Volume editing allows you to examine and 
change almost any information on a volume, 
from boot blocks to data bytes. 

To initiate volume editing, choose Edit Volume 
from the Disk menu. A dialog appears so you 
can select the disk you want to edit. If necessary, 
use the Drive and Eject buttons to locate the 
volume and then click Select. 

(A special feature is provided for selecting a 
device to edit. This is useful, for example, if you 
want to edit an unmounted volume. To use this 
feature, hold down the Option key while 
choosing Edit Volume from the Disk menu. See 
the description of the Edit Volume command 
later in this chapter for any additional instruc­
tions you might need.) 

After selecting a volume, SUM Tools displays its 
contents in a Hex Edit window (see the general 
description of this window earlier in this 
chapter). 

About the Volume 

The window title bar shows the window name 
(Edit Disk) and the name of the volume you se­
lected to edit. 

0 Edit Disk: SUM II 

Hord Disk SCSI 64 HFS Drive: 6 Driver: FFD8 
NumSectors: 86680 Current Sector: 0 I He" Edit 
Size: 44380160 Offset: 0 

Below the title bar is information about the 
volume: 

I 
Q 

Volume type (Floppy, Hard Disk, etc.) and 
format (HFS or MFS). 

NumSectors: Number of sectors on the 
volume. 

Size: Volume capacity in bytes. 

Drive: Drive number. 

SUM Tools 

Driver: Driver identification in hexadeci­
mal. 

Current Sector: Number of the sector 
currently displayed in the window. 

Offset: Current location of the cursor in the 
sector relative to its beginning. 

Editing Volume Sectors 

To edit a volume sector, you must be in Hex 
Edit mode. See Hex Edit Window earlier in this 
chapter for instructions on changing the actual 
data values of information in a sector. 

Note that in any other mode (Disk Info, Disk 
Map, Disasm, or Graphic) you cannot do any 
editing of the volume. These modes are strictly 
for information purposes only. 

Special Volume Sector Operations 

You can find out which file the current sector is 
part of by placing the cursor in the hex area of 
the window and then pressing down and 
holding the mouse button. While the mouse 
button is depressed, a mini-window pops-up to 
give you this information, as shown below. 
Release the mouse button to clear the mini­
window. 

00000060 
00000070 

6F60 7061 7469 626C 6520 2020 
6F74 2063 6F70 792E 0000 0015 

09f!£gf~~~~~~~~~ 7420 6055 rr; 5554 494F 
SUM QuickCopy (R) 
Disk Sector: 484 
AI location Block: 480 

6F6E 2049 
6F70 5965 
2064 5973 

~:::;:::;::::::;::;=~;:;:;::;:::::;:~::::;:::;:;::;=~~ ~172 5765 
OOOOOOEO 7368 2077 5855 5E20 7468 6520 
OOOOOOFO 6574 2069 7320 696E 7355 7274 

While you are in Disk Map mode, you can 
perform a similar function by placing the cursor 
on top of the allocation map and then pressing 
down and holding the mouse button. This 
displays the mini-window described above and 
also displays a special pop-up menu, as shown 
on the next page. 
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This pop-up menu is a power-user 
feature. Please do not attempt to 
use the commands in this menu 
unless you know specifically what 
you are doing. 

De-Allocate Block can be used to deallocate the 
sector currently under the cursor. 

Read Disk Block causes an immediate read of 
the sector currently under the cursor. The sector 
is read into memory, SUM Tools automatically 
switches to Hex Edit mode, and the sector data 
appears in the Hex Edit window. 

Reading Volume Sectors 

When you first select a volume to edit, SUM 
Tools always begins by displaying the first 
sector of the volume (that is, sector zero). The 
Hex Edit Window displays one entire sector at a 
time. Use the vertical scroll bar to display other 
parts of the current sector. 

To move from one sector to another, you can use 
either the horizontal scroll bar or the commands 
in the Read submenu (available from the Edit 
menu). See the descriptions of these commands 
at the end of this chapter. 

Writing Volume Sectors 

You can, at any point, write the current sector 
back to the volume. For example, after changing 
the data in the sector, you can write that sector 
back to the volume to save your changes. 
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SUM Tools makes no logical checks 
to ensure that the data you are 
writing to a volume is accurate. Use 
this function cautiously. 

The program has a built-in safety device to 
prevent accidentally writing to a volume. This 
safety device is the Write Lock command in the 
Edit menu. When the Write Lock command is in 
force (that is, when it is preceded by a check 
mark), you cannot write to the volume. You 
must first select the command to remove the 
check mark, which enables the Write command 
in the same menu. To write the current sector to 
the volume, choose Write. 

Searching Volume Sectors 

You can search for specific information in a 
volume sector using the Disk Search command 
in the Search menu. See the command descrip­
tion at the end of this chapter. 



Memory Editing 

PLEASE NOTE: Editing Macintosh memory 
with SUM Tools requires a great deal of 
caution. Unlike editing volumes and files, 
there is no Write Lock feature available to 
prevent accidentally making a change. So, 
when you select a byte in the Hex Edit window 
and type any character on your keyboard, 
memory is changed immediately and irreversi­
bly - there is no way to undo the change. In 
some cases, you can reverse the change by 
restarting your Macintosh; but in other cases, 
even this is not possible (if, for example, you 
make a change to Parameter RAM). DO NOT 
EDIT MEMORY UNLESS YOU ARE PRE­
PARED FOR THIS POSSIBILITY! 

One of the features available with memory 
editing is the ability to display information 
about your Macintosh. However, the identical 
information is also available by choosing 
System Information from the Macintosh menu. 
If all you want to do is see this information, use 
the menu command rather than entering mem­
ory editing mode. 

Memory editing allows you to examine and 
change any information currently in memory. 

To initiate memory editing, choose Edit Mem­
ory from the Macintosh menu. The Memory 
Edit window opens immediately and SUM 
Tools automatically places you in Hex Edit 
mode. The Hex Edit window initially displays 
the contents of low memory starting at address 
zero. 

SUM Tools 

About Memory 

The window title bar shows the window name -
Memory Edit . 

D-- Memory [lilt -

Bose: 00000000 
Top left: 00040FAO I HeH [llit 

Cursor: 00041 ODD 
0OO40FAO FFEO A878 2F2E FFD8 A873 4E~E 4E7:5 4E50 OO~x/_ O\i~sWN"NIJ 
00040FBO FFEC 48EE 6003 FFFO 206C FFD6 2066 062A OOHO' _ 00 10+-h.* 

Below the title bar is information about your 
current location in memory: 

I 
g 

Base: Indicates the area of memory that is 
being displayed in the window when the 
scroll box is at the top of the vertical scroll 
bar. You can adjust the Base by choosing 
New Memory Base from the Macintosh 
menu. See the command description later 
in this chapter for more details. 

Top Left: Indicates the memory address 
currently displayed at the top left part of 
the window. 

Cursor: Indicates the cursor's present 
location. 

Editing Memory 

To edit memory, you must be in Hex Edit mode. 
See Hex Edit Window earlier in this chapter for 
instructions on changing the actual data values 
of information in memory. 

Note that in any other mode (Mac Info, Struc­
tures, Disasm, or Graphic) you cannot do any 
editing of memory. These modes are strictly for 
information purposes only. 
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Special Memory Edit Operations 

Pressing down and holding the mouse button 
while the cursor is in the hex area of the window 
displays the Structures pop-up menu (which 
can also be accessed via the pop-up menu in the 
upper right corner of the window). This gives 
you immediate and direct access to standard or 
customized structures while you are editing 
memory. Please see Using Structures later in this 
section for more information. 

Navigating Through Memory 

Use the vertical scroll bar to move to different 
locations in memory. 

The File Buffer Base and Disk Buffer Base 
commands in the Macintosh menu provide a 
way to move to these particular memory loca­
tions quickly and easily. See the command 
descriptions later in this chapter for further 
explanations. 

Searching Memory 

You can easily locate any hexadecimal or ASCII 
character string in memory using the Memory 
Search command in the Search menu. Once 
again, see the command description later in this 
chapter for instructions. 

Using Structures 

When you are examining or editing memory, it 
is often very difficult to know exactly what you 
are looking at in a window. This is because what 
you are normally seeing is a string of hexadeci­
malar ASCII characters without any meaningful 
structure. For example, when you look at data in 
the Hex Edit window, you are viewing the data 
in an unstructured form - but when you look at 
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the same data with the Memory Map structure, 
what you see is much more meaningful and 
descriptive. But, essentially, what you are seeing 
is the same information in both cases. 

To make it easier for you to peruse and edit 
memory, SUM Tools provides several prede­
fined structures for your use. And, if you wish, 

"'Memory Map 
Unit Table List 
Unit Entry 
ueB Queue 
UeB Entry 
Drlue Queue 
FeB 
FeB Entry 
UBL Queue 
Working Directory Queue 
Loaded Structure EHample 

you can also create your 
own customized struc-
tures. 

All predefined struc­
tures can be accessed 
through the Structures 
submenu - which is 
available in the pop-up 

menu at the upper right corner of the Memory 
Edit window and, as mentioned earlier, by 
pressing down and holding the mouse button 
while the cursor is in the hex area of the Hex 
Edit window. If you create your own structures, 
they can be added to the Structures submenu. 

SUM Tools gives you ten predefined structures. 
An eleventh structure is provided as an ex­
ample. 

If you would like to create your own customized 
structures, please refer to Appendix C for 
instructions and examples. 

[Ia -- .. ---
When you use any of the predefined 
structures, you will sometimes see a 
delta symbol (.1) at the beginning of a 
line. This symbol indicates that the 

particular line item also has an underlying 
structure. Clicking the line item displays its 
underlying structure. 



Memonj Map Structure 

This structure provides a graphic illustration of 
your current Macintosh memory showing where 
each application is executing and the amount of 
memory allocated to it. Click the List button to 
see more information about the applications that 
are currently running. 

0- Memory Edit 

Bose: 00000000 I 
Top Left: 00000000 Memory Mop II Structure 

Cursor: 00000000 I 
t."~'!':r:~P .. .. . ~Oq8qOqOO . H i ~h Ram con to i ns: Q 

SUM Tools .Code loaded by INITS at 
boot time. Examples are 
device drivers, patc.hes 

Appl icalions runnin~: 2 to the operating system. 
eRam for sys tem each i no . 
.Sound and Olsk Buffers 

Click below for list. .Screen Bu ff ers 

6~ 
eO ther do to and 5 loroge 

System Parms contains: 

.Toolbox Dispatch Table 

.Opera t i ng Sys tem 0 lobo I s 

~\J~~~,!, .. ~~r:'~ ..... $~O~O.'E~O ... .Toolbox Globals 
.Opera t i ng Sys tem 

I Sys tem' parms'l Dispatch Table 
.Operating System Globals 
.Trap Uectors 

~ 
I2J 

Unit Table List Structure 

This structure shows a list of currently loaded 
drivers along with some pertinent information 
about each one. 

OevDrvr Address Nome 

2 FFFD 40810000 /Og(&008/0 I o OY\.;-\8f8,rJ+ngOoOIi'/Os> 
3 FFFC 0082FO 10 . Sound 
4 FFFB 0082D72C . Sony 
5 FFFA A082AB92 .Aln 
6 FFF9 A082ABAA .AOut 
7 FFF8 A082ABC2 .Bln 
8 FFF7 A082ABDA .BOut 
9 FFF6 0082C 19C .MPP 
10 FFF5 0082B480 .AlP 
12 FFF3 40810000 / Og (&008/0 I D Oy \.;- \8 f 8,r J+ng Do o Ii' / OS> 
13 FFF2 007FEEEC . SymPart it i on 
32 FFDF 00005442 . SCS I 00 
34 FFOD 0000404C .SCSI 87.07.10512 
35 FFOC 00035150 .M3R SCSI 
36 FFOB 0002C414 .00 taPakDr i ver4 

" 48 FFCF 80003840 .Radius GSC 

SUM Tools 

Unit Table Entnj Structure 

This is an underlying structure for the Unit 
Table List structure. If you choose this structure 
while working in the Hex Edit window, SUM 
Tools assumes that the byte immediately under 
the cursor is the first byte of a driver entry in the 
Unit Table. 

48 FFCF 

80003034 
4C60 
o 
o 

tJ. 80003840 
Nome 
4COO 
51 

tJ. 80003932 
tJ. 80003840 
tJ. 80003AE8 
tJ. 80003F30 
tJ. 80003ACO 

Dr i ver Re f erence Number 

Dev i ce Con tro I En try Address 
DCE Flogs 
DCE Pos i ti on 
DCE Periodic Ticks 

Dev i ce Dr i ver Code Address 
. Rad i us GSC 
Dr i ver Flogs - > C tiS to tus 
Dr i ver Ticks 
Open Rou tine 
Pri me Routi ne (Read and Wr i te) 
Contro I Rout i ne 
S ta tus Rou ti ne 
Close Rout i ne 

VCB (Volume Control Block) Queue 

Displays a list of all current volumes along with 
additional information from the operating 
system. 

- Address Sig 

"1 000052EC 4244 
2 00012508 4244 
3 000285B4 4244 

VCB Entry Structure 

Dr i ver Dr i ve Name 

FFDF 
FFDD 
FFFB 

HD 40 
DO 50 
SUM~ -2 

This is an underlying structure for the individ­
ual items in the VCB Queue list. If you choose 
this structure while working in the Hex Edit 
window, SUM Tools assumes that the byte 
immediately under the cursor is the first byte of 
a Volume Control Block. 

000286B4 
0000 
4244 
9EOEE883 
0000 

Queue Link 
VeB Flags 
VCB Signa ture Word 
veB Creo le Dale 
VeB A llr i bu tes 
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Drive Queue Structure 

Provides information about the various drives 
attached to your Macintosh. Note that this 
structure includes SCSI devices as well as floppy 
drives. 

Address Drive Drivel" FSID Num...Blks Inplace Double wrtProt NonEJect 

00002EF8 FFFB 155535 Yes Yes Yes No 
00003800 FFDD 103590 No No No Yes 
000048A2 FFDF 80000 No No No Yes 
0000A518 FFDB 0 No No No No 
00013254 FFDC 85584 No No No No 
00025990 FFDC 85584 No No No No 

FCB (File Control Block) Structure 

Provides information about all files currently 
open on your Macintosh. 

FCB Size - 3752 En try Size - 94 Max Open F i 1 es - 40 Open F i 1 es - 30 

Address LEOF i oRe f F i I eJiame 1..10 I Jiame 

IJ. 00005795 308593 2 System (R) HD 40 
000057F4 320512 96 (D) HD 40 
00005852 320512 190 (0) HD 40 
000058BO 49432 284 Mu 1 t I Finder (R) HD 40 
0000590E 414720 378 (D) DO 50 
0000595C 414720 472 (0) DO 50 

IJ. 000059CA 215071 556 MasterJugglerN (R) HD 40 
A 00005A28 179968 560 Bi tmap Fonts 1 (R) HD 40 
IJ. 00006A85 294122 754 Standard DAs (R) HD 40 
IJ. 00006AE4 14714 848 Sw I tch-A-Roo. FK ... (R) HD 40 
IJ. 00006B42 1011785 942 Standard (R) HO 40 
IJ. 00005BAO 2484 1036 Ch I cagoSymbo 1 s (R) HO 40 
IJ. 00005BFE 259848 1130 Bi tmap Fonts 2 (R) HD 40 
IJ. 00005C5C 4299 1224 Zoom OA (R) HD 40 
IJ. 00006CBA 214795 1318 Tempo 11 1.0.20 (R) HO 40 
IJ. 00005018 3394 1412 Tempo I 1 Macros (R) HO 40 
IJ. 00005075 4923 1506 Backgrounder (R) HD 40 

FCB Entry Structure 

This is an underlying structure for the individ­
ual files listed in the FCB structure. If you 
choose this structure while working in the Hex 
Edit window, SUM Tools assumes that the byte 
immediately under the cursor is the first byte of 
the file's Control Block. 
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Name 
284 
788 
768 
49432 
50176 
2805 
000052EC 
00000000 
o 
000002E8 

MultiFinder 
ioRefnum 
Fi leNumber 
Flags ResFrk WrtPerm 
Logical EOF 
Physical EOF 
Current Position 
VCB Address. Name -> HD 40 
Fi Ie Buffer 
Fi Ie Directory Block 
Parent Directory 10 

Symantec Utilities for Macintosh 

VBL (Vertical Blanking) Queue Structure 

Provides information about the procedures 
installed in the VBL queue. These procedures 
are called 60 times per second. 

Address ProcPtr Task..Freq Task...Phase 

Il 00002EAC 0082E23E 14 0 
Il 0000301C 0082F3FE 51 9 
Il 00004858 00005E18 83 0 
Il 00024E22 0082C7DA 11 0 
Il 00025A04 00828ACC 36 0 
Il 007F0074 007EE46C 1 0 
Il 00774AEA 0078A542 32467 0 

Working Directory Queue Structure 

Provides information about your working queue 
of directories. 

VCB Pointer DirlD ProelD Volume Name 

000052EC 00000841 00008023 HD 40 
000052EC 000002E8 00000000 HD 40 
000052EC 000002E8 4552494B HD 40 
00012508 00001C7E OOOOOOOA DO 50 
000052EC 00000848 00000000 HO 40 
00012508 0000 139E OOOOOOOA DO 50 
0OOO52EC 000002E8 OOOOOOOA HO 40 
000052EC 000008FB OOOOOOOA HO 40 
00012508 00001E4A OOOOOOOA DO 50 
000052EC 00000841 OOOOOOOB HO 40 
000052EC 000002E8 OOOOOOOB HO 40 

Defining and Loading Structures 

There are 11 predefined structures available in 
the Structures pop-up menu in the Memory 
Edit window. These are common File system 
and operating system structures; however, you 
can also define and load your own structures. 
Appendix C, SUM Tools Structures, contains 
complete instructions and examples for defining 
your own structures. 



SUM Tools Menus 

File Menu 

Which Fork 

Edit File Attributes... :l€A 
Set File Logical EOF ... 

Other File Tools 

Page Setup ... 
Print Front Window... :l€P 

SUM Disk Clinic :l€D 
Transfer... :l€T 

Quit 

Edit File 

Use this command to select the file you want to 
edit. 

When you select Edit File, a standard file 
selector dialog appears so you can locate and 
open the file you want to edit. If necessary, use 
the Drive and Eject buttons to open a file on a 
different volume. 

You can open and edit only one file at any given 
time. That is, if a file is already open when you 
choose Edit File, the current file is closed as 
soon as you open a new one. 

Which Fork 

Choosing this command displays a submenu for 
selecting the fork of the file you want to edit­
the Resource Fork or the Data Fork. 

......... Resource Fork: 
Data Fork: 

SUM Tools 

Use this command to select and display the 
Resource Fork of the file you are editing. A 
check mark appears next to the command to 
indicate it is the currently selected fork. You also 
see the selected fork indicated in the left panel of 
the Edit File window. 

Edit File Attributes 

This command displays a dialog showing the 
attributes assigned to the currently selected file: 

Type I APPL Creator III BR 

D Locked [8J bFOwnAppl D File Protected 

D Inuisible D Changed D File Locked 

[8J Bundle [8J Inited D File Busy 

D System D Shared 
File Position 

DBozo D Cached 

D Reserud1 [8J Reserud2 D On Desktop 

D Always Switch Launch "oriz 1166 
D Neuer Switch Launch Uert I~i 

n Cancel D (Change) 

You can change the file's attributes by making 
the appropriate changes in this dialog and 
clicking Change. 
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Set File Logical EOF 

This command can be used to set the logical 
end-of-file (EOF) marker for the current fork of 
the file you are editing. Choosing the command 
displays this dialog: 

Set Logical End-of-File 

File Name Disk Librarian 

Current Logical EOF 76065 

New Logical EOF IRani Enter in 
Decimal 

Set EOF I( Cancel H 

Other File Tools 

Choosing this command displays a submenu 
with commands you can use to create or delete a 
file. 

Create File ••• OOK 

Delete File ••. OOY 

Create File 

Choosing this command displays a dialog in 
which you must enter the minimum information 
required to create a new file: 

Create File 

New File Name L-IM...:..YF_II_e _____ _ 

Data Fork Physical [OF LI 0 __ ---'1 ~~~~~~~ 

o Rllocate Contiguous 

Type 111?? I 
Creator I ?11? I 

Create 1 Cancel n 
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Delete File 

Choosing this command displays the standard 
file selector dialog so you can locate and select 
the file you want to delete. 

Page Setup 

Displays the standard Macintosh dialog for 
setting printer options used in conjunction with 
the Print Front Window command described 
next. 

Print Front Window 

Prints the contents of the front-most window 
now on your screen. 

SUM Disk Clinic 

Terminates SUM Tools and launches SUM Disk 
Clinic. 

Transfer 

Terminates SUM Tools and launches the appli­
cation program you select. 

Transfer is especially useful after making 
changes to a disk or file. You use it to launch the 
parent application and verify that your changes 
were correct. 

When you use Transfer to launch another 
application, you do not return to SUM Tools 
when quitting that application - you return to 
the desktop. 

Quit 

Terminates SUM Tools and returns you to the 
desktop. 



Edit Menu 
.:rin.. 

I: ut :$;H 
I:opq :$;C 
Pas1 (~ :$;l} 
U~~ar 

Read .. 

Write Lock: 
Write 

Read 
Displays a submenu containing commands you 
can use to read the various sectors of the file or 
disk you are editing. 

~ Read Absolute Sector... ~G 

Read NeHt Sector ~N 

Read Preuious Sector ~B 

Read Current Sector ~R 

Read Absolute Sector 

Use this command if you know the sector 
number of the sector you want to read next. You 
will be prompted to enter the sector number. 

Read Next Sector 

Reads the next sector of the file or volume. 

Read Previous Sector 

Reads the previous sector of the file or volume. 

SUM Tools 

Read Current Sector 

Rereads the current sector back into memory 
from the volume and displays it in the window. 

This command allows you to discard any 
changes you might have made to the current 
sector, provided you have not written the 
changes to the volume (see Write command). 

Write Lock 

This command provides a measure of safety by 
preventing you from accidentally writing a 
modified sector to a volume. When Write Lock 
is active (as indicated by the check mark next to 
the command), you cannot write to the current 
volume. 

If you make changes to the current sector and 
you want to save them, you must choose Write 
Lock to deactivate this safety feature. When you 
choose this command, the check mark is re­
moved from the menu and the Write command 
(see following description) becomes available. 

SUM Tools automatically activates the Write 
Lock feature every time you choose a new 
volume or file to edit. 

Write 

Writes the current sector back to the volume. 

Write is available only when the Write Lock" 
feature is deactivated (see preceding command). 
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Volume Menu 

Edit Uolume .•. OOJ 

Write Boot Blocks 
Edit Boot Blocks .•• 

Edit Volume 

Use this command to select a volume to edit. 

When you choose this command, a dialog 
appears so you can select .the volume you want 
to use. If necessary, use the Drive and Eject 
buttons to locate the volume, and then click 
Select. 

After reading the volume, SUM Tools automati­
cally places you in Hex Edit mode. 

Special Volume Operations 

SUM Tools provides you with a way to edit 
unmounted volumes and SCSI devices. To select 
an unmounted volume to edit, hold down the 
Option key while choosing Edit Volume from 
the Disk menu. This dialog appears: 
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Cliclc an icon to select the type 
of driuer to use: 

Cliclc this icon to directly edit 
a SCSI deuice. RII of the 
deuice is auailable for edit. 

~ Cliclc this icon to edit a deuice 
c::::::J driuer in the Unit Table. 

l~) 

Symantec Utilities for Macintosh 

Click one or the other of the two icons in this 
dialog to specify which type of device you want 
to edit. If you click the SCSI icon, you see a 
dialog like the one below. If you click the other 
icon you see an almost identical dialog, with 
some minor exceptions. 

Select B SCSI by clicking on the ICON 

Portl t Ions on SCS I' 
1. DO 50 HFS Partition 

lk'~:I""'" fI3I'UU"" tllP<'. 

Click the icon for the device you want to select 
and click OK. 

Once you select a device, the SUM Tools win­
dows work as described earlier in this chapter 
with these differences: 

• The selected device does not have to be 
mounted for you to access it. 

• Allocation maps are not available. 

• Disk Info is not available if you selected a 
driver. It is available if you select a SCSI 
device. 

• The information displayed pertains to the 
drivers and partitions found on the SCSI 
device. 



Write Boot Blocks 

This command writes the boot sectors (sectors 
zero and one) onto the currently selected 
volume. The programs asks for your confirma­
tion before writing the boot sectors. 

You would not normally write the boot sectors 
unless you have changed them using the Edit 
Boot Sectors command (described next). 

This command changes the boot 
information on your volume. Used 
improperly, changing the boot 
sector information might prevent 
you being able to start up from the 
volume. 

Edit Boot Blocks 

This command reads the boot sector information 
from the current volume and displays it in a 
dialog similar to this: 

Boot Blocks Uersion it 
System Resource File Name I System 

~========1 
System Shell name I Finder 

p=========i 
Debugger File Name I Macsbug 

F==~======l 
Disassembler File Name I Disassembler 

F=========l 
Startup Screen File Name I StartUpScreen 

File to run on Startup I Finder 
F=========l 

Scrap File Name I Clipboard File 
F=========l 

MaH Number of Open Files 110 

MaHimum number of Euents 1=12=0 ========l 

System Heap Size (for 12BK) 117152 
p=========i 

System Heap Size (for 512K) '-11_31_0_72 _____ ----' 

I[ Cancel )1 [ Change 1 

You can change the boot sector information by 
altering it in the dialog. If you make changes 
that you want to save, click Change to clear the 
dialog from your screen and then choose Write 
Boot Blocks from the Disk menu (see preceding 
command description). 

SUM Tools 

Search Menu 

File Search ... S€H 
Disk Search ... :3€S 
Memory Search ... S€l 

Find NeHt 

File Search 

This command is available only when the Edit 
File window is active. 

File Search displays a dialog you can use to 
search for hex or ASCII information in the 
current file fork: 

Search File 

Search For: 
@HeH 

OASCII 

Search String L-.I __________ --.JI 

~. Cancels Search in Progress 

Find Cancel 

Click either Hex or ASCII, depending on the 
type of information you want to locate. 

In the Search String text box, enter the data you 
want to locate. (The function is not case-sensi­
tive - you can enter uppercase or lowercase 
characters.) 

Click Find to initiate the search, or click Cancel 
to cancel this function. Type ~-. to terminate a 
search in progress. 
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When you click Find, the search proceeds from 
the beginning of the current sector. If the search 
string is located, it is displayed in the window 
and the cursor is placed at the beginning of the 
string. 

To find the next and any subsequent occur­
rences of the search string, choose Find Next 
from this menu. 

Disk Search 

This command is available only when the Edit 
Disk window is active. 

Disk Search displays a dialog exactly like the 
one displayed by the File Search command (see 
above). 

Memory Search 

This command is available only when the 
Memory Edit window is active. 

The dialog you see after choosing Memory 
Search is similar to that used for File and Disk 
searches, but with one important difference. The 
dialog gives you the ability to specify the area of 
memory you want to search by entering From 
and To values: 
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- Search Memory 

Search Memory For: 

Search String 

Search Range 

@HeH 

o ASCII 

From ...-10--------,1 [set Range to All RAM 1 

To 10 I (set Range to All ROM] 

3€. Cancels Search in Progress 

[( Find a Cancel 

Symantec Utilities for Macintosh 

Clicking Set Range to All RAM automatically 
inserts the lower limit of your Macintosh mem­
ory into the From text field and the upper limit 
into the To text field. 

Clicking Set Range to All ROM works similar 
to the preceding button except that the lower 
and upper limits of your available ROM are 
inserted into the appropriate text fields. 

Find Next 

Locates the next occurrence of the search string 
entered into the File Search, Disk Search, or 
Memory Search dialogs. 



Macintosh Menu 

System Information ..• 3€ I 

Edit Memory 

New Memory Base ... 
File Buffer Base 
Disk: Buffer Base 

Structures 

Rdd Structure ... 

3€E 

System Information 

This command displays a window containing 
various facts about your Macintosh, such as 
computer type, memory size, ROM size, and so 
forth. 

o Memory Edit 

Computer Type : Macintosh II I 
Memory : 8192k (8 Megabytes) I Mac Info 
Rom Size : 250k (Color QuickDraw ) 

System Version : 6.02 (MF) Rom Version: 376 
Mounted Volumes: 3 SCSI Drives :2 

Screen Resolution : 72 x 72 pixels per inch 
Screen Si ze : 1152 x 882 

Processor : 68020 
Co-Processor 68881 : Yes 
D8rll per Mlllisec : 2620 

Key80llrd Type : Extended AD8 

AppleTlll1c Version : 49 

You cannot change anything in this window, it 
is strictly for observation. 

You can display this same window by selecting 
the Mac Info command from the pop-up menu 
in any Memory Edit window. 

SUM Tools 

Edit Memory 

Choosing this command immediately places you 
in Memory Edit mode. While in this mode you 
can examine and edit your Macintosh memory, 
and you also have access to the various menu 
commands associated with this function. 

Please be sure to read the caution at the begin­
ning of the section titled Editing Memory before 
entering Memory Edit mode. 

New Memory Base 

This command makes it possible for you to 
"position" the Memory Edit windows anywhere 
in your Macintosh memory. When you choose 
the command, you see this dialog: 

Enter new Memory Base. 
This is where 0 on the 
uerticlIl scroll bar is set. 

Enter the memory address where you want to 
position the window and click OK. 

This command effectively adjusts the base 
location of the scroll box in the window's 
vertical scroll bar. For example, if you enter 1000 
in the above dialog and then slide the scroll box 
to the top of the scroll bar, your window dis­
plays memory starting at the address you 
entered, i.e., 1000. 

The purpose of this command is to make it easy 
for you to set the window location to a specific 
area of memory and avoid having to subse­
quently "fish around" to find the same location 
again after navigating through memory. It is 
also a useful feature when you know the specific 
address of the area of memory you want to view 
in the window. 
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File Buffer Base 

Choosing this command automatically sets your 
memory base to the area where the File Buffer 
begins. This makes it easy for you to set the 
Memory Edit window's position to the same 
location in memory as the File Edit window. 

Disk Buffer Base 

Choosing this command automatically sets your 
memory base to the area where the Disk Buffer 
begins. This makes it easy for you to set the 
Memory Edit window's position to the same 
location in memory as the Disk Edit window. 

Structures 

Displays the Structures submenu so you can 
choose the structure you want to use to view 
memory. See Using Structures earlier in this 
chapter for complete details. 
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D ../Memory Map 
Unit Table list 
Unit Entry 
UCB Queue 
UCB Entry 
Driue Queue 
FCB 
FCB Entry 
UBL Queue 
Working Directory Queue 
Loaded Structure [Hample 

Symantec Utilities for Macintosh 

Add Structure 

Use this command to add a customized struc­
ture you have created to SUM Tools. Instruc­
tions for creating customized structures can be 
found in Appendix C. 

Choosing this command displays this dialog: 

Rdd nn SSTH structure resource. 

[lick ·Select TeHt rile' to odd SSTH 
structure resources to the SUM Tools 
progrllm. Select II TEHT file thllt 
contains the structure definition. SUM 
Tools will conuert It and odd It to the 
Structures submenu. 

See your U·ser Guide for more 
Information on SSTH resources. 

[ Select TeHt rile) [ancel 

Click Select Text File and a standard file 
selector dialog appears so you can locate and 
select the TEXT document containing the 
customized structure you want to add to SUM 
Tools. When you click Open, SUM Tools 
converts the TEXT document to a valid structure 
and then adds your new structure to the Struc­
tures submenu so that you can use it. 

End of Chapter 11 



Error Messages 

This appendix contains descriptions of SUM 
error messages. It is divided according to the 
particular program in which the error message 
appears. The error messages are listed alphabeti­
cally within each section. 

[EJ Those errors with a problem descrip-
I ::.~ tion reading "U nexpected Error" are 

extremely rare and should not occur. If 
you receive such an error, it is proba­

bly because some other error occurred on your 
system that SUM II cannot reconcile. In such 
cases, we recommend you check your hardware 
and software thoroughly. If you cannot resolve 
the problem, contact Symantec Product Support. 

SUM Install ...................................................... A-2 

SUM Disk Clinic ............................................. A-3 

SUM Recover ................................................... A-6 

SUM TuneUp ................................................ A-10 

SUM BackUp ................................................. A-13 

SUM Partition ................................................ A-14 

SUM QuickCopy ........................................... A-1S 

SUM Encrypt ................................................. A-17 



Appendix A 

SUM Install 

Cannot install SUM. Not enough contiguous free 
space on volume. 

PROBLEM ... There is not enough contiguous free 
space on the volume where you are attempting to 
install SUM. The volume might have enough total 
free space, but it is not contiguous. 

SOLUTION ... You can run SUM TuneUp from one of 
your disk copies to optimize the problem volume 
and create additional contiguous free space. See 
Chapter 6 for instructions on using SUM TuneUp. 

Cannot install SUM on File Server. Install 
cancelled. 

PROBLEM ... The SUM components cannot be 
installed on file servers. 

SOLUTION ... None. You cannot do this operation. 

Cannot locate volume. SUM Install cancelled. 

PROBLEM ... Unexpected Error. 
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Cannot locate volume. Volume Restore Record 
NOT installed. 

PROBLEM ... SUM Install cannot locate the volume 
you have selected for installing the Volume Restore 
Record. The volume is probably not mounted. 

SOLUTION ... Finish installing the other SUM 
components and then rerun SUM Install after 
mounting the volume in question. 

Cannot open volume. SUM install cancelled. 

PROBLEM ... Unexpected Error. 

Not Installed, cannot create ... 

PROBLEM ... Unexpected Error. 

Unknown partition type. 

PROBLEM ... Unexpected Error. 

Unknown volume structure. Install cancelled. 

PROBLEM ... Unexpected Error. A volume where 
you are attempting to install one or more SUM com­
ponents has a structure that SUM Install cannot 
recognize. The program cannot access this volume. 



SUM Disk Clinic 

Destination volume MUST have at least 40k free 
space. 

PROBLEM ... The volume on which you are attempt­
ing to save a backup copy of a Volume Restore 
Record does not have the minimum amount of free 
space available (40k bytes). 

SOLUTION ... You can either use a different Destina­
tion volume, or you can remove enough files from 
the current volume to free up enough space. 

Disk is full. Cannot continue. 

PROBLEM ... There is no free space on the disk 
where you are attempting to store information. 

SOLUTION ... Use a different disk. 

Disk is locked. Cannot continue. 

PROBLEM ... The disk on which you are attempting 
to store information is in a locked state. 

SOLUTION ... lf the disk is a floppy, quit the pro­
gram, eject the disk, slide the Write Protect tab so 
that it covers the hole in the disk, and try again. 

If the disk is a hard disk, quit the program, choose 
Get Info from the desktop File menu, and click to 
remove the X from the "Locked" check box. 

If the disk is a removeable disk cartridge, check the 
manufacturer's instructions for locking and 
unlocking. 

Duplicate file on volume. Cannot continue. 

PROBLEM ... You are attempting to write a file onto 
a volume, but the volume already contains a file with 
the same name. SUM Disk Clinic will not overwrite 
the existing file. 

SOLUTION ... Quit the program, remove the existing 
file from the target volume, and try again. Or if 
possible, give the file you are attempting to save a 
different name. 

Error Messages 

Error backing up record. Cannot continue. 

PROBLEM ... An undetermined error occurred while 
trying to create a backup copy of the Volume Re­
store Record. 

SOLUTION ... The volume on which you are attempt­
ing to store the backup copy might be unusable. Try 
again using a different volume. 

Error creating VIF. Cannot continue. 

PROBLEM ... Unexpected Error. 

Error in split file Control Record. Cannot continue. 

PROBLEM ... Unexpected Error. A disk read/write 
error occurred in the Control Record segment while 
attempting to restore a split file. The file or the disk 
itself might be damaged. 

SOLUTION ... This is an unexpected error. Your only 
solution is to recover the file again. 

Error in split file segment. Cannot continue. 

PROBLEM ... A disk read/write error occurred while 
attempting to restore a split file. The file or the disk 
itself might be damaged. 

SOLUTION ... See preceding error message. 

Error opening VIF. 

PROBLEM ... An undetermined error occurred when 
trying to open the Volume Information File you 
selected. 

SOLUTION ... Use the Create Volume Info File 
command in the Options menu to create a new VIF 
for the device and then try again. 

Error removing Shield files. 

PROBLEM ... Unexpected Error. 
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SUM Disk Clinic (continued) 

Error while unsplitting file. Cannot continue. 

PROBLEM ... A disk read/write error occurred while 
attempting to restore a split file. The file or the disk 
itself might be damaged. 

SOLUTION ... See "Error in split file Control Rec­
ord ... " on preceding page. 

File system error has occurred. Cannot continue. 

PROBLEM ... An error occurred while attempting to 
write the file 'DiskCliniclnfo' on your startup volume. 
('DiskCliniclnfo' is the file SUM Disk Clinic places in 
the system folder on your startup volume to pass 
required information to the SUM Recover program.) 

SOLUTION ... Quit SUM Disk Clinic and then select 
a different volume as your startup device. Restart 
your system from the new device and rerun SUM 
Disk Clinic. If you receive this message again, treat 
it as an Unexpected Error. 

If this message isn't displayed on your second 
attempt, your original startup volume might be 
damaged somehow, such as a bad disk sector. We 
recommend you use the Lock Out Bad Sectors op­
tion in SUM TuneUp on this volume to see if it does 
contain bad sectors. 

Locked; not available. 

PROBLEM ... A volume you are attempting to use is 
locked and, therefore, not available to the program. 

SOLUTION ... Unlock the volume and try again. 
(Also see the message "Disk is locked ... " on 
preceding page). 

No Device Partition Map on drive. 

PROBLEM ... The device you are attempting to 
access does not contain a Device Partition Map. 
Without this map, the program cannot read or write 
information on the device. 

SOLUTION ... You need to load a VIF for this 
volume. Click Load VIF at the bottom of the window 
and select a VIF for the volume. 
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None added. 

PROBLEM ... The program could not locate any 
volumes while trying to collect new configuration in­
formation. The only time this will occur is if electrical 
power is not reaching a device. 

SOLUTION ... Turn on the power to your devices. 

Not enough memory. Cannot continue. 

PROBLEM ... SUM Disk Clinic was unable to obtain 
enough memory to run. 

SOLUTION ... lf you are running under MultiFinder, 
increase the amount of memory allocated to the 
program (use the Get Info command in the desktop 
File menu) and try again. 

If you are running under Finder and have only one­
megabyte of memory on your Macintosh, you are 
probably loading too many startup documents, desk 
accessories, or fonts, and there is not enough room 
for the program to run. You'll have to remove one or 
more of these items and try again. You should also 
turn off the RAM Cache in your Control Panel if it is 
currently on. 

Out of memory. Cannot configure. 

PROBLEM ... SUM Disk Clinic ran out of available 
memory while attempting to create new configura­
tion information (occurs only when you choose 
Manual Configure from the Options menu). 

SOLUTION ... 1f you are running under MultiFinder, 
increase the amount of memory allocated to the 
program (use the Get Info command in the desktop 
File menu) and try again. 

Source and Destination must not be the same 
drive. 

PROBLEM ... When recovering deleted files from a 
volume on which the Shield Deleted File Record is 
not installed, this can result in permanent loss of 
files from the Source volume. 

SOLUTION ... Select a different Destination volume. 



Unable to access Source volume. Is power on and 
device connected? 

PROBLEM ... SUM Disk Clinic cannot access the 
Source volume you have selected for this operation. 

SOLUTION ... Make sure power is turned on to the 
device. Check cables for loose connections. 

Unable to locate Partition. Please consult 'Error 
Messages' in your User Guide. 

PROBLEM ... While attempting to locate a volume 
partition, the program cannot locate the volume 
where the partition should be located. This can 
occur if the name of the volume has been changed 
since your Configuration Information was created. 

SOLUTION ... One solution is to change the name of 
the volume back to what it was originally - that is, at 
the time your Configuration Information was 
created. 

Perhaps a simpler solution is to create new Configu­
ration Information for your system. You can do this 
using either the Manual Configure or Automatic 
Configure commands in the Options menu. 

Unable to locate selected application. Cannot 
launch. 

PROBLEM ... SUM Disk Clinic cannot locate the 
application you selected from the Launch menu. 

SOLUTION ... Install (copy) the application you are 
attempting to launch to one of your mounted 
volumes and try again. 

Unable to open file. 

PROBLEM ... An undetermined error occurred when 
the program attempted to open the file containing 
your Configuration Information. 

SOLUTION ... Use the Automatic Configure com­
mand in the Options menu to create new configura­
tion information for your system. This replaces your 
current configuration information, but there is no 
alternative. 

Error Messages 

VIF is invalid. 

PROBLEM ... The information in the Volume 
Information File you have selected for recovering 
your volume is not valid and cannot be used with 
the device. 

SOLUTION ... Check to make sure you have 
selected the right VIF for the device you are 
attempting to recover. If this is not the problem, use 
the Create Volume Info File command in the 
Options menu to create a new VIF for the device 
and then try again. 

Volume does not contain a Deleted File Record. 
Cannot continue. 

PROBLEM ... The Source volume you have selected 
for recovering deleted files does not contain a 
Shield Deleted File Record. 

SOLUTION ... You cannot continue this operation 
with this Source volume. Check to make sure you 
have selected the correct Source. 

Volume ejected. Cannot continue. 

PROBLEM ... The Source volume you have selected 
for recovering deleted files is not available (it has 
most likely been ejected or unmounted). 

SOLUTION ... Insert or mount the volume and try 
again. 

Volume is crashed. Do you want to use a VIF for 
recovery? 

PROBLEM ... The volume you are attempting to 
recover has sustained a crash and SUM Disk Clinic 
is unable to access it. This question asks whether or 
not you want to use a Volume Information File to 
access the device. 

SOLUTION ... lf you click Yes, a file selector dialog 
appears so you can select the VIF you want to use. 
If you don't click Yes, you cannot continue and the 
procedure is aborted. 
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Volume is locked. Cannot continue. 

PROBLEM ... The Source volume from which you 
are attempting to recover deleted files is locked. The 
program cannot restore your files to this volume. 

SOLUTION ... Quit the program. Unlock the volume 
and try again. 

Your startup disk is locked. Please unlock and try 
again. 

PROBLEM ... SUM Disk Clinic cannot write the file 
'DiskClinicinfo' in the System Folder on your startup 
disk because the disk is locked. ('DiskCliniclnfo' is 
the file the program uses to pass required informa­
tion to the SUM Recover program.) 

SOLUTION ... Quit SUM Disk Clinic, unlock your 
startup disk, and start again. 
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SUM Recover 

The following messages appear when using the Quick 
Fix procedure. These messages indicate the type of 
problem detected on your volume. Solutions are not 
provided because Quick Fix attempts to correct these 
problems for you. If it cannot, SUM Recover termi­
nates the process. Try running SUM Disk Clinic again. 

Since you may not be familiar with some of these 
terms, the Glossary contains definitions. For more in­
formation about the Macintosh Operating System, the 
File Manager, and volume data organization, see 
Inside Macintosh, Volumes I - VI. 

Allocation map is invalid 
Bad Allocation Block Size 
Bad Catalog Extent Node -> 
Bad Catalog Extent Record -> 
Bad Catalog Extents BTH Node 
Bad File Extent Node -> 
Bad File Extent Record -> 
Bad File Extents BTH Node 
Bad first block in Bit Map 
Bad first block of Bit Map 
Bad MOB Catalog Extents 
Bad MOB File Extents 
Bad MOB Sig bytes 
Bad number of Allocation Blocks 
Bad Volume Name 
Cannot load SCSI Partition maps 
Data Fork Err for -> 
DDM number of blocks is bad 
DDM SCSI Physical Block Size bad 
Directory is bad. 
Directory OK. Files contain errors. 
Extents error. 
Loop in Catalog Extents linked list 
No SCSI Partition map for volume 
Number of Files does not match MOB 
Number of Folders does not match MOB 
Res Fork Err for -> 
Resrc Err for -> 
SCSI Device Descriptor Sigs bad 
SCSI mapping is bad 
Unable to check directory. Check is complete. 
Volume Info Block is bad 



Cannot create a folder on the Destination volume. 

PROBLEM ... Unexpected Error. 

Cannot create folder. 

PROBLEM ... Unexpected Error. 

Cannot find Volume Restore Record. Job 
cancelled. 

PROBLEM ... SUM Recover is unable to locate the 
Volume Restore Record on the volume you have 
specified. 

SOLUTION ... Make sure you selected the right 
volume. If you did, your only alternative is to recover 
files from the volume using the Recover Volume / 
Volume Restore Record NOT Installed procedure. 
(See the Recovery Procedures section.) 

Cannot recover file. Allocation used. 

PROBLEM ... The disk space allocated to the file you 
are attempting to recover has been used to store 
other information. 

SOLUTION ... None. The file cannot be recovered. 

Cannot recover file. It cannot be recreated. 

PROBLEM ... Unexpected Error. 

Cannot unmount volume. Job cancelled. 

PROBLEM ... SUM Recover is unable to unmount 
the volume you are attempting to restore. The 
volume cannot be restored unless it is unmounted. 

SOLUTION ... Try restarting your Macintosh and 
make sure the power to the device for this volume is 
turned OFF. Once your Macintosh is running, turn 
on power to the device. This should prevent the 
volume from mounting. Rerun the procedure. 

Error Messages 

CAUTION! This action will CANCEL the continue 
mode. If you click OK, the action will be allowed, 
and recover mode will cancel. 

PROBLEM ... You are recovering multiple files (or 
split files), and the program is in continue mode; that 
is, the current volume is full, and the program wants 
you to select another Destination volume so that it 
can continue recovering files. However, you have 
requested that the program cancel the continue 
mode, and the program asks you to confirm that you 
want to cancel this mode or return to the recovery 
process. 

SOLUTION ... Click OK to cancel the recovery 
process and return to the SUM File Recover 
window, or click Cancel to abort the action you 
requested and continue recovering files. 

Deleted File Record is wrong version. 

PROBLEM ... The Deleted File Record on the 
volume you have selected was created with an 
earlier version of SUM. The record is incompatible 
with the current version and cannot be used. 

SOLUTION ... None. 

Destination volume is full. Select another volume. 

PROBLEM ... The volume to which you are recover­
ing files is full. 

SOLUTION ... Select another volume. 

Duplicate file on Destination. File previously 
recovered. 

PROBLEM ... You recovered this file previously - it 
already exists on the Destination volume. 

SOLUTION ... There is no need to recover this file 
again. But if you wish, you can recover it to a differ­
ent Destination volume. 

Error creating file on Destination. Job cancelled. 

PROBLEM ... Unexpected Error. 
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SUM Recover (continued) 

Error opening Packed Signatures file. 

PROBLEM ... Unexpected Error. The Packed 
Signatures file might be damaged. 

SOLUTION ... Try replacing the Packed Signatures 
document with a copy from your original SUM II 
Program Disks and try again. 

Error opening partition. 

PROBLEM ... A file system error occurred when 
attempting to open a partition. 

SOLUTION ... Unmount the partition and try again. 

Error opening resource fork on Destination. 
Cannot continue. 

PROBLEM ... Unexpected Error. 

Error passing Disk Clinic info. Job cancelled. 

PROBLEM ... SUM Recover receives instructions 
from SUM Disk Clinic by reading a file named 
'DiskCliniclnfo' (which is placed in your system 
folder). The information in this file is unusable. 

SOLUTION ... Return to SUM Disk Clinic and go 
through all of the windows again. This recreates the 
'DiskClinicinfo' file. 

Error reading Packed Signatures file. 

PROBLEM ... Unexpected Error. A file system error 
occurred when attempting to read the Packed 
Signatures document. 

SOLUTION ... Try replacing the Packed Signatures 
document with a copy from your original SUM II 
Program Disks and try again. 

Invalid Volume Restore Record (xxxxx). 

PROBLEM ... Unexpected Error. SUM Recover has 
detected an error in the Volume Restore Record you 
have selected. 'xxxxx' is replaced with a description 
of the error. The possible error conditions are 
"corrupted," "size block difference," "driver map," 
and "startblock invalid." 
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Locked. Not available. 

PROBLEM ... This volume is locked. It is not 
available. 

SOLUTION ... Unlock the volume 

MFS volumes are not supported for this operation. 

PROBLEM ... The volume you have selected is in the 
MFS format, which is not supported by SUM II. 

SOLUTION ... None. You cannot do this operation. 

No Deleted File Record on volume. 

PROBLEM ... There is no Deleted File Record on the 
volume you have selected. 

SOLUTION ... Check to make sure you have 
selected the correct volume. 

No space left after creating folders. Select another 
Destination volume. 

PROBLEM ... There is no space left on the Destina­
tion volume after creating the necessary folders. 

SOLUTION ... Select a different Destination volume. 

No structure found. 

PROBLEM ... Unexpected Error. During a Directory 
Scan operation, the program could not find a logical 
file structure. 



Not enough memory. 

PROBLEM ... SUM Recover cannot obtain enough 
memory to run. This message might appear when 
you launch the program or while you are running it. 

SOLUTION ... 1f you are running under MultiFinder, 
increase the amount of memory allocated to the 
program (use the Get Info command in the desktop 
File menu) and try again. 

If you are running under Finder and you have only 
one megabyte of RAM on your Macintosh, you are 
probably loading too many startup documents, desk 
accessories, or fonts, and there is not enough room 
for the program to run. You'll have to remove one or 
more of these items and try again. You should also 
turn off the RAM Cache in your Control Panel if it is 
currently on. 

Not enough memory for Signature scan. 

PROBLEM ... After reading the Packed Signatures 
document into memory, the program does not have 
enough memory left to scan your volume using the 
Signatures. 

SOLUTION ... The best solution is to try and allocate 
more memory to the program. See the preceding 
message description for details. 

If allocating more memory does not solve the 
problem, you can disable Signature scanning by 
moving the Packed Signatures' document to a 
different folder or by renaming or deleting it. When 
you subsequently run SUM Recover, the program 
gives you the option of bypassing Signature 
scanning. 

Shield Deleted File Record is active. You must use 
Disk Clinic to select any different recovery 
method. 

This is not an error message - it appears when you 
launch SUM Recover directly from the desktop 
without going through SUM Disk Clinic. The 
message is merely telling you that the program is 
preset to operate as if you are trying to recover 
deleted files from a volume where the Deleted File 

Error Messages 

Record is installed. If you want to use the program 
in any other mode, you must launch it via SUM Disk 
Clinic and select the Recover Method you want to 
use. 

Split file error. Cannot continue. 

PROBLEM ... Unexpected Error. 

Startup volume cannot be unmounted. Job 
cancelled. 

PROBLEM ... The Macintosh file system does not 
allow your startup volume to be unmounted. SUM 
Recover must be able to unmount the volume 
before accessing it. 

SOLUTION ... Use the Startup Device CDEV in your 
Control Panel to select a different startup volume. 
Restart your Macintosh and then rerun SUM Disk 
Clinic. This allows SUM Recover to unmount the 
volume-as required. 

Unexpected error. 

PROBLEM ... Unexpected Error. 

Unexpected error creating VIF. 

PROBLEM ... Unexpected Error. (This error occurs 
only in Advanced mode.) An undetermined error 
occurred while attempting to create a Volume 
Information File. 

You cannot use that disk drive for the backup file. 
It is reserved for the volume being restored. 

PROBLEM ... You are attempting to recover a floppy 
disk on which a Volume Restore Record is installed 
using a backup copy of the record. However, you 
have selected the same drive for restoring the vol­
ume and for reading the backup record. You cannot 
do this. 

SOLUTION ... Use one drive for the floppy disk you 
are attempting to restore, and use a different drive 
for obtaining the backup copy of the Volume 
Restore Record. 
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SUM TuneUp 

Bad sector found -> xx 

PROBLEM ... Your volume contains a bad sector. 
The sector number replaces 'xx' in the message. 

SOLUTION ... None. SUM TuneUp automatically 
locks the bad sector, so it cannot be used further. 

Device is too fragmented. 

PROBLEM ... During an Optimize Volume procedure, 
SUM TuneUp found your volume to be extremely 
fragmented, and the procedure cannot be 
performed. 

SOLUTION ... This message is followed by "Try 
using Defragment Files first." Display the TuneUp 
Options dialog, activate the Defragment Files 
option, and deactivate the Optimize Volume option. 
Tune up your volume to defragment your files, and 
afterward try using the Optimize Volume option 
again. 

Directory is full 

PROBLEM ... The directory on the volume you are 
attempting to tune up is full. SUM TuneUp cannot 
defragment a file or optimize the volume because it 
cannot create new directory entries. 

SOLUTION ... Remove some files from the volume 
and try again. 

Directory is too fragmented. 

PROBLEM ... The directory on the volume you are 
attempting to optimize is so badly fragmented that 
SUM TuneUp cannot perform the operation without 
risk of losing data. 

SOLUTION ... Try removing as many files as you can 
from the disk and try again. 

Disk is full 

PROBLEM ... During a Defragment Files operation, 
the program could not find adequate space on the 
disk. 

SOLUTION ... Remove some files and try again. 
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Error creating file. 

PROBLEM ... Unexpected Error. 

Error opening file. 

PROBLEM ... Unexpected Error. 

File is open. 

PROBLEM ... Unexpected Error. 

File resource verification error for: [filename] 

PROBLEM ... Unexpected Error. During a Verify 
Files operation, a file resource for the file named in 
the message could not be verified. The file is 
probably damaged. 

No optimizing was done. 

PROBLEM ... None. This message is always 
preceded by another message indicating why the 
volume could not be optimized. 

No System file present. 

This is not an error but merely a message indicating 
that the program could not find a System file on your 
volume while doing a List AlllNITs operation. 

No system folder on volume. 

PROBLEM ... During a List AlllNITs operation, the 
program could not locate a system folder on the se­
lected volume. Normally, INITs reside in a system 
folder, and thus, this is the only location where SUM 
TuneUp looks for them. 

SOLUTION ... Check to make sure you have 
selected the right volume. 



Not enough memory available. 

PROBLEM ... SUM TuneUp cannot obtain enough 
memory to perform the Optimize Volume option. 

SOLUTION ... lf you are running under MultiFinder, 
increase the amount of memory allocated to the 
program (use the Get Info command in the desktop 
File menu) and try again. 

If you are running under Finder and your Macintosh 
one-megabyte of RAM, you are probably loading too 
has many startup documents, desk accessories, or 
fonts. You'll have to remove one or more of these 
items and try again. You should also turn off the 
RAM Cache in your Control Panel if it is currently 
on. 

Not enough memory. Turn off cache, remove 
INIT's, and try again. 

PROBLEM ... SUM TuneUp cannot obtain enough 
memory to run. 

SOLUTION ... Turn off the RAM Cache in your 
Control Panel and remove as many startup docu­
ments as possible from the system folder on your 
startup volume. Restart your system, launch SUM 
TuneUp, and try again. 

Open files on volume. 

PROBLEM ... During an Optimize Volume operation, 
files were found to be open on the volume you are 
attempting to optimize. This is not allowed. 

SOLUTION ... Quit SUM TuneUp and close all files 
that are currently open, including desk accessories. 
Restart SUM TuneUp and try again. 

Error Messages 

Sector is allocated to a file. Use Verify File to 
determine which file is bad. Recover the file and 
then delete it. Use Lock Out Bad Sectors again to 
lock out the bad sector. 

PROBLEM ... A bad sector was found that is 
currently in use by a file. 

SOLUTION ... Use the Verify Files option to find out 
which file occupies the bad sector. Then, run SUM 
Disk Clinic and use the Recover Volume function to 
recover this file. Run SUM TuneUp again using the 
Lock Out Bad Sectors option to prevent further use 
of this sector. Finally, restore the recovered file to 
your volume. 

Sector is free. Now locked out. 

PROBLEM ... None. During a Lock Out Bad Sectors 
operation, a bad sector was found. The sector does 
not contain any data and has been locked out from 
further use. 

Too many directories open. 

PROBLEM ... Unexpected Error. 

Too many files open. 

PROBLEM ... Unexpected Error. 

Unable to check: file system error 

PROBLEM ... Unexpected Error. 

Unable to defragment, XXXXX 

PROBLEM ... Unexpected Error. An error occurred 
during a Defragment Files operation. The 'xxxxx' is 
replaced by one of these error messages: Un­
known, Directory full, Disk is full, File is open, Too 
many open files, or Too many working directories. 

Unable to list INITs. File system error. 

PROBLEM ... Unexpected Error. 
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SUM TuneUp (continued) 

Unable to open data fork for: [filename] 

PROBLEM ... Unexpected Error. During a Verify 
Files operation, the data fork of the named file could 
not be opened. 

Unable to open resource fork for: [filename] 

PROBLEM ... Unexpected Error. During a Verify 
Files operation, the resource fork of the named file 
could not be opened. 

Unable to open the file 

PROBLEM ... Unexpected Error. 

Unable to read data fork for: [filename] 

PROBLEM ... Unexpected Error. During a Verify 
Files operation, the program could not read the data 
fork for the named file. 

Unable to read resource fork for: [filename] 

PROBLEM ... Unexpected Error. During a Verify 
Files operation, the program could not read the re­
source fork for the named file. 

Unable to unmount volume. 

PROBLEM ... During an Optimize Volume procedure, 
SUM TuneUp could not unmount the volume you 
are attempting to optimize. This is an unexpected 
situation and happens rarely. 

SOLUTION ... Make note of the error message and 
contact Symantec Product Support. 

Unexpected error, cancelled. 0 1 

PROBLEM ... An orphan occurred during an Opti­
mize Volume procedure. This is an unexpected 
error and rarely occurs. 

SOLUTION ... Use the Optimize Volume Option to 
either remove orphans during optimization or have 
SUM TuneUp cancel the optimization when an 
orphan is encountered. 
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Unexpected error, cancelled. 0 2, 0 3, and 0 4 

PROBLEM ... An unexpected file system error has 
occurred. 

SOLUTION ... If this error should occur, immediately 
write down the message and contact Symantec 
Product Support. 

Unexpected error, cancelled. 0 5 

PROBLEM ... A bad directory block was found during 
the optimization. 

SOLUTION ... Make note of the error message and 
contact Symantec Product Support. 

Unexpected error, cancelled. 0 6 

PROBLEM ... An unexpected file system error has 
occurred. 

SOLUTION ... Make note of the error message and 
contact Symantec Product Support. 

Unexpected error, cancelled. 0 7 

PROBLEM ... Usually this message indicates an 1/0 
error. 

SOLUTION ... 1f this message occurs, write the 
message down and contact Symantec Product 
Support. 

Unexpected error. Optimize cancelled. 

PROBLEM ... An undetermined error in logic 
occurred during an Optimize Volume procedure. 
This is an unexpected error and rarely occurs. 

SOLUTION ... Make note of the error message and 
contact Symantec Product Support. 

Unexpected error #2. Optimize cancelled. 

PROBLEM ... An undetermined error in logic 
occurred during an Optimize Volume procedure. 
This is an unexpected error and rarely occurs. 



SOLUTION ... Make note of the error message and 
contact Symantec Product Support. 

Unexpected file system error. Ext. 

PROBLEM ... An undetermined error occurred during 
an Optimize Volume procedure. This is an unex­
pected error and rarely occurs. 

SOLUTION ... Make note of the error message and 
contact Symantec Product Support. 

Volume not mounted. Job cancelled. 

PROBLEM ... You selected a volume in the pop-up 
menu and then clicked the Volume Info button, but 
the volume you selected has since been 
unmounted. 

SOLUTION ... Mount the volume and try again. 

You cannot optimize your startup volume or the 
volume from which SUM TuneUp is launched. 

PROBLEM ... You cannot use the Optimize Volume 
option in the cases stated in the message. 

SOLUTION ... lf you want to optimize your current 
startup volume, restart your system from a different 
volume and try again. 

In the second case, the simplest solution is to move 
SUM TuneUp to a different volume, restart the 
program, and try again. 

Error Messages 

SUM BackUp ~ 

Access denied. 

PROBLEM ... This message appears only if you are 
working on an AppieShareH1 network. You do not 
have access priviledges to the file or folder you 
have selected. 

SOLUTION ... Unless you can obtain access 
priviledges, you cannot continue. 

Bad Disk or Locked. 

PROBLEM ... SUM BackUp had difficulty writing to 
the disk. The disk might be locked or damaged. 

SOLUTION ... lf the disk is a locked floppy, eject it, 
reverse the write-protect tab, and try again. If it is a 
locked hard disk, return to the desktop, select the 
volume, choose Get Info from the File menu, and 
click to remove the X from the "Locked" check box. 
If the disk is a locked removable disk cartridge, 
follow the manufacturer's instructions to unlock it. 

If the disk is not locked, it might be damaged. Try 
using a different disk. Check the problem disk for 
damage by attempting to reinitialize or reformat it. If 
it continues to be a problem, discard it. 

Directory Not Found 

See "File Not Found" below. 

Disk Full. 

PROBLEM ... There is no more room on the disk, 
and SUM BackUp could not add another file to it. 

SOLUTION ... Use a different disk. 

File Busy. 

PROBLEM ... A file you are attempting to access is 
currently in use. This might occur if you are running 
under MultiFinder or using the file with a desk 
accessory. 

SOLUTION ... Close the file and try again. 
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SUM BackUp (continued) 

File Not Found. 

PROBLEM ... SUM BackUp cannot find a file or a 
folder. This can happen, for example, if SUM 
BackUp has read the directory on the Source 
volume and (using a desk accessory or MultiFinder) 
you delete the file before the program attempts to 
read it. 

SOLUTION ... Restore the file and try again. 

I/O Error 

PROBLEM ... Unexpected Error. Your disk might be 
bad. If it is a Target disk, you might want to try reini­
tializing or reformatting it. If it continues to be a 
problem, discard it. 

Insufficient memory. 

PROBLEM ... Not enough memory available for SUM 
BackUp to contain a volume directory in memory. 
This error is most likely to occur if you are running 
under MultiFinder. SUM BackUp is shipped with a 
suggested memory size of 700K, which is enough to 
hold a directory of up to 3,000 files. 

SOLUTION ... lf this error occurs, SUM BackUp 
suggests the memory size you should use. Quit the 
program. From the desktop, choose Get Info from 
the File menu and set the Application Memory Size 
to that suggested. Restart SUM BackUp and try 
again. 

Phase error. 

PROBLEM ... SUM BackUp had a problem attempt­
ing to write to a Backup Volume. This does not 
necessarily mean the volume is damaged. 

SOLUTION ... None required. SUM BackUp will 
recreate the volume. 

A-14 

Symantec Utilities for Macintosh 

SUM Partition 

An illegal operation was attempted on the startup 
volume. 

PROBLEM ... Unexpected Error. 

Master Directory Block is Bad. 

PROBLEM ... Unexpected Error. 

Memory is also trashed. 

PROBLEM ... Unexpected Error. 

Unexpected error 

PROBLEM ... Unexpected Error. 

Volume is damaged. 

PROBLEM ... Unexpected Error. 



SUM QuickCopy 

Bad volume name. 

PROBLEM ... SUM QuickCopy cannot recognize the 
name given to your Source disk. 

SOLUTION ... Quit SUM QuickCopy, and if neces­
sary, rename the disk according to Macintosh 
standards. 

Disk is write-protected - JOB CANCELLED. 

PROBLEM ... The write-protect tab on your Target 
disk is set to the locked position. 

SOLUTION ... Slide the write-protect tab so it blocks 
the hole in the floppy disk and try again. 

Drives are incompatible - Cannot copy. 

PROBLEM ... You are trying to copy from a double­
sided drive to a single-sided drive. 

SOLUTION ... Select the same drive for the Source 
and Target disk and try again. 

Error reading disk - JOB CANCELLED. 

PROBLEM ... The Source disk you are attempting to 
copy could not be read due to a disk error. 

SOLUTION ... Your Source disk might be physically 
damaged or your disk drive could be out of align­
ment. If you cannot open the disk or access the files 
it contains with other applications, try using SUM 
Disk Clinic (Quick Fix and/or Recover Volume 
functions) to recover you files from the disk. 

I/O error. 

PROBLEM ... SUM QuickCopy cannot write to the 
current Target disk. This might indicate that the disk 
is physically damaged or your disk drive is out of 
alignment. 

SOLUTION ... Try using a different Target disk. If the 
problem reoccurs, try using a different Target drive, 
if possible. 

We recommend you set the problem disk aside and 
check it later. If it continues to show problems, 
discard it. 

Error Messages 

Initialization error. 

PROBLEM ... SUM QuickCopy cannot initialize the 
current Target disk. This is usually an indication that 
the disk is physically damaged. 

SOLUTION ... Use a different Target disk. 

We recommend you set the problem disk aside and 
check it later. If it continues to show problems, 
discard it. 

Insufficient memory. 

PROBLEM ... Your Macintosh does not have enough 
memory available for SUM QuickCopy to launch. 
Following this message you return to your desktop. 

SOLUTION ... lf you are running under Multifinder, 
you might be able to allocate more memory to the 
program using the Get Info command in the 
desktop File menu. 

If you are running under Finder, see Overcoming 
Memory Limitations in Chapter 6 for a possible 
solution. 

Must initialize to copy a 400k disk onto an aOOk 
disk. 

PROBLEM ... Your Source disk is single-sided 
(400k), but the current Target disk was initialized as 
double-sided (BOOk). The Target must be initialized 
in the same format as the Source. 

SOLUTION ... Turn on the Initialize Before Copying 
option for the Target disk and try again. 

Must initialize to copy an aOOk disk onto a 400k 
disk. 

PROBLEM ... Basically the same problem as the 
preceding message: the Target disk is initialized in a 
format different from the Source disk. However, 
read the following solution before proceeding. 

SOLUTION ... lf you initialize a single-sided disk 
(400k) as double-sided (BOOk), there is a risk of not 
being able to access your data. Read the section 
Initialize Before Copying Option in Chapter 9. 
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SUM QuickCopy (continued) 

No disk in drive. 

PROBLEM ... You clicked the Write Target button, 
but there is no disk in the drive. 

SOLUTION ... lnsert a Target disk and try again. 

Not enough memory. Select 'Copy ALL Sectors' 
and try again. SUM QuickCopy will do a multiple­
pass copy. 

PROBLEM ... The amount of memory available to 
SUM QuickCopy prevents it from being able to read 
the entire Source disk into memory at one time. 
Thus, it cannot make copies in a. single pass. 

SOLUTION ... As the message states, you can select 
the 'Copy ALL Sectors' option, and the program will 
use multiple passes to make the disk copies. 

Another possible solution (if you are running under 
MultiFinder) is to allocate more memory to the 
program using the Get Info command in the 
desktop File menu. 

You might also want to read Overcoming Memory 
Limitations in Chapter 6 for yet another possible 
solution. 

Open files on Target disk - JOB CANCELLED. 

PROBLEM ... One or more files on your current 
Target disk are presently open and in use. SUM 
QuickCopy cannot write to this disk. 

SOLUTION ... Close any files that are currently open 
on the Target disk and try again. 
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Target drive cannot write the format of the Source 
disk. 

PROBLEM ... The drive where you are attempting to 
write a Target disk cannot write in the same format 
as the Source disk. For example, the Source is a 
double-sided or a high-density disk, but the drive for 
writing the Target can only write single-sided disks. 

SOLUTION ... Reselect your Target drive, making 
sure it can write disks in the same format as the 
Source drive. If necessary, select the same floppy 
drive in both pop-up menus. 

Unrecognizable disk - JOB CANCELLED. 

PROBLEM ... The Source disk you are attempting to 
copy is not in a format that SUM QuickCopy 
recognizes. 

SOLUTION ... Check to ensure that you have 
inserted the correct Source disk. If you have, return 
to the desktop and see if you can open the disk and 
access the files it contains. If you are able to open 
the disk, contact Symantec Product Support and 
notify them of this error. 



Error Messages 

SUM Encrypt (SUM UniCrypt outside the U.S. and Canada) D.!~.i~i·: 

Disk is write protected. 

PROBLEM ... The write-protect tab on the floppy disk 
you are attempting to access is in the locked 
position. 

SOLUTION ... Quit SUM Encrypt. Eject the disk and 
reset the write-protect tab. Reinsert the disk and try 
again. 

File access error on ... 

PROBLEM ... Unexpected Error. 

File already open with write permission. 

PROBLEM ... The file you are attempting to encrypt 
or decrypt is already open by another application 
and that application is able to write to the file. SUM 
Encrypt cannot process the file while it is in this 
state. 

SOLUTION ... Switch to the application that is 
currently using the file, close it, switch back to SUM 
Encrypt, and try again. 

File is busy. 

PROBLEM ... The file you are attempting to encrypt 
or decrypt is currently in use and cannot be 
accessed. 

SOLUTION ... Quit SUM Encrypt. Close the file in 
question. Try again. 

File is locked. You cannot write to it. 

PROBLEM ... The file you are attempting to encrypt 
or decrypt is in a locked state. 

SOLUTION ... Return to the desktop and use the Get 
Info command in the File menu to unlock the file 
and try again. 

Memory full. Unable to open file. 

PROBLEM ... Unexpected Error. 

Too many files open. 

PROBLEM ... Unexpected Error. 

Volume is locked. 

PROBLEM ... The volume on which you are attempt­
ing to encrypt or decrypt files or folders is locked. 
SUM Encrypt must be able to write to the volume. 

SOLUTION ... Quit SUM Encrypt. Unlock the volume 
in question and try again. 

Volume not available. 

PROBLEM ... The volume you are attempting to 
access is not available. It has probably been 
ejected. 

SOLUTION ... Quit SUM Encrypt. Mount the volume 
in question. Then, restart SUM Encrypt and try 
again. 

End of Appendix A 
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Type and 
Creator 

Codes 

This appendix contains a list of Type and 
Creator codes used with the Macintosh file 
system. The purpose of this list is to provide you 
with a source of reference if, in the course of 
recovering a file, the Type and Creator codes are 
missing. 

Following the list is a discussion of how Type 
and Creator codes are used by the Macintosh file 
system and how you might go about using these 
codes in conjunction with Symantec Utilities for 
Macintosh. 

This list was compiled from a variety of re­
sources. It is as complete as current, available 
information permits. If you do not find codes for 
a particular application or document, we 
recommend you contact the software developer 
or publisher direct. They are your most reliable 
source for this information. 



Appendix 8 Symantec Utilities for Macintosh 

APPLICATION TYPE CREATOR APPLICATION TYPE CREATOR 

4th Dimension ......................... APPL ........ .4002 America On Line ..................... APPL ........ AOqc 

4th Dimension-data ................ RECH ........ 4002 America On line - data ........... AOdb ........ AOqc 

4th Dimension-data ................ FLAG ......... 4D02 AppleLink ................................ APPL ........ GEOL 

4th Dimension-data ................ SETT ......... 4002 AppleLink - data ..................... PETE ........ GEOL 

4th Dimension-data ................ VAR1 ........ .4D02 

4th Dimension-data ................. FILT ......... .4002 

4th Dimension-data ................ REPT ......... 4002 
c 

4th Dimension-data ................ TFRM ....... .4002 Canvas ...................................... APPL ........ DAD2 

4th Dimension-data ................ EFRM ....... .4002 Canvas - data ........................... drw2 ........ DAD2 

4th Dimension-data ................ TEXT ........ .4002 Claris CAD ............................... APPL ....... CCAD 

4th Dimension-data ................ INDX ......... 4D02 Claris CAD - data .................. MDCA ...... CCAD 

4th Dimension-data ................. data ......... .4002 Comic Works ........................... APPL ....... MMCB 

4th Dimension-data ................ BAS2 ......... 4002 Comic Works - data ............... CBOK ...... MMCB 

Complete Undelete ................ CDEV ....... UNDL 

Complete Undelete - data ...... LogF ........ UNDL 

A ConcertWare Inst Maker ........ APPL ....... CWIM 

Acta - data ............................... OTLN ....... ACTA ConcertWareInstMake - data CWIF ....... CWIM 

Acta, Configure ....................... APPL ........ ACTA ConcertWare Player ............... APPL ....... CDMP 

Adobe Illustrator .................... APPL ........ ARTy ConcertWare Player - song .. CWMF ...... CWMP 

Adobe Illustrator - data .......... TEXT ........ ARTy ConcertWare Writer ............... APPL ...... CWMW 

After Dark ................................ APPL ........ ADrk ConcertWare Writer - data ... CWMF ..... CWMW 

After Dark - data .................... ADGM ....... ADrk Consultant ................................ APPL ........ CONS 

Aldus Freehand ....................... APPL ........ ACA3 Consultant - data .................... ODSA ....... CONS 

Aldus Freehand -data ............. ACF3 ........ ACA3 Cricket Colorpaint .................. APPL ........ DECO 

Aldus Persuasion .................... APPL ......... PLP1 Cricket Colorpaint - data ....... CRCP ....... DECO 

Aldus Persuasion - data ......... PRS1 ......... PLP1 Cricket Draw ........................... APPL ....... CRDW 

Aldus Persuasion - template. PRT1 ......... PLP1 Cricket Draw - data ................ CKDT ....... CRDW 

Allegro LISP CL 1.2 ................ APPL ......... CCL Cricket Graph .......................... APPL ........ CGRF 

Allegro LISP CL 1.2 - data ..... TEXT ......... CCL Cricket Graph - data ............... CGTX ........ CGRF 
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APPLICATION TYPE CREATOR APPLICATION TYPE CREATOR 

Cricket Pict-O-Graph ............. APPL ........ PGRF E 
Cricket Pict-O-Graph data .... STWK ........ PGRF 

Easy 3D ..................................... APPL ........ EZ3C 
Cricket Presents ...................... APPL ........ CRPR 

Easy 3D - data .......................... EZ3D ........ EZ3C 
Cricket Presents - data ........... PROF ........ CRPR 

D 
F 
File Maker II ............................ APPL ........ FKM4 

Deluxe Music Construction ... APPL ....... UHRU 
File Maker II - data ................. FKM$ ........ FKM4 

Deluxe Music - music scores. USC2 ........ USC2 
FoxBase .................................... CaMP ........ F+ IN 

Deluxe Music - instruments. UVOX ...... UHRU 
FoxBase User ............................ F+US ........ FOX+ 

Desk Organizer ....................... APPL ........ DESK 
FoxBase Install ......................... APPL ......... F+ IN 

Desk Organizer - data ............ DSKF ........ DESK 
FoxBase .dbf ............................. F+DB ........ FOX+ 

DeskPaint ................................. APPL ........ DPNT 
FoxBase .dbt ............................. F+DT ........ FOX+ 

DeskPaint - data ....................... PICT ........ DPNT 
FoxBase .inc .............................. TEXT ........ FOX+ 

DeskPaint - data ....................... TIFF ......... DPNT 
FoxBase .idx .............................. F+IX ......... FOX+ 

DeskPaint - data ..................... PNTG ....... DPNT 
FoxBase .prg.FMT ................... F+PR ........ FOX+ 

Desktop .................................... FNDR ........ ERIK 
FoxBase .cod ............................ F+CO ........ FOX + 

Director .................................... APPL ....... MMDR 
FoxBase .scx ............................. F+ FM ........ FOX + 

Director - data ........................ VWOV ..... MMDR 
FoxBase .vue ............................ F+VU ........ FOX+ 

Dollars & Sense ....................... APPL ......... DAS 
FoxBase .frm ............................. F+ FR ........ FOX + 

Dollars & Sense - data ............ DASD ......... DAS 
Full Impact ............................... APPL ........ GLAS 

Double Helix ........................... APPL ........ ATLX 
Full Impact - data ................... GWKS ....... GLAS 

Double Helix - data ................ HEAP ........ ATLX 
Full Paint .................................. APPL ........ PANT 

Draw It Again Sam ................. APPL ........ DAGS 
Full Paint - data ...................... PNTG ....... PANT 

Draw It Again Sam - data ..... DADG ....... DAGS 
FullWrite ProfessionaL ......... APPL ........ FWRT 

FullWrite - data ....................... FWRT ....... FWRT 
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APPLICATION TYPE CREATOR APPLICATION TYPE CREATOR 

H Mac Project -data .................... MPRD ....... MPRJ 

Helix ......................................... APPL ........ HELX 
Mac Publisher III ..................... APPL ........ DOYL 

Helix - formatted data ........... HEAP ....... HELX 
Mac Publisher - articles .......... TEXT ........ DOYL 

Helix - text only ....................... TEXT ........ HELX 
Mac Publisher - data ............... ISSU ........ DOYL 

HyperCard ............................... APPL ........ WILD 
Mac Publisher - pictures ......... PICT ........ DOYL 

HyperCard - stacks ................. STAK ........ WILD 
Mac SQZ! ................................. APPL ......... SQZ! 

Mac SQZ! - INIT ....................... IN IT .......... SQZ! 

Mac Terminal .......................... APPL ........ TERM 

L Mac Terminal - data ................ TEXT ........ TERM 

LightSpeed C ........................... APPL ....... KAHL Mac Write ................................. APPL ....... MACA 

LightSpeed C - libraries ........... LIB ......... KAHL Mac Write - formatted data .. WORD ...... MACA 

LightSpeed C - projects .......... PROJ ........ KAHL Mac Write - text only data ..... TEXT ....... MACA 

LightSpeed C - source ............ TEXT ........ KAHL Mac Write II ............................. APPL ........ MWII 

Mac Write II - data ................. MW2D ....... MWII 

Macro Mind Director ............. APPL ....... MMDR 
M Macro Mind Director - data .. VWZP ..... MMWW 

Mac 3D ..................................... APPL ....... MC3D MDS Assembly ........................ APPL ......... ASM 

Mac Draft ................................. APPL ....... MACD MDS Edit .................................. APPL ......... EDIT 

Mac Draft - data ..................... DRWG ...... MACD MDS Exec ................................. APPL ........ EXEC 

Mac Draw ................................. APPL ....... MDRW MDS Make ............................... APPL ....... MMAK 

Mac Draw - data .................... DRWG ..... MDRW MicroPhone II .......................... APPL ........ DFBO 

Mac Draw II ............................. APPL ....... MDPL MicroPhone II - data .............. DFBA ........ DFBO 

Mac Draw II - data ................. DRWG ...... MDPL Microsoft BASIC (binary) ...... APPL ........ MSBB 

Mac Link Plus .......................... APPL ....... DVZU Microsoft BASIC - data (bin) MSBC ........ MSBB 

Mac Paint II .............................. APPL ....... MPNT Microsoft BASIC (decimal) .... APPL ........ MSBA 

Mac Paint II - data .................. PNTG ....... MPNT Microsoft BASIC - data (dec) MSBD ....... MSBA 

Mac Pascal ............................... APPL ........ P ASC Microsoft Excel ........................ APPL ........ XCEL 

Mac Pascal - data ..................... TEXT ........ P ASC Microsoft Excel - chart ............. XLC ......... XCEL 

Mac Project .............................. APPL ........ MPRJ Microsoft Excel - macro .......... XLM ......... XCEL 
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APPLICATION TYPE CREATOR APPLICATION TYPE CREATOR 

Microsoft Excel - plot ............. XLPG ........ XCEL o 
Microsoft Excel - text .............. TEXT ........ XCEL 

Omnis 3 Plus ............................ APPL ........ OM$$ 
Microsoft Excel- worksheet ... XLF .......... XCEL 

Omnis 3 Plus - data ................ OM$D ....... OM$$ 
Microsoft File ........................... APPL ......... FILE 

Omnis 3 Plus - library ............ OM$L ....... OM$$ 
Microsoft File - data ................ ISAM ......... FILE 

Omnis 3 Plus - utilities .......... OM$U ....... OM$$ 
Microsoft File - form .............. FORM ........ FILE 

Microsoft File - report ............. REPT ......... FILE 

Microsoft PowerPoint ............ APPL ........ PPNT p 
Microsoft PowerPoint - data. SLDS ........ PPNT Pack It ....................................... APPL .......... PIT 

Microsoft Word - data ........... WDBN ...... MSWD Pack It - data .............................. PIT ............ PIT 

Microsoft Word 3.0 and 4.0 ... APPL ....... MSWD PageMaker 3.0 ......................... APPL ........ ALD3 

Microsoft Works - commun. AWWP ........ PSI2 PageMaker 3.0 - data .............. ALB3 ........ ALD3 

Microsoft Works - database .AWDB ........ PSI2 PageMaker 3.0 - templates ..... ALT3 ........ ALD3 

Microsoft Works - spreadsh .. AWSS ......... PSI2 Panorama ................................. APPL ........ KASI 

Microsoft Works - word ....... AWWP ........ PSI2 Panorama - data ...................... ZEPD ........ KASI 

Microsoft Works 2.0 ............... APPL ......... PSI2 PC Backup ................................ APPL ......... DSB4 

Microsoft Write ....................... APPL ....... MSWT PC Backup - data .................... BACK ........ DSB4 

Microsoft Write - data ........... WDBN ...... MSWT Phoenix 3-D ............................. APPL ......... phnx 

Milo Math Processor .............. APPL ........ MILO Pnoenix 3-D - data ................. PHXM ........ phnx 

MindWrite™ 2.0 ..................... APPL ........ PWRI Poster Maker ........................... APPL ........ PMKS 

MindWrite™ 2.0 - data .......... OUTL ....... PWRI Poster Maker - data ................ PHLP ........ PMKS 

More II ...................................... APPL ........ MOR2 

More II - data .......................... MOR2 ....... MOR2 

More II - translator ................... mkg ......... MOR2 
Q 

MPW ......................................... APPL ......... MPS Quark Xpress ........................... APPL ........ XPRS 

MPW - object ............................. OB] ........... MPS Quark Xpress - data ............... XDTA ........ XPRS 

MPW - source .......................... TEXT ......... MPS 

Music Paint .............................. APPL ....... MUSC 

Music Paint - data ................... PNTG ....... MUSC 
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APPLICATION TYPE CREATOR APPLICATION TYPE CREATOR 

R SUM BackUp - directory ....... SmbD ....... SUMb 

Ready Set Go! .......................... APPL ....... MART 
SUM BackUp - files ................. 5mbF ........ SUMb 

Ready Set Go! - data ............... RSGF ....... MART 
SUM BackUp - info ................. 5mbI ........ SUMb 

Red ux 1.5 .................................. APPL ......... Redx 
SUM Deleted File Record ...... GLON ........ INIT 

Redux 1.5 Restore ................... APPL ........ RdxR 
SUM Disk Clinic ..................... APPL ........ MZRT 

Red ux - directory .................... RdxD ......... Redx 
SUM Encrypt ........................... APPL ....... SMZD 

Red ux - files ............................. RdxF ......... Redx 
SUM Encrypt - data ................ XCRY ....... SMZD 

Redux - info .............................. RdxI .......... Redx 
SUM Install .............................. APPL ......... INSZ 

Right Now ................................ APPL ......... nxAn 
SUM Partition - files ............... LONE ....... LONP 

Right Now - data ..................... nXAd ......... nXAn 
SUM Partition DA ................... DFIL ....... DMOV 

Retrospect ................................ APPL ......... Rxvr 
SUM Partition IN IT ................. INIT ......... LONP 

Retrospect - data ..................... RXV4 ......... Rxvr 
SUM QuickCopy ..................... APPL ....... MCPO 

SUM Recover ........................... APPL ........ GL02 

SUM Recover - signatures ..... MSET ........ MZTl 

s SUM Recover - VIF doc ......... ZAPD ........ MZS2 

SIM City ................................... APPL ....... MCRP SUM Recover - VIF recover .. ZAPD ....... MZR2 

SIM City - data ......................... CITy ........ MCRP SUM Shield ............................... cdev ........ LHGC 

Sound Edit ............................... APPL .......... SFX SUM Tools ............................... APPL ........ STOI 

Sound Edit - sound files ......... FSSD .......... SFX! SUM TuneUp .......................... APPL ........ MZOI 

Stat Works ................................ APPL ........ DMST SUM Volume Restore Record GLOS ......... IN IT 

Stat Works - data .................... STWK ....... DMST SuperEdit ................................. APPL ....... MANP 

Studio/8 ................................... APPL ......... ST 18 SuperCard ................................ APPL ........ RUNT 

Studio/8 - data ......................... PICT ......... ST 18 SuperCard - data .................... MDOC ...... RUNT 

Stuff it ....................................... APPL .......... SIT! SuperCard stand alone .......... APPL ........ STND 

Stuff it - data .............................. SIT! ........... SIT! SuperPaint ............................... APPL ........ SPNT 

SUM BackUp ........................... APPL ........ SUMb SuperPaint - data ..................... SPTG ........ SPNT 
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APPLICATION TYPE CREATOR APPLICATION TYPE CREATOR 

T w 
Teach Text .................................. APPL .......... ttxt WingZ ....................................... APPL ....... WNGZ 

TeachText - data ...................... TEXT .......... ttxt WingZ - .scp ............................. TEXT ....... WNGZ 

THINK Pascal .......................... APPL ........ PJMM WingZ - script ......................... WZSC ...... WNGZ 

THINK Pascal - library .......... QPLB ........ PJMM WingZ - spreadsheet .............. WZSS ....... WNGZ 

THINK Pascal - project ........... QPRJ ........ PJMM Word Perfect ............................ APPL ......... SSIW 

THINK Pascal - source ........... TEXT ........ PJMM Word Perfect - data ................ WPDC ........ SSIW 

T /Maker ................................... ZSYS ........ MACS Write Now ............................... APPL ........ nXl\n 

Write Now - data .................... nXl\d ......... nXl\n 

v Write Now - data .................... nXl\w ........ nXl\n 

VersaCAD ................................ APPL ....... VCAD 

VersaCAD - data ........................ 2D .......... VCAD 

Versa CAD - workfile .............. WRK ........ VCAD 

Versa CAD - work library ........ LIB ......... VCAD 

Video Works II ........................ APPL ...... MMVW 

Video Works II - data ............ VWZP ..... MMVW 

Video Works II - overview ... VWOV ..... MMVW 
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About Type and Creator Codes 
Your Macintosh uses Type and Creator codes to 
perform a variety of functions, which perhaps 
you have come to take for granted. 

Creator Codes 
One of the things you have probably come to 
expect is that when you open a document on 
your desktop, your Macintosh knows which of 
your applications you want to launch to work 
with that document. The Creator code (which is 
actually a part of your document that you 
cannot see) is what tells your Macintosh which 
application to launch. That is, when you open 
the document, the Macintosh file system exam­
ines the Creator code, locates the application to 
which it applies, launches the application, and 
then opens the document you selected so that it 
appears in a window. 

You might have run into a situation at some 
time where you attempt to open a document 
and launch an application only to have your 
Macintosh tell you the application is either busy 
or missing. This normally results from one of 
two conditions: 

• The application is, in fact, either in use or 
not available on your system, or 

• The Macintosh file system cannot match the 
document's Creator code to the application 
you are attempting to launch. 

The first condition is one you can deal with 
rather easily by making the application available 
- that is, by installing it on your system or by 
stopping it from running, as the case may be. 

In this discussion we are concerned with the 
second condition and how it specifically relates 
to your use of SUM II. But first, what about 
Type codes? 
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Type Codes 
Type codes, like Creator codes, tell the Macin­
tosh file system certain specific things it needs to 
know about files. 

In the case of documents (that is, files created by 
applications), Type codes are fairly free form 
and assigned at the discretion of software 
developers. However, in the case of executable 
files (or applications), Type codes must adhere 
to strict standards. 

For executable files, the most common Type 
codes are 'APPL' (for applications), 'cdev' (for 
Control Panel devices), and 'init' (for startup 
documents). If you look at the list of Type and 
Creator codes on the preceding pages, you'll see 
that almost all application type files have a Type 
code APPL. You might also notice that each 
Type cod~ for the various documents created by 
these applications is unique. 

Type codes have a great many uses - far more 
than are pertinent to this discussion. The most 
important point to keep in mind here is that in 
almost every case your applications should have 
the type code APPL. Your documents should 
have the specific Type code indicated for that 
particular type of document in the list on the 
preceding pages. 



Inserting Type and Creator 
Codes 
In Chapter 4, SUM Disk Cli1lic, you learned 
about the three types of Recovery Methods you 
can use to recover files from a volume - Direc­
tory Scan, Volume Scan, and Floppy Recover. 

When you use the Directory Scan method, the 
programs are almost always able to recover a 
file's Type and Creator codes along with the 
data. But, when you use the Volume Scan or 
Floppy Recover methods, the Type and Creator 
codes are rarely, if ever, recovered. 

So if you use either of the latter two methods, it 
is up to you to reinsert the correct Type and 
Creator codes either dllring the recovery process, 
or immediately after. SUM II gives you a way to 
do this. 

During Recovery 

The way to insert the correct codes during 
recovery is to use the Get Info command while 
working with the SUM File Recover window in 
the SUM Recover program. These steps are 
described in Chapter 5, SUM Recover, but we'll 
reiterate them here briefly for your convenience. 

While the SUM File Recover window is on your 
screen, you click the Search button when you 
are ready to begin searching your volume for 
files you can recover. 

Once the search is complete, your recoverable 
files appear in the File List Window. 

Select the file or files you want to recover in the 
File List Window and then choose Get Info from 
the File menu. You then see a dialog similar to 
the following: 

Type and Creator Codes 

File Name 

I Remember.eps 

In Folder 

ITemPlates 

Date Created Date Modified 

11/9/S9 11r--1-2-/2-9-I-SS-6-:0-S-P-M--

Creator Type 

I~I IEPSF 
File Size Recover ab Ie? 

1
26 IYes 

kBytes 

( Done ) ( Change ) ( NeHt 

The information you're concerned with in this 
dialog, of course, are the Creator and Type text 
fields. Also of interest is the indication as to 
whether or not the file is Recoverable. If it isn't, 
there isn't much use inserting Creator and Type 
codes because you won't be able to use the file 
anyway. 

If the dialog you see on your screen already has 
Creator and Type codes inserted, check them 
against the list in this appendix to make sure 
they are correct. If they are, you don't need to do 
anything else. 

If the Creator and Type codes are incorrect, or if 
they are missing altogether, then you need to 
insert the correct codes by typing them into the 
text fields. 

...u- Take your time and check your work 
-n- carefully. Make sure you are inserting 

the correct code into the right text field, 
and also make sure the codes are correct for this 
particular document or application file. 

When everything is correct, click Change. 
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After Recovery 

If you don't discover that a file's Type and 
Creator codes are missing or incorrect until after 
you have exited from SUM Recover, the best 
way to insert the correct codes is to use SUM 
Tools. 

Detailed instructions for using SUM Tools can 
be found in Chapter11, but here again, we'll 
reiterate them for your convenience. 

Launch SUM Tools and after the program starts, 
choose Edit File from the File menu. 

A standard file selector dialog appears. Locate 
and open the file you want to work with. The 
file's data then appears in the Hex Edit window. 

Choose Edit File Attributes from the File menu 
and you see a dialog similar to this: 

Type~ 

D locked [8J bFOwnAppl 

D Inuisible D Changed 

[8J Bundle [8J Inited 

D System D Shared 

DBozo D Cached 

D Reserud1 [8J Reserud2 

D Always Switch launch 

D Neuer Switch launch 

[~I 

creator~ 

D File Protected 

D File locked 

D File Busy 

File Position 

DOn Desktop 

Horiz 1166 

Uert ~IP'iiiiiJ 
[Change] 

From here, the procedure is basically the same 
as described on the preceding page: check the 
Type and Creator codes indicated against the list 
in this appendix. If the codes are correct, no 
further action is required. 

If the codes are incorrect or are missing, insert 
the correct ones by typing them into the two text 
fields at the top of the dialog. Once again, 
double-check to make sure you have entered the 
correct codes into the correct fields. 
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Do not change anything else in this dialog 
unless you fully understand what you are 
changing. 

Once the codes are entered correctly, click 
Change. 

End of Appendix B 



SUM Tools 
Structures 

This appendix contains instructions for creating 
your own structures to use with SUM Tools. 
Structures give you the ability to display mem­
ory in a more discernable way than simply 
looking at strings of hexadecimal characters. 
This feature is provided mainly for software 
developers and advanced users. 

The structure format is defined, and an example 
is also provided. 

You can use any word processing application 
that saves files in pure text format to create 
structures. Once a structure is created, you can 
incorporate it into SUM Tools using the Add 
Structure command in the Macintosh menu. 
SUM Tools converts your structure to an SSTR­
type resource. 

SUM Tools provides a variety of predefined 
structures you can access via the Structures 
command. These structures are discussed in 
Chapter 11, SUM Tools. 
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Structure Definition 

Field 
No. Content Comments 

1 LHST The literal characters 'LHST' must be at beginning of file. 

2 TEXT The literal characters 'TEXT'. 

3 xxxx Four characters. Define decimal x position for printing. 

4 xxxx Four characters. Define decimal y position for printing. 

5 a ... z Up to 100 characters. Text used to label this element. 

6 VALU The literal characters 'V ALU'. 

7 xxxx Four characters. Define decimal x position for printing. 

8 xxx x Four characters. Define decimal y position for printing. 

9 a ... z Up to 100 characters. Text used to label this element. 

10 xxx x Four characters. Decimal offset from base for this value. 

11 xxxx Four characters. (For future use.) 

12 LINE The literal characters 'LINE'. 

13 xxxx Four characters. Decimal x position for Start. 

14 xxx x Four characters. Decimal y position for Start. 

15 xxxx Four characters. Decimal x position for End. 

16 xxxx Four characters. Decimal y position for End. 

17 LAST The literal characters 'LAST'. Indicates end of structure file. 
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Structure Example 

Content Comments 

LHST Indicates this is a structure file. 

TEXT Indicates data is to be displayed as text. 

0200 x position is 200. 

0065 Y position is 65. 

Example Structure Text label to print for this structure. 

VALU Print a value. 

0020 x position is 20. 

0080 Y position is 80. 

qLink Label is printed at x+80,y. 

0000 Offset from base (cursor) is zero. 

0002 Type to print is hexadecimal long. 

VALU Print a value. 

0020 x position is 20. 

0090 Y position is 90. 

qType Label is printed at x+80,y. 

0004 Offset from base (cursor) is four. 

0004 Type to print is hexadecimal integer. 

VALU Print a value. 

0020 x position is 20. 

0100 Y position is 100. 

Decimal Value Long Label is printed at x+80,y. 

0006 Offset from base (cursor) is six. 

0001 Type to print is decimal long. 

LAST End of structure file. 

End of Appendix C 
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allocate - To assign or reserve computer storage 
areas for a specific task. 

allocation block map - Starting in block 2 of a 
disk is an allocation table or map. This map 
represents all the allocation blocks on a volume 
with a 12-bit entry that shows whether the block 
is allocated or not by a file. 

AppleTalk Network - A Local Area Network 
(LAN) that lets everyone in a group connect 
their Macintoshes, other types of computers, and 
their peripherals using cables and connectors. 
Documents, electronic mail, applications, and 
data can be shared across the network. 

Applications - Software programs used to 
create and modify information and perform 
other various tasks. Some examples are MORE 
II, Excel, PageMaker™, Think C, and SAMTM 
Virus Clinic. 

Backup - A procedure that copies and stores 
data to another disk for archival purposes. 

Glossary 

Bad Sector - An unreadable area of a disk con­
taining bad bits, making data within the sector 
inaccessible. 

Baud Rate - The total number of bits transmit­
ted per second. Normally refers to telecommuni­
cations. 

Binary Tree Header (BTH) - This special node 
is found at the beginning of every binary tree. 
There is one for the catalog tree file and one for 
the extents tree file. 

Bit - The smallest unit of information that can 
be represented in binary notation. 

Block - A file unit in which sectors are stored. 

Bomb - A message box containing a bomb icon 
that alerts you when a problem has occurred 
within your software system. Restarting the 
system is required. 

(to) Boot - To start up the computer. 



Glossary 

Boot Blocks - Information for starting the 
Macintosh that is contained within the first two 
sectors of a disk. 

Boot Sector - Blocks 0 and 1 on every disk are 
boot blocks that contain the startup information 
and the bootstrap loader program. 

Bridge - A device that lets you connect Ap­
pleTalk networks together. 

Byte - A set in memory or on disk usually 
containing 8 bits. 

Catalog Extents - Disk storage space allocated 
to the directory. 

Catalog Tree File - One of the binary trees on an 
HFS disk that stores all the directory informa­
tion. 

CDEV - A program accessed through the 
Macintosh Control Panel. Normally CDEV is 
used to configure software. 

Contiguous Space - Space on a hard disk where 
the tracks and sectors are physically next to each 
other. 

Control Panel- A desk accessory used to adjust 
various settings on your Macintosh, such as 
sound, mouse movement, and so forth. 

Copy Protection - Routines that software 
developers build into their programs to prevent 
illegal copying of software. 

Crash - When a system stops working or is 
working incorrectly, forcing you to restart your 
system. 

Creator Code - A code (which is part of a file) 
that tells the Macintosh which application 
created the file. 

Glossary-2 

Daisy Chain - A specific method of spreading 
signals along a bus. This allows devices to be 
assigned priorities based on its electrical posi­
tion along the bus. 

Damaged Volume - A hard disk, floppy disk, or 
volume partition that appears unreadable or 
needs maintenance. The volume may have 
damaged data structures, which organize files 
and documents on a volume. 

Data - Information a program outputs. 

Data Fork - Part of the file that contains the data 
accessed through the Macintosh's File Manager. 

Defragment - To reorganize the fragments on a 
disk into contiguous areas to maximize perform­
ance. 

DES (Data Encryption Standard) - A standard 
encoding scheme developed by the United 
States Federal Bureau of Standards. 

Defective Media - Volumes that do not pick up 
the magnetization pattern written by the disk 
drive. 

Deleted File Record - The record where SUM 
Shield records a deleted file's name and location. 

Desk Accessory - A type of application that is 
accessible at any time, even while another appli­
cation is running. Desk accessories can be ac­
cessed via the IS menu. Examples are Calcula­
tor, Find File, Note Pad, SUM Partition, and so 
forth. 

Desktop - A special program the Macintosh 
uses to represent files, folders, and volumes on 
the screen of your computer. 

Desktop File - An invisible file that is created 
on every volume when it is initialized and is 
subsequently updated to keep track of informa­
tion about the volume, such as which icons are 
used on the desktop. 



Device - Any peripheral or piece of equipment 
that can be attached to a computer. 

Driver Descriptor Map (DDM) - Identifies the 
different device drivers that can be loaded 
during system startup. 

Device Descriptor Sigs - Signature bytes used 
in SCSI boot blocks. 

Device Partition - A special type of volume that 
is actually part of a larger volume and is created 
either by the device manufacturer or by a 
Macintosh user with the help of software 
provided by the manufacturer. Often referred to 
as "hard partitions," "SCSI partitions," and 
various other names. Not to be confused with 
"volume partitions" or "soft partitions." 

Directory - A list of a volume's contents. The 
contents can be listed in numerous ways, such 
as by type, size, date, color, or icon. 

Disk - A device that stores data using a form of 
magnetic impulses. There are two main types, 
floppy disks and hard disks. Often referred to 
generically as a "volume." 

Disk Drive - A device that reads and stores data 
to and from disks. 

Document - A file containing information 
created, modified, and saved using any of 
various applications. 

Downloading - Information retrieved from 
another computer and stored on your own 
computer or Bulletin Board Service (BBS). 

Driver - Software that tells your Macintosh how 
to access and work with a device. 

Encrypt - Coding data in such a way that makes 
it unrecognizable for normal purposes. 

Glossary 

Erase Disk - Found on the Special menu, this 
command completely clears the disk of informa­
tion. If you use this on a floppy disk, there is no 
chance of recovering your files. 

Error Message - An alert indicating that a 
problem has occurred. 

Extents Tree File - One of the binary trees on an 
HFS disk that is used for file mapping. 

FasCrypt - A special form of encryption used 
only with SUM Encrypt. 

File - Accumulative data stored on a disk, 
either as an application or a document. 

File Extent - A series of contiguous allocation 
blocks. Usually the contents of a file are stored 
in several extents across parts of a volume. 

File Server - A file-sharing system that makes 
volumes or folders on a hard disk available to 
multiple users. An example is AppleShare. 

Finder - A special Macintosh application used 
to get information to and from volumes. 

Font - A collection of typographical symbols 
with a consistent typeface. 

First block of Bt Map - First block where the 
volume bit map is stored. 

Fork - One of the two parts of a file, either a 
data fork or a resource fork. 

Format - The storage capacity of a disk. Single 
sided disks can store up to 400K, double sided 
disks up to BOOK, and high density disks up to 
1.4 MB (megabytes). 

HFS - (Hierarchical File System) A multilevel 
method of organizing information on a volume 
so that the files and folders can be stored within 
folders. 
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Hard Partition - See "Device Partition." 

Highlight - A video effect used to indicate 
when an object is selected on a computer screen. 

Icon - A graphic symbol used to represent a file. 

Init File - A type of application file that resides 
in a system folder and loads into memory 
during the startup procedure. Often referred to 
as a "startup document." 

Interface - The software or hardware that links 
a device to the computer. 

Initialize - The process of preparing a volume 
so that you can get information from or save 
information to the volume. The process writes 
zeros to each sector of the disk; therefore, in the 
case of a floppy disk, it eliminates any chance of 
recovering data because the disk is completely 
cleared of information. 

LAN - (Local Area Network) A network of com­
munication cables that physically links personal 
computers together. It usually includes cabling, 
network software, and application software. 

Launch - To start an application. 

Lock - To prevent a volume or file from being 
altered. 

Master Directory Block (MDB) - The data 
structure of a flat directory volume where the 
volume information and the volume allocation 
block map is stored. 

Megabyte - (MB) A unit that measures a com­
puters memory equal to 1024K. 

MFS - (Macintosh File System) A single-level 
method of organizing information on a volume. 
Used with early Macintosh computers but 
superceded by HFS (Hierarchical File System). 

Glossary-4 

Modem - A device that makes it possible for 
computers to exchange information over phone 
lines. 

Mount - Make a volume available for use. For 
example, when you insert a floppy disk into the 
drive, the volume is mounted when its icon 
appears on the desktop. 

Multitasking - Hardware or software that 
enables you to work on more than one task si­
multaneously. 

MultiFinder - A special system softwareappli­
cation that makes it possible to have one or more 
general applications open at the same time. 

Nesting - The placing of folders within one 
another. 

Operating System - A special program that con­
trols basic tasks, such as memory management, 
input/ output processing, interrupt handling, 
and so forth. Also controls operation having to 
do with ROMs, System file, and the Finder. 

Option Card - Specialized functions controlled 
by an electronic function card. Some examples 
include accelerators and coprocessors. 

Orphan - A block on a volume that doesn't have 
a directory entry, file allocation, or belong to any 
file or operating system. 

Parameter RAM - An area of memory where 
Control Panel settings and ongoing basic 
functions are stored. It is battery powered, so the 
information is retained even after the machine is 
turned off. 

Partition - A segment of a volume that is treated 
as a completely separate volume. 

Pop-up Menu - A menu that appears some­
where else other than the menu bar, usually in a 
dialog box, and is identified by a shadowed box. 



Port - A connection socket for a cable. Normally 
located on the back side of a computer. 

Printer Driver - A system file that sends infor­
mation to a corresponding printer. 

RAM - (Random Access Memory) The internal 
memory that stores information temporarily. 
When power is turned off, all data in RAM is 
lost. Parameter RAM (see above) is an exception. 

RAM Cache - A feature that sets aside and 
retains information for an application's repeated 
use. This process is faster than retrieving infor­
mation from a disk. The settings are located in 
the Control Panel. 

Resource Fork - Part of the file where the data 
used by the application is stored, for example, 
icons and menus. 

ROM - (Read Only Memory) Permanent mem­
ory used to store programs that the computer 
uses for various system operations, such as the 
information used at startup. 

SCSI - (Small Computer System Interface) An 
industry standard high-speed interface that 
transfers data from one device to another. 

SCSI Cable Terminator - Hardware devices 
which attach to a SCSI device or cable. Only one 
terminator at the beginning and one at the end 
of a SCSI chain is allowed. 

SCSI ID Number - Device ID number that 
identifies the device and its priority on the 
chain. Only numbers 0 through 7 can be used to 
identify the device's priority onthe chain. 

SCSI Partition - See "Device Partition." 

SCSI Port - A connector located on the back 
panel of a computer (see "Port" above). 

Sector - The storage unit of a volume for basic 
files. 

Glossary 

Serial Interface - A single-path communication 
line that transmits information sequentially, one 
bit at a time. 

Serial Port - A serial interface connector located 
on the back panel of the computer. 

Signatures - Files with special information that 
helps SUM Recover locate and recover files from 
a crashed disk. 

Soft Partition - See "Volume Partition." 

Startup Disk - A disk containing a Finder and a 
System file that your Macintsoh uses to get 
started. 

Startup Document - See "Init Files." 

System File - A collection of information that 
starts up the computer. This program combined 
with a Finder creates an operating system, 
which cannot be launched like a normal applica­
tion. 

System Folder - A folder that contains the 
system file and other programs that control your 
Macintosh. 

Trash - An icon displayed on the desktop used 
for discarding unwanted files. 

Type Code - A code (which is part of a file) that 
specifies the file's type, such as an application, 
Control Panel device, or startup document. 

Virus - A program designed to infect and 
modify data, altering your Macintosh's behav­
ior, usually meant for destruction. 

Volume - Any source that can be read from or 
written to, such as a hard disk, floppy disk, 
volume partition, device partition, or tape drive. 

Glossary-S 
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Volume Bit Map - A data structure used in the 
hierarchical file system that contains a sequence 
of bits with one bit for each allocation block that 
tells if the block is allocated or available for use. 

Volume Information Block - In a hierarchical 
directory, this block contains the volume 
information. 

Volume Information File - A special file SUM 
Disk Clinic uses to determine certain characteris­
tics about a specific volume. 

Volume Parameter - A directory of information 
regarding your hard disk, including size, 
drivers, etc. 

Volume Partition - A segment of a larger 
volume that is created with a special application 
and can only be accessed using the same appli­
cation. For example, SUM Partition creates and 
accesses volume partitions. Contrast with 
"device partition," which can be accessed by the 
Macintosh file system. 

Volume Restore Record - Record that gives 
SUM II the ability to restore a crashed or acci­
dentally initialized volume. 

Zone - An interlink of networks connected by 
bridges. 

End of Glossary 
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menu 11-19 

Map Window 11-4 
memory 

editing 11-9 
map structure 11-11 
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SUM II'" 
Symantec Utilities for Macintosh 

Crashed Disk and File Recovery, Backup, Optimization, and Security 

SUM II ™ is a completely new version of the award-winning Macintosh utility program. This 
version offers all of the power and usefulness of SUM Version 1 while incorporating an 
entirely new interface. three new utility programs. and added features in every other utility. 
SUM II is the most powerful set of utilities available for ensuring that your data is safe. 
secure. and efficiently organized. 
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SUM Disk Clinics easy-to-use interface guides 
you through the recovery process and helps you 
decide what you need to do. 

SUM II Components 
New Utilities! 
• SUM Backup (based on the popular 

7 Redux program from Microseeds Publish-
ing) helps you quickly and easily make 
backup copies of files and applications. 

• SUM Quick Fix will attempt to repair a 
crashed hard disk. 

• SUM Encrypt secures files and folders 
with two forms of encryption (including 
DES). 

Improved Utilities! 
• SUM Shield makes data recovery fast 

and easy when preinstalled and protects 
your data in the event that a disk crashes 
or your hard disk is initialized by mistake. 

SUM Tools compatible only with System 
4.2 and 6.X. 

SUM Backup 

II. Select 88Clcup or Restore function 
• 12. Select one uolume from eoch list 
~ 13. Choose II script from the popup menu 

~ Click the "Begin" button 

B~uprROM. •• 

Hard Dlsle 
I Bockup +1 
I . Restore I 

Backup euerythlng 

I 8aclcup Disk I 

SUM Backup allows you to easily back up and 
restore critical files and applications. 

• SUM Recover can recover your data 
from a floppy or hard disk even when 
SUM Shield is not installed. 

• SUM TuneUp defragments files. optimizes 
disk space. erases free space. verifies 
data. and locks out bad disk sectors. 

• SUM Partition divides disks into multiple 
volumes which you can encrypt and 
password-protect. 

• SUM QuickCopy duplicates and initializes 
floppies much faster than the Macintosh 
desktop. 

• SUM Tools edits files. disks. and memory. 
and contains a graphics editor and 
disassembler. 

• SUM Disk Clini,c helps you "diagnose" 
disk problems and decide how best to 
solve them. 

1919 Macworld 
World Class AWllni 

1!111 MedJMr 
5-111ice rating 

System Requirements 
• Works with a Macintosh Plus or 

higher 
• Works with any floppy disk. hard 

disk. SCSI device. volume file. or 
optical disk 

• Compatible with AppleShare. TOPS. 
and MacServe ~ 

• Requires System v4.2 and Finder v6.0 
or higher 

• Multifinder compatible 
• Not copy protected 

Inlernatlonal versIons of SUM tI are avanable. 
c an Symanlec Inlem atlonal Sales 
al (408) 253-9600. 

Symantec's 3D-day Money Back Guarantee: If you are 
dissatisfied with this Symantec software program. return it to 
your dealer within 30 days for a full refund. 

Use of this product is subject to acceptance of the Symantec 
license Agreement on the sealed diskette envelope included in 
this package.'.. . 

SUM II is a trademark of Symantec Corporation. Other brand 
and product names are trademarks of their respective holderls 
and should be noted as such. © 1989 Symantec Corporation. 
All rights reserved. Printed in U.S.A. 
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